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Copyright 
This documentation is protected by law.  

All rights, especially the right to duplicate, circulate, and translate, are reserved. 

No part of this publication may be reproduced in the form of copies, microfilms or 
other processes, or transmitted into a language used for machines, especially data 
processing machines, without the express written consent of the publisher. 

All copyrights reserved. Errors in and changes to the contents as well as program 
modifications reserved. 

Copyright © MAGIX Software GmbH, 2001 - 2017. All rights reserved. 

MAGIX is a registered trademark of MAGIX Software GmbH. 

Other named product names may be registered trademarks of their respective 
owners. 

This product uses MAGIX patented technology (USP 6,518,492) and MAGIX patent 
pending technology. 
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Preface 
Congratulations on purchasing MAGIX Movie Edit Pro Plus and Premium! 

The useful wizards and templates contained in MAGIX Movie Edit Pro Plus 
and Premium make it easier than ever before to get started with video editing. Create 
videos of your very own for sharing with friends and family by using the program's 
flexible tools for creating effects, background music, menus and much more. MAGIX 
Movie Edit Pro also offers: 

• Record and import all common video formats 
• Video and audio content optimization 
• Possibility of adding transitions, titles and effects 
• Disc menu creation for DVD, Blu-ray Disc, and others 
• Upload videos to the Internet, e.g. to YouTube or Facebook 

In addition to tons of extras, the Plus/Premium version offers everything you need to 
edit 360° material and even position objects in 360° space. Once you're done, you 
can export your 360° video to be displayed on a 360° viewer. You can also integrate 
your 360° material into a 2D video and view it as a "normal" 2D video on your TV. 

Enjoy! 

Your MAGIX team 
 

Note regarding special program versions: This documentation describes the full 
range of features in MAGIX Movie Edit Pro. The range of features may differ in the 
program version/edition you have acquired. 
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Video 360 
If you received MAGIX Movie Edit Pro as part of the Video 360 package, in addition 
to the other software components you also have access to a range of extra services: 

Catooh 

Redeem your coupon at www.catooh.de and select $35.00 worth of MAGIX content. 

Premium telephone support 

Use the Telephone Support coupon by contacting our MAGIX Technical Support 
Team (please refer to the section "Premium Telephone Support"). 

 



 

 

Table of Contents 5 

 

Table of Contents 

Copyright 2 

Preface 3 

Video 360 4 

Customer Support 12 
Particularities for purchases made through Steam™ 14 

System requirements 15 
Uninstalling the program 15 

Serial number 16 

Update Service 17 

Introduction 18 
What is MAGIX Movie Edit Pro? 18 
Classic, Plus, Premium and Control 18 
What is new in MAGIX Movie Edit Pro? 20 
Features 21 
Additional programs 22 

Quick start 23 
Projects, movies and objects 23 
Program start 24 
Import video 25 
Insert AVCHD material 26 
Play movie 27 
Media Pool 27 
Display modes 28 
Removing unusable scenes 32 
Regroup scenes 35 
Burn DVDs with interactive menus 36 
Note: Backup copies 37 

Workspaces 39 
"Edit" screen 39 
Preview monitor 41 
Transport console 44 
Media Pool 46 



 

6   

www.magix.com 

Project window 60 
Toolbars 63 
Adjusting the workspace 72 
The "Burn" screen 72 

Settings 74 
Project and movie settings 74 
Program Settings 76 
Proxy and preview rendering (Plus/Premium version) 83 

Video recording 86 
Select the recording method 86 
Recording AVCHD 86 
HDV camera 90 
DV camera 90 
Analog video recording 96 
Audio 99 
Single frame 102 
Screen Capturing 103 
Edit after recording 105 
Transferring a Movie Edit Touch Project from Android 106 
Import a non-copy-protected DVD 107 

Objects 108 
Insert object into the project 109 
Select and group objects 111 
Move Objects 112 
Cutting objects 112 
Duplicate objects 113 
Object handles 113 
Trim Objects 114 
Extract sound from videos 116 
Save objects separately 116 
Transitions (fades) 118 

Markers 121 
Playback marker 121 
Project markers 121 
Snap markers 122 
Area marker (in and out points) 123 
Chapter markers 123 



 

 

Table of Contents 7 

 

Scene markers 125 
Snap markers and transients (Plus/Premium versions) 126 

Multi-cam editing (Plus/Premium version) 128 
Preparation 128 
Source tracks and preview images 129 
Multicam edit functions 130 
Synchronize video objects using the audio track 131 

Title 132 
Creating titles using a template 132 
Create titles without a template 132 
Edit titles retroactively 134 
Position titles 134 
Other text settings 134 
Fade in date as title 135 
Timecode 136 

Effects 137 
Apply effects to objects 137 
Presets 138 
Video effects in the Media Pool 138 
View and animation 147 
Stereo3D in the Media Pool 153 
Audio effects in the Media Pool 154 
Design elements in the Media Pool 155 
Snap marker (only in the Plus/Premium versions) 155 
My Presets in the Media Pool 155 
Extra effects 155 
Effects masks (Plus/Premium version) 158 
Animate objects, effect curves 162 
Attach to picture position in the video 168 
Image stabilization 169 
Image improvements for the entire movie 171 
Image improvements for individual objects 173 

Audio editing 174 
Load and edit audio files 174 
Adjust loudness of all selected objects 174 
Edit volume curve 175 
Import audio CDs 176 



 

8   

www.magix.com 

Audio effects 179 
Mixer 196 
5.1 Surround 199 
Scrubbing 203 
MAGIX Soundtrack Maker 205 
Mixdown of audio objects 206 

Stereo3D (Plus/Premium version) 208 
3D basics 208 
Record 3D 209 
Prepare 3D editing 210 
Set playback mode for 3D 211 
Align videos and images for 3D 212 
Turn camera movements into 3D videos 213 
Export and burn 3D videos 214 

Special functions and wizards 216 
Proxy editing (Plus/Premium version) 216 
Preview rendering 217 
Use movie templates 219 
Automatic scene recognition 221 
Travel route animation 222 
Produce panorama pictures 230 
360° videos 231 
Slideshow Maker 235 
BPM Wizard 238 
Batch conversion 242 
Backup copy 244 
Load backup project... 245 
Clean-up wizard 246 

Burning 247 
Preview and editing 247 
Menu 248 
Templates 249 
Edit disc menu 250 
Burning wizard 257 
Create label and CD cover 262 

Export 263 
Output as video file 263 



 

 

Table of Contents 9 

 

Export to device 263 
Upload to Internet 265 
Upload to Vimeo 266 

Menus 267 
File Menu 267 
Edit Menu 282 
Effects Menu 291 
Windows Menu 297 
Share Menu 300 
Help Menu 301 
Context menu (right click) 303 

Problems and solutions 318 
File will not load 318 
Choppy or uneven playback 318 
Problems and Remedies regarding the Auto Remix Assistant 318 
Activation problems 319 

Keyboard shortcuts 320 
Playback functions 320 
Monitors 321 
Project window view 321 
Move view and start marker 321 
Transport control in the Media Pool 322 
Mouse Modes 322 
Insert modes 323 
File menu 323 
Edit menu 324 
Effects menu 326 
Window menu 328 
Help menu 328 
Edit keyboard shortcut 328 

Integrated browser 330 
Open browser 330 
Navigation in the browser 330 
Loading Internet media 331 
Define the path for saving Internet media. 331 

Annex: Digital Video and Data Storage 332 
MPEG Compression 332 



 

10   

www.magix.com 

General notes on AVI videos 332 
Overview of the different disc types 333 

Activate codecs 337 
Activate MPEG-4 (MainConcept) (fee-based) 338 
Activate HEVC (fee-based) 339 

MPEG-2 encoder settings (Standard) 340 
Video 340 
Audio 342 
Image settings 342 

MPEG-4 encoder settings (standard) 343 
Video 343 
AAC audio 345 
Image settings 345 
Multiplexer 345 

HEVC encoder settings 346 
Video 346 
Audio 347 
Multiplexer 347 

MPEG-4 encoder settings 348 
Video codec 348 
Audio codec: 356 
Multiplexer 357 

MPEG glossary 359 
Motion estimation 359 
Bit rate 359 
Block 360 
Chroma format 360 
Field 360 
Frame 360 
GOP 361 
I frames 361 
Interlace 361 
P frames and B frames 363 
Prediction 363 
Quantization scaling 364 

If you still have questions 365 



 

 

Table of Contents 11 

 

Tips for Program Help 365 

Glossary 366 

Index 381 
  



 

12   

www.magix.com 

Customer Support 
Dear MAGIX customer, 

Our aim is to provide convenient, fast and solution-focused support. To this end, we 
offer a wide range of services:  

• Unlimited online support: 
As a registered MAGIX customer, you have unlimited access to web support 
offered by the MAGIX service portal support.magix.net. You have access to an 
intelligent help wizard, high-quality FAQs, patches and user reports that are 
constantly updated. 
The only requirement for use is product registration on www.magix.com. 

• Online Community as an immediate support and exchange platform: 
The Online Community www.magix.info is available for free to all registered 
MAGIX customers without any limitations. The community includes approx. 
175,000 members and offers the opportunity to ask members questions 
concerning MAGIX products as well as use the search function in order to 
search for specific topics or answers. In addition to questions & answers, the 
knowledge pool includes a glossary, video tutorials and a discussion forum. The 
multiple experts, found round-the-clock on www.magix.info guarantee quick 
answers, which sometimes come within minutes of a question being posted. 

• Premium Telephone Support: 
If you have received MAGIX Movie Edit Pro as part of the Video 360 package, 
you have access to Premium Telephone Support. During the Video 360 
subscription period you have two tickets per year which can be redeemed using 
the coupon code. 
The coupon code can be found in the Video 360 order confirmation. 
Use the Telephone Support coupon by contacting our MAGIX Technical Support 
Team at the listed number and following the instructions: 

Telephone: 0203 3183666 (UK and IE Costumers) 

1-775-562-0527 (US) 

AU and ZA Costumers: Please contact the office that is nearest to 
your location. International call charges may apply*. 

Accessibility: Monday - Friday (business days) 9:00 am - 4:00 pm 

 * Please remember to add the appropriate country code for the 
country you are dialling, 001 for the US and 00 44 for the UK 

Important Notice: The coupon code for Telephone Support can be used twice within 
one year after the conclusion of the contract. If the annual license is renewed, the 
same coupon code can be used again twice within one year after conclusion of the 
contract renewal. 
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• Email support for MAGIX products: 
For each new MAGIX product you will automatically receive 12 months free 
customer support by email. 

• Premium Email Support: 
For priority support, or if you want the support team to help with non-MAGIX 
related hardware problems you can purchase a premium email support ticket. 
Proceed as follows: 
1. Go to the MAGIX customer support page at http://support.magix.net. 
2. Sign in using your login details. 
3. Click on "Buy access code" in the navigation bar. 

Each ticket corresponds to a specific problem, it will remain valid until the 
problem has been solved. A ticket is not limited to a single email.Log in at 
http://support.magix.net and click on "Purchase access code". The ticket is 
not limited to one email, it corresponds to a specific problem and remains so 
until the problem has been solved.  

Please note: In order to be able to use the Premium email support and free product 
email support online, you have to register your MAGIX product using the serial 
number provided. This can be found on the CD case of your installation disc or on 
the inside of the DVD box. 

• Additional telephone service: 
As well as the large number of free customer service offers, we also offer a fee-
based telephone customer service. 

Here you can find a summary of our technical support telephone numbers: 

http://support.magix.net/ 

Mail (Europe): MAGIX Development Support, P.O. Box 20 09 14, 01194 Dresden, 
Germany 

Mail (North America): MAGIX Customer Service, 1105 Terminal Way #302, Reno, 
NV 89502, USA 

Please make sure you have the following information at hand: 
• Program version 
• Configuration details (operating system, processor, memory, hard drive, etc.), 

sound card configuration (type, driver) 
• Information regarding other audio software installed 
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MAGIX Sales Department 

You can reach the MAGIX Sales Department workdays for help with the following 
questions and problems: 

• Orders 
• Product consulting (pre-purchase) 
• Upgrade requests 
• Returns 

Europe 
Monday - Friday, 09:00-16:00 GMT 

U.K.: 0203 3189218  

Denmark: 45 699 18763 

Sweden: 46 852 500713  

Finland: 35 89 42419023 

Norway: 47 210 35843 

North America 
9 am to 4 pm EST Mon-Fri 

Phone: 1-305-722-5810  

Particularities for purchases made through 
Steam™ 
Different conditions apply if you have purchased the program through Steam™. You 
can find more information at https://support.steampowered.com 
https://support.steampowered.com. 

https://support.steampowered.com/�
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System requirements 
For Microsoft Windows 7 | 8 | 10  

Minimum system requirements 

• Processor: Dual-core processor with 2.4 GHz 
• RAM: 2 GB 
• Graphics card: Onboard graphics card with a minimum screen resolution of 

1280 x 1024¶ 
• Hard disk space: 2 GB free disk space for program installation 
• Optical drive: DVD drive 
• Internet connection: Required for activating and validating the program, as well 

as for some program features. Program requires registration. 

Recommended configuration for 4K/HD editing 

• Processor: Quad-core processor with 2.8 GHz or better 
• RAM: 8 GB 
• Graphics card: Dedicated graphics card with 512 MB VRAM or more 

Uninstalling the program 
If you would like to uninstall MAGIX Movie Edit Pro, go to the Control Panel and 
select "Software" or "Programs and Features". 
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Serial number 
A serial number is included with each product. This serial number is required for 
software activation. Please store this number in a safe place. 

What does a serial number do? 
With a serial number your program license is clearly assigned to you and only you. 
This allows you to use the free customer service via email.  

Serial numbers also help protect against software piracy. This makes it possible for us 
to offer our customers the most value for their money. 

Where is the serial number located? 
The serial number is on the insert card in the program box. 

If you have purchased the download version, you will receive a confirmation email 
containing the serial number that you can use to activate the program. This will be 
sent immediately following purchase to the email address you provided. 

When is the serial number needed? 
The serial number is required when you start the program the first time, as well as for 
program registration. 
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Update Service 
We know that many of you find it frustrating to have to wait a whole year for our next 
update knowing that we are working on (and likely finished) creating new cutting 
edge features and additional content. For us it was also unsatisfying to wait twelve 
months before making the results of our hard work accessible to our customers. 

So we’re changing the model. From now on, we're no longer publishing in yearly 
intervals, but only when something new is finished. We believe this move away from 
once-a-year major updates and towards a more regular update process is better for 
our customers. 

To this end, we have developed the Update Service. For 365 days after the purchase, 
your get free access to: 

• the new Online Content Catalog, including any new templates, graphics and 
designs released during that time, 

• all program upgrades, patches and program features for MAGIX Movie Edit Pro 
released in this period. 

After the expiration of this year period, you can decide whether on not you would like 
to renew your subscription to the Update Service for a fee. You can do this in the 
MAGIX Movie Edit Pro update dialog. 

It’s important to note that our update service is not a subscription. The program you 
purchased is your property. You can keep it, and it will continue to function, without 
your having to pay anything more. If after the expiration of 365 days you decide 
against prolonging the Update Service, you will simply lose access to additional 
updates, new contents and online services. 

Note: If you don't extend the update service, program updates will continue to work 
after the 365 day period. However, if you reinstall the program, updates from this 
period will no longer be included. The software will be reset to the state before the 
time of registration. 

 

Note regarding special program versions: This documentation describes the full 
range of features in MAGIX Movie Edit Pro. The range of features may differ in the 
program version/edition you have acquired. 
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Introduction 

What is MAGIX Movie Edit Pro? 
MAGIX Movie Edit Pro is a complete all-in-one movie studio for your PC. With 
MAGIX Movie Edit Pro you can easily transfer your recordings to your computer and 
then to DVD, AVCHD or Blu-ray Disc after you have enhanced them. It's perfect for 
theater-quality presentation on TV, screen, or monitor. 

Videos, photos as well as additional audio and video material can be transferred from 
various devices to PC. Longer movies can be automatically separated into chapters or 
scenes. You can also do the opposite and automatically combine individual recordings 
to make a single movie. 

Add music, theater-quality transitions, text and selected effects to your own movies 
with a click. The easy-to-use interface, advanced technology and handy assistants 
guarantee perfect results at lightning speed! 

Once your video is finished, you can use it in different ways: transfer it back onto the 
tape or to your camcorder. You can also burn it to disc and view it on TV. Or share 
your video on Internet platforms such as YouTube or Facebook. 
 

Classic, Plus, Premium and Control 
MAGIX Movie Edit Pro is available in four versions: 

• The standard version MAGIX Movie Edit Pro is aimed first and foremost at 
beginners who want to easily make and edit videos on their PC without the need 
for previous video editing experience. This program version contains helpful 
picture and sound wizards that help make the video editing process easier, as 
well as an intuitive user interface. 

• The advanced version MAGIX Movie Edit Pro Plus offers all of the features of the 
standard version plus extra tools and features for video editing. This version is 
intended for advanced users. 

• MAGIX Movie Edit Pro Premium contains all of the features of the Plus version. 
This version also comes with powerful add-on programs from third party 
providers. 

• MAGIX Movie Edit Pro Control is a bundle consisting of the Premium version of 
the program and a MAGIX video editing keyboard for maximum ease of use on 
the most demanding of projects. 
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MAGIX Movie Edit Pro includes the following core features: 

• 32 tracks 
• Automatic wizards 
• 4K and HD support 
• Over 1000 effects and templates 
• Videos with interactive DVD and Blu-ray Disc menus. 
• Direct upload to YouTube, Facebook and Vimeo 

Additional features contained in the versions PLUS, Premium and Control: 

• 99 tracks (instead of 32) 
• Over 1500 effects and templates (instead of 1000) 
• 3D support 
• Multicam editing with up to four cameras 
• Shot match 
• 360-degree camera editing 
• Dolby Digital 5.1 
• Scalable proxy editing 
• Secondary color correction 
• NewBlue Titler EX 

Exclusive features contained in the versions Premium and Control: 

• Add-on programs/plug-ins: Motionstudios Vasco Da Gama 9, NewBlue Titler 
Pro Express, NewBlue ActionCam Package  

Exclusive features contains in the Control version: 

• Video editing keyboard with LED backlit keys 
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What is new in MAGIX Movie Edit Pro? 
New or improved features Classic Plus Prem. 

New program interface with redesigned Mediapool and 
integrated in-app Store 

x x x 

Twice as many multimedia tracks (max. 200 tracks)  x x 

Significantly faster playback performance (5 times faster 
preview for 4K material) 

x x x 

Import (view page Fehler! Textmarke nicht definiert.) 
media directly from Google Photos and Google Drive 

x x x 

Enhanced 360° editing (view page Fehler! Textmarke 
nicht definiert.): 

• 360° stitching + camera presets 
• Auto-recognition of 360° video material 
• 360° perspective rotation/anchor point 
• Optimized workflow 

 x x 

CEWE photo upload (DE & AT only) x x x 

IAS Content Pack Plus: Free additional content from the in-
app Store 

 x  

IAS Content Pack Premium: Free additional content from 
the in-app Store 

  x 

 

Note regarding special program versions: This documentation describes the full 
range of features in MAGIX Movie Edit Pro. The range of features may differ in the 
program version/edition you have acquired. 
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Features 
Recording 
MAGIX Movie Edit Pro features the following recording options: 

• AVCHD camera 
• HDV cameras: HDV1 and HDV2 camcorders 
• DV cameras: Mini DV camcorders or DV video recorders 
• Video: Analog TV, video input, VHS recorders, webcams 
• Audio: Microphones, cassette recorders, MiniDisc players, turntables 
• Screen (Plus/Premium version):  PC monitor. 
• Single frame: Single and series images from webcams, video recorders, video 

cameras, or TV cards 

Analog capture requires capture cards compatible with DirectShow. DV recording 
take place via FireWire. 
 

Supported formats 
Import:  
Video: (DV-)AVI, HEVC/H.265*, M(2)TS, MJPEG, MKV, MOV, MPEG-1/2/4, MXV, 
VOB, WMV(HD) 

Audio: MIDI, MP3, OGG, Surround-Sound/5.1, WAV, WMA 

Image: BMP, GIF, JPEG, TGA, TIF 

Export: 
Video: AVCHD disc, Blu-ray Disc, DVD 

Audio: WAV, MP3 

Image: JPEG, BMP 

Note: This program requires an Internet connection for many of its functions. MP3 
export requires installation of Windows Media Player Version 10 or higher. 

The Quicktime Library must be installed for Quicktime files (*.mov). 

*The codec requires a fee-based activation the first time you import or export HEVC 
material. 
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Editing 
• Picture optimization: Color improvement (RGB,saturation), sharpness (focus 

and feathering), brightness regulator (brightness, contrast), anti-flicker filter. 
• Sound optimization: The equalizer allows you to manipulate the frequency 

spectrum – perfect for cleaning-up muffled dialog. The compressor is a dynamic 
volume regulator. The StereoFX processor controls the position of the sound 
within the stereo panorama. The denoiser and dehisser are professional noise 
reduction tools for removing noise and hisses. 

• Video effects: For example, creative filters, distortion, video mix (Chromakey), 
movement effects (e.g. camera/zoom or rotation), cropping, picture-in-picture 
collages, video effect plug-in support. 

• Automatic scene detection 
• Slideshow Maker turns drab photo collages into spectacular multimedia shows. 
• MAGIX Soundtrack Maker offers a huge selection of fitting sounds for your 

background music. 
 

Burnable disc formats 
You will find the following burning options in the "Burn" area: 

• DVD 
• Blu-Ray disc 
• AVCHD disc (on DVD and Blu-ray Discs) 

In the "File" menu you can make and burn backup copies. 
 

Multimedia editable disc menus 
Included are many disc menu templates which offer selection options for movies and 
chapters on the screen. Many of these are also available in 16:9 format. They can be 
included during burning and give the disc a professional appearance. 

Every menu template may be customized with personal photos, thematic animations, 
3D captions, sound, intro videos, etc. 
 

Note regarding special program versions: This documentation describes the full 
range of features in MAGIX Movie Edit Pro. The range of features may differ in the 
program version/edition you have acquired. 

 

Additional programs 
On the MAGIX website you'll find many additional programs you can use with 
MAGIX Movie Edit Pro. Have a look at the sections "Video" > "Additional Products" 
and "Free Download".
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Quick start 

This chapter explains the basic functions of MAGIX Movie Edit Pro with a step-by-
step introduction. A systematic description of all program functions can be found in 
the following chapters. 

Tip: Use the online tutorial videos that can be accessed in the "Help" menu. This 
feature requires an Internet connection. 

The program keyboard shortcuts (view page 320) for commonly used processes 
and functions are also very helpful. 

 

Projects, movies and objects 
In MAGIX Movie Edit Pro you will be working with "projects", "movies" and "objects". 
In order to work quickly and intuitively, it is important to know the differences 
between these three hierarchically-ordered terms. 

Project A "Project" includes everything that you want to include on a disc. 
Normally this means one or more movies and a menu structure for 
selecting movies for playback. Projects can be saved as "MVP" files on 
your hard drive and can be loaded later to do further editing to the 
movies. 

 

Movie A "Movie" can be one single video clip or a combination of clips and 
photos. It can also include music, titles, transitions and much more. 

Each movie can be exported individually as a video. The "project" can be 
considered a type of drawer into which you can put multiple movies that 
will be edited together and burned to the same disc. 

 

Objects "Objects" are the individual units of the movie. There are different types 
of objects (view page 108): videos, photos, titles, transitions, decorative 
elements, audio (sound). 

Summary: „Projects“ contain „Movies“ and „Movies“ contain „Objects“. 
 



 

24   

www.magix.com 

Program start 
Once you have installed MAGIX Movie Edit Pro, start the program from the Windows 
start menu. The following dialog opens: 

 

Here you can decide if you want to "Load an existing project" for further editing and 
burning to disc or if you want to "Create a new project". 

You can "Automatically create proxy files" in the Plus/Premium version. The original 
material is already converted to a suitable target format in advance, which can (view 
page 216) save a lot of time when editing and exporting when finished. 

In "Movie settings" you can set up the target format for your movie you want to 
create (display norm, resolution, frame rate). This setting has no effect on the internal 
processing quality and can be changed at any time by going to "File" > "Settings" > 
"Movie" (view page 74). 

If you select the option "Add new project folder", all of the files for that film will be 
saved as copies in this folder and used for editing. This option is designed for cases 
where original material is divided between various media, e.g. hard drives, USB flash 
drives, memory cards. The internal hard drive is the best option for working on 
projects in MAGIX Movie Edit Pro because it allows faster access to files compared to 
external storage devices. If files stored on external devices are used it can lead to 
delays and stutters during project editing. You can create a backup of the project 
folder at a later time. 
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Note: If your hard drive is partitioned, you should not save your project folder in C, 
i.e. not on the drive with the Windows operating system. MAGIX Movie Edit Pro 
requires a lot of space. 

 

Import video 
In the following we assume that you want to import an AVCHD recording into the 
program.  

Tip: Pay close attention to which folders you use to save your files and footage so 
you can find them again easily to import and edit them in MAGIX Movie Edit Pro. 
Do not save files under C:\Windows\ or in any of the program folders! Give your 
files and folders short, concise names. 

If you don't have such a recording at hand now, you can load material form the hard 
disk in order to try out the MAGIX Movie Edit Pro workflow. We recommend using 
the included demo project for this: 

 

1. In the Media Pool, click the button "My Media > 
Projects".  

2. Next, open the "_Demo" folder by double clicking 
and then load the MVP movie files.  
( „_Demo.MVP“) by double clicking. 

Note: If you import media to a project, MAGIX Movie Edit Pro must always have 
access to these files. This means that you cannot rename these files, e. g. in 
Windows Explorer or Media Pool, if they have already been imported because 
MAGIX Movie Edit Pro won't be able to find them. Renaming or relocating files can 
lead to error messages and you will have to specify the files and folders again. For 
larger projects this can become very time-consuming. 
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Insert AVCHD material 
3. Connect your AVCHD storage devices (camera, USB stick, SD card and others) 

to your PC. You may first have to turn your camera on. 
4. Click on the red button underneath the preview monitor. 

 
The recording selection dialog will open: 

 
5. Select "AVCHD" from the recording dialog. 

The AVCHD import wizard will open. 
6. Select your connected storage devices as "video source". 

A file list will appear. 
7. In the file list, select all the recordings that you have imported from the device. 
8. You can preview all your recordings using the preview monitor in the middle of 

the dialog in order to decide if they are suitable for your movie. 
9. After selecting all videos, select in "Import options" whether the recordings 

should be directly placed into your movie project or simply copied to your 
computer's hard drive (select the location under "Save in folder"). You can also 
automatically delete your recordings after import. 
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Play movie 
• To play the recording ( or the demo project), click on the play button 

on the transport control below the preview monitor. 
 

During playback a vertical line will move across the project window. This is the 
playback marker that displays the current position. It can be set directly with a 
mouse click in order to jump to certain positions. 

Tip: An even easier way to control playback is by pressing the space bar on your 
keyboard. 

 

Media Pool 

 

The Media Pool can be used to access and load media files of all kinds: videos, photos, 
MP3 files, audio CD tracks, templates, transitions, effects and Internet media, etc. 

• Search your computer for media you would like to use. The navigation buttons 
for the various drives and folders are located in "Import" above the main display 
area. 

If you hover the cursor over a media file, three icons for the options (Preview, Trim, 
Import) will appear. 

 Preview: Click on the playback icon to play back the medium: Video and 
image files are displayed in the preview monitor, and audio files through 
the sound card. There is also only a preview for the provided templates.  
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 Trim: If you only want to import a certain part of a video clip into your 
project, click on the Trim icon with the curved brackets. The video clip will 
then appear in the preview monitor. Now use the brackets to mark the 
area you want to import on the timeline. Finally drag & drop the video 
from the preview monitor into the project by clicking on it and holding 
down the mouse button. Only the area previously marked by the brackets 
will be imported as a video object. 

 

 Import: Click on the Import icon to load the selected medium to the 
project window. 

Tip: You can create a link to your personal media folder in order to access the media 
it contains in a mouse click. You can do this by right-clicking on one of the entries 
and selecting "Create link". Select the media folder and click "OK" to confirm. 

Note: All links are automatically deleted if the function "Reset standard program 
settings" is used. 

 

Display modes 
With the help of the button in the center of the toolbar, you can switch between the 
"Timeline-", "Storyboard" and "Scene overview" modes. Another button for the 
multicam mode is available in the Plus/Premium version. 

 

Storyboard mode (view page 29) (first button) is the 
preset view. This view offers an easy, streamlined 
interface to simplify the editing process. All scenes 
from your film are listed sequentially in the 
"Storyboard" mode. Every scene is displayed with a 
preview picture in the storyboard. 

The scene overview (view page 30) (second button) 
provides a scaleable overview of the scenes. You can 
use this to comfortably view, sort, and delete 
unnecessary scenes.  

In Timeline-mode (view page 30) (third button), 
your movies are displayed as "objects" on the 
"timeline". This means: The longer the object, the 
longer the corresponding film. 

You can display all modes in full screen using the button at the top right. 

Multicam mode is found under the fourth button in the Plus/Premium version of 
MAGIX Movie Edit Pro. Multicam editing enables easy cutting of various recordings 
of the same scene from different camera perspectives. 
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Storyboard mode 

 

"Storyboard" mode represents all scenes in linear sequence on the storyboard. Each 
scene offers the following editing options: 

 
Add title and text: Titles and text can be added to any film. Click 
on the "T" button, enter your text directly in the program monitor 
and select from different animations (try movement from bottom 
to top for a classic end credits effect). 

 
Set volume: The volume in each scene can be set via the 
loudspeaker button. 

 
Effects menu: This switch accesses a menu with different editing 
functions like scene recognition, image stabilization, or the 
trimmer dialogs. The hissing on the track can be minimized by 
selecting "Audio cleaning". 

 
Transitions: Click on the large button between the scenes and 
select a scene transition. 

 
Rotate image (only with image files): If an image or photo is on 
its side or upside down, click on this button. The photo will rotate 
90 degrees. 
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Overview Mode 

 

The Scene overview allows you to manage and categorize scenes. All scenes are 
listed one after the other (in multiple lines, like in a text program) and can be copied, 
cut, moved, deleted and inserted. 

"Overview" mode does not indicate start, playback, or end markers. The scene which 
is currently being played has a frame around it. 

 The zoom slider enables the view 
to be enlarged or reduced. 

This controller also specifies how many scenes are displayed. The smaller the preview 
pictures, the more will fit onto the overview. 

 Maximize: Use this button to maximize the scene overview to fullscreen mode. 

 

Timeline mode 

 

All advanced editing functions should be undertaken in "Timeline" mode. Your movies 
and scenes are shown here: The longer the object in the track, the longer the 
corresponding movie. 
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Playback range: Clicking in the range bar above the first track lets you define start 
markers, i.e. the starting point of the playback range. If you right click, the end marker 
will appear to indicate the end point of the playback range. The length of the playback 
area is shown in the center of the section display. 

 
• When the end marker has been reached, the playback cursor jumps back to the 

start marker and begins playing everything again as a loop. 
• The entire playback range can be moved using the mouse by clicking on the bar 

in the middle while holding down the Ctrl key and dragging it. The in and out 
points can be moved with the mouse. Left clicking positions the in point, and the 
right mouse button sets the out point. The project window playback range above 
the first track is linked to the playback range of the preview monitor. They 
cannot be changed independent of each other. 

• To move the start and end markers to the beginning or the end of the film again, 
click "Optimize movie view" in the "Window" menu. 

Handles: All objects can be shortened by moving the mouse to one of the lower 
corners of the object until the mouse pointer turns into a double arrow. You can now 
shorten the object as much as you like. At the top corners of every object you will find 
two fade handles that can be adjusted to fade an object in or out. The handle at the 
top center can be used to adjust the volume of audio objects and the transparency of 
video objects. 

 

Object selection: For advanced effects editing, the objects must be selected first. 
Individual objects can be selected with the mouse. Objects will change color to show 
that they have been selected. Multiple objects can be selected by holding down the 
Shift key. If you click next to an object, you can drag out a rectangle with the mouse 
button pressed down. All objects contained in this rectangle will be selected. 
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Grid 
The project window features a frame-exact snap grid. This ensures that video and 
image objects snap exactly to the borders of a frame. 

The step size depends on the frame rate specified in the movie settings ("File > 
Settings > Movie"). Choose between Europe's conventional frame rate for PAL (25 
frames per second) and America's and Japan's conventional frame rate NTSC (29.97 
frames per second) or any other manually set frame rate. 

 

When moving an object, the position display indicates at which frame the first image 
of the object is shown. 

The position is displayed in the form of a 
tooltip when moving the object.  

This information is displayed in the form 
"Hours:Minutes:Seconds:Frame". 

 

In addition to the constantly active frame grid, an object grid can also be activated. 
This ensures that two consecutive objects will seamlessly snap together even if they 
are on different tracks. This avoids undesired gaps or overlaps. 

 
The object grid can be activated/deactivated using the magnet symbol in the 
lower toolbar. 

 

Removing unusable scenes 
One of the most important steps during import of your footage is cutting out unusable 
scenes from the material. There are two options in this case: 

• Option 1: First, the complete material is loaded into your project and the 
unusable scenes are cut out.   

• Option 2: You can cut the material already in the Media Pool, i.e. BEFORE you 
import it, and then proceed to import only the scenes you need. This process is 
recommended for long movies with a lot of editing. 
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Cut videos in the project 
Let's assume that you have already imported your film material into a project and 
would now like to edit it. 

1. Play your video by clicking on the up arrow on your keyboard. 
2. Pause playback at the position where the scene is found by pressing the 

downward arrow. The playback marker stays near the start of the scene to be 
removed. 

Note: You can also use the space bar or the play button on the transport bar to 
start and stop playback. However, in order to move the playback marker to the 
position where you stop the playback, you must first go to program settings (File > 
Settings > Program) in the "Playback" tab under "Space bar behavior" and select 
the "Spacebar stops at current playback position" function. 
Tip: In case of long films or to speed up search, you can also fast forward the video 
following the action on the preview monitor. To do so, pull the playback marker 
across the timeline (but not too fast!) while holding down the mouse key. 

3. Set the playback marker exactly at the start of the unusable material. The zoom 
function is recommended to get a better view of longer videos (the +/- buttons 
in the bottom right corner). 

 
4. Press "T" on the keyboard. This will split the current scene into two sections at 

the position of the playback marker. 
5. Repeat these steps for the end of the unusable scene. Find the end of the 

unusable scene, place the play marker as close as possible to the end point, and 
then press the "T" key on the keyboard again. 

 
6. Now you have "isolated" the unusable scene and may delete it from the movie 

using the "Del" key on the keyboard. Before this, the scene must be selected by 
clicking it with the mouse. 
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7. If you didn't work accurately during cutting, then don't worry; you can use the 
object handles to stretch or shorten the remaining objects to recover or exclude 
material from the deleted section. 

 
8. After deletion a gap will appear in the film sequence at the position of the 

removed material. How do you remove gaps from the movie? It's easy: Simply 
drag the later scenes up to the earlier scenes until they "dock" with each other. 
Remember to drag all objects that are further behind, otherwise the gap will just 
be passed on down the line. To pull up later objects, use the "All tracks" mouse 
mode, since this automatically takes all the objects found later on the timeline 
along with the object being pulled. 

 

Note: If your project has an audio track in addition to the image track, it is usually 
necessary to cut audio and video tracks synchronously. After import from the 
camera, video and sound tracks are automatically grouped, which is why all cutting 
and moving actions have an effect on video and sound tracks simultaneously. 
However, if  you have added a separate sound track which has not yet been grouped 
with the video sequence, then you should group them before you start editing.  

 
To do this, select the video object and the audio object with "Ctrl" + click, and 
in the "Edit" menu select the "Group" option (or click the Group Tool). 

Go ahead and experiment with the cutting functions. When cutting and performing 
any other editing functions, the original material on your hard drive remains 
unchanged.  
 

Importing individual scenes from longer movies 
If you have saved a longer video as a file on your hard disk and only want to use a 
section of it for your project, you can proceed as follows: 

1. Select the file in the Media Pool and click on the Trim icon in the middle of the 
features that appear above the file. 
Now you can play the selected file in the Media Pool using the transport control.  

2. Find the starting point of the range to be imported. Position the play marker 
above the transport control at the starting position of the range. 

3. Click on the "Set In-Point" button (Shortcut: I). 

 



 

 

Introduction 35 

 

The start of the range will be placed at the current position of the start marker. 
4. Position the playback marker at the end of the section. 
5. Click on the "Set Outpoint" button (Shortcut: O) 

 
The end of the range will be placed at the current position of the start marker. 
The currently selected range will appear as a blue bar in the range display. 

6. You can play back this range separately with the "Range playback" button.  

 

Note: All range limits can be moved by holding down the mouse button and 
dragging.  

7. Once the range matches the section that you want to import, click on the 
preview image in the monitor and drag it onto the track. An object will appear, 
corresponding to the selected area. 

Tip: Use the Insert modes (view page 323) to quickly and efficiently apply individual 
ranges to the movie. 

 

Regroup scenes 
It will often be the case that you will want to move whole scenes or even groups of 
scenes to a different place within a film. This happens completely intuitively: Single 
scenes can be selected in any view ("Timeline", "Storyboard" or "Overview" modes) 
using just a mouse-click, and then moved to the desired spot with the mouse button 
held down. In the "Timeline" and "Overview" modes you can also create scene groups 
which can be moved together: "Ctrl + mouse-click" lets you select more than one 
scene, "Shift + mouse-click" selects the scenes that lie in between. 

Three final tips for advanced video arranging: 

• Using "Intelligent mouse" mode, which is available in the "Timeline" mode, you 
can move not just the selected scene, but also all elements directly bordering it 
(e.g. transitions, fades, and scenes following the selected scene and those on 
neighboring tracks). 

• The commands "Group (view page 286)" and "Ungroup (view page 286)" let 
you join any scene into groups which can then be moved together as a block. 

• If editing and moving scenes left your project looking like a junkyard, then you 
can also work in the opposite direction by selecting the scenes you want to use 
and saving them to the Media Pool directory. Collect scenes that you want to 
use, place them into the "Takes" folder, start a new project, take scenes from 
that folder, then place them in the second project in the order you want them. 
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The "Takes" folder can be accessed in the Media Pool via the "Import -> My 
Media" button. 

 

Burn DVDs with interactive menus 
Once you are satisfied with your video, move to the "Burn CD" screen to burn it with 
an interactive DVD menu onto a disc. 

 

• If you simply want to burn a DVD the quickest way possible, 
then click the button to burn a DVD. 

For multiple films that are subdivided into individual scenes or chapters, the DVD 
selection menu becomes even more important. This is because you require 
manageable navigation to be able to jump between each film and each scene. 

 

The "Burn" screen has two views: "preview" an "Edit". Use the buttons located in the 
upper left to switch between them 

In both views, you will see a preview of the DVD menu. All movies appear as 
uppermost entries, and all scenes appear as sub-entries. 
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You can use the remote control to the right to test the function of the menus just like 
in a real DVD player. 

In the "Edit" view you can access the structure of the selection menu in "Navigation". 
You can delete unnecessary scenes by clicking the corresponding box. The entry will 
be removed from the menu, but the scene will not be removed from the movie. 

To make sensible chapter divisions in your movies, each movie must feature 
corresponding chapter markers in the "Edit" window. If you want to change the 
current scene splits, it is best to switch back to the "Edit" screen and then choose the 
movie which you would like to split. Place the Start marker where you'd like to have it 
and choose the option "Chapter marker" from the Edit menu (keyboard shortcut: Shift 
+ Enter). If you select the option "Automatic Chapter markers", a Chapter marker is 
automatically placed at the beginning of every scene. Superfluous chapter markers 
may simply be clicked and deleted. 

If you are satisfied with the subdivision of the movies and chapters, you can devote 
yourself to the layout of the selection menu.  

At the bottom of the screen, you'll see an array of preset menu templates. Use the 
scroll bar to view each template. There are plenty to choose from: 

• If you wish to fully apply a template, first click on "Layout" in the template bar 
and double-click on the template of your choice. The complete template will 
then be applied. 

• In the "Edit" view you can also combine various elements of individual templates 
with one another. For example, if you want to combine the text format of a 
template with the background of another one, then select "Font" first and double 
click the template with the text of your choice. Then select "Order" and double 
click the order you like. The preview in the middle shows you the results 
immediately. 

• Double click the preview picture or a menu entry to change the film or chapter 
name and select a different preview picture. 

When all videos and chapters (scenes) are logically arranged and you are satisfied 
with the selection menu, you can go ahead and burn. 
 

Note: Backup copies 
MAGIX Movie Edit Pro comes with a great feature (view page 244) to quickly and 
easily back up your entire project, including video objects, effects etc. It's 
recommended that you make regular backups, especially when working with very 
large projects. Doing this will allow you to quickly and easily return to "old" versions of 
your project if, for  example your hard drive crashes or there's a problem with your 
project. This feature can be found under "File" > "Backup copy" > "Copy project and 
media to folder". 
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Workspaces 

"Edit" screen 
 

 

1 Upper toolbar: These are the buttons for quick access to important commands. 
 

2 Menu bar: This contains important MAGIX Movie Edit Pro functions. 
 

3 Preview monitor: Video and image objects are displayed and files from the 
Media Pool can be previewed here. 

 

4 Media Pool: Here you'll find your hard drive content and the areas for transitions, 
titles and effects. Using the "Import" navigation buttons you can access all of the 
folders on your PC. 

 

5 Content: Various content will be displayed depending on which area of the 
Media Pool you are in. You can preview templates or import media to your 
project. In the "Effects" area you can fade in the effects to create effect curves. 

 

6 Modes:  
• The Storyboard mode displays the scenes in the current movie in a panel so 

that they can be easily arranged and edited.  
• The Timeline mode is for more complex detailed work. It provides a multi-

track view. 
• Overview mode displays all the scenes in tabular form and enables quick 

sorting.  
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• The right button activates Multicam mode in the Plus/Premium version. 
 

7 Scroll bars: The lower scroll bars can be dragged apart and pushed together for 
zooming with the mouse.  The right scroll bar zooms into the tracks vertically. 
Click on the edge of the scroll bars while holding the mouse button to change the 
visible part in the arrangement window. 

 

8 Project window in timeline mode: Drag& drop files from the Media Pool, then 
arrange and edit files in detail here. 

 

9 Timeline with range markers: Defines the range that will be played. It is 
equipped with a time scale. 

 

10 Lower toolbar: Select the timeline or various different mouse modes for diverse 
editing functions. 

 

Project management 
The "Edit" area can be used for editing films and also for managing your projects, i. e. 
here you can sort the order of the movies, add new movies, remove existing movies 
from the project or rename the movies.  

Each film in a current project can be controlled through its own tab above the tracks. 

 

To rename, sort, load or delete movies, the easiest way is to right-click on one of the 
tabs. You can then select the action you want from the context menu that appears. 
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Preview monitor 
The preview monitor shows the content of the current movie. In some cases the 
preview monitor is also used for editing certain effects. Examples of this are: 
• Title Editor (view page 132) 
• various Movement effects (view page 147) 

The preview monitor additionally shows the time position of the playback marker as 
well as the length of the movie. 

Setup 

 

 Preview monitor menu (view page 
42) 

Playback marker position 

 Title bar, shows the name of the 
current film 

Length of current film 

 Full-screen mode button Area to view 

 Transport Console (view page 44)   

Function 
In addition to showing the current film, the preview monitor also performs the 
following functions:  
• Preview of video and image files (view page 109) 
• Inserting sections of video files into the movie (view page 111) 
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• Movie overview (view page 299) 
• Full-screen mode (view page 44) 

Options 
• 3D display (view page 208) 
• Set size (resolution) (view page 42) 
• Move position (with time bar) 
 

Preview monitor menu 

 
The preview monitor menu is opened with the menu button. 

The preview monitor menu contains the following features: 
• Define zoom factor (view page 42) 
• Specify image position for preview 
• Activate movie overview (view page 299) 
• Fade jog and shuttle in and out. 
• Set program monitor standard (2D) view 
• Activate 3D playback (view page 208) 
• Activate 360° display (view page Fehler! Textmarke nicht definiert.) 
• Access to the Performance Menu (this is also in the context menu of the 

Preview quality (view page 45) button) 
 

Zoom 
You can even make the preview monitor bigger or smaller (view page 42). 

 

• The video image in the preview monitor can 
be minimized and maximized with the help of 
the menu entry. This comes into use (view 
page 167) especially during effect animation. 

Note: This zoom applies only to the current view 
in the preview monitor and will not be applied as 
a video effect. 

Tip: The preview monitor also features a full-screen mode (view page 44). 
 

Set size 

Tip: Tip: Useful presets for the arranger and video monitor can be found in the tab 
"Display templates" in the program settings. 
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Set desired size 
You can set the preview monitor to any size you want: 
1. Move the mouse cursor to the edge of the preview monitor. 

This turns the mouse pointer into a double arrow. 
2. Click and hold the left mouse button over the edge of the preview monitor. 
3. Drag the preview monitor to the desired size. 
4. Release the mouse button. 

Note: Setting the size of the preview monitor is easier when you set the height and 
width one after the other. 

Set size through the context menu 
1. Right click to open the context menu in the preview monitor display area. 
2. Select the desired size in the context menu: 

- By default: Choose an entry in the "Default resolution" submenu. 
- Manually: Select the entry "Other resolution" and enter the desired resolution 

in the dialog. 

Use movie to define size 
You can also determine the size according to the size of the movie or an individual 
video clip in the movie. 

1. In the project window, select the video object you want to use to determine the 
size of the preview monitor.  

2. Right click to open the context menu in the preview monitor display area (6). 
3. Select the entry "Adjust preview monitor to selected video". 

MAGIX Movie Edit Pro will adjust the size of the preview monitor to fit the 
resolution of the selected video object. 

Use movie settings to define size 
1. Right click to open the context menu in the preview monitor display area (6). 
2. Select the entry "Adjust preview monitor to movie settings" 

MAGIX Movie Edit Pro sets the resolution in the movie settings as the new 
preview monitor size. 

Note: If the preview monitor resolution is bigger than the screen being used, you will 
receive a warning message from MAGIX Movie Edit Pro and will be given the option 
to cancel or continue the operation. 
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Full-screen mode 
The preview monitor can be expanded to full-screen size. 

Activate full-screen mode 
• Double-click in the preview monitor display area,  
• press the key combination "Alt + Enter" or 
• press the button  located at the upper right edge of the preview monitor. 
• Pressing escape (Esc) exits full-screen mode. 

Note: The preview monitor can also be moved in full-screen mode. A special context 
menu (right mouse button) is also available. The transport control can be faded out. 

Show/hide transport control 
• Requirement: Full-screen mode must be active 
1. Right click to open the context menu in the preview monitor display area. 

You can see the current status of this setting in the check box before the menu 
entry "Show transport control". 

2. Select the entry "Show transport control". 
The transport control will be shown or hidden accordingly. 

 

Transport console 
Transport controls on the preview monitor enable you to play back video and image 
material in the project window or as a preview in the Media Pool. 

 
 

Transport control buttons 
Range: Above the playback functions you can 
select the range between the in and out points 
using the mouse.  

 

 Playback marker: This marker indicates the position of the image currently 
displayed in the preview monitor. 

 

 

Set in/out points: Defines the start and end of the playback range. 

 

 

To range start: This button sets the playback marker to the start of the 
current range. 

 



 

 

Workspaces 45 

 

 

Jump to movie start: Sets the playback marker to the start of the movie. 

 

 

Play/Stop (pause): The playback button in the middle starts playback. A 
second click stops playback. 

Tip: In the menu "File -> Settings -> Program -> Playback", you can set whether the 
playback marker will go back to the start position (stop) after the second click or 
following the appropriate shortcut (space bar), or if it should stay at the current 
position (pause function). 

 

Range playback:This button plays the current range.  

 

 

To range end: This button sets the playback marker to the end of the current 
range. 

 

 

Audio or video recording: Quickly jumps to Recording selection. 

 

 Jog wheel: Using this wheel, you can move by single frames 
within the video and zoom in for precise positioning of the 
playback marker. 

 

 Shuttle control: The further the slider control is moved to the 
side, the quicker the arrangement is played in the 
corresponding direction. This way a specific position can be 
reached quickly. 

 

 
Preview quality switch: Activate Smooth playback (view page 45) if playback 
becomes choppy. 

Hinweis: Jog Wheel und Shuttle-Steuerung sind standardmäßig ausgeblendet. Sie 
können über das Menü des Vorschaumonitors angezeigt werden. 

 

Preview quality switch 
You can "activate" a smoother preview if playback performance begins to suffer. This 
setting does not have any effect on the quality of video files when exporting or 
burning to DVD. 

Poor playback performance can be caused by the following: 
• Under-performing hardware 
• High-resolution source material (HD or higher) 
• A very complex project 
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In the context menu for the preview quality switch, you can set which options 
you would like to use for the optimized preview. 

The options are: 
• Reduce resolution 
• Reduce frame rate 

Reduces the number of frames per second 
• Deactivate plugins 

Deactivates all video effect plug-ins (view page 155). 
• Deactivate effects 
• Use proxy objects 

This option only appears when you activate "Create proxy file automatically" in 
the start dialog in the movie settings. 

Note: "Reduce resolution" and "Reduce frame rate" are preset. 
 

Media Pool 
The structure and functioning of the Media Pool is similar to Windows Explorer. The 
only difference is that the Media Pool only displays files that can be used in the 
slideshow. This is used to access and load multimedia files of all kinds: photos and 
other image files, video files, audio files, transitions, effects, and also complete 
projects. 

 

Note: The Media Pool displays the files on your hard drive. Files that are deleted 
here cannot be recovered in Windows Explorer. 
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If you hover the mouse pointer over a media file, two icons for the options will appear: 
playback (preview) and import. 
• Preview: All available media can be previewed using the preview function. If you 

click on the playback icon, the file will be played back in the preview monitor. 
Video and image files are displayed and audio files are played back through the 
sound card. There are previews for the templates and effects included to make it 
clear how they will function.  

• Import: All media files from local drives or the Internet can be dragged and 
dropped into the project or loaded through the Import icon. 

You can also load files from the Media Pool by double-clicking. Selected entries 
(including entire folders) can be selected by holding down the left mouse button and 
dragging them into the slideshow (drag & drop). If you want to load several files 
simultaneously, you first have to select them in the Media Pool.  
• Click on the selected entries one after the other while holding down "Ctrl".  
• If you want to load a sequence of files, hold the "Shift" key and click on the first 

entry and then on the last. All entries in between will be selected.  
• By holding down the left mouse button you can drag out a selection box over 

multiple image files to select them. "Ctrl + A" selects every entry contained in a 
Media Pool folder. 

Tip: Improve access to your media folder by creating a link in the "Import" area of 
the Media Pool. You can do this by right-clicking on one of the entries and selecting 
"Create link". Select the media folder and click "OK" to confirm. 
Note: All links are automatically deleted if the function "Reset standard program 
settings" ("Edit" menu > "Settings") is used. 

 

Importing 
Navigation buttons 
 The navigation buttons let you navigate through your computer’s drives and folders.  

 
Forwards/Backwards: These buttons access the previously viewed 
folders.  

 
 

 
Up: This button brings you to the next highest folder level. 

 

 
Folder tree: Here you can activate a folder tree to navigate through your 
computer system. 

 

 
Search: The search function allows you to find specific files quickly. You may 
specify your search according to file type, date, or certain folders. 

 

 
Browse history list and Path details: In the top center you 
will see the path of the current folder. Use the arrow 
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 button to open the menu to find the folders you 
previously visited. 

 

 
Options: All functions of the context menu (switch views, rename, or delete 
files, etc.) can also be accessed using the options button. 

 

 
Display options: Settings for how detailed the entries should be listed may be 
made here. 

 

 
Zoom: A zoom slide can be used to set the number and size of visible symbols in 
the "Large symbols" view. 

 

Search 

 
The Media Pool has an easy search function for finding files on the computer. 
It may be activated and turned off again with the shown button. 

 

File name: Enter any part of the name of the file you are looking for in the "File name" 
field. The X symbol deletes the entry. A "?" may be used as a placeholder for a single 
character, and "*" for any number of characters. 
 

File type: Here you can enter a file name extension. Multiple entries are separated 
using a semicolon. Below the entry field, various presets may be selected for often-
used file name extensions. 
 

Date: Here, you can set time period limits on your search. Choose an entry from the 
list. 
 

Folder: If you don't want to search the entire computer, but only look on certain drives 
or in a single folder, you can define a certain search path. 
 

Search depth: Here you have various options that determine whether additional 
locations should be searched. 

• Search indexed locations and the selected folder 
• Search indexed locations, the selected folder and personal files 
• Search indexed locations, the selected folder, personal files and the project file. 

"Indexed locations" are folders, which are searched and cataloged in Windows via the 
index list. If the index list is activated, the files in the indicated folders will be indexed 
while the computer is idling, so that the user's search query may be completed faster. 
 

Computer 
The link button "Computer" displays the drives in the Media Pool. All drives will be 
listed along with their drive letters and can be opened with a double click. 
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User directory 
The second button featuring the user's name opens their personal folder in the Media 
Pool. 
 

My media 
Projects: Here you can switch to the folder where your projects and films are usually 
stored. 

You will find the "Show project contents" function in the context menu of a project. 
Using this function, you can display all objects of a project and copy them into the 
current project, retaining the editing and effect state of the object. This means that 
you don't have to edit the objects again to keep the status of the "old" project. But you 
can certainly continue editing the transferred object. These changes will be then 
saved in the current project. 
 

My Videos: Displays all usable files found in "My Documents\My Videos." 
 

My Music: Displays the contents of the "My Files\My Music" folder. 
 

My Pictures: Switches to the "My Documents\My Pictures" folder. This folder is often 
used by digital cameras and scanners by default to store transferred images. 
 

Recordings: MAGIX Movie Edit Pro specifies standards for all recordings. 
 

MAGIX Tools 
Internet media: This opens the integrated browser (view page 330) in MAGIX Movie 
Edit Pro. This allows you to collect media directly form the Internet, e. g. images for a 
current film project etc. 

Travel route: Click here if you would like to create a travel route (view page 222). 
 

Send Anywhere 
If you have received a 6-digit key for Send Anywhere and want to receive media, click 
here and enter the key in the text field.  

Click on "Receive" to start the transfer. 
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Cloud Import 
Use the MAGIX Cloud Import function to import images from your Google Photos 
account to MAGIX Movie Edit Pro. To do this, click on "Cloud Import" on the "Import" 
tab of the Media Pool. This opens the NetSync tool. 

 

Click "Connect to Google Cloud" and select the Google account that contains the 
photos you want to access. 
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If you are doing this for the first time, you need to grant NetSync permission to access 
your Google account. Log in with your email and password and then click on "Allow" 
in the following screen to authorize NetSync to access your Google account.   

 

Your Google photos will then be displayed. Select the photos you want to import. 
Click "Download" to download the photos you've selected. You can specify the 
storage location above in the dialog. 

 

Once you've finished, you can continue to download more images or close Cloud 
Import. You will return to the NetSync tool, where you can open the files with 
<Programmname> right away or display them in the folder. 

Note: The NetSync tool will start together with the system by default, in order to 
transfer images when MAGIX Movie Edit Pro is not running. To modify this setting, 
you can deactivate the  option "Run NetSync at system start" in the settings. 
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Downloads 
Use this button to access the media files that you downloaded with Catooh. Also, all 
data received via Send Anywhere is stored here. 
 

Effects 
MAGIX Movie Edit Pro offers a wide range of effects and effect settings. The "Effects" 
(view page 137) chapter contains detailed descriptions of each of them. 
 

Video effect templates 
Here you can find pre-configured effect templates that can be dragged-and-dropped 
onto a video or image object. These effect templates consist of a combination of 
various effect settings which you can adjust in the appropriate effect dialogs. 

In the "Video mix effects" subfolder you will find templates for mixing two video or 
image objects. To do so, two video or image objects have to lie on two tracks directly 
above or below the other. To use a mix effect template, drag on the lower object. 
 

Video effects 
Here you can find adjustable effects for video and photo objects. The effects can be 
set only after selecting an object in the respective effects dialog. For more 
information, go to the "Video effects in the Media Pool" (view page 138) section in the 
"Effects" chapter. 
 

Movement effects 
These are movement effects you can use to animate the frame by using zoom or 
camera movements. For more information go to the "Effects" chapter, section 
"Movement effects in Media Pool" (view page 147). 
 

Stereo3D 
This accesses the program's Stereo 3D functionality. Please read the corresponding 
chapter "Stereo 3D". (view page 208) 

Note: This function is available only in the Plus/Premium version. 
 

Audio effects 
Here you will find many audio effect templates such as echo, reverb, equalizer, 
compressor, etc. Read the "Audio editing" (view page 174) for more information.  
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Design elements 
Picture-in-picture: These are various effect templates for image stacking. 

Collages: These work similarly to normal picture-in-picture effects but more objects 
are used. Depending on the collage, arrange the selected objects one after the other 
and drag the collage onto the first object. 

Test images: These are professional test images for calibrating your system. You can 
also use the colored backgrounds for your own color transitions, for instance. The 
special "User" template opens a color selection dialog where you can choose the 
desired color. 

Backgrounds: Here you can find static and animated photo and video backgrounds. 
Video backgrounds are capable of being looped, meaning that their length can be 
extended by duplication. 

Image objects: Here you will find various image objects like black bars, thought 
bubbles for cartoons, etc. 

Intros/Outros: These are beginning and end scenes for films with various themes. 

You can find additional information in the "Effects (view page 155)" chapter, in the 
section "Design element in Media Pool". 
 

Snap marker (only in the Plus/Premium versions) 
Select a location directly in the video object with a snap marker (view page 126) to 
indicate where another object should snap in. This snap marker will stay in place even 
if the object is moved into the Timeline. 

Snap markers are helpful for trimming, moving and synchronizing objects, 
for instance, when you want a title to fade in at a specific position in a video object. 
Snap markers can also be applied to playback and stop positions, and to and between 
object edges. 

They can also be aligned to transients (signal peaks) in order to select these signal 
peaks as snap points in audio material. 
 

My Presets 
Here you will find the folder for your own effect templates. For more details, please 
read the "My Presets in Media Pool" section in the "Effects" chapter (view page 155). 
 

Additional Effects 
Here you will find all available effect plug-ins. Please read the "Additional effects in 
the Media Pool" section in the "Effects" chapter (view page 155). 
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Templates 
In the "Templates" tab, you'll find all additional content that can be used for your film, 
including titles, transitions, intros/outros and film templates. In addition to the 
content installed alongside MAGIX Movie Edit Pro, you can purchase additional 
content in the Store from directly within the program. 

Following categories are available: 

• Movie templates and editing templates (view page 219) 
• Intro/Outro animations 
• Transitions (view page 117) 
• Titles (view page 132) 
• Movie looks 

 

 All Media Pool content is displayed by default. Here, you can filter the display 
according to category, e.g. title or transition. 

 You can use the search field to search for templates by name. 

 Each category contains sub-categories. Click on one to open a detailed view that 
displays the contents separately. 
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When you mouse over content, three symbols appear: 

 
Use these to load the content to your film. 

 
The preview monitor will provide you with a preview of the content. 

 
Click on the heart symbol to mark the content as a favorite. 

Tip: You can set the size of the tiles under the three points above right in the 
detailed view. 
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Buy new content 
If you click on a Store tile in the bottom section of the Media Pool, the details for a 
pack will display on the right. 

 

The price and size of the pack will be shown, and you can preview the content by 
clicking the Play button. Click Purchase to open the Store window. 

When you make your first purchase, you will be asked to select a currency. Then, log 
in to your MAGIX account. 

 

In the next step, select the payment method and enter the required details. 
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This step will be skipped for later purchases and you will go straight to the "Purchase" 
window. You can also adjust the payment method afterwards by clicking on the pen 
icon next to "Pay with". 
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Click on "Buy now" to complete the purchase. 

Your purchase will download immediately, as shown by the download 
progress on the tile. 

Once your download is complete, your new content will be added to the 
top section of the Media Pool and will appear alongside content you have 
already installed. You can use the content you have purchased in your 
projects right away. 

 

 

Note for Premium version users 
Notice for users of MAGIX Movie Edit Pro Premium: Once you have activated the 
additional content packs via the Help menu (view page Fehler! Textmarke nicht 
definiert.), you can download five content items of your choice in the Store for free. 
You don't need to provide any additional payment information.  

 

Simply try out the Store for free, without obligation. 

Audio 
Under "Audio", you'll find installed content and offers from the Store for background 
music and sounds. The tab functions the same way as the "Templates" tab.  

Various file list view modes 
All supported multimedia files and subfolders of the currently selected folder are 
displayed in the file list. Three different views (list, detail, large symbols) can be set by 
right-clicking on the Media Pool context menu. 

 

List: Only file names are listed. This 
view mode displays the most files 
simultaneously. 

 

Details: For each media file, its type, 
size and date of last change will be 
displayed next to its name.  
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Large symbols  can be quite useful 
because they show a preview frame for 
each movie and picture file. This allows 
you to sort through the material 
quicker.  

As soon as you activate this display, 
the zoom function will appear. With it, 
you can additionally magnify 
thumbnail images. 

 

Preview function 
This is a preview function for all files in the Media Pool which can be started by 
dragging & dropping onto the video monitor or by pressing the play button. 

There are also previews for effects that illustrate their functionality. 

The "Extras" button or the enhanced transport control function provides a selection of 
sections from a longer video file in the Media Pool. Please refer to the "Inserting 
objects into the project" chapter. 
 

Project window 

 

MAGIX Movie Edit Pro offers an editing interface for advanced editing: audio dubbing, 
professional editing, plus precise transitions and effects editing. 
 

Editing mode 
With the help of the button in the center of the toolbar, you can switch between the 
"Timeline-", "Storyboard" and "Scene overview" modes. Another button for the 
multicam mode is available in the Plus/Premium version. 
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Storyboard mode (view page 29) (first button) is the 
preset view. This view offers an easy, streamlined 
interface to simplify the editing process. All scenes 
from your film are listed sequentially in the 
"Storyboard" mode. Every scene is displayed with a 
preview picture in the storyboard. 

The scene overview (view page 30) (second button) 
provides a scaleable overview of the scenes. You can 
use this to comfortably view, sort, and delete 
unnecessary scenes.  

In Timeline-mode (view page 30) (third button), 
your movies are displayed as "objects" on the 
"timeline". This means: The longer the object, the 
longer the corresponding film. 

You can display all modes in full screen using the button at the top right. 

Multicam mode is found under the fourth button in the Plus/Premium version of 
MAGIX Movie Edit Pro. Multicam editing enables easy cutting of various recordings 
of the same scene from different camera perspectives. 
 

Tracks 
The project window is divided into tracks where the multimedia material can be 
positioned and edited. The number of tracks that are displayed can be specified in the 
file menu under "Movie settings". 

In principle, any object type can be placed on any of the tracks. Video and image 
objects can also be combined with audio objects within a track. The maximum length 
of a movie is restricted to six hours. 

 

At the left edge of each track is a track box where you can 
mute (Mute) the track or play it back Solo. 

Clicking the "Lock" symbol protects all objects in a track against unwanted editing.  

The two double arrow symbols can be used to minimize or maximize the the height of 
the track.  

When a track has exceeded a certain height, a text field for the track name can be 
seen in the track box. The track name can be edited by double-clicking this text field. 

A right-click on the track box opens the context menu: 
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• Multicam > Source track: Here you can activate/deactivate a track as a source 
track (view page 129). 

• Multicam > Master audio track: Here you can designate the master audio track 
for Multicam editing (view page 130). 

• Track height: Set whether the selected track or all tracks should be displayed as 
small, large or in standard size.  
You can also adjust the size using your mouse. To do so, drag the lower border 
of a track box downward using a mouse. 

 

Zoom 

 

The vertical zoom function sets the 
number of visible tracks. On many tracks 
zooming is useful for selectively editing a 
track or an object in full view. 

Use the horizontal zoom functions to set up the visible section of the project on the 
timeline. 

Clicking and dragging on the bottom border of a track allows you to adjust the height 
of the display. 
 

 Object zoom: Vertical and horizontal zoom stages are enlarged so that all of 
the selected objects are displayed at maximum size. 

 Optimize view: Displays the full project. Zoom will be set to 100%. 

When the function is turned off, the old zoom level will be reactivated. 
 

Preview rendering 

 
You can reach the preview rendering (view page 217) features by pressing 
this button, located next to the timeline. 
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Toolbars 
Upper tool bar 

 

The upper tool bar can be found in the monitor to the top left. It has the following 
functions: 
 

New project 

 

A new MAGIX Movie Edit Pro project is created. The Start dialog opens. 

A start dialog will open when the program is launched or a new project is loaded.  
Here you can make important presets for the project. You can change these settings 
at any time by going to "File" > "Settings". 

 

Create new project: Here you can assign a name to your new project. 

Options: This button lets you open and close the options area of the start dialog. 

Watch the intro video: Here you can launch the introductory video with information 
about workflows in MAGIX Movie Edit Pro. 
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Project file: Here you can set the path for the project directory where all project files 
should be saved. 

Movie settings: Here you can set the movie's target format (display norm, resolution, 
frame rate). This setting has no effect on the internal processing quality and can be 
changed at any time by going to "File > Settings > Movie" (view page 74). 

Audio sample rate: Here you can set the audio track's audio sample rate. 

Load existing project: Here you can select and load a previously saved project. 

Use movie template: Here you can choose an included movie template for a new 
project. Read the "Using movie templates" (view page 219) section for more details. 
 

Load project 

 

With this option you can load a project or a media file. Please note that all 
media files associated with it must be loaded along with a project. 

MAGIX Movie Edit Pro will search for all used sounds and video files in the folders in 
which they were located when the move was saved. 

Keyboard shortcut:   Ctrl + O 
 

Save project 

 

The current disc project is saved with the name displayed in the project 
window. If you have not yet specified a name for your project, a dialog will 
open wherein MAGIX Movie Edit Pro asks you to do so. 

Please note: In the project file (*.MVP), all information about the used media files, 
cuts, effects, and titles are saved, but not the picture and sound material itself. This 
is found in the recorded or imported media files that remain unchanged during the 
entire MAGIX Movie Edit Pro editing process. To save the full movie into a 
dedicated directory, for instance to continue editing on a different PC, please use the 
command "Copy movie and media into folder". 

Shortcut:  Ctrl + S 
 

MAGIX News Center 
The MAGIX News Center features links to current online tutorials and tips & tricks on 
the software application examples. The "News" is indicated by color according to 
content:  

• Green indicates practical tips & tricks for the software 
• Yellow reports the availability of new patches and updates 
• Red for special offers, contests and questionnaires 
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If no new messages are present, the button will appear gray. When the MAGIX News 
Center is clicked, all of the available information will be displayed. Click the messages 
to reach the corresponding website. 
 

Catooh 

 
Catooh - the Online Media Marketplace offers you the option of finding and 
purchasing more media and templates. You can open the internal browser and 
access Catooh via this button. 

 

Lower toolbar 
The following toolbars are displayed in Storyboard Mode: 

 

 
 

Undo 

 

This command allows you to undo the last changes made. This way, it's no 
problem if you want to try out critical operations. If you don't like the result, 
you can always revert to the previous state using "Undo". 

Clicking on the arrow next to the button opens a list of changes made until now, 
allowing you to undo several changes made in sequence. 

Note: You can adjust the length of the list to your needs in program settings (view 
page 76). A general rule: The longer the list, the more RAM is used. 
 

Redo 

 

This function undoes the previous "Undo" function. 

Clicking on the arrow next to the button opens a list of revoked changes made until 
now, allowing you to restore several "undo steps". 
 

Delete objects 
This command deletes the selected scene (or the selected object in 
Timeline-mode). 

Shortcut:  Del 
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Title Editor 

 
Opens the Title editor for the selected photo, video, or title 
object. 

Keyboard shortcut:  Ctrl + T 
 

Set chapter marker 
Places a chapter marker at the position of the playback marker. This creates a 
chapter entry in the disc menu in case the movie is being burned to disc. 

You can rename the chapter markers by right clicking and selecting "Rename" in the 
context menu. The new name will also appear in the chapter menu (view page 248). 
 

Set snap markers 

 
To set a snap marker, select an object and place the playback marker at the 
position where you want to place the snap marker. You can set as many snap 
markers as you like per object. 

You can move a snap marker with the mouse using drag & drop. 
 

Object grid 

 
Use this button to switch the object grid (view page 32) on and off. When 
the object grid is switched on, the objects snap into place beside one 
another so that everything fits in seamlessly. 

 

Form group 
Orders all selected objects into groups. As soon as an object from the group is 
selected, all other objects in the group will be highlighted as well so that you 
can work on them collectively. 

Keyboard shortcut:  G 
 

Ungroup objects 

 
This turns all selected objects into free-standing objects again. 

Keyboard shortcut:  Shift + G 
 

Mouse mode for individual objects 

 
This is the preset mouse mode where most work is performed. 
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Select objects by left-clicking them. You can move an object by holding down the 
mouse over it while dragging it to the desired position. 
Keyboard shortcut:  6 
 

Move everything on the track 

 

Basically, this mouse mode behaves like the mouse mode for individual objects, 
but moving one object will also move all other objects located behind it on the 
same track. 

This is practical if space is needed at the start of a track, since all objects can be 
moved together without moving them underneath each other. 

Shortcut:  8 
 

Move everything 
 

 

This mouse mode in principal behaves like the "Single object mouse mode". All 
objects that have the same or a later starting point will be moved. 

This is useful if something should be inserted in the middle of an arrangement, but 
there is not enough space, meaning that all contents have to be moved down. 

Shortcut:  7 
 

Additional mouse modes 

 

MAGIX Movie Edit Pro offers additional 
mouse modes for different kinds of 
editing. They can be opened by holding 
down the mouse button or through the 
context menu of the last button. 

. 

Stretch mouse mode 

 
This special mode is for customizing the length of objects. 

With timestretching, audio objects can be expanded or compressed using the handles 
at the bottom. The duration of the audio material is therefore lengthened without 
changing the pitch. Playback of the video objects is accelerated/decelerated with the 
help of the handles at the bottom. 

Warning! If the object to be stretched or compressed is going to be animated with 
an effects curve, then the option "Connect curve length with object length (view 
page 165)" should be set for the effects curve. 
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Keyboard shortcut:  0 
 

Curve mouse mode 

 
This mouse mode is used especially for drawing effects curves. 

The effects curve controls the intensity of the effect: The more higher the curve point, 
the more intense the respective effects parameter at this location. The curves can be 
used for video and image objects on the image tracks and also for audio objects on 
the audio tracks. 

More information about this can be found in the chapter "Animate objects", section 
"Editing object effects curves". 

Keyboard shortcut:  9 
 

Preview audio 

 
This mode allows you to preview audio objects (as long as the mouse button is 
held down). 

In this mode, objects cannot be moved or changed. 

Shortcut:  Alt + 6 
 

Cut button 

 

MAGIX Movie Edit Pro offers various editing functions. They can be opened 
using the small arrow next to the button. 

Hint: If the commands "Split" and "Remove beginning/end" are applied without a 
selection, all objects at the position of the playback marker are cut. 

 

Split 

 

This command cuts a scene at the point where the playback marker is 
positioned. This way, two free-standing objects are created. 

Keyboard shortcut:   T 
 

Remove start 

 
This command cuts a selected scene in two at the point where the playback 
marker is positioned and removes the first part. 

Shortcut:  Z 
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Hint: If the commands "Split" and "Remove beginning/end" are applied without a 
selection, all objects at the position of the playback marker are cut. 

 

Remove end 

 
This command cuts a selected scene in two at the point where the playback 
marker is positioned and removes the second part. 

Shortcut:  U 

Hint: If the commands "Split" and "Remove beginning/end" are applied without a 
selection, all objects at the position of the playback marker are cut. 

 

Remove scene 

 
This command allows you to completely remove selected objects. The parts 
that follow will be automatically moved to the end of the object in front of the 
object to be removed. 

Keyboard shortcut:  Ctrl + Del 
 

Split movie 

 
This command divides the movie into two individual movies at the position of 
the playback marker. 

The current project window retains the portion that is located in front of the playback 
marker. The latter part will be removed from the current project window and placed 
as a new film. You can find this movie by going to the "Window" menu. 

Shortcut: Alt + Y 
 

Special functions for inserting new objects 
MAGIX Movie Edit Pro offers various options for adding an object selected in the 
Media Pool to the project. A right-click opens the list. 
 

Automatic application 

 
Inserts the selection on the monitor or in the Media Pool into the project 
window. Video and image objects will always be placed behind the last object 
into the first track, audio and text objects are separated into different tracks. 

Shortcut (is applied directly):  1 
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Single-track ripple 

 
This adds the currently selected object from the Media Pool or project temp 
folder and/or from the selected area of the source monitor to the position 
where the playback marker is located while moving the objects located 
behind it on the track.  

• In contrast to automatic insertion, in a single-track ripple all objects are inserted 
at the position of the playback marker. The objects on the target track are 
automatically moved back on the track behind the inserted object. Bordering 
tracks are unchanged. 

• Videos and images are placed on the first track. If another object is found at the 
playback marker position, then it will be cut and continued at the end of the 
inserted object (so that the inserted object can start exactly at the point of 
insertion). 

Keyboard shortcut (is applied directly):  2 
 

Multitrack ripple 

 
This adds the currently selected object from the Media Pool or the project 
temp folder and/or from the selected area in the source monitor to the 
position of the playback marker. All objects found at the playback marker 
position will be split and moved down the length of the inserted object. All 
subsequent objects on all tracks will also be moved. 

• Objects located further along on all tracks will also be moved further down. 
• In contrast to automatic insertion, the object will be inserted at the position of 

the playback marker. 
• Videos and images are placed on the first track. If another object is found at the 

playback marker position, then it will be cut and continued at the end of the 
inserted object (so that the inserted object can start exactly at the point of 
insertion). 

• If other objects are located at the playback marker position, these will also be 
separated and moved further along the track. 

Keyboard shortcut (is applied directly):  3 
 

Exchange 

 
This replaces the object selected in the project with the currently selected 
object from the Media Pool or the project temp folder and/or from the selected 
area in the source monitor. Length adjustment moves the objects following it 
correspondingly. 

Keyboard shortcut (is applied directly):  4 
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Overwrite 

 
This overwrites the object at the position of the playback marker with the 
currently selected object from the Media Pool or the project temp folder 
and/or from the selected area in the source monitor... 

Note: In contrast to Replace, no length adjustment takes place here. The "Replace" 
functions moves subsequent objects, whereas "Overwrite" overwrites subsequent 
objects as well (sometimes only partially), depending on the length of the object 
being inserted in comparison to the object being overwritten. 

Keyboard shortcut (is applied directly):  5 
 

Audio functions 
Below to the right of the Media Pool, you will find two more buttons for important 
audio functions. 

 
 

Mute 

 
You can use the speaker button to mute the arrangement.  

 

A muted arrangement is characterized by a crossed through speaker symbol. 

 

Scrubbing 

 
The small arrow next to the mute button opens a menu where you can select 
the scrubbing functions (view page 203). 

 

Mixer 

 
This button opens the audio mixer (view page 196). 
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Adjusting the workspace 
The project window, video monitor and Media Pool can be positioned anywhere on 
the screen or completely hidden. Personal settings are automatically saved when 
MAGIX Movie Edit Pro is closed and remain when the program is reopened. 

For larger arrangements, the program monitor can be used to show an overview of 
the project window (Window -> Movie overview (view page 299)). 

Note: If lose track of the settings, you can use "Window -> Reset window 
arrangement" or the keyboard shortcut "F9" to reset the basic settings. 

Tip: If you are working with two monitors, you can use one to display the preview 
monitor as a full screen. To do this, move the cursor to the upper border of the 
preview monitor and click and drag it to the other screen. Then click on the small 
rectangle in the upper right. The preview monitor will now be displayed in fullscreen 
mode. 

 

The "Burn" screen 

 

1 Menu preview: Here you can see a selection menu preview. For more information, 
read the "Edit disc menu" chapter. 

2 Switch views: Here you can switch between preview and edit views. 

3 Remote control: Here you can check how your future disc will react when you 
press the buttons of your player's remote control (view page 247). 
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4 Output:Before burning the project, select the desired format (view page 257). 

5 Play preview: Play the preview menu and test how it works with the remote 
control.  

6 Template category: Select the desired section from various categories with 
different menus. 

7 Menu templates: Switch between different templates for designing your menus. 

8 Use templates: Here you can select whether a template should be assigned to a 
page, the menu or all menus on a disc. 

You will find more information in the "Burning" (view page 246) section. 
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Settings 
All settings dialogs can be accessed through "File -> Settings". 
 

Project and movie settings 
You can reach these settings through "File > Settings > Movie". Here you can 
determine the settings that can be individually adjusted for every movie and project. 

Note: A project can include multiple movies. 
 

Settings 
Play film in loop mode: The movie is played over and over again, i.e. when the movie 
reaches the end marker, it starts again from the beginning. 

Use as presets for new projects: The settings specified in the dialog are used as the 
standard settings for newly created projects. 

Automatically adjust new images to fill screen (borders are faded out): This option 
is especially useful for photos that are part of the arrangement but have a different 
format. When the option is activated, there are no bothersome black bars; however, 
parts of the image along the edge will be hidden. 

Automatically create proxy files (Plus/Premium version):Using proxy/preview 
rendering, you can render complicated sections of your project in advance in order to 
produce a smooth preview. You can start this feature in the context menu of the 
marker bar. More about this is available in the "Proxy editing" (view page 216) 
section. 

Number of tracks: Here you can change the number of tracks. 

Audio sample rate: The preset sample rate is 48 kHz. This sample rate is used for all 
recordings and is also the standard setting for DVD audio tracks. With this setting, 
optimum sound quality is guaranteed. Audio material at different sample rates (e. g. 
CD Audio with 44 kHz) is automatically adapted when loaded (resampling).  Only 
change this value if you want to use audio with a different sample rate or if your 
sound card does not support this sample rate.  

Video settings:  This is where you set the standard settings for the picture format and 
frame rate for PAL or NTSC TV pictures or for your own format. 
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Movie information 
This option opens an information window: 

Name: Here you can enter the name of the current movie. 

Date of creation: Displays the time the movie was created. 

Last changed: Displays the time of the last save. 

Number of objects used: Displays the number of all objects in the movie. 

Used files: All files used in the movie are listed here. 
 

Project settings 
You can change project settings here. A project can consist of multiple movies and is 
saved as an MVP file. 

Name and path: Displays the name of the movie and the location where it is stored on 
the computer. 

Description:  Here you can give your project a description - perhaps a few statements 
about the state of the editing progress, e tc.  This is something like a notepad function. 

Date: Here you can assign your project a specific date. You can choose between a 
date - e. g. "Dec. 25, 2010" - or a written description - e. g. "Christmas 2010".  

Preview: This is the preview in a file manager such as Windows Explorer. You can use 
the automatic selection for the preview image or choose an image from your hard 
drive. You can also use a preview image from movie project. 
 

Select preview image automatically: MAGIX Movie Edit Pro uses an automatically-
selected preview image. 
 

Use image file 
Clicking the folder button opens a dialog to load image files. In this dialog, you can 
navigate to the directory where the image file is found and select it by double clicking. 
 

Use preview image from movie 
Use the controller to select a frame from the corresponding directory. 
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Program Settings 
All basic settings for MAGIX Movie Edit Pro are made in this window. 

Open 
"File" > "Settings" > "Program" 

Shortcut:  Y 
 

Playback 
Audio playback 
Driver selectionHere you can specify whether the Windows Wave driver or the 
DirectSound driver will be used for audio playback. DirectSound is a component of 
DirectX and, if necessary, is installed together with MAGIX Movie Edit Pro. 
DirectSound has the advantage that the sound output (for all modern sound cards or 
onboard soundchips) can also be used by other programs open simultaneously. WAV 
drivers are recommended if the CPU load is higher, as the larger buffers allow better 
handling of the load peaks (otherwise this would cause crackling). 

Note: "DirectSound" must be activated to work with 5.1 Surround Sound. 

Output device: Use this option to specify which sound card plays the wave audio 
objects. This is especially important if you have multiple sound cards installed on your 
computer, e.g. "onboard sound" as well as an additional sound card.  

Audio buffer: In order to allow smooth playback of a complex arrangement, MAGIX 
Movie Edit Pro creates a RAM data buffer into which the current data is loaded.  This 
allows for step-by-step preprocessing instead of preprocessing for the entire 
arrangement. 

Number of buffers: Here you can specify how many buffers should be used. More 
buffers increase reliability and improve playback performance, but they also increase 
the memory requirements. If played via DirectSound (see settings in the "Playback 
parameter" dialog), only one buffer is used automatically. 

Note: If response and loading times are too slow, reduce the buffer size; otherwise 
increase the buffer size if the audio playback is choppy or if real-time errors occur. 
Since error-free playback is usually more important than fast reaction times, the 
buffer size should be raised to 16384 or 32768 to avoid drop-outs. The possible 
number of used buffer updates is between 2 and 10. 
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Multitrack size/Preview size: Specify the buffer size used to play the entire 
arrangement or for previewing waves in the file manager. 

Video playback 
Overload optimization for real-time playback: Here you can activate or deactivate 
overload optimizing during realtime playback of the arrangement. This feature is 
particularly suitable for lower performance PCs. 

Instant Cache Refresh in Multicam Mode: Activate this mode to empty the cache in 
short intervals which will make the preview for multicam editing immediately visible 
in the preview monitor. This may result in juddering during playback. 

Track number for parallel track optimization: This is an option, which is useful for 
projects with an especially high track number which leads to problems when saving 
the project. If you get errors, try using a value of "2" here. If you continue having 
problems, try using "1". 

Note: This option influences program function only when MPEG and AVCHD 
material is being edited. However, performance declines to reduce disk space usage 
with increasing values. 

Project window 
Autoscroll during playback: If autoscroll is activated, the screen view automatically 
shifts when the playback marker reaches the right edge of the screen, which is useful 
for longer arrangements. You can select the size of the scrolling steps from either 
"Fast" (whole pages) or "Slow" (half pages).  

Attention:  Scrolling requires constant recalculation of the screen view which may 
lead to interrupted playback if system RAM is too low. If this happens, simply 
deactivate the autoscroll feature.  

Display: Display of objects in timeline mode can be simplified to improve 
performance. You can decide whether to display preview frames for video objects 
across the entire object, or just for the first and last frames. For audio objects you can 
hide the wave form display. This is particularly recommended for MPEG data streams. 

Update in background: The update of the object display after move and zoom 
operations in the project window is performed in the background in order to let you 
work smoothly. 

Spacebar behavior: Here you can determine whether pressing the spacebar during 
playback resets (deactivated) the playback marker or leaves it at the current playback 
position (activated). 
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Image playback 

Resizing high-quality image material: Use this feature to improve the quality during 
resizing, particularly when downsizing to less than half of the original size (e.g. for 
picture-in-picture effects). Keep in mind that this function requires more processing 
power. 

Load image material in background: Activate this option in order to load inserted 
image material already before playback in background. 
 

Folder 
Here you can set the path where 

• you want to save your projects (Projects) 
• files are exported (Export) or imported (Import), and recordings (Recordings) 

are saved, 
• Disc Images are saved 
• and where EXE files for the external audio and picture editor are located so that 

they can be launched via the Effects or Prepare menu (only Plus/Premium-
Version) 

Note: Folders placed here are fundamental for the entire program. Newly created 
projects are stored in a separate subfolder, which you can define in the "Program 
start" (view page 24) screen.  

 

Video/Audio 
In this tab you will find all settings concerning video and audio files. 

Video standard 
Normally the right video standard is set up automatically. PAL is used in Europe; the 
United States and Japan use NTSC. 

Timeline 
Simple display of video objects (first and last image): Activate this function if you are 
having performance problems. The preview images of a video in the project window 
will only be displayed at the beginning and end of the video.  

Half waveform display: Half of the waveform display (upper part) is enough for audio 
editing. This is the default setting. If you want to do more detailed, professional audio 
editing, you can display the complete waveform. 

Video/Audio on one track: Activate this option if you want imported video footage to 
be displayed as one object with video and audio on one track. You can always use the 
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options in the object menu to put the video and audio on separate tracks later to edit 
them individually. 

Display guidelines: If needed, you can display guidelines in the project window. The 
spacing between guidelines is adjusted to the zoom factor set in the project window. 

Audio -6 dB on import: When you load a file containing audio material (sound), the 
loudness of the generated object will be set to -6 dB. This is particularly useful when 
playing back several objects that contain audio material at the same time. This 
reduces the risk of undesirable clipping. Object loudness can be edited (view page 
113) at any time. 

Import 
Automatically create frame table during import Sometimes, rebuilding a frame table 
can get rid of problems in certain MPEG files. For example, such problems can be 
present if the navigation (positioning of the playback marker, transport) is bumpy or 
doesn't function at all. 
Normally, when loading MPEG video, a frame table is not created in order to speed up 
the loading process. If you do create one anyway, MPEG files are normally noticeably 
faster and easier to edit. 

Automatically create waveform when importing: Select this option to automatically 
create a waveform display for the audio track. This can also be created at any time via 
the context menu. 

Import videos with audio: If a video file contains video and audio data, the audio track 
of the video will also be imported if this option is activated. It will be displayed as an 
audio object in the project below the video object. Both are automatically grouped 
together. If the audio track has to be edited or replaced later, you first have to ungroup 
it ("Ungroup" button in the tool bar or in the "Edit" menu). 

Standard display time: Specify how long an image in the project should be displayed 
before moving to the next object.  

Note: Adding transitions between the objects will reduce the actual display time. If 
you plan on using transitions, it is best not to set the display time too short. 

Trim videos: Sometimes video clips have damaged frames at the beginning or end. 
Most often these are green, black or incomplete. Here you have the option of 
automatically trimming your videos during import if your footage constantly has 
damaged frames. Specify how many images (frames) should be trimmed at the 
beginning and the end of the video.  

Note: The frames are not lost due to the shortening. By adjusting the object length in 
the project window you can make the trimmed frames reappear. 
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Other 
Reduce bitmap resolution for preview: The resolution of image files is reduced during 
playback to decrease required memory. This requires less computing power than 
playback in full resolution; full resolution is always calculated during export. 

Relocate memory for bitmaps to other process: Activating this option will improve 
handling of bitmaps as they will be processed differently. This function can lead to 
delays in 32 bit systems. If this happens, you can deactivate the function. 

GPU acceleration for standard transitions: Here you can (de)activate hardware 
acceleration of your graphics card for 3D effects. More information about this topic is 
available in the 3D transitions (view page 119) chapter. 

Automatic interlace processing: MAGIX Movie Edit Pro normally detects whether 
the loaded video files were recorded with the interlace or progressive processes 
automatically, and half-image format is detected for interlaced movies. If automatic 
detection fails, you can deactivate it here and set the object properties (view page 
308) of video objects to the correct process. 
 

System 
Program interface 
Reactivate warning dialogs:In its newly installed state, MAGIX Movie Edit Pro 
displays a number of security queries at various parts of the program. Each of them 
can be switched off by clicking the small box at the bottom that says "Don't show this 
message again". To display these warning messages, select the "Reactivate dialogs" 
option. 

Begin online configuration: If you have an Internet connection and use MAGIX Online 
Services, you can configure your services here. 

Undo/Redo 
Here you can set the maximum number of undo commands. The higher the value, the 
higher the CPU load on the computer. 

Save automatically 
Auto Save projects allow you to set a time interval at which the project will be 
automatically saved. If the program crashes, this feature will restore the project to the 
state it was in when last saved. 
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Other 
Automatic preview when changing transitions: When this option is activated, a short 
preview of the transition effect will be quickly played between the two objects you 
selected. 

High output quality for dynamic zoom and combination effects: The Title Editor is 
used in high resolution by default. The display quality of titles is improved, but this 
also results in longer loading times for movies. 

Move playback marker when selecting objects: This option automatically moves the 
playback marker to the beginning of the selected object. 

Activate mobile sync: Mobile sync is necessary for transferring Movie Edit Touch 
projects to MAGIX Movie Edit Pro (view page 106). When this option is activated, 
you can transfer projects created with Movie Edit Touch directly to MAGIX Movie 
Edit Pro to continue editing them. 

Double-click properties: Specify whether a double-click plays back files in the Media 
Pool or imports them to the project window. 

Preferred codec for import and export of MPEG-2/MPEG-4: This option is only 
available after you have installed the MainConcept encoder for MPEG-2 and MPEG-4 
and defined whether the standard encoder or the MainConcept encoder will be used 
for the corresponding file format. 

Import formats 
File formats that you never use can be deselected here. Once deselected they won't 
be imported anymore. Please keep in mind that several import modules exist for some 
file types (AVI, WMA). MAGIX Movie Edit Pro uses the fastest one in each case. If 
you experience problems when importing certain files, you can experiment with 
deactivation of certain import modules, forcing the program to use the slower but 
more compatible import module. 
 

Display options 
Video output to external device 
With this option, you can display the project window view on an additionally 
connected monitor. Without additional hardware, you can play a preview in any mode 
in order to see how the final material looks. 
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Preview in the Arranger/preview window and playback in video 
recorder/analog recording 
You can set the playback mode separately for the project window (including all 
preview windows and effects dialogs) and the preview monitors during recording and 
in the video recorder. 

Always use DirectX9  

Normally DirectX11 is activated for the preview in the project window. DirectX9 can 
be activated for Windows XP and graphics cards that don't support DirectX11. You 
can also activate it if you are having general problems. 

Video mode:  

Hardware acceleration (Direct3D) is the default setting and as a rule should not be 
changed, since it delivers the best results. If you notice problems, such as the image 
turning black, you can try to see if picking another mode helps. The Compatibility 
mode (VideoForWindows) completely turns hardware acceleration off, which should 
deliver the best results. However, it is also the slowest mode and can result in choppy 
playback. These options are irrelevant for data export or disc burning. 

Note: Only change the video mode when there are problems with the presets, e.g. 
choppiness or lengthy screen distortion. 

Compatibility mode (Video for Windows): This is the standard mode that functions 
on all systems. 

Standard mode (hardware acceleration, Direct 3D): This mode offers an extreme 
speed advantage by letting the graphics card directly calculate mixing, many effects 
and various transitions. Depending on the graphics card, performance can increase by 
300%. The graphics card will not be used during export. If you activate this mode and 
have multiple graphics cards installed, you can also select which graphics card should 
be used. 

Important: To use this mode the graphics card must have at least 128 MB memory 
available. You will need to install Direct 3D 9 or higher, and the graphics card driver 
must support "High Level Pixel Shader Language 2.0". MAGIX Movie Edit Pro 
checks the corresponding properties when this mode is selected, and switches it off 
if necessary. 

Alternative mode 2 (video mixing renderer 9):  

This mode uses the hardware de-interlacing function of modern graphics cards 
together with DirectX 9. Make sure that you are using the most recent version of your 
graphics card driver, which must be compatible with DirectX 9 to function properly. 
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Image formation in Vertical Blank Intervals (VBI) 

The image formation takes place in the vertical blank intervals of the monitor signal 
(or the connected TV signal). This helps avoid image interruptions. This option is only 
selectable in compatibility mode (video for Windows). 

Warning: Because of waiting time required for the next VBI, this process adds 
significant computational time! 

For digital displays like the TFT monitors you can deactivate the option. In the 
Standard Mode (Overlay mixer) image formation occurs exclusively in VBI. 

De-interlacing: 

In the DirectShow modes "Overlay mixer" and "Video mixing renderer 9", you can 
activate hardware de-interlacing for your graphics card. For general information about 
de-interlacing and the options "Top/bottom field first", please read the corresponding 
article "De-interlacing (view page 361)" in the manual. 

Comparison image in source monitor for editing effects in the Media Pool: 

If this option is activated, the "Selected objects without effects" comparison mode will 
be automatically activated when switching into the Media Pool effects, and will be 
automatically deactivated when the mode is exited. This serves to compare the 
original and edited image. This automation will be suppressed if the option is 
deactivated. 
 

Proxy and preview rendering (Plus/Premium 
version) 
The proxy/preview rendering settings concern the way in which MAGIX Movie Edit 
Pro creates (view page 216) proxy files when importing or renders selected areas in 
the project window. This dialog can be accessed through "File" -> "Settings" -> "Proxy 
and preview rendering". 

Keyboard shortcut:  Alt + R 
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Info: The proxy and preview rendering function enables smooth preview playback by 
rendering complicated passages in the project in advance. You can start this 
function in the context menu of the marker bar. More details are available in the 
"Preview rendering" (view page 217) section.  

 

Presets: Choose a preset that is suitable for your project. The rendered files will have 
a correspondingly higher or lower quality, and the quality of the preview will be 
determined. 

• Playback: The lowest quality. Preview rendering should only be used for 
improved performance during playback in the program and not during export or 
burning. This is the default setting. 

• DVD export: Playback in the program will be smoother and writing standard 
video DVDs will be faster. 

• HD export: Playback in the program will be smoother and writing Blu-
ray/AVCHD will be faster.  

Options 
• Use files created during rendering for export and burning: If the resolution of the 

rendered files is sufficient for the finished movie, you can use them for the final 
export. This shortens the time required for creating the movie. 
This function is set as default when you select presets for DVD or HD export, 
since quality is also optimized for export.  
You cannot select this setting if you have activated the option "Best 
Performance during Playback". 

• Extract audio when creating proxy files: In addition to the proxy files for videos, 
separate audio files (*.wav) are created in order to improve playback 
performance. 
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• Create Stereo3D files for preview rendering: You can also view the preview in 
3D. 

Note: Rendering may take longer depending on the selected format and size of the 
set range. 
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Video recording 

Select the recording method 

 

To start recording, click on the red "Record" button below the preview 
monitor. 

 

The following selections are possible: 

 
• Import from AVCHD/SD card/USB For importing from AVCHD cameras, 

removable storage devices and MTP devices. 
• HDV camera: For HDV cameras 
• DV cameras: For mini DV cameras and DV video recorders 
• Video: For analog video cameras TV, analog TV, VHS recorders, webcams and 

others 
• Audio: For microphones, cassette recorders, MiniDisc players, turntables, etc. 
• Screenshot: Records directly from the computer monitor. 
• Single frame: For single and series images from analog cameras, analog TV, or 

VHS recorders, webcams, etc. 
 

Recording AVCHD 
When importing from AVCHD/SD card/USB, files created by the camera will be 
copied to the computer.  
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In addition to normal removable storage devices, so called "MTP devices" are also 
supported. "MTP" is short for "Media Transfer Protocol" and refers to the transfer 
protocol of media devices such as photo cameras, video cameras and MP3 players. 

On older systems it is sometimes helpful to convert AVCHD files into MPEG-2 format 
when importing. A corresponding query appears during importing of these files. 

Note: When importing AVCHD videos it is necessary to activate (view page 337) 
the MPEG-4 codec and download an audio package upgrade if necessary. MAGIX 
Movie Edit Pro offers this option as soon as a codec is required. 

 

Connect camera 
Suitable cameras are essentially available in three varieties: 

• Cameras featuring removable data storage: These cameras have a slot for a 
memory card. Your computer should have a card reader for the corresponding 
memory card, which you can then remove from the camera and insert into the 
card reader. Different camera models can also be connected via USB. 

• Cameras which burn DVDs directly (usually 80 mm diameter instead of the 
regular 120 mm): The DVD can simply be taken out of the camera and inserted 
into the computer. For so-called "Slot in DVD" drives, look beforehand in the 
operational manual whether or not 80 mm DVDs (also called 3" DVDs or 
MiniDVDs) are acceptable. 

• Cameras with built-in hard drives: The camera will respond as a drive as soon as 
it is connected via a USB cable to the PC. This additional drive will appear in 
Media Pool. 

Hint: The listed options and procedures reflect our experience with what works. Still, 
we recommend you read the camera's manual for the exact sequence of actions and 
contact the manufacturer in case of problems. 
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AVCHD/SD card/USB 
After selecting the import, the following dialogue will open: 

 

 Video source: Here you specify the hard drive that will be used to access the 
storage medium or connected AVCHD camera. 

 

 Save in following folder: Create a target folder for the files to be imported. 
 

 Advanced settings: Adjust various settings for the name and date of the files to 
be created. 

 

 Select: This offers self-explanatory options for file display ("all", "only new", or 
"none"). 

 

 Preview monitor and transport control Here you can play back, rewind or fast 
forward clips in the file list. 

 

 Medium/general: An info area for the files is provided to the right next to the 
preview monitor. 

 

 Options for displaying files, here you can also specify the criteria which will be 
used to sort the files. 

 

 File list: The contents of the selected drive are shown here. Use the display 
filters (10) to reduce the types of files shown. 
You can select every file separately using the little check boxes in order to import 
them later.  

Note: The files are color-coded. The same colors indicate roughly the same 
recording times, so that you can quickly recognize which recordings were made at 
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the same time. Color assignments come with a certain "intelligence", which means 
they take into account how far apart the displayed recordings are chronologically. 

 

 Import: Imports the selected file to the target folder. 

Cancel: Closes the dialogue without importing. 
 

 Display filter: The display filter can be used to define if certain files should be 
hidden. 

When you uncheck a box, the corresponding files will be hidden. 
• Videos: Hides all video files. 
• Photos: Hides all photo files. 
• Selected files: All files selected for import will be hidden. Only the files which 

have not been selected will be displayed. 
• Not selected files: All files which have not been selected will be hidden. This is 

useful if you want to check your selection before importing. 
• Imported files: All files which have already been imported by MAGIX Movie Edit 

Pro from the specified device will be hidden. 

 Import options: Here you can define what happens after import. 
• Insert into movie: The media will be directly inserted as an object into the 

open movie. When inactive, they will be simply copied into the target folder 
and can be selected from the Media Pool at any time. 

• Delete all media after camera import: This option deletes the selected media 
after importing from the camera. 

• Close dialogue after import: The dialogue closes as soon as the import has 
finished. 
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HDV camera 
Use this option to open the HDV camcorder record dialog. To do this, you have to 
connect an HDV camcorder. 

 

The options in this dialog can also be found above in DV recording. 
 

DV camera 
DV devices 
MAGIX Movie Edit Pro supports continuous editing of DV (digital video) files. A DV 
recorder or camcorder and a computer with a FireWire interface are required. 

To record digitally, the digital output of the Mini-DV camcorder or DV video recorder 
must be connected to the DV interface of the PC, yet switched off. You must also 
have Microsoft’s DirectX8a (or higher) installed on your PC. Now switch your 
camcorder to “video recorder” or “playback” mode (depending on your particular 
device) and open the DV capture dialog. 
 

Connect a DV or HDV camera 
• Connect the digital output of the switched-off camera with the computer's DV 

interface (also called FireWire or iLink). 
• Insert a DV cassette or the storage device into the camera. 
• Switch your camera’s operating mode to "Video recorder" or "Playback". 
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The camera is now ready to transfer video to the computer. 
 

Note: You may also use a HDV camera in DV mode to, for example, transfer 
recordings in the old DV format. We have noted problems with this mode in many 
cameras, and therefore recommend that the Record mode of the camera is also 
switched to DV, switching the camera off and then on again. 

 

Capturing DV recorders or cameras 
• Select "DV camera" from the recording dialog. Uncompressed DV capture 

requires approx. 220 MB per minute of video. If you would instead like to record 
using the more space-saving MPEG format, then you should first activate the 
"Record DV as MPEG" option. 

• This opens the actual recording dialog. Check to see if a DV camera driver has 
been selected. 

• Name your recording. It's worth choosing a logical name which will allow you to 
find it easily again on the hard drive. 

• You can access the appropriate place on the camcorder tape by using the 
remote control buttons: shuttle forwards, backwards, and start/stop playback. 
To start recording, click on the "Record" button. Keep an eye on the remaining 
hard drive space. 

• Cease capturing with the "Stop" button and exit the record dialog. You can see 
the recording in the film-strip in the lower third of the screen. 

Tip: In the DV recording dialog, you can set clips from the DV video which then will 
be recorded one after the other (batch capturing). Read more on this in the chapter 
"Batch processing" (view page 95). 
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"DV capturing" dialog 

 

Note: Keep an eye on the available hard drive space before each recording. DV 
capture requires approx. 220 MB per minute of video! 

 

Select DV device driver: The device driver for your DV device should be listed here. If 
"Record audio" is deactivated, then video without sound is recorded only. "Audio 
preview" activates the audio output of the recording. 

Note: The audio preview is deactivated at first, since DV cameras usually include 
built-in speakers. 

 

Save movie file as/save in folder: Enter the name of the movie to be recorded. You 
can also select the folder where you wish to store your video file. The default 
recording directory is set by default, but you can change the Path settings (view page 
78) under menu item "File -> Program settings -> Path settings". 
 

Edit after recording: This provides access to the automatic editing options. 
 

Start the DV device automatically: Starts the DV recorder or DV camera 
automatically when the "Record" button is pressed. This does not function with all 
digital cards/video devices. 
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Video preview: On the preview monitor you can see a preview of your movie. 
 

Original size: This option allows you to preview the video in the original size. To 
return to the dialog use the "Esc" key. 
 

Batch recording: Here the start and end points can be set for the capturing. This 
allows you to search the entire video for all captures to be used and list them for 
planned batch capture. This is then processed in sequence when the recording starts 
(via the red button). That way you don't need to record each scene individually. You 
simply determine recording time points, and the computer takes care of the rest. To 
set the start and end points precisely, click "Enter start/end point (view page 94)" 
 

Record list: Use this button to view the available list of already recorded videos and 
scheduled recordings. All entries from the list can be selected and deleted.  
 

Record: Starts the recording process. Also contains the list of scheduled recordings. 
These are processed step-by-step (batch capturing). 
 

Stop: Stops the recording process. 
 

Snapshot! With the Snapshot! button, you can create a frozen image directly from the 
preview monitor. Start the camcorder and watch the preview window. When the 
image you want appears, click "Snapshot". Or you can navigate using the remote 
control to the position you want, and stop there in Pause mode. Stopped playback on 
the DV camera will not deliver an image! The images are saved in the record directory 
as graphics files in the set resolution.  
 

Remote control 
MAGIX Movie Edit Pro also supports remote controls for most digital camcorders. 
This does not function with all digital cards/video devices. If your hardware does not 
support the remote control function, the buttons will not be usable. 
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The transport controls required for this are featured in the DV or HDV recording 
dialog. 

 
 

Tape title: Enter a name for your tape here. MAGIX Movie Edit Pro requires this name 
for the DV logging feature. 
 

Recording information: Displays various information about your recordings. 
 

Set recording start/end point: Enter the exact start and end point or the recording 
length for a scene. 

Both values can be entered as ATN (absolute 
track number) or as a timecode in 
hours:minutes:seconds:frames. 
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DV as MPEG 
This recording selection dialog option allows you to transfer DV recordings directly 
into the space-saving MPEG format on the harddisk. 

 

From the "DV as MPEG" dialog window you can find MPEG encoder settings options 
under "Advanced". 

You can also burn your DV material direct to disc without any intermediate steps. 
 

Recording list 
Set the start and end points for the capture here. This allows you to search the entire 
video for all captures to be used and list them for planned batch capture. This is then 
processed in sequence when the recording starts (via the red button). That way, you 
don't need to record each scene individually. Simply specify the recording time points 
and the computer takes care of the rest. To set precise start and end points, click 
"Enter start/end point (view page 94) 

 

Record list: Press this button to view the available list 
of already recorded videos and scheduled recordings. 
All entries from the list may be selected and deleted.  

Every batch recording is automatically logged. 
Conversely, every "manual" DV and HDV recording is 
transferred into the recording list in order to restore lost 
recordings without much effort. 

 



 

96   

www.magix.com 

Logging 
Logging means that MAGIX Movie Edit Pro also saves the original save location, 
position and additional information (metadata, e.g. scene, take, rating, comments, 
etc.) about DV video and audio files. 

Everything copied using DV recording, DV to MPEG recording and HDV recording 
appears in the recording lists of the corresponding recording dialog. Recordings for 
which the corresponding video material is no longer on the hard disk will appear as 
"planned recordings". 

If MAGIX Movie Edit Pro does not find the corresponding DV and WAV files during 
the loading of a video, it will ask that the corresponding DV tape is inserted into the 
connected camcorder again for automatic scene import. 

You no longer have to save DV AVI and audio files (which can be very large). If at a 
later time you would like to work on a film again, but do not have the space to keep 
the material for it on your hard disk, then you can simply delete the bulky DV AVI and 
audio files. 
 

Analog video recording 
Connect analog video source 
Connect the video out of your video camera, DVD player or VCR to the video in (TV, 
video, or video-in graphics card) of your computer, and the audio out to the line in of 
your sound card. 

Due to the variety of device configurations, it is difficult to say which cable will 
function best with your setup. If you’re not sure, check the manual of your VCR or 
your TV-, video- or graphics cards. 

Example: Many VCRs have a SCART output and most DVD players have three RCA 
outputs (two for the stereo track, one for the image). In such cases, you will need a 
SCART to RCA adapter, a cable with 3 RCA plugs at each end. 

   

SCART/RCA adapter Scart/RCA adapter with 3 
RCA jacks 

Stereo RCA/mini phone jack 
adapter 
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Most sound card inputs are mini stereo jacks. To connect the audio out of your VHS 
recorder to the sound card audio in, you will need a stereo RCA/ mini phone plug 
adapter. 

You will have to purchase a cable with three RCA plugs and a stereo RCA/mini phone 
plug adapter. 
 

Analog video recording 

 

Video/Audio driver: Here you can set up the video card or sound card for recording. 
In practically every case the driver software supplied with the hardware must be 
installed. 

Hint: Under "video driver" you will find a "screen capture" entry in the Plus/Premium 
version. You can read about how it functions in the "Record screen contents 
(Plus/Premium version)" (view page 103) section. 

Input/Tuner settings: If your video capture card supports multiple sources, i.e. your 
card also has a TV tuner or multiple inputs (SVHS, composite, etc.), then you can 
select the proper recording source and the TV channel to be recorded here. 

Save movie file as/Save in folder: Enter the name of the movie to be recorded. You 
can also select the folder where you wish to store your video file. The standard 
recording folder is set as default. The location of this folder can be changed in "Path 
settings (view page 78)" under "File -> Program settings -> Folders". 

Edit after recording: Use this to access the automatic editing options. 



 

98   

www.magix.com 

Record quality: You can choose between various predefined recording qualities in the 
list box according to your computer's processing power and how you wish to use the 
picture material. They are sorted according to picture quality. Use Configuration to 
fine-tune the quality for the preset. 

Presets displayed with MPEG record directly in MPEG format. 

Tip: Use the presets marked MPEG if you want to burn your recordings straight 
away, since smart encoding can omit laborious encoding after recording. 

Advanced...: Opens the video driver settings dialog (view page 98). 

Capture control: Here you'll find the "Red" record and "Stop" buttons. With them, you 
can start and stop recording. 

Timer recordings active/time limit: Here you can specify a recording start time and 
length, and thus turn your PC into a fully functioning VCR. 

Snapshot!: With the "Snapshot" button, you can create a still image directly from the 
preview monitor. The images are saved in the recordings folder as graphics files in the 
resolution you have set. 

Recording details: This shows statistical information such as the recording time, 
available space on the hard-drive, the recorded frames, and the “dropped” frames. 
Dropped frames are frames that have been left out because the computer processor 
is too slow for the selected image format and cannot accept all incoming frames. 

Preview: Some graphics adapters allow you to reduce the system lead by deactivating 
the video preview. If you hear an "echo", deactivate the audio preview. 
 

Advanced configurations in the video capturing dialog 
Here you can adjust certain settings for the video recording driver. 

These dialog boxes, so-called “property sheets,” come with the video card drivers. 
These driver-specific performance properties may deviate depending on the cards. 
We also have a very limited influence on the behavior of these drivers. If you 
encounter any difficulties, please contact the video card manufacturer for the latest 
driver updates. 

Source: Sets the crossbar of the video card. 

The crossbar determines which video and audio input signal will be recorded. The 
crossbars are connected in series to the video recording chip itself. In the output field, 
the video output (for the crossbars) is the input for the recording chip (video or audio 
decoder-in) of the video card. In the “Input” field, select the signal source that will be 
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used by the video card to capture for this input. Many video cards have separate 
crossbars for audio and video. If you have a problem, try out the different 
configurations until the right sound matches the right image. 

Composite-in = the normal video input (typically a cinch jack) 

S-video = S-video input (mini-din jack) 

SVHS-in = SVHS input (special cable) 

Tuner-in = TV signal of the integrated tuner 

Display 
Video decoder: If the picture only appears in black & white or it flickers, the video 
standard may be set incorrectly. In mainland Europe, PAL_B is used. 

VideoProcAmp: Fine-adjustment of colors, brightness, contrast etc. We recommend 
against changing any of the manufacturer’s settings. 

Format: Please do not change anything here. The capturing format is set in the 
"Recording quality" option in the video recording dialog. 

Station selection 
This option is only available if a TV tuner is integrated into your video card. 
 

Audio 
Songs, noises, or instruments can be easily recorded in MAGIX Movie Edit Pro using 
the audio recording function. A hooked-up microphone or various audio devices 
(especially a stereo system) can be used as recording sources. 
 

Connecting the recording sources 
First, the recording source must be connected to the computer. There are several 
possibilities depending on the equipment you are using: 
• If you would like to import music from a stereo system, use your sound card's 

line-in input. If the stereo system amplifier comes with separate line-out or AUX 
out connectors, they should be used. In this case, they have to be connected to 
the computer's line-in. Hi-Fi amplifiers usually have RCA (composite) 
connectors and the computer has mini stereo connectors. You need to then get 
a suitable cable with two small RCA (composite) connectors and a mini stereo 
jack. 

• If the amplifier comes without separate outputs (other than the speaker 
connectors), you can also use the headphone jack for recording. Normally, you 
will require a cable with stereo or mini stereo jacks. This type of connection has 
the advantage of a separate volume control to set the headphone input signal 
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level. However, headphone jacks are often not very high-quality. For this reason, 
you should use line-out outputs whenever possible. 

• To record cassettes from a tape deck, connect the tape deck’s line-outs directly 
to the computer's line-in. 

• When recording LPs, the record player's outputs should not be connected 
directly to the computer because the phono signal has to be pre-amplified. In 
this case, connecting through the headphone jack or an external preamp is 
recommended. Some record players also have normal line-out connections. 

• If you would like to make recordings with a microphone, connect it to the 
computer using the microphone input (usually a red jack). 

 

Adjusting the Signal Level 
Adjusting the signal level to the sound card is also recommended to get the best 
sound quality during digital recording. 

Once a recording source is connected to the sound card, the "Record" button opens 
the recording dialog and starts the recording source. 

You can now adjust the recording level with the help of the LED display in the 
recording dialog. For this, you must first check off "Show Levels". 

If the adjustment is set too high, distortion occurs and the incoming signal must be 
reduced. If you have connected the source through either an amplifier or tape deck 
output to the sound card, you can only reduce the signal level in your sound card’s 
software mixer interface. You can access the mixer directly from within the recording 
dialog via the “Recording Level” button. 

If you reduce input sensitivity by using the input fader, the resolution at which the 
analog signal is digitized is also reduced. Try to set these automatic controllers to the 
loudest sound level possible. 

The maximum setting for an optimal level is the loudest part of the material. The 
loudest part should be adjusted to be the maximum. The actual recording begins 
when you press the "Record" button.  At the end of the the recording you will be 
asked if you want to use the recording. Upon confirmation, the newly-recorded 
material will be placed at the next free position of the start maker in the arrangement. 
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Audio record dialog 

 

Audio driver: Selects the sound card for the recording. 

Save audio file as/ Save in folder: Here you can select the title of the audio file you 
wish to record. You can also select the folder where you wish to store the file. 

Recording quality: Sets the sound quality of the recording. In the preset menu you can 
choose between medium wave radio ("AM tuner"), UKW ("FM Radio"), DAT (Digital 
Audio Tape) and CD quality. 

Display Volume control: Using the peakmeter, you can monitor the level of the 
incoming signal. Please read more on this in the chapter "Adjusting levels" (view page 
100) 

Record: This button starts the actual recording. 

Stop: Click this button to stop recording 

Normalize after recording: With this option activated, your material's volume is 
raised to a proper level after recording is completed. In order to achieve good results, 
you should try to record the source as loud as possible without overmodulating it. To 
do so, refer to the peak meter reader in the recording dialog. 
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Play while recording: This option is particularly important for spoken commentary, 
etc. If activated, the selected movie (or selected scene if recorded in the "Edit" screen) 
is played while recording. This acts as orientation for the movie. 

Advanced: Use this button to open a window where you can select from special 
features: 
 

Advanced settings for audio recordings 
• Mono recording: Activate to record in mono. This reduces the required memory 

space in half. Mono recordings are recommended for voice recordings made 
using only one standard mono microphone. 

• Real-time resample to project's current sample rate: Automatically matches the 
sample rate of a new file to be recorded with the sample rate of the current 
movie's sound track (set in the video recording). 

• Automatic volume reduction of other audio tracks ("ducking"): To add narration 
or other sound material to a video that already has sound volume levels set, 
activate the option ”Automatic reduction of sound volume of remaining audio 
tracks”. This automatically reduces the volume of audio objects in the 
arrangement during the recording session (”ducking”). This is achieved using an 
automatically configured volume curve: Before and after the recording, other 
tracks will be faded in or out, resulting in a homogeneous total volume level. 
(Lowering of volume level during spoken comments is also called "Ducking".) 

 

Single frame 
Single frame recording may be used to record snapshots from the connected video 
source. This requires a DirectShow compatible video recording or TV card or a 
corresponding USB device (e.g. a webcam). 

The time control function allows you to automatically take snapshots. This is useful 
for the following applications: 

• to create slideshows using videos 
• for animation films (stop-motion recording) 
• for video surveillance 
• or in time-lapse photography 

The recorded images are added to the current arrangement. 
 

Timer-controlled recording 
Recording interval: When active, starting recording produces a sequence of images. 
Snapshots are saved according to the selected time interval and numbered 
sequentially. For example, if snapshots are taken every two seconds and then inserted 
every five frames into the slideshow, then a ten times accelerated time lapse 
recording will result. 
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Photo length in frames: Specifies how long the photos appear in the slideshow. 
 

Erweiterte Einstellungen 
Hier können verschiedene Einstellungen des Videoaufnahmetreibers vorgenommen 
werden. Diese Dialoge, sogenannte „Property Sheets“, werden von den 
Videokartentreibern zur Verfügung gestellt. Die treiberspezifischen Features können 
in gewissen Grenzen abweichen, auch hat das MAGIX Team nur begrenzten Einfluss 
auf das Verhalten dieser Treiber. Sollte es Probleme geben, kontaktieren Sie bitte auch 
den Hersteller ihrer Videokarte nach Treiber-Updates. 

Eingang: Stellt den sog. „Crossbar“ (= Kreuzschiene) der Videokarte ein. Mit diesem 
wird festgelegt, von welchem Video- und Audioeingangssignal aufgenommen wird. 
Diese Kreuzschiene ist dem eigentlichen Videoaufnahmechip vorgeschaltet, im Feld 
Output ist der Videoausgang (der Kreuschiene) also der Eingang des Aufnahmechips 
(Video bzw. Audio Decoder In) der Videokarte. Im Feld Input wählen Sie die 
Signalquelle aus, die die Videokarte zum Aufnehmen für diesen Eingang benutzen soll.  

• Composite In = der normale Videoeingang (i.a. Cinch-Buchse) 
• S-VHS In = S-VHS-Eingang (Spezialkabel) 
• Tuner In = TV-Signal des eingebauten Tuners. 

Videodecoder: Sollte Ihr Bild nur Schwarzweiß sein oder flackern, kann es daran 
liegen, dass der Videostandard falsch eingestellt ist. In Deutschland wird PAL_B 
verwendet. 

VideoProcAmp: Feineinstellungen für Farben, Helligkeit, Kontrast usw. Es empfiehlt 
sich, die Herstellereinstellungen nicht zu ändern. 

Format: Hier bitte keine Änderungen vornehmen! Einstellungen zum 
Aufnahmeformat werden im Aufnahmedialog unter Auflösung vorgenommen. 
 

Screen Capturing 
Use this feature to record everything that moves on your monitor. This process is 
called "screen capturing". 
 

Note: This function is available only in the Plus/Premium version. 
 

Step-by-step screen capture 
Use this feature to record your screen content. This process is called "screen 
capturing". 
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• Under Recording quality, you will find 
various presets for different 
applications. You can either record the 
entire monitor ("fullscreen"), a frame 
of variable size (e.g. to film the 
Windows Media Player display), or a 
different video player. Click 
"Configuration" to make custom size 
adjustments. 

Hint: Because many video players work 
with overlay, it is recommended to open 
each player before starting the capture! 
This way switching into "Overlay" mode 
can be prevented. 

• Select the "Screen" option in the recording selection dialog.  

An additional dialog with a red record button, a black stop button as well as a frame 
with dashed bordering appears.  

• Activate the option "Record mouse pointer" to record the movements of the 
mouse pointer. 

• Now select the screen area you wish to record, i.e. the screen of the video player 
in which the video is playing. Drag the frame over the area you wish to record 
and adjust its size as required by dragging the edges and corners. 

Note: If you previously selected "Fullscreen", the window will be hidden. 

• To start recording, press the red record button. The recording starts; the record 
symbol appears in the task bar (tray). 
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• If you are finished with everything, click on the record button or the stop button 
to stop recording. Recording ends and the recording dialog is visible once again. 

 

Edit after recording 

 

The "Edit after recording" dialog can be 
opened from the "HDV Camera", "DV 
Camera" and "Video" recording dialogs. 

This dialog offers these options: 

• Automatic scene recognition: This divides the footage into scenes. Please also 
read the section "Automatic scene recognition" (view page 221). 

• Automatically set chapter markers: Please also read the section "Set chapter 
marker automatically (view page 289)" in the chapter "Edit" in the PDF manual 
(press "F1"). 

Burn project immediately after recording: You can use this option to record and burn 
to a disc in a single step. Simply select the format you would like to burn, insert a 
suitable blank disc into the drive, and press record.  

Note: Make sure that the selected recording quality corresponds with the disc type 
(for DVDs the preset "MPEG DVD"). 

If you use your own settings for MPEG encoding (e.g. half image resolution for long-
play DVDs) make sure that settings for recording and later for burning are the same 
so that no new encoding is necessary (Smart encoding). 

After recording, the program automatically switches to the "Burn" screen, the burn 
window opens and the disc is burned. The last set layout is used for the menu layout 
for the DVD. 

Tip: This function is particularly suitable for handling lengthy projects in one go. You 
can start recording in the evening and have the finished DVD by morning. 
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Export for mobile device: The recorded movie is immediately converted into the 
format of the selected mobile device and transferred. The preset in the list field is the 
device which has been selected in the Export video/audio (view page 276) dialog. 

Settings: Opens the Export settings (view page 270) for the selected target device. 
 

Transferring a Movie Edit Touch Project from 
Android 
 Projects from Movie Edit Touch for Android can easily be 
transferred to MAGIX Movie Edit Pro. While MAGIX Movie 
Edit Pro is running, the Movie Edit Touch project is transferred 
from an Android tablet to MAGIX Movie Edit Pro where it can 
be edited in more detail as a separate movie. 

Tip: Scan the displayed QR code with your Android tablet to 
open the Movie Edit Touch product page in the Google Play 
Store 
https://play.google.com/store/apps/details?id=com.magix.
android.met. 

 

Example Application 
You've recorded, sorted and roughly edited some video footage with your tablet and 
Movie Edit Touch. Now you want to transfer the Movie Edit Touch project to MAGIX 
Movie Edit Pro and finish it there. 

Movie Edit Touch projects that have already been transferred can be transferred again 
to update them. Keep in mind that this will overwrite the corresponding project file in 
MAGIX Movie Edit Pro. For this reason it is a good idea to save the movie in MAGIX 
Movie Edit Pro under a different name. 

Requirements 
• The Android tablet and the PC with MAGIX Movie Edit Pro are on the same 

network 
• Movie Edit Touch is installed on the Android tablet 
• Android version 4.3 or higher 

Instructions 
1. Start MAGIX Movie Edit Pro. 
2. Start Movie Edit Touch on your Android tablet. 
3. Open the Movie Edit Touch project. 
4. Activate the Edit View in Movie Edit Touch. 
5. Press the following button in Movie Edit Touch: 

 

https://play.google.com/store/apps/details?id=com.magix.android.met�
https://play.google.com/store/apps/details?id=com.magix.android.met�
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6. Confirm the project transfer by clicking the "Start" button. 
Result: 
4. Movie Edit Touch searches for MAGIX Movie Edit Pro on the same network. 
5. When Movie Edit Touch finds MAGIX Movie Edit Pro on the same network, 

MAGIX Movie Edit Pro displays a corresponding query. 
7. Confirm the transfer of the project to MAGIX Movie Edit Pro. 

Result: The Movie Edit Touch project will be transferred to MAGIX Movie Edit Pro 
and opened as a separate movie. 

If another project is currently open, MAGIX Movie Edit Pro will ask whether the 
new movie should be added to it or saved as a separate movie. 

Notices 

 If you have edited the Movie Edit Touch project on your tablet since 
transferring it and want to transfer it again, make sure that this project is not 
currently open in MAGIX Movie Edit Pro, otherwise it might be overwritten. 

 Changes you have made to the project in MAGIX Movie Edit Pro will be lost 
when the Movie Edit Touch project is transferred again. 

Problems and Solutions 
Movie Edit Touch cannot find MAGIX Movie Edit Pro. 
• Check the network connections on the Android device and the PC. Both devices 

must be on the same network. 
• Make sure that the following ports in the network are accessible: 

- UDP-Port 6666 
- The HTTP Port can can be dynamically assigned through the Android device. 

The project cannot be transferred again. 
• The project might still be open in MAGIX Movie Edit Pro. Close the project in 

MAGIX Movie Edit Pro and repeat the transfer of the Movie Edit Touch project. 
 

Import a non-copy-protected DVD 
Click in the Media Pool under "Import" on "Computer" and select by double clicking 
the DVD drive where the DVD to be imported is located. 

Now you can load the listed VOB files into the project as described in the "Add 
objects into the project" chapter. MAGIX Movie Edit Pro recognizes which files 
belong together, so that you only have to load one file. 
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Objects 
In the MAGIX Movie Edit Pro "Timeline" mode you are dealing with objects. The 
general term "object" includes all media types that are present on the tracks in the 
project window. The following object types are found in MAGIX Movie Edit Pro: 

Combination objects: Combination objects are 
video objects with an image track and an audio 
track. In the context menu, you can add the 
waveform representation of the audio track or 
add the sound as an independent audio object. 

Video objects: Video objects include a file 
extension typical for videos (e. g. *.mpg, *.avi, 
*.mxv). Depending on the length of the video 
object, you will see several frames representing 
various positions in your video. 

Image objects: Image objects are photos or 
other static images. They have a file extension 
typical for an image (e. g. *.jpg, *.png, *.bmp). In 
contrast to video objects, you'll always see only 
one frame.  

Audio objects: All objects that contain only 
sound are considered audio objects. They have 
an extension typical for audio (e. g. *.ogg, 
*.mp3, *.wav). With a right-click you can add a 
waveform display to any audio object. 

Title objects: Title objects are created using the 
title editor (view page 132) and contain the text 
that appears in your projects. They have no file 
extensions. 

In the following chapter you can read about working with objects. The workflow for all 
object types is the same. In the following chapter you can read about what you can do 
with these objects. The workflow for all object types is the same. 

Tip: You will find many functions in the object context menu (view page 303), 
which can be opened by right clicking on the corresponding object. There, you will 
also find the "Object properties" dialog, where in addition to current settings you can 
also change interlace settings for the object. 
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Insert object into the project 
Data selection using the preview monitor 
You can view and cut your footage in the preview monitor before importing. There are 
various buttons on the transport console (view page 44) for this. There is a preview 
function for most of the files in the Media Pool. 

• Use the playback button to start the preview of video or image objects in Media 
Pool. A preview is also provided for special objects like titles or transitions. 

• Audio files from the Media Pool can also be previewed via the playback button. 
 

Full-page view of image 
• The option "full screen" in the context menu maximizes the preview monitor. 

Alternatively, a double click on the monitor or press "A + Enter" to maximize the 
window. The fullscreen view is especially recommended for working with two 
screens; one screen for the film preview, and the other for the project window. 

• You can also shift the monitor into full screen mode and access it via the context 
menu (right mouse button). There, you can also hide and display the basic 
transport controls. 

• With "Esc" you will go back to the normal view (or click on "smaller" button to 
the right in  the fullscreen mode). 

 

Show movie overview 
The option "Film overview" in the "Window" menu enables an overview of the entire 
project window. All objects in the project window will be displayed in the program 
monitor. The overview display is especially recommended for work with long movies 
because the reduced overview in the program monitor and the zoomed detailed view 
in the project window present a good combination.  

The film overview can be used for moving around in the movie and for editing certain 
parts: 

• When you click on a certain object in the video monitor, the project window will 
zoom on that object.  

• Using the mouse, you can draw a frame in the video monitor – and the 
corresponding range will be zoomed in the project window. 

• When you move the playback marker in the video monitor, the project window 
playback marker will also move correspondingly. 

Tip: If you use this option very often, you can use the keyboard shortcut (Shift + A). 
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Load files 
Media files can be loaded into the project window from the Media Pool in several 
different ways: 

• The fastest way: Drag the desired file from the Media Pool into the desired track. 
If an object is already present at this position, the file is inserted at the desired 
time position on the next empty track below. 

• Load several files: If you want to load several files, hold down the "Ctrl" key 
while clicking on the entries you want to use. If you want to load a sequence of 
files, hold the "Shift" key and click on the first entry and then on the last. All 
entries in between will be selected. Then you can drag all of the selected files 
into the project window with the mouse button held down.  

• Insert by command:You can also use the commands of the "Insert modes" (view 
page 69). 

• Pop-up symbol: For each entry in the Media Pool there is a two to three-part 
pop-up symbol. It appears when the mouse pointer is positioned over an entry. 

 

 Preview: Click on the playback icon to play back the medium: Video and 
image files are displayed in the preview monitor, and audio files through 
the sound card. There is also only a preview for the provided templates.  

 Trim: If you only want to import a certain part of a video clip into your 
project, click on the Trim icon with the curved brackets. The video clip will 
then appear in the preview monitor. Now use the brackets to mark the 
area you want to import on the timeline. Finally drag & drop the video 
from the preview monitor into the project by clicking on it and holding 
down the mouse button. Only the area previously marked by the brackets 
will be imported (view page 111) as a video object. 

 Import: Click on the Import icon to load the selected medium to the 
project window. 

 

Files with multiple audio tracks 
MAGIX Movie Edit Pro also loads VOB files that contain multiple audio tracks. After 
the VOB file has been loaded, simply click the audio object created and select the 
desired audio track. 

Note: To view and select audio objects in the arrangement, Timeline mode (view 
page 30) must be active. 
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Loading parts of movie files 
Videos can be trimmed in the preview monitor before being imported. To do this, 
proceed as follows: 

1. Select the desired file:  
- by double-clicking in the Media Pool, 
- clicking the middle icon in the Media Pool 

 or 
- drag and drop files from the Media Pool into the preview monitor. 

2. If you want to have an overview of the video material, first locate the edges of 
the range.  Play back the selected file in the preview monitor and determine the 
range you want to use in the project. 

3. Set the range edges (In Point and Out Point): 

Tip: You can also set the range edges with the keyboard during playback. This 
keyboard shortcut is especially useful when setting precise positions with the 
"Shuttle and jog" wheel. 

- Move the range edges by holding down the mouse button, 
- set the range edges with the button 

 or 
- set the range edges with the keyboard shortcuts I (= In Point) and 

O (= Out Point). 
4. Apply the range to the movie: 

- Click on the image in the preview monitor and drag it into the project window 
by holding down the mouse button. 

- Use the Insert modes (view page 323) to apply the selection to the project 
window. 
You can also use the Insert modes keyboard shortcuts (view page 323)! 

Result: An object corresponding to the selected area will appear on the track. 
5. If you want to load several ranges from the same video file, repeat steps 3 and 4 

until all desired ranges have been applied.  
 

Select and group objects 
To edit or delete objects using menus, you must first select them. To do so, simply 
click on the object you wish to select. Objects will change color to show that they 
have been selected. 

When the Shift key is pressed, multiple objects are selected. You can open up a 
rectangle positioning the mouse over the object, then holding down the mouse button 
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and marking all objects within the rectangle (”elastic band selection”) by left-click-
dragging. 

Any object can be combined with others to make up a group, to avoid the objects 
being unintentionally moved out of relation to each other. Once they are combined, 
clicking on one object of a group will select the entire group. To group or ungroup 
objects, use the buttons in the tool bar or the corresponding commands in the "Edit" 
menu. 
 

Move Objects 
Hold down the mouse button to move selected objects to any tracks and positions via 
drag and drop. It is recommended to place objects that belong together on 
neighboring tracks and to create separate tracks for audio and video objects. For this 
reason, videos that should overlay each other should usually be placed on the same 
track. 

If the Shift key is pressed, objects can be moved from one track to another, without 
the time position being changed. 
 

Cutting objects 
All objects can be split. Each object section then becomes an independent object: 

1. Select the object to be cut. 
2. Position the playback marker at the position where the movie is to be cut. 
3. Click on "Cut" (view page 68) button or select the "Cut" option in the 

"Edit" > "Split scene" menu.  

Note: If the commands "Split scene" and "Remove beginning/end" are applied 
without a selection, all objects at the position of the playback marker are cut. 

Tip: You can find detailed step-by-step instructions on how to remove (view page 
32) unusable scenes from video material in the "Quick start" chapter of the print 
manual. 

There are three options for joining split objects:  

• Click on the undo button in the lower toolbar (view page 65). This will work only 
directly after applying the split command. 

• In order to rejoin these split objects at a later stage, simply highlight the 
individual parts and select the command "group" to join the selected objects 
together into one group. 

• Remove the back object and move the front object forward and with the bottom 
right handle put it back to the original length. 
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Duplicate objects 
Objects may be duplicated very easily. Click on the object to be copied with the 
mouse while holding down the "Ctrl" key. This generates a copy, which you can 
immediately drag to the desired position or cut separately. 
 

Object handles 
All objects can be re-sized with their lower edge “object handles”. Move the mouse 
over one of the lower corners of the object until the mouse pointer becomes a double 
arrow. Move the mouse over one of the lower corners of the object until the mouse 
pointer becomes a stretch symbol. 

 

5 "handles": Length, fade, transparency (volume) 

An object can be faded in or out with the handles to the left and right upper corners of 
the object. Cross-fades between different objects can be created by overlapped 
positioning of objects that are fading in and out. The length of the cross-fade can be 
adjusted with the handles. 

Using the transparency/volume handle located centrally at the top of the object, 
adjusts the transparency of video and Bitmap objects, or the volume of audio and 
image objects.  

If you adjust the middle handle of a video object all the way down, the object will 
become transparent. If a second object is located on a track above it, a black color will 
appear from below it, so that brightness will be reduced. 
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Trim Objects 
Trimming provides exact placement of object borders or transitions. MAGIX Movie 
Edit Pro has two different trimmers, and these can be opened using the context menu 
for a video or image object. 
 

General advice for operating both trim editors 
Play functions: The trim window contains its own play functions that allow the object 
to be played individually or in relation to the arrangement.  

The right play button plays the arrangement normally. Replays can sometimes appear 
shaky because the processor may be over-worked. Those frames that the processor 
cannot calculate quickly enough are left out.  

The middle play button plays the arrangement “frame by frame”, which means no 
frames are left out. Depending on the processor load, playback may thus be slower, 
but still smooth. 

The left play button renders material before playing, i.e. the current settings are 
calculated first and then exported. This method ensures a smoother playback.  

With the fast forward and rewind functions you can change the range start in the 
timeline. This allows for complete control of transitions between two videos. 

Increments:  A click on the arrow buttons in both trim editors moves the handle or 
the material within an object exactly by one frame. With the Ctrl key you can increase 
the frame rate gradually to 5 frames per mouse-click. 
 

Trimmer for individual objects 
A schematic display of the selected object and its handles can be found in the center 
of the trimming window.  

 

Fade in/out (4, 5): These buttons adjust the upper fade handles of an object. 
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Object content (3): Here you can move the video material to be played without 
changing the object length. 

Position (2): Moves the object on the track. 

First frame/End fade-in (7): Toggles the left monitor between the first frame of the 
object and the end of the transition. 

Start fade-out/Last Frame (8): Toggles the right monitor between the start of the 
transition and the last frame of the object. 

Left/right arrow buttons (1, 6): Here you can adjust the lower object handles. 

Next object/cut (9, 10): The buttons below and to the right skip to the next/previous 
object and/or cut in the project window. These buttons make it easy to move and 
trim objects in the arrangement without having to leave the trimmer. 

Keyboard shortcut: Shift + N 
 

Cut trimmer 

 

A schematic display of the selected transition and its handles can be found at the 
center of the trimming window.  

Left arrow buttons (1): These buttons move the last frame of the first object while 
adjusting the second. The length of the transition remains. The display indicates the 
relative change in comparison with the starting situation when the trimmer was 
opened. 

Position (2): Moves the second object. The length of the transition is changed. This 
corresponds with shifting an object in the project window.  

Object content (3): Moves the movie under the second object. The length of the 
object and the object itself are not changed. 
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Crossfade (4): Changes the transition’s length between both objects. The objects 
remain of equal length. The length can be numerically entered. 

Middle arrow buttons (5): Shifts the existing transition. Both objects remain in their 
positions, but the transition’s center point moves. 

Transition (6): Displays the type of transition. A mouse click opens a popup window 
from which you can select a transition. 

Right arrow buttons (7): Move the first frame of the second object. The first object 
and the transition remains. Only the length of the second object changes. 

Start fade-out/Last frame (8): Switches the left monitor between the start of the 
transition and the last frame of the object. 

First frame/End fade-in (9): Switches the right monitor between the first frame of the 
following object and the end of the transition. 

Next cut (10)/Next object (11): The buttons below and to the right skip to the 
next/previous object and/or cut in the project window. These buttons make it easy to 
move and trim cuts in the arrangement without having to leave the trimmer. 

Keyboard shortcut: N 
 

Extract sound from videos 
Video with sound material appears in the project window on two tracks as two 
objects (an audio object and a video object). The two objects automatically form a 
group. 

To edit the video and audio material separately from one another, the objects can be 
separated with the Ungroup (view page 286) function in the "Edit" menu or button in 
the project window. Now you can replace the audio or the video track, or process 
each file separately. Rejoin/regroup the tracks with the ”Export project” function. 
 

Save objects separately 
Individual objects or object groups from the arranger can be saved separately in the 
project folder as a separate files. For example, cut out trailers, jingles, and so on that 
you need converted, and then save them for other projects for reuse as a take. 

A take file (*.tk2) contains a reference to a multimedia file or to a special object 
(videos, sound, visuals, etc.) including all additional properties that an object may 
possess (start and end time, fades, and effects including effects curves (view page 
162)). 
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Save take 
1. If you want to save several objects in one take, proceed as follows: 

Select the objects in the arranger and group them. 
Shortcut:  G 

2. Select the option "Save object as take" in the "Edit" menu or in the context menu 
of the object or group. 
Shortcut: Shift + K 

3. Rename the take (see below). 

Save take using drag & drop 
1. In the Media Pool open the folder where the take will be saved (e. g. "My Media 

> Takes"). 
2. If you want to save several objects in one take, select the corresponding objects 

in the arranger and group them. 
Shortcut:  G 

3. Click on the selection and drag it to the Media Pool while holding down the 
mouse button. 
MAGIX Movie Edit Pro creates a take file (*.TK2) which is named after the 
object in the arranger. The objects are removed from the arranger. 

4. Rename the take. 

Rename take 
1. Select the take from the Media Pool. 
2. Now open the context menu. 
3. Select the option "Rename". 

Keyboard shortcut:   Alt + R 
4. Enter the new name. When you do this, make sure that the file ending ".TK2" 

remains intact, otherwise MAGIX Movie Edit Pro won't recognize the file as a 
take. 

5. Press Enter to confirm the entry. 

Load take 
As with all objects, takes are loaded into the project. 
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Transitions (fades) 
When importing video files into the project window, individual objects usually follow 
directly after one another. This is called a "hard cut". However, you can make scenes 
blend or “transition” into each other. 

This means that for the duration of a transition, two objects are shown at once and 
can be mixed "faded" together in different ways. You will find numerous blends in the 
Media Pool’s transition directory. 
 

Simple dissolve 

 

A simple transition can be created in the project window by dragging one object over 
another. A dissolve will be automatically created. During this standard transition, the 
brightness of both objects is increased, i.e. the first clip fades out while the second clip 
fades in. The duration of the dissolve is displayed in the project window by white 
crossing lines. You can adjust the length of the dissolve by dragging the upper handle 
of the second object to the left or to the right. 

  
To select a different fade click on the transition symbol displayed when an 
object is selected. 

The transition menu opens. The transition icon will change, depending on your 
selection. 
 

Transitions from the Media Pool 
6. In the "Transitions" section in the Media Pool, click on one of the tiles in 

"Transitions" under the Templates tab to display the transitions for this 
collection. 

7. A click enables a preview of the transition. 
8. Simply drag the desired transition onto the border between the two transitioning 

objects. Only when the mouse pointer is placed over a scene change will it turn 
from a lock symbol into an object symbol, i. e. you can place the transition at 
that position. The object at the back will be shifted to the front to accommodate 
the duration of the transition.  

The length of a transition is decided by you. If a transition is shortened, it  means that 
the resulting effect is speeded up.  
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Some transitions can be adjusted even more precisely in the Media Pool (e. g. the 
strength of edge smoothing, or mirroring left or right). The settings that apply for the 
transitions at the beginning of the selected object are always shown in the Media 
Pool. 

The so-called alpha transitions (in the subfolders "Iris", "Objects", "Random", etc.) are 
actually pre-produced black and white videos that are combined with the alpha keying 
effect to be used as transitions. 

Other transitions use sound effects and various blurring effects are available under 
effect transitions (only in Plus and Premium versions). Try out different transitions to 
get an idea of what you can use in your projects. 

Tip: Use transitions sparingly! Look closely when you are watching movies in the 
theater or on TV. You will notice that hard cuts are used as a rule and transitions are 
used less frequently. Videos appear unprofessional and too ornate if transition 
effects are added to every change of scene. 

 

Exporting own transitions 
Alpha keying extends the range of transition effects used in MAGIX Movie Edit Pro to 
produce black & white movie transitions or selected color fade-ins and fade-outs. You 
can create such a video from any video material (also color) by exporting it as a 
transition (File -> Export movie -> Export as transition). 

The loaded movie is then exported as a black and white video in mxv format and 
stored in the transition directory. Afterwards, it will be available in the Media Pool and 
the transition menu. 
 

3D transitions 
3D effects offer exciting and varied opportunities to create transitions between two 
videos. 

The following transition settings are available: 

Anti-aliasing: An undesirable step effect is usually created at the borders of 3D 
objects. Anti-aliasing reduces this effect, but also requires more computer power. The 
setting applies globally to all 3D fades, switching on anti-aliasing during 3D fades has 
the effect that all other 3D fades are also affected by this setting. 

Horizontal / Vertical Mirror: Use these options to influence the path of the 3D 
objects within the fades. "Horizontal" mirrors the movement of the object 
horizontally, i.e. along the X-axis. "Vertical" mirrors the movement of the object 
vertically, i.e. along the Y-axis. 
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3D series 
The 3D series are a further development of 3D transition (view page 119), where the 
transitions are thematically sorted. For instance, you can let photos pop up and 
disappear on a notice board or make it look as if the photos were hung on the walls of 
a gallery.  

You have the following options to open 3D sequences for photos or scene transitions: 

• Click on "Templates" -> "Transitions" -> "3D series" in the Media Pool. Select 
the desired 3D series and drag it onto the first scene or image transition where 
the 3D series should start. 

You can select how many of the subsequent transitions should be replaced by the 3D 
series in the dialog. 
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Markers 
In MAGIX Movie Edit Pro you can set various types of markers within your project. 

 

The Lock button (at the very front, next to the time ruler) lets you lock 
all markers (jump markers, chapter markers) against accidental moving 
or deleting. 

 

Playback marker 

 

The playback marker indicates the point from which the material – 
either the arrangement or a selected file from the Media Pool – will 
be played back. There is a playback marker below each preview 
monitor and an additional one above the timeline in the project 
window. 

The playback marker is displayed as a red triangle below the monitors. In the project 
window it is displayed as a red triangle. 

In order to move the playback marker, simply double click on the desired area below 
the monitor. Alternatively, you can click on the playback marker and move it by 
dragging it with the mouse. While being moved, the current image will appear on the 
monitor, letting you see exactly where in the material you are located. 

The playback marker in the video monitor can also be moved by clicking on the lower 
section of the time scale in the project window. The playback marker will also be 
moved on the program monitor, as both markers are coupled to each other. 

The exact position of the playback marker can be seen in the time display at the top 
left, below the corresponding monitor. There, you can change the displayed values 
(Hour:Minute:Second:Frame) per mouse click to reach a certain point in time. Simply 
enter the desired value and the playback marker will jump to the corresponding 
position. 

Tip: In the "Playback" tab under "File -> Settings -> Program", you can set whether 
repeatedly pressing the space bar resets the playback marker to the current position 
or moves it to the original position. 

 

Project markers 
The "Edit" menu or the keyboard shortcut "Shift + numerical keys 1-0 (0 for the tenth 
marker) allow you to set a project marker (view page 288) at the current position of 
the playback marker. They function as a mental marker or indicate certain positions or 
events within the project. 
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After selecting the menu item, a dialog appears to input a name for the marker to be 
created. The first ten project markers may be accessed via Ctrl + number keys 1-0. 
This allows you to jump to a particular position of a longer video immediately, without 
scrolling and searching. 

Project markers may be deleted or renamed via the context menu at any time. This 
does not provide direct influence on the result, but they do make the workflow much 
easier. 
 

Snap markers 
Objects, object edges, markers or the playback marker will spring automatically to 
particular "Key positions", when you move them close enough with the mouse. This is 
called "snapping". This helps to position objects exactly, even if the project is zoomed 
out. One snap point per object may now be placed in order to mark where other 
objects should snap to within that object. This can be helpful, for instance, if you want 
a title to be shown at a specific position in a video object. 

Set snap marker: To set a snap marker, select an object and place the playback 
marker at the position where you would like the snap marker to be. You can set as 
many snap markers as you like per object. 

You can move a snap marker with the mouse using drag & drop. Or use the "Align 
objects to grid markers" function. 

Keyboard 
shortcut:
 
 #  

Ctrl + P 

A snap marker will be set where the playback marker is located in 
the selected object. 

Set snap markers (advanced): Open the snap markers section in the Media Pool 
under "Effects". 

Align objects on snap grid: Aligns the objects so that they snap to the snap markers. 

Delete all snap markers: This deletes all snap markers for all objects in a film. 

Show or hide snap markers:You can hide snap markers if required and show them 
again later. 
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Area marker (in and out points) 
Area markers are the start markers (in-points) and end markers (out-points). The 
serve to mark a certain area, which will be played back by pressing the "area 
playback" button at the bottom of the corresponding monitor. 

 

To the left, you see a start marker, and to the right, an end marker. 

The area markers in the arrangement serve to indicate the paste position of new video 
or sound material. 

Hint: The value between both markers shows the length of the selected area 
following the pattern of Hours:Minutes:Seconds:Frames. 

 

There are various options for changing the playback range, and with it the project 
start and end markers. 

• Set the playback marker at the desired position and press "Set start of range (in-
point)" or "Set end of range (out-point)" underneath the monitor to set the in 
and out points of the range. 

• Click on one of the markers below the preview monitor and move it with the 
held-down mouse key to the desired position. 

• Click one of the markers in the upper-most bar in the project window and drag 
it. 

• A right click on the bar moves the range end to the position of the mouse cursor. 
A left click moves the start of the range. The area grows or shrinks in size 
correspondingly. 

• You can adjust the position of the entire range by clicking the blue bar between 
the markers and moving it by dragging while holding down the Crtl button. 

 

Chapter markers 

 

The chapter marker defines the start of a new chapter. Chapters serve to 
improve navigation when burning the project to disc. 

The following options are provided via "Edit -> Marker" or by right-clicking on the 
playback marker. 
 

Marker > Set chapter marker 
Places a chapter marker at the position of the playback marker. This creates a 
chapter entry in the disc menu in case the movie is being burned to disc. 
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You can rename the chapter markers by right clicking and selecting "Rename" in the 
context menu. The new name will also appear in the chapter menu (view page 248). 
 

Marker > Automatic chapter markers 
This option automatically sets chapter markers in the project according to specific 
rules that will then appear as chapters in the film menu of a disc. This is useful if you 
need to burn a disc immediately after recording. 

Keyboard shortcut:  Shift + Alt + Return 

 

Automatically create chapter marker 
• At the beginning of a movie: The movie contains only one chapter 
• At object starts in a track: Every object in a track creates a chapter, Track 1 is 

preset. 
• At the position of existing title objects: Subtitles, for instance, as faded-in 

subheadings, give the position of the chapter markers. 
• Provide interval (in minutes)/provide quantity: If the chapters are separated 

without any particular method and are just needed for quicker navigation, 
chapter markers may also be inserted in pre-defined intervals or as a pre-
defined number of chapter markers. 

Naming chapter markers 
• No marker name: Marker name and marker number are not specified. 
• Custom: You can use a custom name. A sequential marker number will be 

attached to it.  
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• Apply object name: The marker name is taken from the object name and the text 
in the text object. No sequential marker number  is specified. 

Options 
• Delete existing chapter markers: Deletes chapter markers that have already 

been set. 
• Only take the selected area into account: The chapter marker is automatically 

set to the area between the start and end markers only. 
 

Marker > Delete (all) chapter markers 
Delete one or all chapter markers. This removes chapter entries in the disc menu if 
the film is burned to disc. 

Keyboard shortcut:  Ctrl + Alt + Enter 
 

Scene markers 
Scene markers separate a complete video into scenes. You can load any video into 
MAGIX Movie Edit Pro and have it divided into scenes. 

Load the desired video into the project window. Then, right-click on the video and 
select "Scene detection". The following dialog appears: 

  

After clicking "Start search", an overview of the detected scenes will be displayed 
underneath the scene control. 

Delete scene markers: Here you can delete individual markers by selecting them from 
the list. 

Delete all markers: Deletes all project markers. 
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Action on OK: You have three options. Either MAGIX Movie Edit Pro splits your video 
into individual scenes (cut at all markers), you select a scene and cut only at this 
position ("Cut at Selected Marker") or you can save the scenes as "Takes" (view page 
116). 

After deciding in favor of one of these options, red scene markers will 
appear on the timeline in the project window.  

Note: An important difference between a scene and a chapter marker is that a scene 
marker can be set only within a continuous video, while a chapter marker can 
include several videos consecutive videos. 

Additional information about scene recognition is provided in the chapter "Insert 
objects into the project" (view page 221). 

Shortcut for scene recognition: Shift + Z 
 

Snap markers and transients (Plus/Premium 
versions) 
Objects, object edges, markers or the playback marker will jump automatically to 
particular "Key positions" when you move them close enough with the mouse. This is 
called "snapping".  

Select a location in the object with a snap marker to indicate where another object 
should snap in. This can be helpful, for instance, if you want a title to be shown at a 
specific position in a video object. 

You can find the "Snap Marker" in the Media Pool under "Effects". 

Set snap marker 
• To set a snap marker, select an object and place the playback marker at the 

position where you want to place the snap marker.  
• Now click on the button "Set snap marker". 
• You can move a snap marker with the mouse using drag & drop.  

You can set as many snap markers as you like per object.  

Align snap marker with transients 
Transients are signal peaks in audio material that can also appear in video footage; 
e. g. a door slamming shut. 

Transients in video footage can be used as a starting point for editing - for instance, 
fading in a title or making a picture-in-picture effect appear. 
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The "Align snap marker to transients" feature analyzes the signal peaks of the 
selected object and sets snap markers to these locations. This moves snap markers 
that have already been put in place near the transients into the new locations. 

Note: Combination objects must be displayed separately so that transients can be 
seen clearly. In the context menu of the combination object, select the command 
"Audio functions" > "Video/Audio on separate tracks". Snap markers are set 
independently of this setting. 

 



 

128   

www.magix.com 

Multi-cam editing (Plus/Premium version) 
Multicam editing enables easy cutting of various recordings of the same scene from 
different camera perspectives. The program monitor displays footage from up to 
4 sources at the same time. This footage can be cut together in real time just like in a 
real studio. 

Tip: MAGIX Movie Edit Pro conducts an audio analysis of multicam tracks and 
synchronizes them. For this reason, you should pay attention to the following notes: 

 Deactivate your camera's dynamics editing (limiter, compressor and 
leveler)before you start recording, otherwise the quality of the effects in 
MAGIX Movie Edit Pro can be negatively affected. 
Footage that has been "adjusted" can also not be edited further in full width. 

 Only use the audio effects in MAGIX Movie Edit Pro (view page 179) for 
audio editing beforehand. 

 

Note: This function is available only in the Plus/Premium version. 
 

Preparation 
Multicam editing is a special project window mode. The top two tracks serve as target 
tracks for copying sound and video from two different source tracks. The two top 
tracks must be empty when switching into the multicam mode, otherwise existing 
objects will be moved to a different track. 

Next, load various video recordings of the same scene one under the other starting on 
track 3 in the project window.  

It is important that the individual sources are synchronized to each other exactly. It is 
best to find a noticeable movement, or an "o" sound, if audio was recorded.  

Hint: To localize the sound in the audio track exactly, you may have to create a wave 
display of the track. Right click on the sound track and choose "Create wave form 
display". 

You can use a clapperboard during filming, since this offers both sound and motion; 
an actor's clapping in front of running camera before the start of the scene is also 
helpful. Set a grid point at this position in the object ("Alt + Shift + P"). You can now 
move the source objects over each other, so that the grid points are aligned. 



 

 

Multi-cam editing (Plus/Premium version) 129 

 

Two video sources with sound tracks can be automatically synchronized using their 
audio material. Move the video and audio objects with the mouse to the right 
position, until the sound of both videos is exactly synchronous. 

It is also important that you make all effect settings for the output material (e.g. video 
or audio cleaning) before the multicam edit on the objects on the source track and on 
the master audio track (view page 131). These effects will be transferred to the objects 
in the target track with the edit. Otherwise, you will have to apply the effects from 
every single object to the target track. 

 
You can activate "Multicam" mode with this button or with the "Multicam" 
command in the "Edit" menu. 

 

Source tracks and preview images 
The source tracks for multicam editing will be selected automatically. When the 
multicam mode is activated, the source tracks will be assigned to all tracks containing 
video objects starting from track 3. 

You can also conduct or change the assignment manually. To do this, open the 
context menu of the corresponding track box to assign or unassign a track to be used 
as a source track. In this way, you can use more than two tracks for multicam editing, 
but no more than two simultaneously. The source tracks are marked using color. 

A preview appears in the preview monitor for every assigned track, and the source 
track's color corresponds to the frames around the preview images in the program 
monitor so that you can quickly assign each preview image. 

Tip: If you computer is powerful enough, perform multicam editing in full screen 
mode. 

 

If the objects created using multicam editing are located on the target track, a preview 
image of the assigned source track highlighted with a yellow frame will be shown for 
the duration of playback. 
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Multicam edit functions 
You can edit various sources in the the target track during playback in real time or 
during stopped playback. 
 

Real-time Multicam editing 
You can edit various sources together during playback in real time: 

• Start playback. 
• Click on the desired source in the preview monitor. The corresponding video is 

added into the target track starting from this time point. 
• To switch the source, click in the source monitor on another source. A new 

object will be created using the new source from this point in the target track.  

You can repeat this process as often as you like. 

For precise editing in the target track, use the usual edit functions or the Trimmer 
(view page 114). Keep in mind that as long as you are in Multicam mode, only the 
object borders are moved, and not the objects themselves. Otherwise, gaps or image 
jumps could form while you use the Multicam edit function again later. 
 

Replacing an object's source 
Replacing an object's video material in the target track with another source: 

• Select the object for which the source is to be replaced in the target track. 
• Click the source you want to replace the video material with in the source 

monitor object. 

The video material will now be replaced by the new source. The project length is not 
changed. 
 

Insert cut 
Insert material from one of the sources between any position on the target track and 
the next object. 

• Place the playback marker at the desired position. 
• Click on the desired source in the preview monitor. 

The material from this source will now be inserted into the target track. The new 
object ends at the next object. The portion below an existing object is overwritten in 
the process. 
 

Overwrite range 
You can overwrite a selected area of the target track with one of the source videos. 
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• At the upper edge of the project window, select an area to edit by determining 
the in point by clicking with the left mouse button and the out point by right 
clicking. Or use the corresponding buttons in the transport control. 

• Click the desired source in the program monitor. 

The target track will be overwritten with the video material from the selected source 
in the selected area. 
 

Master audio track 
Normally, videos in the source track are edited together with their audio tracks. Since 
the original sound can differentiate from camera to camera due to different camera 
positions, you will probably prefer using either the soundtrack from only one camera 
for all settings, or to replace the soundtrack completely (for music videos, for 
example, you will use the studio version of the original track). 

Right click on the track box of one of the source audio tracks or a different audio track 
and select "Multicam: Master audio track" from the context menu to assign a master 
audio track for multicam editing. The master audio track will be appear in a dark color. 

Now, during every multicam cut, material from the master audio track will be inserted 
on track 2, independent of the source track used.  
 

Synchronize video objects using the audio track 
Video objects can be synchronized using their audio tracks. This is done by comparing 
the audio tracks for similarities. If videos come from the same recording environment, 
the same acoustic events will be found on their audio tracks (e.g. the sound of the 
clapper board). 

Synchronization of multiple objects on one track is possible.  

1. On the reference track, select all audio objects that are to act as reference 
positions. 

2. On another track, select all audio objects that should be moved. 
3. Choose the "Align with other audio objects on this track" function from the 

audio object context menu. 

Note: If the desired audio track is found in a combination object, you will find the 
"Align with other audio objects on this track" option in the "Audio functions" 
submenu. 

MAGIX Movie Edit Pro attempts to locate the acoustic events in the reference objects 
of the second track and to move these to the corresponding position. Because the 
audio objects are grouped with their corresponding video objects or comprise a 
common object, videos are synchronized in the process. 
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Title 
Titles can be used for many applications: as a running text (ticker), subtitles, speech 
and thought bubbles, to display date and time, and much more. 
 

Creating titles using a template 
In the Media Pool, there are a wide range of title templates for fonts, opening and 
closing credits, captions and much more in the "Templates" tab in the "Titles" section. 

• Open one of these entries and select any title template. Start a preview or add a 
title to a playback marker location using the quick access feature. 

Note: Templates may be applied to an existing title object. Only the text will remain 
when the template is applied. All other formatting settings will be lost. 

 

Create titles without a template 
1. Position the start marker in the project window where you would like the title to 

be displayed. You can adjust this position later at any time. 
2. Click on the "General" entry under "Title" in the Media Pool. 
3. Create text fields: 

- If you want to create a text field where the text is automatically adjusted with 
breaks, drag a text field onto the preview monitor. 
The option "Automatically adjust text" is activated and cannot be changed. 

- If you would like to create a text field where the text can automatically be 
adjusted with breaks only where required, click on the preview monitor. 
The option "Automatically adjust text" is activated but can be deactivated at 
any time, e. g. if you want to let the text run through from right to left using 
animation. 
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4. Use the keyboard to enter the text and click on the checkmark in the preview 
monitor to confirm it. You can edit it any time you like in the text field. 
You can format your title later through the title editor in the Media Pool. 

Tips for working with text 
• To adjust the text properties for several objects simultaneously, hold down the 

Ctrl key and select the text objects in the timeline. The settings will only be 
applied to the text objects you have selected. The individual properties of each 
text object remain unchanged. 

• Use the slider to adjust the text size. 
• Hold down the Shift key and drag the title field handles to switch from "Adjust 

text field to title field" mode and back. 
• Use the arrow keys in the title editor to move from one title object to the other 

without having to search in the project window. Captions are not included in 
this. 

 

Texts can be displayed in all kinds of 
fonts and colors. 

If you want to format individual 
words or letters, select them with 
the mouse and choose a different 
format or color. 

Without any selection, the entire 
text in the object will be formatted. 

You can open the title editor by pressing "T". A title object will be created where you 
can immediately enter your text. 
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Edit titles retroactively 
• Double-click on the title in the preview monitor or the title object in the project 

window. Now change the text any way you like.  
• You can also go to the Media Pool area "Titles" and enter your text in the input 

field there. 
 

Position titles 
• Click once on the title in the preview monitor and a positioning frame will 

appear. Simply move the positioning frame using drag & drop. 

 
• Click on the corners of the positioning frame and drag it to the desired size. 

When the "Adjust font size to title field" function is activated: The text size will be 
adjusted to fit the size of the positioning frame. 

• Click once on the button located in the Media Pool under "Title > General > Title 
object" to center the title horizontally and vertically.  

 
 

Other text settings 
You can edit titles precisely with different text effects: font, font size, justification, 
spacing etc. 

Line spacing: Cannot be applied to only one line. When applied to multiple lines, this 
alters the spacing between the lines. Line spacing always applies to the entire line. 

Tracking: This controls the spacing between characters. Negative values move the 
characters closer together, positive values move them apart. 

Transparency:  Controls foreground transparency levels. 

Soften: Makes the edge of the shadow harder or softer. 

Width: Enter the width of the frame in points. 
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Filled in: The text will be filled with the color selected in the Title Editor. If the option 
is deactivated, only the frame will be visible, and the background will appear instead 
of the color fill. 

Outline: A border appears around the letters in the text. 

Shadow: The position of the shadow may be set on the horizontal and vertical axes.  

3D: The text appears with a 3D-style outline. The width and thickness of the 3D 
contour (H) can be set in points. 

Color: Clicking on this button opens a color selection dialog, where you can set the 
frame color. 

Animation: Make your credits scroll down the screen or select one of the many other 
text movements from the menu. You can also set the display duration for the title 
here. 

Background: Specify here whether the text's background should appear black or 
white. This is only meaningful if no other video or image object is in the background. 

Wrap text automatically: When activated a break will be inserted automatically after 
each line. 

Adjust font size to title field:  The text size will be adjusted to fit the size of the 
positioning frame. 

Only use visible TV area: The text will be zoomed so that it will always be within the 
TV's screen area, which is specified in the Movie effect settings (view page 172). 
 

Fade in date as title 
MAGIX Movie Edit Pro can add a time or date (“time code”) to the picture material. 
To add a time code, right-click the video object and choose the “Fade in date as title” 
option from the context menu. 

If you’re using a DV-AVI file (a digital recording from a camcorder, for instance), the 
recording date will be used from the chosen place. If you’re using a different file, the 
creation date will be used as the time code. The title editor is then opened in order to 
customize the entry. 

In the preview monitor context menu you will also find the "Display play time" option. 
This will create a time code. 
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Timecode 
In the "Timecode" section you will find various presets that you can use for displaying 
the timecode. This function adds a special timecode object to a free track under the 
video object. 

You can adjust the position of the timecode by moving the timecode object in the 
preview monitor. The handles on the borders can be used to adjust the size. 

• Select the right template for your project. Try out a few to find the one that's 
right for you. 

The following times will be displayed in the various templates: 

• Movie time: The time position in the MAGIX Movie Edit Pro project window. 
• Recording date/time: The date and time when the footage was recorded. This 

timecode information must be saved in the video, otherwise the display will be 
empty. 

• Recording timecode: The timecode for the video that is created by the camera. 
This timecode information must be saved in the video, otherwise the display will 
be empty. 

Note: If the recording date/time and the timecode are not saved in the source 
material, only placeholders in the form of "-" will be displayed. 
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Effects 
MAGIX Movie Edit Pro offer a large palette of various video effects. The video effects 
used the most can be found directly in the Media Pool, while others can be found in 
the object context menu or in the "Effects" menu. 
 

Apply effects to objects 
There are various approaches for applying effects: 

• Video and audio effect presets are loaded into the corresponding object from 
the Media Pool using drag & drop. 

• Effects that can be animated (in the Media Pool under "Effects -> Video effects 
/ movement effects") will be applied directly to the objects selected beforehand 
as soon as changes are made in Media Pool. 

 
This button resets all of the current effect settings. 

Note: If you animated the effect using keyframes, resetting will affect the entire 
animation. Individual keyframes may be deleted via click + Del (view page 164). 

 

Transfer effects settings 
The items video effects (view page 138), movement effects (view page 147), and 
Stereo 3D (view page 208) on all effects pages provide the option to transfer the 
current effects settings to other objects or to load previously saved settings. Use the 
above right arrow button to open the video effects menu. 

 

Save/load video effects: The current effects settings may be saved for later use in 
other projects or previously saved settings may be loaded. A dialog allows the effects 
to be selected. 

Reset video effects: Resets the effects settings for the selected object. 
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Copy/paste video effects: Copies or inserts the current settings as a new object. Use 
the dialog to select which settings should be copied. 

Apply video effects to all: Copies the current effects settings to all objects in the 
arrangement. Use the dialog to specify which settings should be copied. 

Apply video effects to all the following objects: Copies the current effects settings to 
all of the following objects in the arrangement. Use the dialog to specify which 
settings should be copied. 

Load effects mask (in the Plus version): An effects mask (view page 158) may be 
loaded for a selected object. 
 

Presets 
You can drag & drop video effect templates directly from the Media Pool onto video 
or image objects. You will find the following categories in this item: 

• General: Provides various distortion or optimization effects that can give your 
files a specific appearance, e.g. an antique image. 

• Video mixing effects: Various presets for chroma key effects (view page 140). 
Depending on the background that is to be hidden, select "Black box", "Blue 
box", "Green box", or "White box". 

• Film looks: Specifically for the appearance of certain types of film presets 
 

Video effects in the Media Pool 
Video effects in the Media Pool can always remain open independently from the 
selection of an object. 

The image is always displayed at the position of the playback marker in the program 
monitor. To see the impact of the effect settings, you must always set the playback 
marker to the position where the selected object is located. The playback marker also 
enables you to jump to a specific position in the video object in order to check the 
results of the effects by starting and stopping playback. 
 

Brightness & Contrast 
Auto exposure 

With this button you can automatically optimize brightness and contrast with a click. 
Use the fader in the dialog for finer adjustments. 

Brightness/contrast: Use the sliders to increase or reduce the brightness and the 
contrast of the picture. 
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Gamma: Set the mean gray value that can be calculated from the various color 
ranges. In the preset list, select various areas to edit only the dark, median, or 
brightest areas of the image. 
Using the fader, you can also set the level of brightening or darkening. 

HDR Gamma: Unlike "Gamma", very dark areas are selectively lightened. 

HDR Blur: This changes the transition between light and dark areas together with 
"HDR Gamma". 

Note: The functions HDR Gamma and HDR blur are only available in the 
Plus/Premium version of MAGIX Movie Edit Pro. 

 

Color 
White point: An incorrect white balance can lead to an unnatural blue or red hue. 
Instructions: To use the white balance, click on on the button to the right of the label 
"White balance" and then select a point which represents white or a neutral gray to 
the "outside world". The color temperature is then corrected automatically. 

Tip: Interesting color effects can be achieved by setting a color other than white. 
There is definitely room for experimentation! 

Red Eye Removal: Using this photo function you can remove unnatural red eyes that 
are the result of using a flash. Click on the eye symbol and then select the red pupils in 
the preview monitor using the mouse.  

Saturation: Use the saturation slider to increase or reduce the hue proportions in the 
image. A newly developed algorithm is applied which makes color changes related to 
other parameters (for example contrast settings) in order to achieve the most natural 
coloration possible. With some experimenting, you can achieve some amazing results 
– such as turning summer images into autumnal pictures, or creating funky pop art... 

Hue: Select a color for coloring the image from the color chart. 

Red/Green/Blue: Changes the color portion mix using the slide controller. 
 

Color correction 
Secondary color correction allows individual colors in video and image objects to be 
adjusted. The two layers, the front and background, are separated from each other 
using a mask. Both can be edited separately. The master layer may also be used to 
influence the overall image. 



 

140   

www.magix.com 

The foreground layer corresponds with the mask created, and editing in the 
background changes all of the areas outside of this mask. 

This is how you can create a mask for the background: 

1. Activate "Add". 
2. Place the mouse over the preview monitor. The mouse pointer turns into a 

pipette. 
3. Click with the pipette tool on the color in the program monitor that you would 

like to assign to the mask. Unwanted colors can be removed from the selection 
again by selecting "Remove" and clicking the corresponding color. 
MAGIX Movie Edit Pro displays the mask in black and white stripes to highlight 
the current selection. 

4. Adjust the color using the color selection slider until you like it. 
 

Glow 
Apply the "Glow" effect to create a halo effect around bright objects in a video. 

Glow percent: Changes the quantity of light emitted (similar to Blur effect) 

Intensity: Sets the intensity of the glow color. 

Suppression: Drag this to reduce the glow so that it can only be used for highlights. 

Color: Select individual color channels (Red, Green, Blue) where you want to apply 
the effect. 
 

Chroma key 

 

This section contains the effects for chroma 
keying used to mix together two videos into a 
foreground and background.  

Note: The background video must be placed 
in the track above the foreground object.   
E. G.: Track 1: Background, Track 2: 
Foreground  

 

Mode 
Stamp: The currently selected object is "stamped" onto the video on the track above 
the object. This is only possible if the bottom video takes up only a part of the image. 
Otherwise only the bottom (currently selected) video would be visible. Normally, the 
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object should be reduced or moved first. This is done with the help of "Position/size" 
(view page 147) effect or via the submenu "Section" in "Effects -> Video object 
effects". 

Color: In the preview monitor, drag the cursor over the color that should be 
transparent and select a section. The video is made transparent in the sections with 
this color and the video on the top track will show “through”. You can use the 
"Threshold", "Fading range" and "Antispill" controls to fine-tune your results. 

Mix: This button mixes the two videos together based on the brightness. Brighter 
areas accumulate and quickly appear white; darker areas have less of an effect on the 
result. 

Colors to be hidden 
Green/blue/black/white: All green/blue/black/white areas of the video below 
appear transparent. This makes it possible to "place" a person who has been recorded 
in front of a blue background into any type of landscape. 

Water: Only the contours of the upper video are mixed, which results in something 
like a water effect.. 

Alpha: This video effect uses the brightness of a video to control a transition effect 
between two other videos on neighboring tracks. The additional videos should be 
situated directly above and below the alpha-keying object. 
In all black parts of the alpha-keying object, the top video is faded in, while in all white 
passages the bottom video is shown. Grey passages are permeable for both videos 
and create a mixture of the two. In the case of colored passages, the brightness of the 
color is used for control purposes. 

Video Level 
Changes the brightness of the video before additional video effects are applied. This 
can have a serious influence on the effects, in particular on Chroma Keying. The level 
setting may be automated so that two videos can be mixed dynamically with each 
other. Read more about this in the chapter "Animating objects" (view page 162). 
 

Mask generator 
Type: Select the method for setting transparency. 

• Alpha: Use the alpha channel to set transparency. 
• Luminance: Use Luminance to set transparency. 
• Red/Green/Blue: Select a color to set transparency. 

Invert: Reverses transparent and opaque areas in the mask. 

Low in/High in: Use these faders to determine the range for minimum transparency 
value. 
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Low out/High out: Use these faders to determine the range of maximum 
transparency value. 
 

Stamp forms 
Apply the "Stamp forms" effect to create picture-in-picture effects or to crop your 
video. 

Color: Select individual color channels (Red, Green, Blue) where you want to apply 
the effect. 

Shape: Select a shape in the drop down list to define the cut form. 

Methods: Specify whether part of the video image is visible/masked: 

• Cut everything apart from section:  The cut form opens a window which displays 
your video. 

• Cut section: The cut shape covers your video and the area outside the shape is 
visible. 

Soft edges: Drag the fader to determine how the cut frames appear in the 
background. 

Borders: Drag the fader to determine the size of the frame around the cut shape. 

Repeat X: Drag the fader to repeat the cut shape along the horizontal axis for the 
number of times specified. 

Repeat Y: Drag the fader to repeat the cut shape along the vertical axis for the 
number of times specified. 

Size: Drag the fader to determine the size of the cut shape selected. 

Center: Enter coordinates for the center of the effect or,for instance, drag the circle 
wherever you want on the display. 
 

Art filter 
Erosion: The image is broken-up by means of small rectangles and resembles a 
"patchwork". 

Dilate: This works like erosion, but uses light surfaces instead of dark ones to form the 
rectangle. 

Emboss creates a relief of the image edges, in which case strong contrast differences 
are interpreted as edges. 
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Substitution: Using the rainbow scale red, green, and blue components are 
exchanged. Quickly create surreal landscapes or a green face! 

Move: The color values are inverted increasingly. Blue colors turn red, and green 
appears purple. 

Quantize: Depending on the setting, colors are either rounded up or down so that the 
overall number of colors is reduced. This creates interesting grids and patterns. 

Colorize: Using this slider, color in the video with red, green, and blue colors (the 
basic TV colors). 

Contour: The image is reduced to its contours in two sizes (3 x 3 or 5 x 5). It is 
possible to select either vertical or horizontal contours. 
 

Lens reflection 
Apply the "Lens reflection" effect to simulate the light reflected by a camera lens. 

Light color: Set the color value to which you want to apply the effect. 

Light position: Set the position of the light source that creates the Lens Flare effect. 

Lens type: Click on a lens in the drop down list to select the number of light flares to 
be created. 

Tint:  Drag a fader or enter a value in the field to set the strength of the tint that will 
be applied to the light source. 

Intensity: Drag the slider or enter a value in the field to set the strength of the effect. 

Blend: Drag the slider or enter a value in the field to set the transparency for the light 
flare effect. Setting 0 is fully transparent; setting 1 is opaque. 

Size: Drag the slider or enter a value in the field to set the size of the light flare effect. 

Perspective: Drag the slider or enter a value in the field to set the angle of the light 
flare effect. 
 

Distortion 
Motion: Moving parts of the image are enhanced and warped. 

Echo: The moving images create an optical "echo"; previous images stand still and 
gradually turn paler until they completely disappear. 

Whirlpool: The image is twisted into an "S" shape. 
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Fisheye: The perspective is distorted as if the image were viewed through a fisheye 
lens. 

Mosaic: The video is depicted as a mosaic. 

Lens: The image is dynamically distorted at the edges. 

Sand: The image is depicted in a granulated manner. 

Kaleidoscope: The left upper corner is mirrored horizontally and vertically. 

Mirror horizontal/vertical center: The object is mirrored vertically or horizontally – it 
appears on its side or upside down. 
 

Sharpness 
Sharpen: The fader allows you to increase the sharpness of the image. 

Blur: The fader allows you to reduce the sharpness of the image, making it blurry. 

• Apply to: This allows you to set just how much the sharpness or blur should be 
applied to surfaces or edges. This enables you to effectively reduce ongoing 
image distortions (noise). 

Artificial blur: Here you can blur the image in an alternative manner. The achieved 
effects are much stronger compared to simply sliding the fader under "Blur". 

• Quality: The artificial blur is enhanced. 

Tip: Artificial blur produces good effects when used for transitions. To do so, you 
can animate (view page 162) the first video so that it is strongly blurred and let the 
second video begin with blur and slowly return to normal focus. 

Note: The higher the quality of the effect should be, the longer the calculation will 
take. 

 

Gaussian blur 
This filter adjusts the video focus and adds blur and soft focus effects. It can also be 
used to flatten certain types of noise or as a correction filter. 

Horizontal range/Vertical range: Drag the slider or enter values in the editing fields 
to specify the number of pixels in a block.  

Color channels: Select individual color channels (Red, Green, Blue or Alpha) to which 
you want apply blur. If the video or image contains an alpha channel, applying blur to 
this channel can enhance transparency and the mask dissolve. 
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Speed 
The playing speed can be adjusted with the slider control. The range between 0 and 1 
plays the video slowly; values above 1 accelerate playback. If the playing speed is 
increased, the object length in the project window is automatically shortened. 

Frame rate: Here you can set the video's frame rate directly. Changing it directly 
affects the speed factor, while moving the slider conversely results in changing video 
frame rate. 

Algorithm: Here you can determine how to adjust the soundtrack. "Timestretching" 
changes the playback speed, without influencing the pitch: "Resampling" changes the 
playback speed together with the pitch (the faster the playback, the higher the pitch). 

Reverse playback: With this button the playback direction will be reversed (with the 
same tempo). 

Interpolate intermediate frames: Activate this option if your video lags as a result of 
being slowed down. MAGIX Movie Edit Pro then automatically fills in missing frames 
so that your video can be played back more smoothly. 

Maintain length: If you shorten an object in the arranger, you can play a video faster 
without reducing the object length. The shortened footage is used to maintain the 
object length. 
 

proDAD Mercalli 2.0 
Remove shaking and jerking from your video recordings. Uneven panning and 
zooming shots can also be "calmed" and improved. 

Profile: Select the right camera type for analyzing and correcting your video data. It is 
necessary to select the right camera here to get the results you want, regardless of 
how the original video was filmed. The universal camera profile will improve any video 
data, but try out different camera types to get the best result for your material. 

Run analysis... : Analyzing your video data is always the first step before starting 
detailed improvements. 

Rolling shutter correction: Balances any distortion (only with CMOS) that appears in 
moving images - in other words, videos. 

Note: For this effect to work correctly, the correct field setting for the video must be 
used. 

View camera dynamics: Activate this feature if camera movements have not been 
smoothed or stabilized. 
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Enhance panning shots: Entire panning movements in a video can be balanced, 

Smooth zoom: This balances shaky zooms.  

Reduce tilting: This can be used to reduce horizontal and vertical tilting of the camera 
when the recording was made. 

Border editing: Through balancing unwanted movements in film footage, it's also 
possible to edit borders. Here, you can specify how to deal with borders: 

• Optimal stabilization: A black border appears in the stabilized video. This border 
can differ in appearance from image to image, depending on the extent of 
shaking. 

• Without border: No border appears in the stabilized video. A border can be 
avoided by zooming the video. This depends on the extent of shaking in the 
video and the desired level of correction. 

• Image area: A static border appears in the stabilized video. The form of this 
border is characterized by the strongest shaking in the video. 

Zoom: The border can be minimized by zooming in the video. 

Fill with edge color: This option lets you fill an existing border. However, this means 
that the video content will look slightly blurred.  

Comparison view: The stabilized video can be shown in the preview window. 

• End result: Only stabilized video will be displayed in the preview. 
• Vertical split screen: This vertical screen displays the source material and the 

stabilized video. 
• Horizontal split screen: This horizontal screen displays the source material and 

the stabilized video. 

Show evaluation grid: A grid to help you evaluate stabilization appears. 
 

Shot match 
This function lets you match the appearance of two video clips to each other. The 
colors and tonal values of two separate photos are aligned fully automatically.  

You can do this in the following way: 

1. Open the "Shot match" effects area in the Media Pool under "Effects" > "Video 
effects". 

2. Select the object where you want to match a shot ("target") and place the 
playback marker within this object at the shot that you want to change. 

3. Click "Select target frame". 
The selected position will be displayed. 

4. Place the playback marker in the arrangement at the position with the look you 
want to use ("reference").  
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Note: Make sure you don't change the object that is selected! You need to keep 
the selection on the target object. 

5. Click on "Select reference frame".  
The selected position will be displayed. 

6. Click on "Match shot" to adjust the look of the object. 
The playback marker automatically jumps back to the modified target object. 

7. You can reduce the strength of the effect by moving the "Intensity" slider.  

Shot match works best under the following conditions: 

• The same scene has been filmed with multiple (different) cameras from various 
perspectives. 

• The same scene has been filmed in different lighting conditions. 

Different conditions can lead to suboptimal results. 

A note on multiple selection: Selecting multiple objects will apply the effects of shot 
match to all selected objects.  

 

View and animation 
Size/Position 

 

Values in: Set whether the values are applied in percent or pixels. 
 

Position 
Left: Enter the start position from the left image border. 

Top: Enter the start position from the top image border. 

Center: Based on the current image size, the image starting points (left and top) will 
be positioned so that they are centered. 
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Note: Negative values can, of course, also be entered. The image borders will then 
be outside of the visible area. 

 

Size 
Width: Enter the width of the image here. 

Height: Enter the height of the image here. 

Maximize: The image is maximized to the resolution of the film. 

Set original size: The image will be scaled to its original size. 

Fix proportions: This option makes sure that the image will not be stretched or 
distorted. The ratio between width and height will always stay the same. 

Note: In the preview monitor you can use the object handles on the sides of the 
decorative element to adjust its size. The additional handles for rotation located at 
the top can be used to tip the element and align it with a background object. 

 

The size and the position of the image can be roughly entered in the program monitor 
by simply moving the image into it and dragging on the handles. The frame of the 
video monitor with handles can also be moved with the keyboard. 

Keyboard shortcuts for moving the edges of the frame that are visible in the video 
monitor: 

Nudge the screen 1 pixel: Arrow keys 

Nudge the screen 5 percent: Shift + arrow keys 
 

For animated movement effects, it often makes sense to zoom out of the video 
monitor and use the resulting workspace to, for example, let a minimized image or 
text object move through the picture. 

Keyboard shortcuts for the preview picture: 

Thumbnail zoom in/out: Ctrl + mouse wheel 

Move thumbnail: Ctrl + left mouse button + drag 

See the "Animation from outside of the image" (view page 167) section for more 
detail. 
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Section 

Note: In order to move the section with a movement effect across the image, please 
refer to the following section "Camera/zoom" (view page 149). 

Sections may be used to display only part of the image.  

• You can specify an image section in the preview monitor. Use the eight handles 
to reduce the frame displayed in the monitor and move it to the desired position. 

Preview: With this button you can preview how segment will look like in the movie. 
Click on this button a second time in order to keep editing this segment. 
 

Movie size: The section will be adjusted to the size of the movie. This way if your raw 
material is, for example, in 4K quality, you will get a section in top HD resolution.  

Keep proportions: In this menu, you can select the format for the section. The format 
of the original picture is used as the default. 

Fullscreen: If this check box is selected, the opened section will be zoomed to 
fullscreen. If this option is deactivated, only the section of the image within the frame 
will be displayed and the edge will remain black or filled with the object behind it. 
 

Camera/zoom 

 

With this effect, you can move a 
previously selected frame inside the 
image, creating an impression of 
camera movement or zoom. 

 

Movement in direction 

 

Determine the direction in which the selected section or image will 
move in the process during the time selected under "time period". In 
addition to horizontal and vertical movements, diagonal movements 
are also possible. 

Preview: Displays a preview of the section at the playback marker location. 
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Zooming 

 

Zoom out: The selected picture section is displayed and is then zoomed 
out to display the entire picture according to the time set in “Length of 
movement”. If no portion is previously set, a central portion of 50% of 
the picture is set. 

 

Zoom in: The entire picture is displayed and then zoomed in to show 
only a smaller picture section according to the time set in “Length of 
movement”. If no portion is previously set, a central portion of 50% of 
the picture is set. 

 

Duration 
The option selected here sets the position where the keyframes of each movement 
effect are set by default. You determine the positions where a movements begins and 
ends. 

Note: Automatically placed keyframes may be edited retroactively, and the option 
will then be set to "Use custom settings". Read the section "Retroactively editing an 
effect's keyframes" (view page 164) in the chapter "Objects". 

 

 
Reset: This option applies a static zoom to show the selected section of the 
picture only. 

 

The size and the position of the image can be roughly entered in the program monitor 
by simply moving the image into it and dragging on the handles. The frame of the 
video monitor with handles can also be moved with the keyboard. 

Keyboard shortcuts for moving the edges of the frame that are visible in the video 
monitor: 

Nudge the screen 1 pixel: Arrow keys 

Nudge the screen 5 percent: Shift + arrow keys 
 

For animated movement effects, it often makes sense to zoom out of the video 
monitor and use the resulting workspace to, for example, let a minimized image or 
text object move through the picture. 

Keyboard shortcuts for the preview picture: 

Thumbnail zoom in/out: Ctrl + mouse wheel 

Move thumbnail: Ctrl + left mouse button + drag 

See the "Animation from outside of the image" (view page 167) section for more 
detail. 
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Rotation/Mirroring 

 
 

Rotation 

 

Rotates the image on the horizontal axis. 

 

Rotates the image on the vertical axis. 

 

Rotates the image around its center point. 

 

Straighten horizon 
The image can be rotated around the axis using the slider. The image is automatically 
zoomed to avoid black edges. 

Show guidelines: Activating this check box displays a grid in the program monitor for 
orientation during horizontal straightening. 

Zoom automatically: This function is preset to active. Unwanted black borders that 
result from horizon straightening are eliminated by zooming in on the image.  

Note: If the image format does not completely conform to the current movie format 
and already has black borders, these cannot be eliminated with the horizon 
straightening function. 
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Mirror/Rotate 

 
Mirrors the image on the vertical axis. 

 
Mirrors the image on the horizontal axis. 

 
Rotates the image 90° clockwise. 

 
Rotates the image 90° counterclockwise. 

 

Lens correction 
With the lens correction you can remove image distorions caused by certain lenses. 
Even so called "converging lines" can be easily straightened. Here is an example: 

 

Original image Image after editing 

Setup 
• Lense: Affects the curvature of the image 
• Section//zoom: Corrects the black edges that appear around the image when 

changes are made to the "lens" parameter. 
• Automatic: Automatically sets the "Section/zoom" parameter to remove black 

edges caused by changes to the "lense" parameter. 

Note: Manually changing the "Section/zoom" parameter will automatically 
deactivate this. 

• Perspective: Strongly upward or downward facing image material often contains 
distortions which are unnatural for the human eye and causes so called 
"converging lines". This parameter balances out these distortions, allowing 
images with "converging lines" to appear more natural. 

Tip: The lens correction parameter can be animated (view page 162). This is 
particularly useful in videos where the perspective changes, causing, for example, 
converging lines to also change over time.  
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360° editing 
Here you'll find two functions for editing 360° video material: one function to 
integrate 360° videos into regular videos and another to place regular videos and 
images into 360° videos. Find out more in the section 360° videos (view page Fehler! 
Textmarke nicht definiert.) in the "Special functions and assistants" chapter 
 

360° Stitching 
Here you will find a stitching function for 360° videos, more information can be found 
in the section 360° videos (view page Fehler! Textmarke nicht definiert.). 

3D distortion 
This enables the 
perspective of images to 
be distorted and moved. 
This produces a 3D 
impression by causing 
several components of 
the image to appear 
further in front of others.  

Enter the individual corner points numerically or move them in the preview monitor 
using the mouse here. 

Note: Unlike Stereo3D, this does not involve genuine 3D positioning. The image is 
only distorted so that it appears three-dimensional on a normal two-dimensional 
monitor. 

 

Movement templates 
This is where you can find finished templates for movement effects that can be 
applied to objects. 
 

Stereo3D in the Media Pool 
This accesses the program's Stereo 3D functionality. Please read the corresponding 
chapter "Stereo3D". (view page 208) 
 

Note: This function is available only in the Plus/Premium version. 
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Audio effects in the Media Pool 
The Media Pool offers various opportunities to add effects to your audio objects. 
Another advantage of this so-called "object-oriented" working method is that 
automations are moved automatically with objects when they are moved, since they 
are attached to the object and not to the track itself. 

See the "Audio effects" (view page 179) section below for more detail. 
 

General options 
Under "Effects -> Audio 
effects -> General", you 
will find audio effects 
that can be animated 
using effects curves 
(view page 162). This 
means that certain 
effect settings can be 
changed during 
playback. 

Effect curves are always 
object related, i.e. they 
only apply to one object 
and are moved or copied 
together with the object. 

Note: The faders AUX 1 and AUX 2 control the volume at which the object's signal is 
sent to the corresponding FX tracks in the mixer. 

Audio Cleaning (view page 180), Echo/Reverb, and Timestrech/Resample (view page 
185) can also be accessed here. 

Note: Volume and balance curves are also present in the track. The set values in the 
curve are also active, respectively. 

 

Audio effect presets 
In the Media Pool you will find a broad palette of effect settings which you can add to 
audio objects via drag & drop. 
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Design elements in the Media Pool 
In this category you will find a large selection of decorative elements: templates for 
image juxtapositions (multiple picture-in-picture) and collages, moving objects 
(balloons flying through the frame, trains moving across the picture, snowfall....), color 
fields for your own backgrounds, intro videos, outro videos, visuals... 

You should first look through all the options and take stock of what there is.  

• Open the categories one after the other to get a general impression. You can see 
a preview of all deco elements. 

A simple example for use are the frames (Media Pool > Effects > Design elements > 
Image objects > Frames“). These are much like picture-frames that can be modified 
by video mix effects. Simply drag them directly on an object, which will then appear 
as if inside a picture frame. 

The design elements create own objects on a different track. You can use the lower 
handles to adjust the size of the borders to fit any length of the video. You can also 
achieve interesting effects by inserting and discarding borders within a video. 
 

Snap marker (only in the Plus/Premium 
versions) 
You can find more information about this topic in the "Snap markers and transients" 
(view page 126) section. 
 

My Presets in the Media Pool 
Your personal effects configurations in the Media Pool can be saved and applied again 
later. You can reach these customized configurations in the Media Pool folder "Effects 
> My Presets". They may be dragged onto objects as usual. 

First, this folder will be empty, of course, because you still have to create your own 
configurations. 
 

Extra effects 
Video effect plug-ins are additional programs from third-party manufacturers that can 
be used to apply additional video effects to video objects. MAGIX Movie Edit Pro 
supports the plug-in format of the freeware video editing software VirtualDub, as well 
as the "VitaScene" and "Adorage" programs by proDAD and effects based on 
OpenFX standard. 
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Install the OpenFX plug-ins and click on "Scan" under "Effects" > "Extra effects" in the 
Media Pool. Then restart MAGIX Movie Edit Pro. OpenFX plug-ins appear directly 
below and are ready for use. 

Important applications for plug-ins: 
• Removal of broadcast logos 
• Removal of interference 
• Addition of special effects 
 

Using video effect plug-ins 
First select the video or image object. Then open "Effects -> Additional effects -> 
Plug-in manager" in the Media Pool menu. This opens the manager dialog for video 
effect plugins, which lists all available plugins on the right side of the dialog. 

Note: In order to use plug-ins, you have to install them first. After you install the 
plug-ins, they will appear in the plug-in manager. 

 

Video plug-ins manager 

 

Effect templates for plug-ins: MAGIX Movie Edit Pro does not include plug-ins due to 
licensing reasons. 

  You can save your settings by pressing the "Save" button and 
remove them by pressing "Delete". 

Available plug-ins: All available plug-ins are listed here. 

Add plug-in: The selected plug-in will be added to the editing chain ( "Plug-ins on the 
current object" list on the right side of the dialog).  You can load as many plug-ins as 
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you like simultaneously. They are then edited subsequently according to the list 
sequence. The plug-in order can be changed using drag & drop in the list. 

Plug-in settings: Opens the settings dialog for the selected plug-in. All plug-in 
settings for the entire list can be saved together as a preset (effect templates for plug-
ins). 

Advanced...: Opens the dialog with advanced settings. 

Navigation buttons: Switch to the previous or next movie via the navigation buttons 
in the lower part of the dialog of a movie.  

Last used: The settings used for the last videos will be applied. This option is active 
only if you edit one image after the next using navigation buttons (see above). 

OK: Settings will be applied to the current video. 

Apply to all: Effects will be applied to all objects included in the movie.  

Cancel: The dialog will close, settings will not be applied. 
 

Advanced... 

 

In the "Advanced" dialog, you can specify the search path for plug-ins. MAGIX Movie 
Edit Pro checks these for available plug-in files at program start and adds these to the 
list of available plug-ins. "Add search path" adds new search paths, and "Delete 
searchpath" removes them from the list again. 

Check file extension: Accelerates the search for new plug-ins if a larger number of 
plug-ins are available by not checking if they are valid. 
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Scan subfolders: Extends the search to subfolders below the selected paths. 

Local settings 
Recalculate video effect plug-in on bitmaps for each frame dynamically: If you apply 
a plug-in to a bitmap (image), then this option must be activated in case the plug-in 
creates moving effects. 
 

Effects masks (Plus/Premium version) 
Effects masks help you to apply effects in different areas of one video image with 
varying intensity. A specific image is used as a mask to determine the specific areas 
where the effect should be applied.  

Typical applications include: 

• Image optimizations. A typical example is a horizontal pan with a horizon, where 
the upper or lower area of the image is brightened or colored in. 

• Eye-catching color gradients, colorations, etc. 
• Special effects such as automatic license plate anonymization. 

Effects masks are regular image objects, and as such may be animated or attached to 
a certain image position to use them as moving video images. 
 

Note: This function is available only in the Plus/Premium version. 
 

Create an effect mask with MAGIX Movie Edit Pro 

 

• Select the object in the arrangement to apply the effects 
mask to. 

 

 

• Open the desired effects page in the 
Media Pool. 

• Click on the down arrow button and 
select the "Load effect mask" entry 
from the menu. 

 

When using color images, the brightness values are used. The lighter the area in 
effect mask is, the stronger will the effect be applied: black means no effect, white 
means full effect strength. 

To apply the mask at a certain position in the video, you must edit it again. There are 
many options available for editing effects masks: 
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• You can define the size and the position of the effect mask in such a way, that 
the mask fits exactly over the image element to be edited. Please read more on 
this in the section "Position/size" (view page 147). 

• You can attach the mask to the position in the video so that it moves together 
with the image element. To find out more, read "Attach to picture position in the 
video (view page 168)". 

• Or animate the effect mask object directly. Read more about this in the chapter 
"Animate effects" (view page 162). 

• In the effects overview, the effects 
mask can be deactivated for certain 
effects. The effects are applied to the 
whole image. 

• Click on the down arrow button again 
and select the "Delete effect mask" 
entry from the menu to remove the 
effect mask. 

 
T 

Tip: You can also use your own effect masks. Any image or photo in JPG format can 
be used. You can draw a fitting image in a graphics program, save it as a JPEG and 
load it using the "Load effects mask" option in Movie Edit Pro. 

All effect masks can easily be inverted so that the light area becomes the dark area 
and vice versa. To do this, click on the arrow on the effect mask object. 
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This will invert the effect mask. 

 
 

Designing effect masks with Xara Designer 
You can also create animated effect masks in Flash format to adjust the effect 
regulation to the moving video images. To do this you will need to have either Xara 
Photo & Graphics Designer 2013 (or newer) or Xara Designer Pro X (or newer) 
installed on your computer. 

Please proceed as follows: 

1. Select the image or video object for which you would like to create an effect 
mask. 

2. Open the effects page in the Media Pool that will be used as the effect. Click on 
the down arrow button and select "Create effect mask".  
Here you will also see the option for deleting the effect mask if necessary. 

 
MAGIX Photo Designer or Xara Xtreme Pro will start with the animation 
document and the opened frame gallery. The first frame will be added 
automatically and will display the selected image or video object from MAGIX 
Movie Edit Pro.  

3. Create effect mask: 
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Note: Be aware that the lighter the effect mask, the stronger the effect will be later 
in MAGIX Movie Edit Pro. Black indicates no effect, and white indicates full effect. 
The best option is to color the object that will be used as the effect mask white 
and to adjust the intensity of the effect yourself in MAGIX Movie Edit Pro. 

1. Use the tools in the editor to create the desired mask form. Add an object 
that marks the area where the effect should later be applied. It will 
automatically be assigned to the first frame.  
With the "Invert mask" function in MAGIX Movie Edit Pro you can use an 
object to indirectly select the precise area where the effect should not be 
applied. 

2. Color the object white.  
3. Give the object a name by clicking on "Names..." in the context menu. Enter 

the name under "Names" and click on "Add" and then "Close". 
4. Create additional frames by clicking on "Copy" in the Frame Animation 

Gallery. The object that should move will automatically be added to the new 
frame. 
With each new frame the video moves to the corresponding position making 
it easier for you to adjust the objects directly on the video image by moving 
them to the right position. 

Tip: More information about Flash animations is available in the documentation 
for the editor. 

4. Close the document from the external editor. You do not need to save it because 
it is automatically transferred to MAGIX Movie Edit Pro when it is closed. It will 
then appear as a linked effect mask object under the image or video object.  

 
If you would like to edit the effect mask retroactively, double-click on the effect 
mask object to start the external editor with the opened mask. 
The next thing to do is set up the effect that will be regulated by the effect mask. 

5. Set up effect:  
1. Select the source object for which you just created the mask. 
2. Set up the effect parameters in the Media Pool that should be regulated by 

the effect mask. These must be parameters from the "Video effects" area 
(without "speed" and "Chroma Key"). 
The effect will be applied to the whole object. 

6. Activate effect mask: 
In the effect overview click on the mask icon in the bottom edge of the Media Pool 
for every effect the mask will be applied to.  
You can invert the effect mask by clicking on the small arrow on the left of the 
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effect mask object. The effects will then be applied to the rest of the image instead 
of the mask. 

 
 
 

Animate objects, effect curves 
The "Effects" tab under "Video effects" and "Movement effects" provide you with the 
effects which can animated using keyframes. 

The following objects can be animated: 

• Combined objects 
• Video objects 
• Image objects (still images) 
• Title objects 
• Audio objects (in the Media Pool under "Effects" > "Audio effects" > "General") 
• MAGIX 3D Maker objects (3D texts) 
 

Preparing animations 
• First, select the object in the project window to animate. For complex 

animations, we recommend placing a marker beforehand for orientation. 
• In the Media Pool, open the "Effects" tab and click on the effect you would like to 

animate under "Video effects" or "Movement effects". 
• If necessary, set up the effect however you would like it for the start of the 

animation. 

 

• Using this button, at the bottom of the Media Pool, a timeline may be 
shown or hidden. You can see here which animated effects are currently 
applied to the selected object. Keyframes may be placed, selected, 
moved, and deleted. 
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There are two stippled lines in the timeline to 
help you orientate yourself while you edit 
movement. These lines will help you recognize 
the start or end of the transition. 

 

Place keyframe 
Click the timeline to set the playback marker at the locations where a keyframe 
should be added. 

Note: You can also use the timeline in the project window for exact positioning. 
Using project markers (view page 121) is recommended in this case. 

 
• This button places keyframes for all parameters required in the animation. 

• Additional keyframes may be added simply by placing the playback marker at 
the next keyframe location and changing the effects parameters directly. 

The positioned keyframes may also be retroactively moved via drag & drop. 
 

Copy keyframe 

 
• Select the keyframes to be copied by clicking them and then press the 

"Copy" button. 

 
• Next, set the playback marker at the location for insertion and the press 

the "Insert" button. 
 

Display keyframes of individual parameters 
Multiple keyframes are added simultaneously to effects if they include multiple 
parameters. 

 

Click the small arrow beside the name of the animated 
effect to display all of its parameters. 

 

Now all keyframes of the effects parameter can be 
individually moved, deleted, activated, and deactivated. 

Note: Only those parameters are listed which are used for the animation. As soon as 
another parameter is required for editing the effect, it becomes visible to you here. 
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Retroactively editing an effect's keyframes 
Previously set keyframes can be retroactively and temporarily moved and their values 
edited. 
 

• Keyframes may be moved via drag & drop. Simply click on the keyframe to be 
moved and drag it to the desired position. 

 

• To change an effects setting for an already positioned keyframe, click the 
keyframe and adjust the effect in the Media Pool. 

 

Soft movement 
 The automatic Bezier interpolation applies an approximation curve at the 
keyframe. 

This makes the movement progression softer and more natural.  
 

Delete keyframe 

 

Select the keyframe to be deleted by clicking it. 

 

 This button removes the selected keyframe. 
 

Editing an effects curve in the object 
 Activate effects curve: For each of animated effects parameter, a curve is 

created and placed over the object. Click this button to display the effects curve 
on the object. 

 

 

Edit curve points: The curve point can either be edited with 
the individual curve points (in "Standard" mouse mode) or 
by freely drawing the effect curve (in "Curve" mouse 
mode). 

New curve points can be added to the curve in "Standard" mode via "Ctrl + Shift" and 
clicking; existing ones can be deleted in the same way. Every curve point can be 
moved with the mouse horizontally and vertically. 

Note: The buttons for activating effects curves are first displayed once the first 
keyframe has been placed. 
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Effects curves - Additional functions 

 

The context menu can also be opened via the small arrow beside the effects indicator. 
 

Delete effects: Removes the selected effect completely. 
 

Delete effects curve: Removes the effects curve to be created again. 
 

Copy effects curve: The effects curve is copied to the clipboard to be used at other 
positions. 
 

Insert effects curve: A previously copied effects curve can be inserted elsewhere with 
this function at any time. This may be in the same object or in another object. 

Note: If you would like to insert the curve into a longer or shorter object, then think 
about setting the option "Connect curve length with object length" correctly before 
copying. 

 

Combine effects curve with object length: If this option is set, then changes to object 
length will affect the effects curve accordingly. 
In practice, this behavior is needed rarely, for example if objects are stretched or 
compressed. The option is deactivated by default for this reason. 
 

Load effects curve: A previously saved effects curve may be loaded via this menu 
item. This is useful, for example, if you have added your own default animations. 

Caution! The current effects curve will be overwritten as another one is loaded. 
 

Save effects curve: Effects curves can be saved as a separate file. This is useful, for 
example, if you want to add your own default animations and simply load them again 
at other positions again. 

Tip: Be aware that during saving the setting "Connect curve length with object 
length" is saved as well and applied during loading. 
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Edit effects curve 
This dialog serves to stretch, compress and move effect curves within an object. The 
info bar of the dialog will display the effect, whose automation curve is currently being 
edited. 

Move position 
Time: With each click on the arrow, you can move the effect curve forward or back by 
the displayed time value. 

Effect: Every click on the arrow up or down moves the effect curve by the entered 
value. Depending on the effect, it is possible to enter exact or percent values. 

Stretch/Compress 
Time: The effect curve will be stretched or compressed by the entered time value. 
Invert reverses the curve on the time axis and reinserts it in "reverse". The entire 
object duration will be considered. 

Effect: The effect curve is stretched or compressed in its values, no time-related 
editing takes place. The selected option (see table) is decisive in editing. 

Mirror: The entire curve is mirrored along the X-axis, whose position is determined by 
the following option (see table). 

... around object center: 
The X-axis lies exactly at 
the center of the object. 

 

...around curve center: The 
X-axis lies between the 
upper and lower 
automation point.  

...around curve minimum: 
The X-axis lies at the level 
of the lowest automation 
point.  

...around curve maximum: 
The X-axis lies at the level 
of the highest automation 
point.  
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Create overlay graphic/animation 
Create vector graphics or animations in an external editor such as Xara Designer Pro 
in order to use them as overlay objects in MAGIX Movie Edit Pro. A typical use 
scenario would be to draw an object in order to darken certain portions of the video, 
such as a black bar to cover a person's eyes. Overlay objects aren't bound to the 
source material by grouping. They can me moved and edited as you please.  

Note: This menu will appear only when a corresponding graphics program is 
installed on your PC. 

To create an overlay object, proceed as follows: 

1. In the arrangement, select the image or video object, for which an overlay effect 
should be created. 

2. Right-click on this object and in the context menu select "Create overlay 
graphic/animation". 

The external graphics editor will be launched. Your selected object will be displayed 
to help you get a better idea of how to best design your overlay.  

3. Create the template for the overlay object. You can use all editor functions. 

4. Close the editor You don't have to save the project in the editor, as the overlay 
object will automatically be transferred to MAGIX Movie Edit Pro and placed below 
the image or video object when the program is closed. 

You can continue to edit it in MAGIX Movie Edit Pro as you wish, for example using 
Animated movement effects (view page 147). 
 

Animation from outside the image 
Animated effects are useful for making objects or titles appear to "fly" across the 
image. In this case it is recommended that the start and end point of the animation 
are placed outside of the image. 
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This will require a video object and a second object to be animated, for example a title 
or a small object to float across the video image. 

 

This is how it works: 
1. Click on the preview monitor and zoom out of the video image (Ctrl + mouse 

wheel). This displays the workspace at the edges of the reduced preview image.  
2. Select the effect "Position/size" (view page 147). 
3. Move the object to be animated to the position on the workspace where the 

animation should start. For example, to the left of the preview image. 
4. Position the playback marker at the location where the animation should start. 
5. Create a keyframe for the animation start. 
6. Position the playback marker at the position where the object to be animated 

should disappear from the image. 
7. Move the object to be animated to the position on the workspace where the 

animation should end; For example, to the right of the preview image. 
8. A second keyframe for the end of the animation will be placed automatically.  
9. Play back the result. The object to be animated should now fly from left to right 

through the video picture. 
 

Attach to picture position in the video 
You can attach a video, picture or text object to moved picture content of another 
video. The attached object automatically completes the movement of a picture 
element from the film, making it appear magnetic. For example, you could use this 
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method to insert a hat that stays on someone's head throughout, even if the person 
hops through the picture.  

Let's roll: 

• Place an overlay object (e.g. a photo of a hat) on a track below a video with a 
moving image element (e.g. a walking person). 

• Right click the object and select the "Attach to picture position in the video" 
movie point. 

• Then click "Continue" in the dialog that appears. 

Note: If you want to attach two objects, e.g. a title and a speech bubble, an 
additional dialog appears, which lets you select the objects you want to attach to 
your video. 

• The next dialog asks you to draw a frame around the image content to be 
tracked. The content should have high contrast to its background. 

• Movement will be automatically calculated and a series of keyframes that 
control the position and size of the effect according to your wishes will be 
generated. 

 

Image stabilization 
The motion stabilizer reduces unsteady camera motion and helps to smooth pans. 
This option can be accessed from the context menu of a video object or the "Effects" 
menu > "Open video objects". 

Functionality 
Image stabilization balances undesired picture movements. The motion stabilizer 
equalizes inadvertent movements in the image by moving the image in the opposite 
direction in accordance with the wrong movements. This produces unusable edges in 
the footage that are cut off automatically, and black strips, which are then removed 
using a zoom shot. The result: A clearly more stable, almost imperceptibly larger 
picture. 

Application 
First you have to check the movie material for shaky scenes. To do this click on the 
"Stabilize" button. Based on the preset parameters, a relative shift between the 
pictures is calculated. After concluding the analysis, take a look at the suggested 
correction, then use the slider for further adjustments. Once you are happy with the 
final correction click OK. If the first scan did not provide a satisfactory result, try 
changing the parameters below and repeat the process. 
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Image stabilization dialog 

 

Stabilization radius for analysis: To prevent the image stabilizer from recognizing 
every camera movement as unwanted shakiness, you can determine the radius within 
which movement is accepted; the larger the stabilization radius, the more shakiness is 
corrected. Changing this parameter will require re-analysis of the source footage. 

Section of analysis: This area determines the area of the footage that should be 
analyzed. The center of the image is preset. If shaking occurs in one area more than in 
another, then you can move the analysis area (e.g. a foreground element at the edge 
is especially shaky). To do this, use the mouse to “capture” the shaky area. The 
smaller the area, the quicker the analysis will be calculated. Generally, changing this 
parameter will require re-analysis of the source footage. 

Maximum displacement: Correction moves the image accordingly to the shaking 
movements. This means that the edge of the image will be removed. This value 
determines how large the edge area is which may be cut away by the stabilization 
feature; the smaller the value, the less movement correction. Changes to this value 
are immediately applied. 

Temporal smoothing: This value determines the speed of the movements considered 
shaky. This allows you to differentiate between a panning shot and a nervous hand-
held shot. Changes to this value are immediately applied. 

Cancel: Exits the dialog without accepting changes to settings.  

Reset: Resets the current settings. 
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Image improvements for the entire movie 
You can open the effects from the the settings via the "Effects" menu. All of the 
settings made here influence the entire movie. Settings are made separately for each 
individual movie in the project. 

On the right, you'll see a preview of the current setting. Use the position slider to jump 
to different positions in the movie or to various scenes in order to see how the 
selected setting affects the image material. 
 

Brightness/Contrast 
Brightness: Use the sliders to reduce or increase the objects' brightness. 

Selective brightness (gamma): “Gamma” determines the mean gray scale that can be 
calculated from the various color ranges. "Selective brightness" is the most important 
function for image improvement. In the preset list, select the various envelope curves 
to edit only the dark, median, or brightest areas of the image. 

Using the fader you can also set the power of the brightness/darkness adjustments. 

Contrast: You can increase or lower the object's contrast. 

Color space correction: This option is effective against powerful colors that violate TV 
standards and can no longer be displayed correctly on-screen. The color saturation of 
the affected material is thereby reduced until the maximum permitted value is 
reached. 
 

Color 
Saturation: Use the saturation slider to increase or reduce the hue proportions in the 
image. A newly developed algorithm is applied which makes color changes related to 
other parameters (e.g. contrast settings) in order to achieve the most natural 
coloration possible. 

Hue: Use the palette to select a hue for coloring in the picture. 

Red/green/blue: Changes the color mix using the slide controller. 
 

Image sharpness 
Use the slider to adjust the sharpness or blurriness of an entire slideshow. 

Apply to: Set whether the sharpness should only affect edges or whether the 
blurriness should only affect surfaces. This enables you to effectively reduce ongoing 
image distortions. 
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Anti-flickering filter intensity: The anti-flickering filter affects only still images. It is 
especially intended for zooms in images with many edges and transitions with high 
contrast (e.g. fences, bars, brick walls). High-frequency images such as these begin to 
flicker when they are reduced in size. This filter smoothes these edges somewhat. 
You should set the intensity of the anti-flickering filter according to your preferences, 
because smoothing is always a compromise between good contrast and fluid image 
sequence during playback.. 
 

TV cropping 
This option provides optimal adjustment of the image size for a real television screen 
(anti-cropping). Without this adjustment, the screen could cut off edges of the image 
in some cases. 

Show TV screen area in preview monitor: This option displays the image borders of 
the television as lines in the preview monitor. The four image borders of the TV area 
may be specified via the four input fields. Of course, the real size of the TV image 
must be familiar for this. The following process is available to determine this: 

The four input fields also enable the borders of the four sides to be adjusted freely in 
percent. In this case, the best approach is to determine a balance between reduction, 
bar formation, and the image section: 

• If all four edges feature the same value, then the image will be reduced 
proportionately. In this case no distortions will occur, but there will be bars along 
the edges. 

• If different values are entered for the 4 fields, the image size is reduced 
disproportionately. This will distort the image. 

Apply border range to: With this option, the entered values for the four borders are 
applied as an image reduction. The result may be checked immediately in the preview 
monitor. 

Determining the visible TV frame size 
To determine the picture properties of your television as well as optimal image size 
editor settings, you should perform a test run:  

• Load the project "Visible TV image" from the folder "My Media -> Projects -> 
Visible TV image" in the Media Pool. 

• Play back the film and read the instructions on the video screen. 
• Burn the project to DVD 
• Place the disc into the player and play the film. Compare the TV picture to the 

picture displayed on your video screen by MAGIX Movie Edit Pro. 
• Determine the proportional value of the borders cropped by the television with 

the four measurement scales along the edges of the test picture. 
• Enter the values in the "Full TV size" editor. 
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The image size is now optimized to your TV picture. Please note: Depending on 
device settings and disc media type, the cropping values may vary slightly. 
 

Image improvements for individual objects 
The context menu or in "Effects -> Video object effects" features various adjustments 
for selected video and image objects. 

Interpolation for interlace material: Select this option to remove interlace artifacts 
from the (video) image. If, for instance, you extract still shots from a video, interlace 
artifacts appear in sequences which feature movement. 

Anti interface filter: Choose this option for still pictures with detailed structures and 
high contrast. This filter reduces line flickering during TV playback. 

Border crop adjustment: Select this option if the edges are cropped during playback 
on your television. Values stored in "Film effect settings (view page 172)" will be 
applied. 
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Audio editing 
In principle, any track in MAGIX Movie Edit Pro can be used as a sound track. There 
are no specific track types. But it is easier not to mix object types within one track. 
 

Load and edit audio files 
• All importable audio files may be accessed in the Media Pool and previewed via 

the video monitor by a clicking on the file name.  
• The files may be dragged into the project window by holding down the mouse 

button (drag & drop). Tracks from audio CDs may also be integrated via drag & 
drop. 

• Edits, fine positioning, volume settings, and fading in and out may all be adjusted 
in the project window using the object handles directly. 

• Various effect curves (view page 164) may be selected for audio tracks, 
dynamically controlling selectable effects, volume or stereo panorama. 

 

Adjust loudness of all selected objects 
This function adjusts the loudness values of all selected objects according to the 
"reference object". The object that has just been activated is used as the reference 
object. 

Requirements 
• Objects need to be at least 5 seconds long for a reasonable calculation. An 

object length of 10 seconds or longer will provide better results. 
• Background music provides the best results. In the vast majority of cases, music 

provides a homogeneous sound image and minimal volume changes (of course, 
very good results can also be obtained with video material). 

Open 
1. Set the object loudness (view page 113) of the reference object to the desired 

value. 
2. Select all objects (including the reference object) whose loudness you would like 

to adjust. 
3. Right click the reference object to open its context menu. Select "Adjust 

loudness of selected objects" (for Combo objects (view page 108) in the 
submenu „Audio functions“). 
or 
Press the Shift key and click on the reference object. Then go to "Effects > Audio 
object effects" and select "Adjust loudness of selected objects". 
Result:  
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- MAGIX Movie Edit Pro determines all loudness values for the selected 
objects und adjusts them to fit the reference object. The object loudness of 
the remaining objects will also be adjusted accordingly. 

- If the adjustment results in an object loudness which is so high that it could 
possibly cause clipping, MAGIX Movie Edit Pro will provide an automatic 
correction. This will lower the volume of all objects (including the reference 
object). 

Problems & solutions 
For objects containing large loudness differences or noises (e. g. in video camera 
recordings) the result may not always be satisfactory. Prepare these objects as 
follows: 
1. Split (view page 284) the object at the corresponding transitions before carrying 

out the function.Loud 
2. Open the function (see Open). 
3. Afterwards transition the objects with simple crossfades (view page 117).Loud 
 

Edit volume curve 
You can use volume curves to easily edit the audio track of an object as you wish. 

1. In a project, select an object, whose volume you would like to adjust. 

2. Open the volume curve by going to "Effects" > "Audio object effects" > "Volume 
curve". 
You will now see an additional line in the audio track, the volume curve. 

3. When you touch this line with your mouse cursor, the cursor is transformed from a 
hand symbol to an arrow. Now if you click on the line, you will create a point 
(keyframe), which you can grab with the mouse cursor and drag to a lower position. 
This lowers the volume of the overall object.  

 

4. Create an additional point and move it down as well, lowering not the entire 
volume curve, but simply a section of it.  

You can create as many keyframes a you wish, adjusting the volume curve section by 
section, until all segments play at the appropriate volume. Check whether the 
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keyframes are positioned right by playing back the track (spacebar starts and stops 
playback) and listening to hear the effect of the keyframes. 

If you would like to move a keyframe to the left or right, grab it with the mouse cursor 
and move it to the right position. 

If you would like to delete keyframes, use the effect overview in the Media Pool under 
"Effects" > "Audio effects" > "General" as described under "Animate objects, effect 
curves" (view page 162). Select the keyframe that you wish to delete and click on the 

Delete button. . 
 

Import audio CDs 
Entire music tracks from audio CDs can be imported into the project through the 
Media Pool in the same way as importing files from the hard drive. 

1. Insert an audio CD into the CD/DVD drive of the PC 
2. Go to your CD/DVD drive in the Media Pool (File Manager, Computer). The 

individual CD titles appear in the file list. 
3. A simple mouse click starts the playback of the CD title for sampling purposes 
4. Drag & drop the track from the CD into a track of the current project and it will 

be digitally scanned and copied to the hard-drive. The files will be saved in the 
import folder (may be specified in "File" > "Settings" > "Program..." > "Folder" 
(More information can be found in the section "Folder" on page 78)). 

5. The CD track appears in the track as an audio object and can be played back or 
edited immediately. 

 

CD track list 
Use the CD import dialog for more advanced control of the import process, e. g. 
importing sections from music tracks. You can access this dialog box via "File" > 
"Import audio CD track(s)...". This opens the dialog "CD track list". 
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Tracks can be selected from the list with a mouse click or with the key combination 
Shift + arrow or Ctrl + mouse click. 

Transport control in the dialog activates the preview function. The playback arrow 
starts audio playback of the first selected track. 

Select all tracks: This option selects all audio tracks in order to copy the complete CD.  

Save selected tracks: This button opens dialog to save selected tracks. You can either 
place all files into a single WAV file or create a separate WAV file for each track. A 
new object will be created in the arrangement for each track in either case. 

Options CD drive: With this option you can access the "CD-/DVD drive list". 
 

CD/DVD drive list 

 

Configuration: This button opens the configuration dialog, where various special 
settings can be made. 

Reset: sets drive settings back to default. 

Add: Creates a new drive in the list, which first requires special settings. 

Delete: Deletes selected drive from the list. 

Load setup: Loads the current drive list and all configuration data from a *.cfg file. 

Save setup: Saves the current drive list and all configuration files in a *.cfg file. 
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CD/DVD-ROM configuration 

 

Drive Name: Lets you edit the name of the drive in the list. This is useful if you create 
more than one entry accessing the same physical drive.  

Host Adapter Number: Lets you specify the number of your SCSI adapter - normally 
0. 

Bus ID: Here you can enter the ID of your CD-ROM drive. Be sure to set the correct 
ID, there is no error checking! 

Bus LUN: sets the LUN parameter, normally 0. 

Alias: Lets you select the manufacturer type of your CD ROM drive. 

Normal copy mode: copies audio files without any software correction. 

Copy mode sector synchronization: copies audio files with a special correction 
algorithm. This is especially useful, since many CD drives have problems finding an 
exact position again and gaps can occur.  

Burst copy mode: optimizes the speed of the copy process, no software correction is 
used.  
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Sectors per cycle: defines the audio sector count that should be read from the audio 
CD in one cycle. The higher the number of sectors, the faster the copying process. 
Numerous SCSI systems have problems with more than 27 sectors. 

Sync sectors: sets the count of audio sectors, which should be used for software 
correction. A higher number results in a better synchronization but also in a slower 
copying process. 
 

Audio effects 
Using audio effects 
Audio effect presets 
In the Media Pool you will find a broad palette of effect settings which you can add to 
audio objects via drag & drop. 
 

Track effects 
Track effects always apply to all audio objects of a track. This sets the mixer (view 
page 179). 
 

Audio effects plug-ins 
MAGIX Movie Edit Pro supports VST as well as DirectX audio plug-ins. These are 
usually effects modules such as reverb, equalizer, dynamics compression, etc. 

Installation 

Before using audio effect plug-ins, they first have to be installed – this process may be 
different depending on the plug-in. VST plug-ins are typically saved in a certain 
directory, which must be entered in the MAGIX Movie Edit Pro path settings (view 
page 78). After the path has been indicated, MAGIX Movie Edit Pro scans it for 
working plug-ins and offers them to be used. You can also indicated multiple 
locations where VST plug-ins are installed. 

Using plug-ins 

Two so-called slots for track effects are located in the channel strip of the mixer for 
the corresponding track as well as in the FX tracks. 

Clicking on the small triangle will let you select an effect from the list. Select "No 
effect" to remove a plug-in from the slot.  
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Master effects 
Master effects influence the mixed sum of all audio tracks. For this purpose a Master 
Audio Effects Rack and further plug-ins are provided. The Plus/Premium version 
includes the special MAGIX Mastering Suite for perfect sound. 
 

Sound optimization 
This option opens an editor for correcting audio material discrepancies. 

Select the cleaning function you desire from the upper part of the dialog: 

• The equalizer (on page 182) allows you to manipulate the frequency spectrum – 
perfect for cleaning up muffled dialog.  

• The compressor is a dynamic volume control that lends the overall sound a 
deeper, richer quality. 

• The stereo FX processor justifies the position of the sound in the stereo 
panorama. 

• DeNoiser, DeClipper, and DeHisser are professional noise reduction tools that 
do exactly what their titles say they do. 

Presets: You can try out the suitability of a number of presets in the preset menu. 

Temporarily deactivate all effects: Switches all the effects off. 

Apply to all scenes: Applies the selected cleaning settings of all effects to every scene 
of the movie. 
 

Declipper 
Should the input level of an audio recording be too high, overmodulation may result at 
the louder parts (the signal peaks). This digital distortion is also called "clipping": At 
the overmodulated area, the values that are too high are simply cut off, and typical, 
quite unpleasant-sounding crackling and distortion appear. 

MAGIX Movie Edit Pro contains a special function for dealing with digital clipping and 
analog distortions. Of course, this only works to a certain degree. 

Using the fader you can set at what level the Declipper should register a signal as 
being overmodulated and, if required, correct it (Clip level). This is important, as 
different sound cards show different clipping methods. The more the fader is turned 
up, the lower the level recognized by the program as overmodulated. If the clip level is 
set too high, unwanted sound modification may occur. 

Get clip level: The clip level is gaged automatically. 
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Denoiser 
The Denoiser removes persistent background noise like computer hum, hissing, 
noises from sound charts, disturbance from ground circuits, interference from audio 
equipment with high-impedance outputs (such as record players), impact noise, or 
the turntable rumble. 

The Denoiser requires a noise sample. Some typical noise sounds are included in the 
"Preset" selection menu.  

Set the degree to which the noise should be reduced with the fader. It is often better 
to reduce interference signals by 3-6 dB rather than as much as is possible in order to 
keep the sound "natural". 

A different option consists of creating a noise sample yourself. All that's needed is a 
short section from the audio track in which the distortion can be found. To get it, 
switch to the DeNoiser dialog by pressing  "Advanced". 
 

DeNoiser – Advanced settings 

Step 1: Choose a noise sample 
First of all, a sample of the distortion you wish to remove must be selected, i.e. a so-
called "noise sample".  

You have two options to choose from: 

Pick out typical background noise: You can select and use a number of typical 
background noises from the flip menu. Select one and listen to it by pressing the 
"Play" button. If it is similar to the background noise in your sound track, go ahead and 
use it (see "Step 2: Removing background noise"). 

Extract a new noise sample from an audio track: You can also pick out a short 
passage (from the existing sound track) in which you can hear the background noise. 

Automatic search: Searches especially quiet passages in which background noise is 
most noticeable. 

Previous / Play / Next: These buttons allow you to play all of the passages found for 
easy comparison. 

Save as: Once found, you can save noise samples to the hard drive. They then appear 
as entries in the "Typical background noises" flip menu to be used in other projects. 

If you only wish to use the noise sample in the current project, you don't have to save. 
Instead just go to the "Remove noise" category. 
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Step 2: Removing background noise 
Noise level: The level of the noise reduction function should be set as precisely as 
possible. Values that are too low are expressed at a low distortion dampening level 
and in artifacts, like noises or "twittering" (see below). High settings produce dull 
results – useful signals that sound similar to hissing noises are also filtered away. Try 
to find the best setting for the project at hand. 

Reducer: This sets the balance between the original signal and the signal with the 
applied noise reduction. It's often better to reduce interference signals by 3-6 dB 
rather than as much as is possible, so as to keep the sound "natural". In case of 
buzzing, it’s best to apply complete removal. 
 

Dehisser 
The Dehisser eliminates regular "white" noise typically produced by analog tape 
recordings, microphone pre-amplifiers, A/D converters, or transformers. 

Noise reduction can be regulated in decibels with the fader. It is often better to reduce 
interference signals by 3-6 dB rather than as much as possible in order to keep the 
sound "natural". 

Noise level: You can choose between different noise levels. The level of the noise 
reduction function should be set as precisely as possible. Low settings result in 
incomplete deletion of the hissing. Incomplete deleting of hissing produces artifacts 
and should be avoided, since high settings will produce dull results and some useful 
signals (i.e. woodwinds) which are similar to hissing are also filtered away. 
 

Equalizer 
The 10-track equalizer divides the frequency spectrum into 10 areas (tracks) and 
supplies them with separate volume controls to allow you to achieve many impressive 
effects, from the simple rising of the bass to total sound transformation. If you raise 
the low frequencies too much throughout the whole level, it might cause distortions.  

Fader: The volume of each of the 10 frequency bands can be set separately with the 
10 volume controls. 

Link frequency bands: The frequency fields can be bundled together flexibly in order 
to avoid artificial-sounding exaggeration in individual frequency fields. 
 

Compressor 
The compressor is an automated, dynamic volume controller. Loud passages become 
quieter and the total value is raised. This makes the volume more consistent and 
speech easier to understand. A compressor is mainly useful in case background noise 
or music interferes with speech and simply increasing the volume of the individual 
objects or tracks does not result in any significant improvement. 
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Level: Regulates the level of compression applied (the "ratio"). 

Function: Defines the compressor depending upon the sound material. 
 

Stereo FX 
The stereo FX processor provides adjustment of the alignment of the audio material in 
the stereo balance. If the stereo recordings sound weak and undifferentiated, an 
extension of the stereo base width can often provide better transparency. 

Bandwidth control: Adjust the bandwidth between mono (on the extreme left), 
unchanged base width (center) and maximum bandwidth ("wide" on the extreme 
right). 

Reducing the bandwidth can raise the overall level. In extreme cases, when the left 
and the right channels include identical material and the bandwidth control is pushed 
to the extreme left on "mono", the result can be a level increase of 3 decibels. 

Raising the bandwidth (values of 100) diminishes the mono compatibility. 
 

Audio effect dialogs 
Some of the following effects can be opened individually (via the context menu), or as 
part of the track or master effects rack. However, the functionality remains the same. 
 

Effect devices controls 
Some effect options (e.g. options from the "Echo/Reverb" or "Time stretching" effects 
menu) open a graphic interface that recreates an audio studio effect. 

These virtual effects are controlled in the conventional way by using slider controls, 
turning knobs, or buttons, or alternatively using the graphic sensor fields. 
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Sensor fields: You can control sensor 
fields intuitively with mouse 
movements. The graphics and the 
respective effect setting change in 
response to each other. 

 

 

Power switch: Each effect device in the rack can be switched on or off 
separately. This button allows you to directly compare the neutral, unedited 
sound of the audio object with the effect setting you have chosen. 

 

 

Every effect has a reset button that restores the effect device’s 
initial default settings. In this starting point, no computing power is 
required and no effect is added to the sound 

 

 

Each effect device features a selection of presets that can be 
selected via the drop-down menu. 

 

 A/B: The A/B button compares two settings with each other. If you 
have selected a preset for the effect and make manual changes to it 
later, you can compare the original preset sound with the new 
settings by using the A/B button. 

Note: The graphics displayed are examples only and differ according to effects 
device. 
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Tempo pitch/resample 

 

This effect device changes the object’s speed and/or pitch.  

Tempo: This control changes the tempo independent of the pitch ("time-stretching"). 
The object acts as if it were compressed or stretched on the track. 

Pitch: This control changes the pitch independent of the speed of the object ("pitch 
shifting"). 

+/- buttons: Use this feature to change the pitch in semitones. 

Setup: This button opens a settings dialog where you can set the algorithm for tempo 
and pitch correction. 

• Standard: Time stretching and pitch shifting in standard quality. The method is 
suitable for audio material without a pronounced beat. Existing beat markers are 
evaluated to improve audio quality. 

• Smoothed: Time stretching and pitch shifting for audio material without abrupt 
elements. The method is suitable for several voice orchestra instruments, 
surfaces, speech and singing. Beat markers will not be evaluated.  
A significantly more demanding algorithm is used for this, which requires more 
processing time. The material may also be used with very large factors (0.2...50) 
without causing severe artifacts. To do this, the material is "smoothed" to give it 
a softer sound and a different phase length. This smoothing is hardly audible, 
e.g. with speech, singing, or solo instrumentation. More complicated spectra — 
such as a sound mixture containing different instruments or a finished mix — 
can cause problems. 
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• Beat marker slicing: Beat-synchronous time stretching and pitch shifting via 
splitting and temporal repositioning. Exactly set beat markers are required at the 
beats or transients.  Markers can be generated in real time (automatically) or 
read out from the source file, as long as they are available (patched). The 
MAGIX Music Editor contains a patch tool which allows the user to set markers 
manually. The algorithm is suitable for rhythmic material that can be divided into 
individual beats or notes. This requires that the material contains low levels 
before and after the individual beats or notes. 

• Beat marker stretching: Beat-synchronized time stretching and pitch shifting in 
high audio quality. The material is stretched between beat markers positions so 
that the impacts or attacks at the beat markers positions are not impaired by 
stretching. The markers can be generated in real time from the audio material 
(automatically), provided they are present (patched). This method is suitable for 
rhythmic material that cannot be divided into individual beats or notes because 
the beats or notes overlap each other. 

• Beat Marker Stretching (smoothed): Beat-synchronized time stretching and 
pitch shifting in high audio quality, even with more intense time stretches. Beat 
markers are used at the beats or transients. The markers can be generated in 
real time from the audio material (automatically), or read out from the wave file, 
provided they are present (patched). This method is suitable for rhythmic 
material that cannot be divided into individual beats or notes because the beats 
or notes overlap each other. This method requires a relatively high amount of 
processing time. If you have a slow system, you should only use it if needed. 

• Universal HQ: A universal time stretching and pitch shifting method for very 
high audio quality. Suitable for all types of audio material. Existing beat markers 
are evaluated to improve audio quality. This method requires so much 
processing time, that a real-time application is recommended only in 
exceptional situations. 

• Monophonic voice: Time-stretching and pitch-shifting for vocal solos, speech or 
solo instruments. Your material should be free of any background noises; strong 
reverb can also make it difficult to apply this method. With suitable material the 
audio quality is very high. Formants are also preserved during pitch shifting. Beat 
markers are not evaluated.  

• Resampling: Pitch shift and tempo can not be changed individually. This method 
requires comparably little CPU time. 

 

Reverb 
You can control the sound of the reverb effect using the following parameters: 

Room size: Defines the size of the room (or the system for the plate and spring). The 
larger a room, the longer the sound travels between walls or objects. With some low 
"size" settings you can also reduce the distance between the individual reflections. 
This allows resonance to develop (accentuated frequency ranges), which can sound 
oppressive if the reverb sustain is too long. 

Tone quality: You can manipulate the sound characteristics of the effect to an extent. 
The effect of this controller depends on the preset used. In rooms, "Color" controls 
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the dampening of the highs in the reverb (from dark to bright) as well as pre-filtering 
of the signal. With plate and spring presets, this fader determines the dampening of 
the basses as well. 

Reverberation time: With this knob you can adjust the reverberation time and 
determine how much of it will be absorbed and, simultaneously, the reverb's decay. 

Pre-delay: The reverb portion ("Mix") and the early reflections play a big role in the 
spatial perception of the sound. Here the time required for the perception of the early 
reflection is know as "Pre-delay". For sound sources that are close, the reverb portion 
is usually low and the early reflections reach the ear noticeably later than the direct 
sound. In contrast, sound sources that are far away usually have a high reverb portion 
and the early reflections reach the ear almost simultaneously with the direct sound. 
The length of the pre-delay can be used to influence the perceived "distance" between 
the sound source and the listener. 

Mix: This controller sets the mix ratio between the original and the edited signal. For 
rooms, you can move a signal further into the room by increasing the effect share. The 
last four presets are intended for use in an AUX channel of the mixer and are set to 
100%. 

Presets 
The presets represent the basic settings for the various room algorithms, which can 
be still be varied along with the other parameters. Hence, they are more than just 
simply parameter sets. 
 

Delay 
This effect is like an echo which delays the signal and repeats it. 

Delay: This sets the period of time between the individual echoes. The more the 
control is turned to the left, the faster the echoes will follow each other. 

Feedback: This adjusts the number of echoes. Turn the dial completely to the left, 
there is no echo at all; turn it completely to the right and there are seemingly endless 
repetitions. 

Mix: This fader determines how much of the unprocessed original sound (dry signal) 
is subjected to the echo (wet signal). Application of this effect in an AUX bus requires 
the controller to be set to 100% (all the way to the right). 
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Audio effects in the mixer 

 

You can open audio effect devices in the mixer using the "FX" 
button found in each track or in the right master area.  

Under "Mastering" you will also find MAGIX Mastering Suite. 

"Reset" resets all effect settings to original values. 

 

Equalizer 

 

The 10-band equalizer subdivides the frequency spectrum into ten areas ('bands') and 
equips them with separate volume controls. This way it is possible to create many 
impressive effects, from a simple boosting of the bass to complete elimination of a 
certain range of frequencies. Note: If low frequencies are boosted too much, the 
overall sound level is heavily increased which may lead to distortion. In this event, 
adjust the overall volume downward by using the 'master volume' control situated at 
the bottom center of the effect rack. 

Slider control: Each of the ten frequency ranges can be separately boosted or turned 
down with the ten volume controls. 

Link bands: Using this button randomly combines the frequency ranges with each 
other in to avoid artificial-sounding overemphasis of an individual frequency range. 

Touch screen (right EQ section): This is the 'sensor field' of the EQ. Here you can 
draw any type of curve with the mouse. This will be immediately translated into a 
corresponding control setting on the left side of the EQ. 
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Compressor 

 

The compressor is an automated, dynamic volume adjustment controller. Louder 
passages become quieter and quiet passages become louder. A compressor is useful 
to make spoken passages more audible against background noise or music in case 
simple increase of the overall volume is insufficient. Several useful presets are 
included for this purpose, however compression may also be set manually. 

Threshold: Set the volume threshold, below and above which compression is applied. 

Ratio: This parameter controls the amount of compression. 

Attack: Sets the algorithm's reaction speed to increasing sound levels. 

Release: Sets the algorithm's reaction speed to falling sound levels. 

Gain: The gain controller amplifies the compressed signal. 
 

MAGIX Mastering Suite 
MAGIX Mastering Suite is a special effects rack for use with the mixer master 
channel. The effects in the Mastering Suite are used as part of the mastering process, 
in which the mixed music piece is given a final polishing. 

 

The On/Off switches switch the effects on and off individually. Each effect 
has a range of presets that can be selected from a list along the lower border 
of the effect. 
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Each effect can be reset by pressing the "Reset" button. 

 

Note: 5.1 Surround mode only provides the compressor (view page 189) and 
parametric equalizer devices in this case. 

 

Auto Mastering 
The Auto Mastering feature enables you to automatically apply the sound of typical 
musical styles from the past and present (e.g. 70s disco, 90s club, jazz etc.). The 
sound of the source material is analyzed and appropriate equalizer and dynamic 
effects are applied. 

 

1. Activate the Auto Mastering Wizard. 

2. Now choose a musical style.  
MAGIX Movie Edit Pro will analyze the audio material in the project. The settings that 
are used to achieve the optimal sound for a particular musical style depend on the 
audio properties of the source material. 

Use the "Original" interface in order to compare the original with the edited version. 
 

Parametric 6-band equalizer 
The parametric equalizer has six filter bands that you can use to shape the sound of 
the music track. Each band is a filter with a typical "bell shape". You can increase or 
reduce the signal level gain within a specific frequency range around an adjustable 
middle frequency . The width of this frequency range is called bandwidth. The 
bandwidth is defined by the Q value. The higher the Q value, the narrower and 
steeper the filter curve.  
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You can influence the basic sound of the mix by boosting or cutting specific frequency 
ranges (low Q value) to give it more "depth" (lower mids 200-600 Hz) or more "air" 
(Highs 10Khz). You can also decrease very specific frequencies (high Q-value) to 
remove unwanted noise. 

 

 

Sensor field: The sensor field displays the resulting 
frequency response of the equalizer. The frequency is 
displayed horizontally and the increase or decrease 
of the respective frequency is displayed vertically.  

The blue bullets 1-6  symbolize the six frequency bands. You can move them around 
with the mouse until you find the frequency response you want. The bandwidth (Q 
value) can be adjusted using the mouse wheel. 

The faders under the filter graphic display the parameters of the currently selected 
band. 

 

You can use the knobs to set the values for each band more precisely. There is also a 
numeric field for each parameter where values can be entered. 
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Gain: This controller allows you to raise or lower the filter. Setting the controller to 0 
deactivates the filter so it does not use any processing time. 

Freq: The center frequency of the individual filters can be set between 10 Hz and 24 
kHz with the frequency controller. The freedom to select frequency enables you to set 
multiple filters to the same frequency in order to have a greater effect. 

Q (Bandwidth): Here you can set the bandwidth of the individual filters to between 10 
Hz and 10 kHz. 

Bands 1 and 6 are special: Their Filter Curves can be edited in three different modes. 
The four editing points in the graphic have different functions in each mode. 

 
Peaking: Here the effect curve is brought closer to the working point (which 
represents the peak of the curve) from both sides simultaneously. 

 
Shelving (Basic setting): Here the working point displays the beginning of the 
filter curve. From this point on there is a gentle increase or decrease in the 
frequency. 

 
High or Low Pass:In Band 1 the working point displays the frequency which is 
filtered out of particularly high or low frequencies.  

 

 

You can control the output level of the equalizer with the Peak Meter 
. The output amplification beside it lets you offset the level changes 
resulting from EQ adjustments. 
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Multimax 

 

Multimax is a compressor with three independent frequency bands. The dynamics are 
edited separately for each band. 

The advantage of a multi-band compressor versus a "normal" compressor is that the 
"pumping" tendency and other unwanted side effects are dramatically reduced while 
editing the dynamics. For instance, it can prevent a peak in the bass range from 
suppressing the entire signal. 

Multiband technology also lets you specifically edit individual frequency ranges. 

Setting the frequency bands: The settings of the frequency bands are changed 
directly in the graphic. Simply click on the separator lines and move them. 

Lows/mids/highs: These knobs control the level of compression for each frequency 
band. 

Link: When this button is activated and a fader is adjusted, all other faders are 
changed proportionally. However, the way the dynamics are edited is not affected. 

Presets:In MultiMax, you can use Presets 2 to open further special features: 

• Cassette NR-B decoder: MAGIX Movie Edit Pro simulates decoding of Dolby B + 
C noise suppression if a Dolby player is not available. Cassettes recorded with 
Dolby B or C sound more muffled and dull if played back without the 
corresponding Dolby.  

• De-esser: These special presets help to remove overstressed hissing sounds 
from speech recordings. 
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Enhancer 
The Enhancer enables the justification of the audio material in the stereo panorama to 
be adjusted. If the stereo recordings sound unfocused and undifferentiated, an 
extension of the stereo base-width can often provide better transparency. 

Use the maximize function to move the echo and improve the stereo picture, for 
example, into the foreground. 

 

Volume controller: Adjusts the volume of every single channel to adjust the complete 
panorama. The reduction of left and right levels is displayed under the control 
buttons. 

Pan-direction: Use this controller to move the sound source from the middle into 
stereo panorama. The signals at the outer edges of the sound picture remain 
unchanged. 

Multiband: This option switches from "Stereo FX" to "Multiband" mode. Stereo 
editing only applies to the middle frequency, the bass and highs remain unchanged. 

Bandwidth/maximize sensor field: Adjusts the base width between mono (extreme 
left), unchanged base width (normal stereo), and maximum base width (wide, 
extreme right). Raising the bandwidth (values over 100) diminishes the mono 
compatibility. This means that recordings edited this way sound hollow when listened 
to in mono. 

Maximize strengthens the spatial component of the recording, which also increases 
the stereo transparency without influencing the mono compatibility. 
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Stereo meter (correlation gauge): This provides a graphical display of the phase 
relation of the audio signal. You can use it to review the orientation of the signal in the 
stereo balance and the effect of the stereo enhancer. To maintain mono-compatibility, 
the "cloud" shown should always be higher than it is wide. 
 

Limiter 

 

The limiter prevents clipping by automatically lowering the level 
if it is too high. Quiet parts remain unaffected. In contrast to the 
compressor it tries to leave the basic sound as unaffected as 
possible.  

 

Automatic track damping 
This command from the context menu automatically dampens the volume of other 
audio objects. The volume of the selected object on the track remains unchanged. 

 

Only original sound: Here you can also specify whether you want to dampen the 
original sound of the video or all audio tracks. 

Transition length: In the dialog you can activate and deactivate the value of the 
dampening. You can use this command while recording audio (view page 101) (Audio 
recording, advanced options). 
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Mixer 

 

The Mixer can be opened by pressing the "M" key or via the button bar in the main 
window (also: "View" > "Mixer").  
 

Mixer channels 
In the mixer, every project window track is represented by a corresponding mixer 
channel. The mixer channel offers a series of options for regulating the audio signals 
of objects in the track. 

 

FX: Opens (view page 188) the audio effects rack for the corresponding 
track. 

Auto: Activates the volume and panorama automation (view page 198) 
of the corresponding track. 

Plug-ins: Click the triangle button to access theaudio plug-ins (view page 
179) installed on your PC. 
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Volume: You can set the volume of a track using the large fader. 

The fader can be fine-tuned in the following way: 
• Press the Shift key while setting the fader. 

This makes the control range of the fader ten times larger. 
• While setting the fader, move the mouse away from the fader 

horizontally. The control range of the fader will increase in 
accordance with how far the mouse is from the fader. 

 

Stereo panorama: Use the knob to define the stereo position of each 
track.  

Note: Double-clicking on the volume or panorama control resets it to its 
default passive setting in which no processor output is required. 
Double-clicking again sets it back to its former position. 

 

Solo/Mute: The "Solo" button switches a track to solo mode, i.e. sound 
playback for all tracks which have not been switched to solo mode will 
be deactivated. "Mute" mutes the track. 

 

Effect channels 
In addition to normal mixer channels that correspond to the tracks in the 
arrangement, you can create two separate effect channels. The principle behind them: 
You can take a partial signal from a normal channel into an effect channel, where the 
partial signal is then processed with additional effects. This is a common process used 
in professional audio production. 

 

In each mixer channel there are two FX-Send knobs (FX 1 and FX2 ) 
under plug-in slots.  

Here you can determine the strength of the signal from the track that is routed into 
both available effect channels.  

The FX tracks are usually hidden in the mixer. When an FX-Send is used, they will 
appear to the left next to the master section. 
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An effect channel is a complete additional mixer channel with 
volume and panorama controls, an effect rack and two plug-in 
slots. 

Reverb is activated in the first effect channel by default because 
this is the most important application of send effects. 

The volume control regulates the strength of the effect channel and 
corresponds to an AUX return control. The"Mute" button is used to 
switch the FX function on and off. By activating "solo", you can 
listen to the effect channel separately. Track peakmeters that send 
to the FX track appear greyed out. 

 

Master channel 
The master channel is to the right of the individual channels. It controls the overall 
sound and offers all editing options: volume, panorama, plug-ins and effects. 

The FX buttons and the plug-in slots work just like in the other channels. The FX 
button opens the master audio effect rack. With "Reset" you can rest all mixer 
settings, including effect channels. 

Mastering: Here you can open the MAGIX Mastering Suite. 

5.1 Surround: This button switches the mixer into Surround mode (view page 202). 

Both faders control the total volume. 

Link buttons: If the link button is deactivated, the 
volume of the right and left channels may be set 
individually. 

 

Note: This function is available only in the Plus/Premium version. 
 

Volume and panorama automation 
You can automate volume and panorama for a track. This means that during playback 
you can record the movements of the sliders on the track. This way, for instance, you 
can simulate the movement of a sound source from left to right and make volume 
adjustment instantly during playback. 
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As long as the autobutton for a track is activated, all movements of the 
volume and panorama sliders will be recorded. 

The automation is displayed as a curve in the project window and can be edited later 
with the mouse. 

Note: The mixer's automation curves relate to a track, which means that they are 
independent of the objects contained on it. 

 

5.1 Surround 
MAGIX Movie Edit Pro supports playback and export in authentic 5.1 surround. 
 

Note: This function is available only in the Plus/Premium version. 
 

Requirements 
You will require a sound card or a sound chip which is integrated into the computer's 
motherboard with six individual outputs to playback the individual channels: 

• front left (L) / right (R) 
• centre (C) / subwoofer (LFE) 
• back left (Ls) / right (Rs) 

Surround playback is possible with all audio driver models (see Playback settings 
(view page 76)), (Wave, DirectSound). 

DirectSound is supported by most of the standard sound cards.  

Wave drivers are similarly supported by many standard sound cards; however, 
individual sound cards (for example, Soundblaster) require access to DirectSound.  

Output of the six output signals is achieved in all driver models in the output channels 
in the same (standardized) order: 

Channels 1/2: L-R 

Channels 3/4: C-LFE 

Channels 5/6: Ls-Rs 

When using WAV drivers, the loudspeaker settings normally have to be changed to 
5.1 playback in the control panel. On most systems the program does this 
automatically while using DirectSound. 
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Importing and exporting surround audio files 
Import 
When importing MPEG-2 files with surround sound (e.g. VOB files from DVDs or 
DVB-TV recordings), you can choose from two different applications: 

• Mixdown: Surround sound is displayed as an audio object under the video 
object, playback of the Surround track is reduced and recalculated to stereo 
playback. Use this option if you don't wish to edit the surround sound, but rather 
wish to export it. You can also use it if you think that a stereo export is enough 
to meet your requirements 

• Surround mix: The individual Surround channel pairs (L-R, C LFE, Ls-Rs) are split 
into three audio tracks as separate objects and the mixer is then set to Surround 
mode (view page 201). This mode allows you to change the Surround mix. 

Note: Downloading an audio package upgrade is required for importing surround 
files. This is done automatically when you first import a data file. 

In MAGIX Movie Edit Pro the import of surround is always executed as a mixdown. 

MAGIX Movie Edit Pro Plus and Premium can also import interleaved wave files 
(multi-channel wave files), multi-channel Windows Media Audio and MP3 surround 
files. A surround mix is always created. 
 

Export 
Surround mix exports can occur in any one of the following formats: 

• 6-channel PCM files (interleaved wave) 
• Windows Media files (as a surround soundtrack of a Windows Media Video or 

WMV-HD disc) 
• MPEG-2 files; requires downloading the audio package upgrade 

The files created are fully compatible with the normal file formats, this means that 
they can also be played on computers incapable of playing surround (in normal 
stereo). 

The export is performed via the same menu commands (e.g. "File -> Export movie -> 
Audio as wave") like the normal stereo export. You will then be asked if the export 
should be in stereo or surround format. 
 

Export 5.1 surround via Smart Encoding 
You can also burn original material with surround sound to DVD again without the 
need for the 5.1 surround codec or export the corresponding MPEG files while keeping 
5.1 Surround Sound. To do so, use the "Smart Rendering" option which transfers the 
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unprocessed parts of the original material to the destination file without renewed 
encoding. Read more on this in the MPEG encoder settings section General settings. 

Note: The import has to be executed as a mixdown, the audio material cannot be 
changed (no fades, no audio cleaning, no volume adjustment). Hard cuts are not 
made precisely according to the frame but at the GOP borders. 

 

The mixer in surround mode 

 

To activate surround playback, open the mixer (M key) and click on "5.1 surround" 
button in the master. 

In the master, six peak meters for the individual channels are provided. The normal 
panorama button turns into a representative display of the surround editor (see 
below), which can be opened by clicking on the display.  

The surround sound editor is also available to the effects tracks. For example, you can 
send the original track to the front L/R speakers, the FX track however will remain at 
the rear L/R speakers.  

The master volume is applied to all channels, here the left controller influences 
channels L and Ls, the right controller; channels R and Rs and the middle value of both 
controller; the channels C and LFE. 

The master plug-ins are only applied to the front channels. 
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The full effects palette of the mastering effects rack in MAGIX Mastering Suite is not 
available in 5.1 surround mode, but rather only the compressor and the parametric 
equalizer (from the Mastering Suite) are provided. The settings of these effects have 
the same effect on all six channels.  
 

5.1 Surround editor 

 

The selected mixer track's 5.1 surround editor allows you to arrange the audio signal 
of a track (displayed as two red sound sources) in stereo space. The signal is 
dispersed to the 5 (blue) loudspeakers which represent the individual surround 
channels.  

There are 6 channels: 
• L: front left 
• R: front right 
• C: center 
• Ls: back left/left surround 
• Rs: back right / right surround 
• LFE subbass (Low Frequency Effect) channel 

Dispersing the signal to the 5 loudspeakers occurs after the sound source emits a 
sound field of a certain level (displayed as red circles). The further away a 
loudspeaker's source is, the lesser its share of the corresponding loudspeaker channel. 
The position of the loudspeaker can be moved with the mouse. 

The subbass share (LFE) is set directly from the corresponding value table. It can also 
be changed by dragging the mouse. 

There are various modes in which you can use the source signal: 
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• Mono: The (stereo) source signal is seen as mono material, the left and right 
channels are mixed together and arranged together. The original stereo 
information is lost here. 

• Stereo 1: Similar to mono mode insofar as the left and right channels are moved 
together, but only a portion of the left source is audible in the loudspeakers L 
and Ls and only a portion of the right source in the right channels R and Rs. The 
stereo information remains as intact as possible. 

• Stereo 2: The left and right channels can be moved individually. The distance 
between the left and right source is retained when you move the left source. You 
can move an individual source by holding down the "Alt" key. 

• Center/LFE: Only the left channel is arranged. In return, the LFE share is drawn 
solely from the right channel. This mode is only important for importing 
Surround material. 

Width determines the level of the sound field of an individual source. 

Automation 
Panning of the sound source on the loudspeaker can be automated to simulate 
movements in the room.   

For this to happen "Automation" must be activated. There are two methods to create 
automations: record and draw. 

To record (when automation is on), the sound source is moved between the 
loudspeakers during playback. When recording the automation, the "Record" check 
box lights up red. 

The draw function is an alternative to drawing out complex movements. When 
drawing in active mode, all panning movements are transmitted to the time interval 
between the start and end marker (when the mouse button is held). You can thus 
draw the entire movement curve for the selected time range. 

"Reset" deletes surround automation from the track. 

There is no automation of the parameters for width and LFE, of the distance 
between the left and right source in "Stereo 2" mode, or of the loudspeaker 
positions. 

 

Scrubbing 
The term "scrubbing" originates from the age of cassette players and provides quicker 
monitoring of passages of a film or a piece of music. The function plays short samples 
at the original speed. 
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Note: In order to preview individual audio objects completely, use "Preview (view 
page 68)" mouse mode. 

 

Activate scrubbing 

 

Scrubbing can be activated by right clicking the 
speaker button. 

 

Scrubbing: Modes 
No scrubbing: Scrubbing is inactive. If the playback marker is set or moved, then 
sound will not be played. 

Scrubbing (1 frame): Scrubbing is active and samples are only 1 (video) frame in 
length. The speed is 25 fps, i.e. 1/25 second. This mode is suitable for positioning the 
playback marker exactly. 

Scrubbing (long): Scrubbing is active, the sample length amounts to approx. 0.5 
seconds. In this mode, locating specific events is particularly easy. 

Play 1x with scrubbing: If this option is active, the current position will be played one 
time. If it is inactive, then it will be repeated. 
 

Using "Scrubbing" 
If scrubbing mode is selected, set the playback marker to a certain location in the 
timeline using the mouse. Hold the mouse key and move the playback marker to 
various locations in the arrangement. 

 

Scrubbing may be used also by employing the jog and shuttle wheel on the video 
monitor, as well as through various hardware controllers, which gives the software the 
feel of an analog video editing system! 
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MAGIX Soundtrack Maker 
MAGIX Soundtrack Maker automatically generates music tracks that correspond to 
the indicated mood. Even mood changes are possible. 

You can open MAGIX Soundtrack Maker by going to "Edit" > "Assistants (view page 
286)". 
 

Select music style 
Choose a musical style first.  

The option "Apply to selected range only" limits the length of the background music 
you want to create.  

Note: The "Apply to selected range only" function will only work if an emotion has 
not been set outside of the selected area. Otherwise, the soundtrack will be used up 
to the point where the selected emotion is in place, so that there are no gaps in the 
soundtrack. 

Range start and end may be set with the left and right mouse button if MAGIX 
Soundtrack Maker is open. 

 

 
 

Set mood change: 
You can select a mood from the list. 

 

Preview audio: Preview the selected mood here. 

Position: Use the position slider to skip to a certain position in order to set the mood 
for a certain position. The start marker may be moved instead with the left mouse 
button. The preview will be displayed in the video monitor simultaneously. 



 

206   

www.magix.com 

Add emotion: This button inserts the selected mood at the current position. MAGIX 
Soundtrack Maker will then suggest a new position for the next emotion by 
repositioning the position slider. Of course, you may also position this elsewhere to 
insert further moods. 

Delete emotion: Removes the currently set. 
 

Generate background music 
Clicking "Create soundtrack" creates a new soundtrack. "Progress" shows the current 
status. 

Note: Soundtracks you create are beat-based. In most cases the length of the 
soundtrack will not match the marker positions, so that the track can play. These are 
frame-based and as such, can be set to a more precise grid than a beat-based 
soundtrack.  

 

Variations: If the background music that has been created is not suitable, a variation 
may be created. This process may be repeated for the entire background music as 
well as for individual emotions: 

• If you want to vary the entire background music, then click on "Create 
variations". 

• If you only want this to apply to a certain emotion, then move to it with the 
position slider first in the dialog (or the play marker on the main screen). Then 
activate the option "Vary only selected emotions". Now click on "Create 
variation". 

Automatic cut adjustment: This option re-arranges the video and photo objects in 
your project to match the music. Make sure to deactivate this option if you do not 
want this function. 
 

Mixdown of audio objects 
If the project window becomes too full to manage, the system is out of RAM, or you 
just want to "summarize" your production, use the mix down function to convert the 
entire audio arrangement into a single audio file. Just click on the mix down button in 
the button bar or select the function from the "Processing" menu. 

You can choose a name and a destination for storing the mix down object. The default 
directory is "My audio/video". 
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Storage of the audio arrangement will take up a little more space on your hard-drive, 
but it requires less RAM for playback than an unmixed entire arrangement.   

Note: The mix down effect optimizes the volume automatically. Even if the mix 
down function is used various times, you will not lose audio quality. 

 



 

208   

www.magix.com 

Stereo3D (Plus/Premium version) 

Warning for small children: The eyesight of small children (especially those younger 
than six years old) is not fully developed. We recommend referring to a doctor or 
optometrist prior to allowing your child to view 3D-videos. 

MAGIX Movie Edit Pro Plus and Premium also enables creation and editing of 
"genuine" 3D videos and photos. First, let's create an overview of this complex topic 
by familiarizing ourselves with the most important principles and the golden rules that 
are involved. Next, we'll look at the individual steps of the workflow in more detail. 

Note on using 3D content: Some people experience unpleasant symptoms (e. g. 
headaches, overexertion, eye strain or nausea) when they are exposed to 3D video. 
We recommend taking regular breaks for this reason. In case of problems, the user 
should immediately stop use and refer to a doctor or optometrist. Incorrect 
production of 3D-content may also produce these symptoms. 

 

3D basics 
Human eyes perceive objects from 2 different angles and our brain "calculates" 
images from this information. This way we can tell the distance and position of an 
object. For this reason, 3D material should be shot according to this principle. 

Viewing 3D 
A regular screen or TV can show images only in 2 dimensions, and various 
technologies have been developed to enable perception of images in 3D. To this day, 
all technologies share the following: You need special glasses to deliver different 
information to the left and right eyes. We will examine these technologies in detail 
later. 

The three golden rules 
• Stay within limits during recording: To make a 3D recording (view page 209) 

with realistic depth information, certain limits must be respected. The most 
important rule is not to go below the point of minimum distance. Minimum point 
is the point in the picture, where the camera is the closest. 

• Frame closest point: In order to place the 3D effect behind the imaginary frame, 
both image components must over lay each other exactly at the closest point. At 
the same time, the same objects must be visible at the edges of both partial 
images, for which, if needed, you can use the Cropping function in the Media 
Pool (view page 149). 
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Note: The imaginary window is a type of a plane, behind which the 3D movie plays. 
You select the closest, frontmost point. Not keeping up with this rule can result in 
the object to "jump out" of the imaginary window, which when used too much, can 
cause headaches. 

• Maintain realistic eye angles: Object with a 3D depth effect viewed as a 
red/cyan image (Anaglyph) without glasses will appear displaced. This 
displacement should, if possible, take up less than 1/30 of the entire image. 
Otherwise, it will appear that the eyes are looking in different directions. 

Notice: Displacement may only occur along the horizontal axis. Displacements on 
the vertical axis and rotated portions must be adjusted. 

 

Record 3D 
The distance between eyes in humans is ca. 65 mm, which forms the so-called 
"stereo base width". But because our eyes are dynamic and we can even "cross" our 
eyes, it is possible to focus on objects that are closer. 

Various techniques exist for 3D recording. Each method has its advantages and 
disadvantages: 

• 3D cameras with two lenses: The advantages are obvious; these cameras 
produce 3D material without excessive work involved. The disadvantage is that 
the stereo base width (lens distance) cannot be changed. 

• Two cameras on a special mount: This involves a little more work. Two cameras 
are mounted on a special support to record material for the left and the right 
side of the 3D image simultaneously; microphone booms for stereo recordings 
may also be used for this purpose. 
The disadvantage in this case is that the shutter releases have to be pressed at 
exactly the same time if there are moving objects in the picture. In case of video, 
both movies must be synchronized before being edited. 
Advantages: Stereo base width may be changed by adjusting the distance 
between the cameras; larger selection of camera models. 

• Two photos via the same camera: This technique only allows still images. The 
camera is simply used to record two images from different perspectives, and 
these are used as the right and left images. For best results, use a tripod. 

• Consistently fast camera movement, e. g. along a street: Only a single 
conventional camera is required in this case, but the range of applications is very 
limited. This is the most cost-effective method for creating 3D videos. Material 
is filmed at a speed of circa 6-to 15 km/h. During editing, the edited video object 
is duplicated and one of the videos is played back with a time lapse. The 
movement direction determines which is the right and left image. 3D photos 
may also be created using this method. 
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Warning, minimum distance! 
The position of the object closest to the lens is designated as the minimum point. This 
minimum point may not exceed a specific minimum point; this is easy to calculate via 
the following formula: 

Note: Lens focal point (e. g. 25 mm) x stereo base width (e. g. 65 mm) x 1.5* /1 
mm= minimum point (2437.5 mm ~ 2.44 m) 
*1.5 is a factor derived from the cut-off appearing when filming through a lens. 
**1 mm is the so-called "deviation" or "spatial dimension". This only involves a rough 
value in this case. 

Examples for 3D cameras: 
Panasonic HDC-SDT750 ( base width 12 mm): minimum point is approx. 1.5 m. 
Fuji REAL 3D W3 (base width 75 mm): minimum point at approx. 3 m; for long-
distance recordings as much as 8 m. 

This so-called minimum point has an important role in other aspects of 3D editing. 
 

Prepare 3D editing 
3D videos are filmed and saved by different cameras, which means: depending on the 
camera model or recording method, the videos or images vary. 

In one file 
Many cameras, especially for photo recordings, create one single file containing the 
left and the right image next to one another. 

• Drag these files from the Media Pool directly into your arrangement.  
• Select the created objects. 
• Select the "Side-by-Side (left images left/right)" entry in the Media Pool under 

"Effects > Stereo3D > Properties > Create stereo". 

In multiple files 
Some 3D cameras create a file for each the left and the right side. This working 
technique works also if you simply take 2 pictures with a regular photo camera. 

• In the Media Pool, open the folder in which the desired file can be found. 
• Sort the files in increasing order according to the date. This way, all files will lie 

in pairs one below the other. 
• Now, select the files and drag them from the Media Pool directly into your 

arrangement. 
• In the Media Pool select "Side-by-side (left image right/left) under "Effects > 

Stereo 3D > Properties > Create stereo" for material with halved width. 
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Note: If you have created side-by-side material yourself (e.g. placed two photos next 
to each other in an image file), proceed as described, but at the end select the "side-
by-side (left image left/right)" for material with full width. 

 

Note: To load MVC material into MAGIX Movie Edit Pro, you must first activate this 
codec for a fee (view page 338).  

 

Set playback mode for 3D 
There are various techniques available for playback of 3D videos on the computer. 
Depending on the technology used, the corresponding playback mode may be 
activated in MAGIX Movie Edit Pro. 

 
Select the 3D mode you want to work with in the upper left corner of 
the video monitor. 

Here is a list of available techniques and the corresponding requirements: 

3D mode Equipment Requirements 

View partially interlaced Polarizing filter • Polarizing filter glasses 
• Special monitor, typically 

referred to as a 3D monitor or 
 similar 

Note: You can choose between right or left image first, depending on which type of 
display produces better results on your monitor. 

Shutter export Shutter mode • nVidia 3D Vision Kit 
• 120 Hz monitor/projector 

Side-by-Side- 
Display 

Side-by-side • 3D TV device 

Note: You can choose between right or left image first, depending on which type of 
display produces better results on your monitor. 

Note: These three modes should be set only when the preview image is to be 
exported to a separate monitor or TV device. Shutter mode also requires a 3D-
capable graphics card. 

Anaglyph display Color anaglyphs • Red/cyan glasses 
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Align videos and images for 3D 
Anaglyph display is recommended for this and can be set in the video monitor (view 
page 211). Precise geometric alignment of images is only possible in this mode. 

Note: If you want to edit 3D-video material, it is recommended to conduct scene 
recognition and split the video into individual scenes. This is necessary because the 
left and right side of each scene must be arranged individually. 

The so-called minimum point is the point in the 3D picture that is closest to the 
lenses. This forms the "center" of the 3D image and must be defined as such in 
MAGIX Movie Edit Pro. 

To do this, go to the Media Pool and select the option "Effects" -> "Stereo 3D" > 
"Alignment".  

 

Move both images one over the other so that the minimum point of both sides is at 
the same location on the screen. 
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You should first see whether automations for spatial adjustment and synchronization 
deliver the desired results. Click on the button "Automatic". 

If you notice that the left and right images are on the wrong sides, click on the "Swap" 
button to reverse this. 

If this does not produce the desired effect, proceed as follows: 

• Find the minimum point in the image. 
• If the images are offset vertically, they need to be balanced using the lower of 

the two slide controllers under "Spatial alignment". 
• If the images have rotational differences, you have to adjust these with the knob. 
• Try to position the minimum points of both sides precisely one above the other 

using the upper slider. 
• To test the results, put on the cyan/red glasses. In case the image has an 

exaggerated spatial depth, try to position the left and right sides closer to each 
other using the controls under "Spatial alignment". 

• Use perspective correction in case the left and right image haven't been 
recorded in quite the right perspective in relation to each other in order to be 
able to join them into a single clear 3D image. Enter values into the dialog or 
drag on window edges in the video monitor. 

 

Turn camera movements into 3D videos 
Camera movements may be transformed into 3D videos by being duplicated and 
converted via time displacement. To do so, you can simply record on the right or the 
left side while, for example, driving along a street. 

The speed should be set between 6-15 km/h (approx. 4-10 mph) and depends on the 
frame rate, the focal point, and the distance of the objects being filmed (among other 
things). At increased speeds, it may occur that the spatial impression is too strong 
and the filmed material seems unnatural and unpleasant. 

• If the video is in the arrangement, the stereo depth for the 2D object may be set 
in the Media Pool via "Effects -> Stereo 3D --> Properties". 

• Depending on the direction of the recordings, you will have to move the control 
either to the right or the left.  

• Check the results in the anaglyph display with red/cyan glasses 
• Correct any unrealistic effects by adjusting the controller in the opposite 

direction. 
• If the spatial depth is exaggerated, reduce the changed parameters. 

Note: Not only camera movements, but also other 2D materials may be arranged 
spatially. 

3D material may be edited with the same functions as 2D material. 
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Export and burn 3D videos 
There are no special requirements for export and burning. Only the desired 3D 
technique is specified. 

Anaglyph: This technique is recommended for uncomplicated playback of finished 
videos or playback with conventional TV sets or projectors. Viewers must simply put 
on a pair of red/cyan glasses to be able to enjoy a 3D movie. 

Side-by-side: Create 3D movies for a 3D-capable playback device without having to 
compromise the quality. It doesn't matter initially whether your video is viewed in 
"Shutter" mode or in "Polarized filter". 

• Depending on your playback device, you should set double resolution in order to 
produce full resolution for both the right and the left image. 

• Not all playback devices are capable of double resolution. If this is the case for 
your device, 50 % pinched images will be displayed. The quality is nevertheless 
higher than output using the anaglyph technique. 

Note: When exporting to side-by-side-formats, make sure that the vertical 
resolution is the sum of both images, but the aspect ratio (e. g. 16:9) is based on a 
cropped image.  

Only left/right side: This settings exports only one side of your 3D video instead of 
the entire 3D video. 

Lenticular image: This allows you to view 3D footage without 3D glasses. The footage 
is displayed interchangeably to give the impression that it is wiggling or shaking. 

Superimposed: This export option is similar to „Side-by-Side“. The images are 
superimposed during output. 

• Depending on your playback device, you should set double resolution in order to 
produce full resolution for both the upper and the lower image. 

• Not all playback devices are capable of double resolution. If this is the case for 
your device, 50 % pinched images will be displayed. The quality is nevertheless 
higher than output using the anaglyph technique.  

Note: When exporting to superimposed-formats, make sure that the vertical 
resolution is the sum of both images, but the aspect ratio (e. g. 16:9) is based on a 
cropped image.  

Export files/upload movies to the Internet 
The standard path for all file exports is "File > Export" or "File > Internet". Depending 
on the export format and destination, the export dialog also allows the 3D technique 
to be used to be selected. 
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For direct selection as Windows Media Video 3D, click "Output" and select "3D 
movie" from the dialog. 

Burning 
When burning a Blu-ray Disc or DVD, you must first open the encoder settings in the 
burn dialog and set the desired 3D technology. Next, you may proceed to burn the 
disc as usual. 
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Special functions and wizards 
In this chapter, we will introduce you to some of the especially useful special 
functions.  
 

Proxy editing (Plus/Premium version) 
If performance deteriorates and playback becomes shaky due to hardware limitations, 
hi-res source material or very complex projects, it is recommended to use proxy files 
for editing. Lower resolution copies of the original file in a format that is better for 
playback are created and used for the editing process. The original files in a higher 
resolution are then used for the export process by default. 

You can activate the "Create proxy files automatically" function directly in the start 
dialog or at a later time in "File" > "Settings" > "Movie..." > "General movie settings". 
By default this option is not selected. 

When this option is activated, proxy files will automatically be created for all video 
files imported to the arranger or the project folder. 

Note: Make sure there is sufficient memory available if proxy files are going to be 
created. 

You can set the quality of the proxy files in the dialog "Configure proxy and preview 
rendering" > "Presets". Shortcut: Alt + R. The rendering process can be canceled by 
pressing the "ESC" key. Proxy files will not be created if the quality settings for them 
are higher than the quality of the source material. 

• It is not possible to create proxy files on an FAT file system (such as on an SD 
card) so the source material for proxy files should be saved on an NTFS drive 
(Windows standard). 

Tip: You can activate or deactivate proxy files using the Quick function (view page 
45) for a smoother playback. This is useful during proxy editing if you want to 
quickly check how an effect will look on the original material. 

Use proxy files during rendering: If you want to burn your HD material to DVD, you 
can reduce the rendering time. Activate the settings "Best performance for DVD" in 
the dialog "Configure proxy and preview rendering" before the proxy files are created. 
This will ensure that the quality of the proxy files is sufficient for output on DVD. You 
should also activate the option "Use files created during rendering for export and 
burning" to use the proxy files during export. 
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Preview rendering 
With MAGIX Movie Edit Pro you can pre-render specific sections of your movie. This 
is especially useful if smooth playback is not possible due to the applied effects and 
transitions. The advantage versus the option "Combine audio and video" in the "Edit" 
menu is that all of the objects will be maintained in the arrangement. The rendered 
material will only be played in the background when the playback marker reaches the 
corresponding position. 

 

Preview rendering is available in timeline mode and multicam mode.  

Note about multicam mode: Only the source tracks will be rendered, not 
the target tracks. 

MAGIX Movie Edit Pro offers two options: 

• It can automatically indicate all sections that can be rendered. 
• Or, alternatively, you can indicate the section that should be pre-rendered 

manually. 

Note: The format that is used to render can be set via "File" > "Settings" > "Proxy 
and preview renderings" (view page 83). 

 

Automatic preview rendering 
When using automatic preview rendering, you don't have to think about which 
sections could be affected. MAGIX Movie Edit Pro analyzes your computer's 
performance and determines which sections can be considered for preview rendering. 

To perform automatic preview rendering, proceed as follows: 
1. Click on the preview rendering button in front of the timeline. 

 
<MAGIX Movie Edit Pro will then analyze which sections should be pre-rendered. 
A dialog will appear, indicating how many areas have been located: 
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These sections will be additionally marked in the MAGIX Movie Edit Pro timeline 
using red bars. 

 
2. Select "Yes" in the dialog to start preview rendering.  

The red bars will appear green after preview rendering is over. If you make 
changes in the pre-rendered section, it will appear red again and will have to be 
updated (view page 218). 

3. If you choose "No" instead, you can still conduct preview rendering later. 
 

Manual preview rendering 
In manual preview rendering you first have to identify the section with potential 
problems. 

1. Place an in and out point above the range to be rendered. 

 
2. Finally, click on the "Preview rendering" button. 

A preview rendering dialog will appear. 
3. Selected "Section". 

The preselected range will now be rendered. 
After rendering, a green line appears in the timeline to symbolize that this range 
has been rendered. 

 
The section will remain green as long as no further changes are made to it. The 
green line will then turn red and can be updated again. 

 

Update preview rendering 
Preview rendering is effective only as long as no changes are made to the pre-
rendered area. You can recognize a prerendered area from the green bars appearing 
above it on the timeline. As soon as an object in the section has been edited, the 
green bar will turn red. You can update this section at any time.  

1. To do this, place the playback marker inside the section to be updated. 

2. Click on the "Preview rendering" button:  
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3. In the preview rendering dialog select "Section" in order to update just the 
section selected by the playback marker. If you select "All", all non-rendered 
(red) sections will be rendered. 

 

Use movie templates 
Use movie templates in order to tell a whole story using just a few mouse clicks. 
 

Note: This function is available only in the Plus/Premium version. 
 

Opening movie templates 
All movie templates in the Media Pool can be found under Import > Movie templates. 
Select the movie template according to the desired length of the movie. Double 
clicking on a movie template opens it for filling. 
 

Insert your own material 
Manual filling 

 

You can insert your content anywhere you see a media 
placeholder (see illustration). 

The specified length will be displayed on the media 
placeholder. The length cannot be changed. 

The placeholder icons indicate which type of material 
should be inserted here (e. g. group shot, landscape, 
close up). 

1. Drag the desired image or video from the Media Pool or the project temp folder 
in front of the placeholder to be replaced. 
If your inserted video is too short, it will be rejected by MAGIX Movie Edit Pro. 

 
Images always have the length of the controlled media placeholder. 
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2. If the video is too long for the media placeholder, move the position of the video 
in the editing area. 

 

Automatic filling 
To add content quickly, use automatic filling.  

Select multiple media items in the Media Pool or in the project temp folder and drag 
them over the movie template. A field will appear where you collect your media. The 
movie template will now be automatically filled. The order of the media items in the 
template determines the date of the files; the sections are selected at random.  

Note: Depending on the template, either the entire template will be filled with the 
video footage or individual placeholders will each be filled with a video from the 
selection.  

If you do not like the compilation, click on "Reapply" and the program will select new 
video sections. 
 

Design title 
• To customize the text, click on the corresponding placeholder and enter the 

desired text to the right of the editing area in the text field. 
 

Further use of movie templates 
Burning (view page 246) and Exporting (view page 263) a filled template works just 
like with any other project. In the "Burn" screen you will find menu templates that are 
specially adjusted to menu templates in the "Menu templates" (view page 249) 
categories. 
 

Manually editing a movie template 

 
Click this button if you want to customize the movie template in detail. The 
movie template will be transferred to the known edit screen and every object, 
every transition, every music title, etc. can be customized. 

Note: You cannot return to the movie template wizard. 
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Automatic scene recognition 

 

Automatic scene recognition can be opened via the "Effects" menu. The scene 
recognition function analyzes the film for scene transitions and scans for drastic 
changes in the brightness and color distribution within the picture.  

Automatically created timestamps from digital video devices (the points in time at 
which the device was turned on and off) are also marked as scenes. 

• First, select "Start" from the "Scene change" box. The search for possible scene 
transitions will begin. If you have a large amount of material, then this may take 
a while, but the image analysis has to be done just once for each recording. The 
results are saved together with the video file. 
If the scene recognition is performed again with the same source material, then 
the scene transitions found are immediately displayed. If you are still not happy 
with the resulting scene partitioning simply repeat and correct where necessary. 

• All found scene transitions in the list can be checked in the dialog. Every scene 
marker can be selected or deleted. Select a scene transition from the list of 
found scene transitions and use the preview images to check whether the found 
transition is really a scene change or not. 

Tip: This option is helpful, for example, if a camera flash was captured in the source 
footage. The flash from the camera would cause a sudden brightness modification 
even though there was no actual scene change.  

The preview always displays the end of the previous scene and the beginning of the 
new scene. If the images do not differ except for the brightness, then the scene may 
have been falsely recognized. In this case select "Delete scene marker". 
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Via the zoom +/- buttons you can enlarge the part of the project window where the 
selected scene begins or previous scene ended.  

You can use the "Sensitivity" controller to change the sensitivity of the scene 
recognition to detect different scene changes, depending on the settings. 

"Action on OK" lets you specify whether the movie should be cut at the selected 
scene transition or at all scene transitions and whether the found scenes should be 
saved as takes.  
 

Travel route animation 
Using the travel route animation, you can quickly create maps with animated travel 
routes. You can start travel route animation with the "Edit" menu > Wizards > Travel 
route animation" or in the Media Pool > Import > MAGIX Tools > Travel route...". 

If you have imported photos with GPS geotags into your movie, you can create a route 
that will appear as transitions between the photos.  

• Position the photos from the start of the trip and the end of the trip directly 
beside each other and select the first photo. 

• Start the travel route animation. The locations will automatically be entered on 
the map. 

• Click on "Animation", save the route as a video and close the travel route 
animation feature. The travel route video will automatically be inserted between 
the photos including transitions. 

If there are no photos with GPS information, the travel route animation will start 
without locations. Select the locations on the map yourself to export a travel route. 
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Program interface of the travel route animation 

 

 Map: Displays map material from openstreetmap.org. 

 Selected locations: All locations, searched using geonames.org or selected 
manually on the map, will be shown on the list and marked using pins. 

 Map section + zoom: The map may be moved by pressing the arrows. "Zoom" 
enables you to zoom into the current section (+) to view more details or to zoom 
out (-) for a better overview. 

 Show lines: If at least 2 locations are marked on the map, then this function will 
be available for linking the locations. The line color and thickness may be 
changed. 

 Animation: You can animate your travel route and save as video in WMV 
format. 

 Save as image: The current map section may be saved as an image in the format 
PNG, BMP, JPG, or TIFF. 

 

Note: This function is available only in the Plus/Premium version. 
 

Select locations on the map 
There are several options for selecting locations on the map for creating a travel route. 
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Note: The map section will adjust itself depending on how many locations you select 
and where they are. If you would like to view details about a location, simply zoom 
via "+" on the number block or mouse wheel into the detail view. 

Search and select locations: 

 
1. Click on the "+" button below "Edit destinations" to add an entry. This new 
entry will appear blue below existing locations. 

2. Assign the new location a name and press enter. The destination will be added 
to the map. An additional marker is set for the start and end of a route. 

Note: If there multiple locations could be possibly indicated, a list with possible 
choices will open. You can determine the destination by picking one from the 
list with your mouse.  

 

 

If important intermediate stages of the route should also have a 
marker, click on the marker symbol in properties (arrow down) of the 
destination. 

Set destinations manually: 
 1. Move the map boundary by clicking on the map and holding down the mouse 

key so as to make the desired destination visible. 

 
2. Click on this button under "Edit destinations" to activate manual entering of 
locations, or use the keyboard shortcut "M". 

3. Click the target destination on the map. The new entry to the list will be 
created. 

Search destination anew: 

 

If the destination is incorrect, you can search the location again in 
order to adjust the position of the marker. 

Enter a new name in the entry field and click on the magnifying glass or 
press enter. 

Rename destinations: 

 

You can rename a destination without changing it by going to its 
properties (arrow down). 
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Object follows route: 

 

Various objects can follow the route from 
destination to destination. 

Import GPX file: 

 If you have created a route with a GPS device and saved it as a GPX file, you can 
import it and show the route on the map. 

Note: Depending on the length of the route, it can take some time for the file to be 
imported and displayed. 

 

Adjust & delete keyframe 

Change the sequence of destinations: 
The order of destinations in the list corresponds to the sequence in which they were 
created. You can edit the order of the destinations by clicking on a location on the list 
and dragging it to a new place with the mouse key held down. The route on the map 
will be adjusted. You can see this especially well if you've activated the line (view 
page 227) in order to optimize the travel route display. 

Adjust the position of the destination: 
You can adjust the position of a destination by grabbing the marker on the map with 
your mouse and dragging it with the depressed mouse key to a new position on the 
map. The marker will be moved, the travel route adjusted and the new name of the 
destination will be automatically changed in the list. 

 

Note: If the destination marker doesn't appear, you can activate it in 
the properties (arrow down) by clicking on the marker symbol. 

 

Hide destination: 

 

Click under properties (arrow down) of a destination on the eye 
symbol. The destination will remain in the list, but will be hidden on 
the map and will not appear in the route. Click on the eye again to 
display the location again. 

Remove destination from the list: 

 
To delete a destination from the list and the route, click on this button next to 
the destination. 
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Save and load routes 
The entire list of marked locations may be saved to load it later - without having to 
search for and select all of the locations again. 

Save as file: 
 

• Click on this button under "Edit destinations" or use the keyboard shortcut 
"Ctrl + S". 

• Enter the save location and name of the location list in the dialog that 
appears. 

• Click "Save" to back up the list and quit the dialog. 

Open list: 
 

• To load a saved location list, click this button under "Edit destinations" or 
use the keyboard shortcut "Ctrl + O". 

• Navigate to the save location and select the location list in the dialog that 
appears. 

• Clicking on "Open" closes the dialog and opens the list with saved 
destinations. 

 

Adjust map section 

 

Use this button to move the map section upwards (north), to the right 
(east), downwards (south), or to the left (west).  
The arrow keys on the keyboard may also be used to move. 

Click on the point between the arrows to move the map window in order 
to center the selected destination. 

 

 

Use this controller to zoom out of the map (-) or into it (+). The keys "+" and 
"-" on the keyboard or the mouse wheel may also be used to zoom in and out. 

 

If you would like to show all marked locations and reveal as much of the map 
as possible, click this button and the map will be adjusted automatically. 

 If you would like to display only the route without the location markers, click 
here and the pins will be hidden. A repeat click will display them again. 
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Show lines (connect locations) 
For two or more marked locations, the function "Show lines" will appear. This function 
connects destinations on a map with a line in order to better visualize the route. 

 
Click this symbol to show lines connecting selected locations. The functions 
responsible for line transparency, thickness, and color are to the right. 

Tip: The order of destinations in the list corresponds to the sequence in which they 
were created. You can edit the order of the destinations by clicking on a location on 
the list and dragging it to a new place with the mouse key held down. The route on 
the map will be adjusted and the line will follow a different course. 

Hide line: To hide the line, click on the "Lines" button again. 

 

Transparency and line thickness: Use the controller to change 
the transparency (left controller) and the thickness of the lines 
(right controller). 

 

Line color: Set the desired line color using the color field and 
slider. 

Tip: You can also create animations for the connecting line in the "Animation" (view 
page 227) section and save it as a video. 

 

Animation 
For two or more marked locations, the function "Animation" will appear. 

 

This enables you to display your travel route in motion and even save it 
as a WMV format movie, e. g. to integrate it into vacation movies or to 
send it. 

Scroll map: Activate "Scroll map" and the map will move from location to location 
when the animation is played back. 

Animate line: The connecting line slowly connects all selected locations, from the first 
to the last. It moves at exactly the same speed as an animated object. 

Soft animation: The animation starts slower, speeds up, and then slows down before 
each location. 
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Animate object: You can select an object to follow the route, such as an auto or an 
airplane. This function is used when no particular object has been selected in the "All 
destinations list". 

Duration (seconds): You can adjust the duration of the animation however you like, 
depending on the length of the route. Enter the duration of the animation in seconds. 

 

Preview: Before you save an animation as a video, test it to see if it looks the 
way you want. 

 

 

Click on this button to save the animation as a video. Enter the 
save location and name of the video in the dialog that appears. 

Note: This button indicates the height and width of the future 
image. These values are adjusted as soon as window sizes are 
adjusted or when the location list is shown (arrow next to 
"Destinations"). 

Close: Click this to leave the animation area. 
 

Create a picture of a map 
You can create a picture from a section of a map (including location markings), e.g. to 
print it. 

Step 1: Zoom into the map until you have reached the desired level of detail. 

 

Step 2: Click this button (shortcut "Ctrl + E") and enter the save 
location and the name of the image in the dialog that appears. You 
may also select the format for the picture. 

Note: This button indicates the height and width of the future image. These values 
are adjusted as soon as window sizes are adjusted or when the location list is shown 
(arrow next to "Destinations"). 

Step 3:  With one click on "Save", the image is saved and the dialog is closed. 

 
If you want to, you can hide the list of locations to the left to show a larger 
section of the map. 
Another click on this symbol will show the list again. 
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Options 
Benchmark: The map legend appears/disappears and also appears on the image or in 
the video. 

Mouse position: The GPS coordinates for the current mouse position appear in the 
lower right-hand corner on the map when this option is activated. Use this option 
together with the "Set destinations manually" function to set destinations precisely. 

Distance:Calculates the total length of the route. 

Map: Specify which maps you want to use. Use the "Shift + M" shortcut to change 
maps when the focus is on the map. 

Hide: Click this to leave the options. 
 

Shortcuts 
Manually mark locations M 

Zoom into map "+" on the number block 

Zoom out of map "-" on the number block 

Save location list Ctrl + S 

Load location list Ctrl + O 

Save map section (with location markings) as 
image 

Ctrl + E 

Move map section north (upwards) Up arrow 

Move map section east (right) Right arrow 

Move map section south (downwards) Down Arrow 

Move map section west (left) Left arrow 

Cancel video export Esc 

Change map  Shift + M 
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Produce panorama pictures 
This special feature can be applied to selected photos by going to "Effects" > "Video 
object effects" > "Create panorama". Using it, you can combine several photos into a 
wide panorama photo. 

Tip: Optimize you photos beforehand, so that the transitions are not to be seen in 
the finished panorama. 

 

Select pictures for panorama 
Load all necessary images into the film project as usual. The images that should make 
up the panorama should be selected one after the other while holding down the 
"Shift" key. Select the entry "Create panorama" from the context menu "Effects" (view 
page 291) > "Video object effects". 

 
 

Invert image sequence for panorama image 
Sometimes photos are accidentally loaded in the wrong sequence.  To sort the photos 
properly, click on the "Invert sequence" button. 
 

Calculating the panorama image 
If you click "Create", the panorama image will be processed. Depending on the 
resolution and number of original images included, this may take some time. The 
original photos are replaced in your slideshow with the panorama image you've 
created, but the original files on the hard drive will remain intact. 
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Hint: You can create a panorama image from a maximum of six images. Click on 
"More options" for more information on the upgrade. 

 

Finished panorama (2 images) 

 

Finished panorama from 2 images 
 

360° videos 
360° videos are videos, in which video is recorded in all directions simultaneously. 
Special cameras are used for this, consisting of several normal cameras that record in 
different directions. In the simplest case, they're two cameras with super wide angle 
lenses that record in two directions; better models use six or more cameras.  

The result is that the viewer can view "around" him or herself by determining the view 
direction.  To do so, drag the mouse during playback on PC. On mobile devices, the 
built-in orientation sensor can be used: The view direction follows the device's 
rotation. In combination with VR glasses or a smartphone attachment such as 
Samsung Gear VR or Google Cardboard, it is possible to be completely submerged in 
a virtual environment with a 360° video. 

360° videos are supported by the most important video platforms like YouTube, 
Vimeo and Facebook. 

Technically, 360° videos are regular, two-dimensional videos. The images of the 
sphere surface around the camera are displayed distorted, similarly to how the Earth's 
surface is projected onto flat maps of the world. This results is relatively large videos 
in order to provide enough resolution along the strongly distorted edges after 
rectification. 
 

360° editing 
There are two options for dealing with 360° videos in MAGIX Movie Edit Pro: 

1. You can create a 360° video using your 360° original material, with added 
contents (videos, images and titles) and effects, or 

2. You can integrate your 360° contents into a normal video, where you can set an 
image frame and view direction. 
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You can find editing functions for both use cases under 360° editing in the 
Mediapool, Effects tab in the section View/animation (view page 147). 

Create 360° video 

To create a 360° video, open a new project and in the Movie settings (view page 74) 
select a corresponding video preset (360°...).  

For such videos, the video monitor is switched into a 360° mode 
which rectifies the image and makes it possible to change view 
direction with the mouse. (You can reach the 360° mode via the menu 
in the top left corner of the program monitor.) 

You can edit this video in MAGIX Movie Edit Pro as usual and add video effects. 
Please keep in mind that most effects in View/Animation destroy the 360° effect. 

If you would like to integrate additional contents into this video such as titles floating 
in space, proceed as follows: 

 
1. Place the play cursor at the time position where the title object should appear. 
2. Create your Title object (view page 132). 
3. Select it and switch into the 360° effect editing in the Mediapool. 
4. Activate 360° editing (1) and switch on the "Position object in 360°space" (2) 
5. Using the mouse, rotate the view to the position where the title should appear 

on the video monitor in 360° mode. 
6. Then click on "In view direction" (4) and the title will be positioned exactly in the 

view direction. With viewpoint (5) you can set the distance from the viewer. 
7. If the title should fly in and out,  Keyframe animation (view page 162) of the 

viewpoint and parameter orientation can be used.3). 
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Video monitor in 360° mode with 360° video with a placed 3D title object 

Integrate 360° contents in other videos 

To integrate 360° videos or photos into normal videos, proceed as follows: 

 

1. Load your 360° video or photo and select the object. 
2. Switch to 360° editing effect in the Mediapool and activate 360° editing (1). 
3. Switch into the "Select section from panorama" editing mode (2). 
4. With "Alignment" (3) you can set the view orientation. You can simulate a dolly 

through the 3D space by animating this parameter and the viewpoint (5)  using 
Keyframes. (view page 162).  

5. "Recording perspective" (4) is preset for 360° videos as 360°, for panorama 
photos with a lower angle you can check this box and set a different angle. Look 
for the "exact" value by estimating the result and adjusting the angle. 
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6. "Viewpoint" (5) determines how far into the space you would like to zoom for 
details, or how far you'd like to zoom out to see as much as possible at once. 

7. You can correct possible distortion with the other parameters: "Extra wide 
angle" (6) enables an expansion of the viewpoint above the maximum possible 
180% up to 360°. This allows creation of so-called miniworlds. Using the fisheye 
lens ( 7) perspective is distorted. If distortions are already visible due to the 
wide angle, the fisheye effect can be used to correct this. For example, an 
arching horizon can be "leveled". 

 

Preprocessing / stitching 
Stitching describes processing of images from individual cameras to form a single 
images in the projection of the spherical image into a rectangular flat video surface. 
While better cameras manage to accomplish this already in the camera, simple 
cameras with just two lenses create a video that still has to be stitched together into a 
real 360° video. 

 

Unstitched video from the two 180° fisheye lenses from a 360° camera 

Often, stitching software is included with cameras, but it is more elegant to do this 
directly in MAGIX Movie Edit Pro. You will find the Stitching function in the 
Mediapool, Effects tab in the section View/animation (view page 147). 

Select the video object and the effect and click on "Apply effect". The video should 
look something like this in the video monitor: 
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For most 360° cameras with two lenses, there are presets at the top, while for others 
it is possible to adjust parameters below. 

Slideshow Maker 
Slideshow Maker is ideal for converting still images into moving pictures, adding 
background music, and effects. 

• Open Slideshow Maker via "Edit -> Wizards". 

 
 

Style templates 
Select a template that best matches your needs.  

 

This button plays a sample slideshow with the selected style template.  
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Save/delete style template 

 
Homemade style templates appear in the list of 
included style templates. 

 
If you like, these can be deleted again. 

 

Intensity 
Controls the portion of video and image objects that feature effects. With "Normal" 
you will see a balanced amount, whereas with "Weak" or "Strong", correspondingly 
fewer or more effects.  
 

Transitions 
Transitions can be individually activated or deactivated using this button.  

The slider in the transitions dialog can be used to adjust the amount of each type of 
transition.  

Transition duration: Set the length of the transitions in seconds.  

3D transitions use Stereo 3D mode: If this option is activated, 3D transitions use 
Stereo 3D mode. 

Random transitions: The transitions are set to random values. 

The "play" button below the preview monitor plays a preview. 
 

Effects 
Various effects can be individually activated or deactivated using this button.  

The slider in the dialog controls the amount of each effect type.  

Random effects: The faders that control the amount of effects are set randomly. 
 

Treat special image formats intelligently 
Treat special image formats intelligently: Panoramas and portrait photos can be 
treated "intelligently". If this option is activated, then panoramas and portraits will be 
treated with special effects adjusted to the format. These effects can also be selected 
and unselected in the detail view. 
If this option is not selected, then these images will use the same effects as all other 
images. 
 

You can turn effects and transitions belonging to each category on or off using the list 
symbol. The arrow below the preview monitor plays a preview. 
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Properties & titles 

 
 

Film length 
Resulting film length: This is an estimation of how long the film will be after applying 
Slideshow Maker. 

Available music: This is the complete length of the music that is currently selected. 
Background music (view page 238) enables detailed settings for the pieces of music 
to be used. 

Adjust film length to the music: An attempt is made to adjust the length of photo 
objects to the background music. If the film is too short the music will be cut off. If the 
film is too long, the music will repeat. 

Adjust music length to the film: Photo objects have a set length, and the resulting film 
is filled with music. The music at the end of the movie is simply faded out. 
 

Including video objects 
Process videos: If this option is set, then videos will be automatically processed with 
effects and transitions. 

Length: Settings may be made here about whether the original length of the video 
should be maintained or if it should be shortened. 
 

Opening and closing credits 
Set the text for opening and closing credits here. 

Text: Enter the corresponding text for opening and closing credits that should be 
added by Slideshow Maker. 

File: A title template, a video, or an image file may also be used. 

Note: Titles created using Slideshow Maker may also be edited (view page 132) at 
any time. 

 

Group associated images together 
If this option is active, an attempt is made to detect associated events via their date 
information and to separate them from each other optically. Detection of individual 
events is based on the time span of these events to achieve a sensible separation. 
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Begin group with black fade:A black fade is added between the different events. 

Begin group with title and black fade:A black fade is added between the different 
events.A title is also faded in with a suitable duration, e.g. 1st/2nd/3rd day, provided 
the events take place over multiple days. 

Begin group with title and picture:A black fade is added between the different 
events.A title is also faded in with a suitable duration after the black fade, e.g. 
1st/2nd/3rd day, provided the events take place over multiple days. 
 

Background music 

 

Specify if and which music should be used for the background here. 

Use background music: Adds background music. 

Load file(s): A file selection dialog will open to choose a folder featuring music; select 
one or multiple files. 

Remove: The selected pieces of music are removed from the list and will not be used. 

Insert random: MAGIX Movie Edit Pro selects random pieces of music from the 
folder "Import -> My Media -> Slideshow music" in the Media Pool. 

Preview: This button previews the selected piece of music. 

Volume ratio: This slider controls the volume ratio between the original sound and 
the background music. 
 

Tip: Music objects, located on the 5th track will be listed and used together with 
audio objects for background music.  

 

BPM Wizard 
Hidden behind the "BPM Wizard..." option in the audio object context menu is the 
option to analyze the tempo and bars of audio objects. This is particularly useful e. g. if 
you want to synchronize an image sequence to music. 

Note: This function is available only in the Plus/Premium version. 

• To do this, load a suitable song in MAGIX Movie Edit Pro and in the context 
menu select "BPM Wizard". The "MAGIX Remix Agent" dialog will open. This 
tool can analyze the song's rhythm. 
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Follow the instructions from the assistant to work out the tempo of the selected piece 
of music. 

In the last step there are three different ways to use the information supplied:  

• "Create Remix Objects" splits up your audio object into individual objects which 
are each one bar long. 

• "Adapt tempo" adjusts the tempo of the analyzed object to that of the 
arrangement tempo and vice-versa.  

• "Save tempo & bar info" only saves the information itself. This option is 
particularly important for musical cut adjustment, described below. 

Note:In the menu under "Edit > Musical Cut Adjustment" you can make MAGIX 
Movie Edit Pro automatically organize all video objects in the first track according to 
the tempo of the analyzed audio object. 

 

Note: This function is available only in the Plus/Premium version. 
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Preparation - Setting the start marker and object end 
Before opening the Auto Remix Assistant, you should set the start marker at the 
position in the song object in the project window where you want detection to start. If 
the song contains a long intro without beats, set the start marker after the intro. As a 
rule of thumb, the Auto Remix Assistant should always be "fed" dance music.  

• The start marker should be set before a quarter note beat or, better still, briefly 
before a beat at the start of a bar. 

• If the start marker lies before the song object, the object is examined from the 
beginning.  

• If detection is not performed by the end of the song, the object can be shortened 
accordingly with the object handle at the end of the object.  

 

Checking the automatic tempo and bar recognition 
The analysis takes place in four steps: 

Step 1: Checking the start marker 

Step 2: Tempo recognition 

Step 3: Specifying beat starts 

Step 4: Application of BPM and beat recognition 

Step 1: Checking the start marker 
Before you start the analysis you should set the start marker at the position where the 
rhythmic music begins. This means that if the song has a long ambient intro, the start 
marker should be set after the intro. If the wizard can't detect any rhythm it will ask if 
the start marker has been set after the intro. If not, you can move it to a better 
position in the dialog. 

If the beginning of the song does not have a definite rhythm, you will be asked if you 
want to move the start marker. 

Step 2: Checking the automatic tempo recognition 
The Remix Agent will analyze the audio material and try to determine the tempo. The 
object is played back while a metronome click can be heard and numbered green beat 
lines appear in the waveform. 

Under the waveform on the left side the established tempo is displayed in BPM. There 
is a small transport console in the middle to make navigating easier. The slider serves 
as a position controller. To set the metronome volume, an additional fader and mute 
button are provided on the right-hand side. 
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The automatic tempo recognition doesn't always work right away. If you don't hear 
the metronome clicking in time with the music, click the "No" button in the upper 
section of the dialog in order to access the manual tempo input dialog. 

To correct the metronome speed and any timeshift that may occur between the 
metronome clicks you can use the tempo correction as well as the "Tap tempo" 
button: 

Tempo correction: The Remix Agent offers various speed settings. The most probable 
tempo detected by the Remix Agent is preset. If this tempo isn't correct, you can 
choose another one from the list. The next time you play back the song it should be in 
sync with the metronome. 

On/Off beat correction: Now it may happen that the tempo is right, but the beats 
have been displaced. "On/off beat correction" provides a number of alternatives for 
moving the beats according to the complexity of the rhythm. Try out various 
alternatives until the metronome clicks are in sync with the beat. 

Tap tempo: Instead of selecting the tempo under "Change Tempo", you can click 
rhythmically on the "Tap tempo" button or press the "T" key. Additional blue lines are 
displayed in the wave display. After at least four taps, the Remix Agent attempts to 
select the correct tempo from the list in "Tempo correction". The display next to the 
"Tap tempo" button displays the current status. Keep tapping until the red display 
showing "Unlocked" changes to the green "Locked" setting. 

Use the "0" key to manually set the quarter beats while the music plays. Surrounding 
markers will automatically be removed to ensure that the set tempo remains intact.  

You can move the markers with the mouse. If you hold down the "Ctrl" key 
simultaneously, the subsequent markers are also moved. 

If the metronome clicks now correspond with the music, you can continue to the next 
step. 

Step 3: Determining the start of a bar: 
Next you can set the time signature. The default setting is 4/4 but you can adjust this 
if necessary. The beat at the start of the bar should coincide with the high sound of 
the metronome, or the red line in the waveform display. 

It can now be corrected in one step: If the start of the bar can be heard, click on "Tap 
One" once using the mouse or press the"T" key on the keyboard. 

Alternatively, select how many quarter notes the "One" is to be moved back. 

Use the "0" key to manually tap the position of the beginnings of the bars during 
playback. This allows you to correct the beginnings of the bars in longer sections. 
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Continue to the last step if the starts of the bars are now correct. 

Step 4: Applying BPM and bar recognition 
Select which action should take place: 

• Create remix objects mode: The object is positioned in the remix object 
according to bar length. What "Audio Quantization" is activated, remix objects 
are precisely arranged on the bar grid. The remix objects can then be re-
organized in a different rhythmic sequence, mixed with loops or remix objects 
from other tracks etc. 

• Tempo adjustment: If the object and arrangement tempo are to be aligned, you 
can either adapt the object tempo to that of the arrangement via timestretching 
or, vice versa, you can change the arrangement tempo to that of the object. As 
most music has slight tempo fluctuations, the time synchronization is often not 
perfect: After some time the arrangement and the music "drift" apart. If the 
object tempo is to match the arrangement tempo, this can be prevented using 
audio quantization. 

• Save only tempo and beat information: Tempo and beat information will be 
added to the audio material, object and VIP are unchanged. The images on track 
1 will be repositioned according to this information. 

 

Batch conversion 
Batch conversion makes it is possible to convert multiple video files, movies, objects, 
or whole projects into another format in just one step. 
 

Open batch conversion 
Batch conversion can be opened using different presets. A pre-selection appears only 
if you have loaded a film or a project. 

The following scenarios exist: 

• Batch conversion has been opened from the context menu in the Media Pool 
(view page 27, view page 46): The file selected in the Media Pool beforehand 
will be transferred to the task list and can be converted to the available formats. 
In case of projects which contain multiple movies, all movies will appear as 
individual tasks. 

• Only one empty movie is open: A dialog opens additionally for batch conversion, 
in which video files that have to be converted to other formats can be selected 
and loaded. 

• A movie with video material and more than one object in the first track is 
opened. A dialog opens, in which you can select which tasks should be created 
for batch conversion. 
- All scenes in the movie: All objects present in the 1st track will be used as 

starting points for the video files to be exported. An application for this could 



 

 

Special functions and wizards 243 

 

be that all scene beginnings of a movie should be exported as bitmap files or 
a backup for a movie is to be created as individual scenes. 

- Multiple movies: The opened movie will be exported as a whole video. 
Additional movies can be added to the list in the dialog. 

• Multiple movies with video material are open: The opened movie will be 
exported as a complete video. This is especially useful for large projects with a 
lot of individual movies, eliminating the need to export each one individually. 

 

Administration 
Save and load your settings here. These include the list of files to be exported and the 
export settings and names of all entries. 

Caution!  Batch conversion references the projects, movies, and the objects 
contained therein directly. Keep in mind that when converting entire movies, the 
source material must also be available. During conversion of individual objects from 
movies, you have to make sure that the movie file has not been changed between 
loading and saving. 

 

Queued entries for batch conversion 
This is the list of all objects that have to be converted into the indicated format. Each 
task can have its own export settings. 

Add files (not during conversion of individual objects from movies): Manually add 
files, including video files and projects. 

Remove selected: The marked tasks will be removed from the list. 

Duplicate selected: If you would like to export tasks in multiple formats, you can 
simply mark and duplicate them and assign individual export settings to them. 
 

Format settings for the selected conversion process 
These are settings for the currently selected tasks, and multiple tasks can be given a 
setting simultaneously. Select one or more tasks from the task list. 

Note on format setting for multiple tasks: If one of the marked tasks already has an 
individual setting, its will be lost after another format is selected. To prevent this, 
remove the selection for each task using Ctrl + mouse-click. 

Set the target format in the flip menu. Windows Media Video format (*.wmv) is the 
default.  

Advanced settings: This opens the dialog for the advanced format settings. This 
corresponds to the dialog for normal video export of a movie. 
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Tip: If you give several tasks the same file name, the files created will be 
documented intelligently. For example, you can easily convert and simultaneously 
line up multiple movies that belong together thematically. 

 

Shut down PC automatically after successful export 
This option is especially useful when you export long movies and are using an 
especially high-quality and resource-demanding export format. You can leave the 
computer to work on the individual tasks and after finishing them it will turn itself off. 
 

Start batch conversion 
Click on "Start conversion" to start the process. After ending conversion processes, a 
list of all export processes with a message informing of its success will appear. 

Hint: During batch conversion, messages that appear during normal file import will 
be for the most part suppressed. This is to enable the smoothest conversion of all 
tasks. Therefore, please make sure that all files to be converted or the project can be 
easily loaded before starting a batch conversion. 

 

Backup copy 
Files must be saved to be able to be easily retrieved in case of a hard drive crash or 
some other error. 
 

Copy movie/project and media to folder 
This menu option allows you to put a complete MAGIX Movie Edit Pro arrangement, 
including all applied multimedia files, into one folder. This is especially useful if you 
want to archive an arrangement for later use or in case the files are on multiple data 
carriers (CDs, DVDs, etc) so that on loading you continually have to change them. 
Effects files used are also saved in a folder together with the other files. 

If the option "Copy disc project, movies, and media in folder" is activated, all movies 
in the current disc project, including all of the related media, are combined and copied 
into the selected folder. 

Note: MAGIX Movie Edit Pro also features DV logging. Large DV-AVI and audio 
files no longer need to be backed up, since MAGIX Movie Edit Pro saves the position 
of this material on the DV tape and imports missing files automatically when 
reloading the DV tape. 

A dialog opens to specify the path and name of the video. 
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Shortcut: 

Copy movie and media into folder "Shift + R" 

Copy project and media into folder "Alt + S" 
 

Burn movie and media to CD/DVD / Burn project and 
media 
Use this option to burn the film as well as all associated files to disc. To do so, you 
must have a burner installed on your computer and a blank CD must be inserted. 

If you choose the option "Burn project and media", the current project and all of the 
associated media files are grouped together and burned onto disc. 

Even larger projects can be burned straight to disc. The project, if necessary, will be 
split up and burned automatically to multiple discs. A restore program which is 
burned to the first disc of this type of backup guarantees that the backup can be 
restored without any problems. 
 

Restore project from video disc 
This command restores a project backup that has been saved on a disc. The disc must 
have been burned with the option "Add project backup" (see "Burn disc" dialog 
options). 

Choose which of the movies contained on the disc should be restored by selecting it 
from the list and highlighting and selecting the corresponding directory. You must 
also indicate the directory where the project should be saved. A subfolder 
"Backupxxx" will be created in this folder where all project files from the disc will be 
saved. All of the restored movies will be loaded into MAGIX Movie Edit Pro for 
editing. 

Select the option "Restore image files only" and only the original image files 
contained on the disc will be restored. 
 

Load backup project... 
This option loads an automatically created slideshow backup. This type of automatic 
backup gets the file extension MV_ (underscore). This command is only intended for 
use in emergencies, for example, if you unintentionally saved your change and wish to 
return to the previous version of the movie. 

Keyboard shortcut:  Ctrl + Shift  + O 
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Tip: Under "File -> Settings -> Program...", you can determine how often an 
automatic backup will be created in the "System" tab under "Automatic backup". 

 

Clean-up wizard 
The clean-up wizard helps delete projects from the hard drive, including all of the 
media files used. Use this function to free up disk space for future projects. 

Caution: If the files you used in the movie have also been used in other movies (like 
trailers, opening music, etc.), then you should make backup copies of these files 
beforehand. 

Keyboard shortcut:  Ctrl + Shift + Y 
 

Delete specific files 
Choose this option if you would like to select certain files for deletion. In the file 
selection dialog, you can select the desired files. In the next step, the clean-up wizard 
searches for other files which belong to your selection. Using this method, you can 
delete an entire movie with all of its accompanying media, help, project, and backup 
files. Before they are deleted, you will receive relevant information in a dialog and a 
confirmation request.  
 

Search and delete superfluous files 
Choose this option if you would like to find unnecessary files or free up some space 
on your hard drive. The clean-up wizard automatically looks for extraneous files 
created during use of MAGIX Movie Edit Pro. Before they are deleted, you receive 
relevant information in a dialog and a confirmation request.  
 

Advanced 
"Advanced" lets you set which files and folders should be included in the cleaning 
process. 

 



 

 

Burning 247 

 

Burning 
The "Burn" screen enables you to create a selection menu to burn the entire project 
including all movies and the selection menu to disc later on. 

 

Switch to the "Burn" screen first by pressing the button displayed. 

 

Preview and editing 
MAGIX Movie Edit Pro provides two different modes for designing and previewing 
the disc menu. 

 
"Preview" mode simulates the behavior of a playback device, e.g. 
DVD player or Blu-ray player.  
You can select a template for the menu and burn the disc. 

 
In "Editing" mode, you may adjust many features of the disc menu. 
Templates are also available here that may be flexibly adjusted to 
suit your needs. 

 

Remote control 
The virtual remote control is an important helper when it comes to checking how the 
disc will perform later. 

When the disc featuring the project is inserted into the player, this remote control will 
control the preview picture just like a "real" remote control controls the picture on a 
monitor or TV. The menu navigation may be activated via the arrow keys or the "OK" 
button. Activated buttons are highlighted. 
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The number keys select the corresponding entry on the menu 
page. All menu entries are marked with a corresponding number. 
Within a chapter menu, playback is started from the particular 
scene. In the movie menu, the corresponding chapter menu (if 
available) is changed or movie playback is started.  

Navigation button: Use these buttons to navigate in the menu of 
the disc being burned. The individual entries may be changed and 
confirmed by pressing "OK". The remote control reacts exactly 
like a genuine DVD/Blu-ray player's remote control. 

Skip/move forward/back: This allows you to skip to the next or 
previous scene while playing back your movie. In the menu, you 
can skip forward or back from one menu page to another. 

Play: Starts the first entry in the menu. In case chapter menus are 
available (view page 251), the chapter menu will be displayed 
first. Press the play button again to start playback at the 
beginning of the first scene of the first chapter. 

Stop: Pressing stop halts playback. 

Disc: Switches to the first page of the film menu. 

Sub: Switches to the chapter menu (if available) for the currently selected film. 
 

Menu 
The selection menu is also burned to disc and appears when inserted into your player. 
Just like with a store-bought DVD or Blu-ray Disc, you may easily select your movies 
with the help of preview pictures, or access particular chapters within a movie. 
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Templates 
You will find the menu templates below. 

 

To the left, you will see a tree structure for selecting various menu templates. At the 
top, you should first select whether you would like to use templates in ratio "16"9" or 
"4:3".  

• Animated  (DVD): These templates contain background and introductory videos 
as well as music. The control elements are displayed in various modes. The 
templates can be used only for mini DVDs, DVDs and AVCHD discs.  

• Static (4:3 only, DVD): Here you will find templates made up of regular 
background pictures and control elements. 

• Custom: These templates adjust to your disc project; the movies and scenes you 
use are integrated directly into the menu. 

• HD  static (16:9 only, DVD, Blu-ray, AVCHD, WMV HD): These templates 
contain super-sharp, high-res background images that are particularly 
noticeable on HD TV devices. 

• Movie templates (only 16:9): Here you will find menu templates that are 
specially made for movie templates (view page 219) found in the Media Pool. 

Note: These menus require "Film menu" and "Chapter menu" to be activated in the 
"Edit" screen under "Disc options". 

If you've selected one of the menu templates, you can use the horizontal scroll bar to 
view all the others available. There are lots of options when using the templates: 

• To apply a template to all menu pages, double-click the desired template. The 
complete template will then be applied. 

• You can also combine various elements from different templates with each 
other. To do so, you must first switch into Editing mode. If, for example, you 
wish to combine the text format of a template with the background of another 
one, double-click on the template containing the background first. Then click on 
the "Font" tab and select a template for the font. 

• You can load the layout (or individual layout elements) for the current menu 
(movie or scenes) as well as for all menus. 
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Note: Some menu templates include intro videos with a smooth transition to the 
menu page! 

 

Edit disc menu 

 

To edit individual menu elements and the menu structure, 
activate the "Edit" button. 

 
 

Edit menu elements 
Hold down the left mouse button and drag text boxes or graphical elements to the 
desired position. You can adjust the size by dragging out the corners and edges of the 
frame. 

 

Undo: This command allows you to undo the last changes made.  

 

Redo: This function undoes the previous "Undo" function. 

 

 
Lock aspect ratio: To avoid distortion, use this button to lock the aspect 
ratio for the menu elements.  

 
Group: Menu elements are moved or resized simultaneously as a group, 
including the description text and number. 

 
Fade in TV display area in the preview monitor: This option displays the 
image borders of the television (view page 172) as lines in the preview 
monitor.  

 
Grid: This button shows a grid to help position frames exactly next to 
each other as required. Using the small arrow next to the button you can 
open a dialog to fine tune the grid settings. 

 

Navigation 
Using navigation links above you can reach the structure of the menu entries. 
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• All movies are listed as first entries. The 
corresponding menu level is the film menu. 

• All scenes are listed as second entries next to it to 
the right. The corresponding menu level is the 
chapter menu. 

Removing the red check deactivates the corresponding 
entry in the chapter menu. The scenes are still displayed 
of course, but you can no longer select them directly from 
the menu. 

• You can open the movie menu for further editing by 
clicking on the movie above it.  

• If you click on one of the chapters, the chapter menu 
in the preview will be opened for editing. 

 

Disc options 
Here you can activate or deactivate certain elements or even complete menus. 

Intro video: Press this button to load videos to be used as introductions to your discs. 
The following formats are supported: "*.avi", "*.mpg", "*.mxv", "*.vob". The intro is 
played immediately after the DVD has been inserted into the player. The DVD menu 
will then appear. A check mark "Do not skip" ensures that the intro video must be 
played completely each time the disc is inserted and that it may not be skipped with 
the remote control or otherwise. 
 

Film menu & chapter menu 
The disc menu essentially consists of two layers: 

Film menu: The upper layer includes the film menu, which is only used if a project 
contains multiple movies.  

Chapter menu: This is the lower layer of the disc menu, which utilizes the chapter 
markers in a movie as menu entries. More information about this is available in 
Chapter markers (view page 123). 
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Note: A chapter menu cannot contain more than 99 entries. If your movie should 
have more chapters, either burn it without a chapter menu or split your movie into 
multiple parts. 

 

Preview pictures: Shows/hides the preview pictures in the disc menu. 

Numbering: The numbers beside the menu entries may be selected directly using the 
remote control, but they might be unwanted at times. Use this option to show/hide 
them. 

Frame: A frame borders the preview pictures. If this is unwanted, it may be removed 
easily using this option. 
 

Create your own menu background 
You can edit the existing menu background or create a new one from scratch.  

 
A click on this button switches to the "Edit" interface and 
loads the selected menu background as video.  

Here you can change and design the background as you please. The background 
movie will be set as the menu background automatically after pressing "Save". 

Tip: If you would like to design a new menu background, simply delete all existing 
objects from the menu project and load new ones. 

 

Designing a page 
New menu pages may also be added or irrelevant pages may be removed. 

 
Adds a new menu page. 

 

 
Removes the selected menu page. 

 

Background: Here you have three options for creating a static background image for 
the menu: 

• You can set a certain color value for the background. 
• You can select an image saved on your hard drive 
• You can select a frame from your project. 
 

Animated selection menus 
Audio-visual animations may also be added to the DVD menus. As required, 
background videos are played as endless loops while the menu is shown on the 
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screen. Add background music in various formats or use any background picture for 
each menu. 

Sound/music: Load an audio file into the preview monitor and use it as an animation 
in the menu background. 

Video: Load a video or graphics file into the preview monitor and use it as an 
animation in the menu background. In addition to the options for the background 
graphic (see above), you may also use a sequence from a loaded slideshow or from a 
different video file. 

Background video options: 
• Create animated menu buttons: The preview images for individual movies in the 

movie menu are shown as small movie samples. Set the start point and length of 
the animation using the sequence options faders. 

• Use video's audio track: The audio track of the background video is used with 
the menu. 

• Play menu animation as a loop: The background video (audio and/or video) is 
played back as a loop. 

• Length of the menu view is set by: Audio/video or whichever medium is longer. 
You can specify how long the background video should be here. The other 
medium will be played as a loop. 

 

Create a button design 
MAGIX Movie Edit Pro enables easy editing of all buttons together with their menu 
entries. 

 
You can edit menu entries that you created using this 
button or with a double click on the menu. The dialog with 
the properties of the menu entries (view page 254) will 
open. 

 
Edit in MAGIX Photo Designer: You can open MAGIX 
Photo Designer for additional editing of elected menu 
elements. 

 
Apply to all objects: Applies the properties of the selected 
button to all remaining buttons. 

 

New entries may also be added or irrelevant entries may be removed, together with 
all corresponding buttons. 

 
Adds a new menu entry with button. 

 
Removes the selected menu entry with button. 
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Tip: You can deactivate unused menu items in Navigation (view page 250). 
 

Note: The chapter menu is formed via chapter markers (view page 123) and can be 
influenced in detail with these. 

 

Pressing this button or double-clicking the menu entries 
allows menu entries you have created to be edited. The 
dialog with the properties of the menu entries (view page 
254) will open. 

 

 
These buttons open MAGIX Photo Designer for 
further editing of your background pictures or 
the selected menu elements. 

 

Jump to linked page 

 
To test the targets of menu entries, select the desired 
menu entry and click the button. 

 

Menu entry/menu page properties 
Double clicking the preview picture or a menu entry opens an editor for you to adjust 
the preview picture or menu entry.  

 
 

Menu text 
In the text input field, you can enter any text to match the chosen menu entry. 
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Set the vertical direction of the text (upwards, centered or 
downward). 

 

Set the horizontal direction of the text (left, centered or 
right). 

Font size: Set the height of the text in pixels. 

Font color: Define the foreground color of the text. 

Font: Set which font and which style (bold, italic, etc.) should be used. 

Shadow: Set the color and size of the shadow that will appear underneath the text. 

3D effect: If you would like to make your text appear three-dimensional, you can set 
the width, height, and color of the 3D effect. 

Apply to all: Except for the text, all settings are applied to all entries in the current 
menu. 
 

Menu image 
Use frame from movie: Use the fader to set which frame should be used in the video 
as a preview picture. The numerical input fields are sorted as follows: 
Hours:Minutes:Seconds:Frames. 

Use different graphic: You can also load your own bitmap images to be used as menu 
pictures. 

Hint: It may be the case that there are no menu pictures in some menu templates, 
so changing the menu picture won't have any noticeable effect. 

 

Actions at the end of the movie (preview images in film menu only) 
Enter which action should be carried out once the film has finished playing here. 
Select from: 

• Stop playback: This option depends on the DVD player being used. Most DVD 
players show the DVD player's own menu (or background picture) after 
playback. 

• Jump to movie menu/chapter menu: Jumps back to the previously displayed 
menu. 
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Tip: If one of these two options is not available, please check which menu mode is 
set. 

• Jump to next movie: The next movie will be played without any additional action. 
• Play movie as endless loop: Any movie may be burned onto a disc as a loop. This 

means that the movie will be played as a endless loop until the next menu entry 
is accessed using the remote control or playback is stopped. This way, you can 
transform your TV into an aquarium, a train journey, a fireplace or anything that 
you could watch over and over again. 

Note: This option only functions for DVDs, Mini DVDs, or Blu-ray Discs. 
 

Edit your own menu entries 

Note: This function is available only in the Plus/Premium version. 

There is another view in this dialog to edit menu entries you have created. Menu links 
can be edited here. This makes it possible to link a menu entry with a certain action, 
menu page, or a certain position in the movie. 

No link: The menu element cannot be selected and has no function other than to 
display menu text. 

Link to page in current menu: Jumps to a menu page in the current movie or chapter 
menu in the current film. 

Link to another menu: Opens another movie or chapter menu. 

Link to chapter in a movie: If this option is selected, enter a film and chapter marker 
where playback should start. 

Note: For DVDs, only chapters within the current movie may be jumped to. 

Link to film start: The movie will play back from the start. 
 

Save your own templates 
If you make custom changes to a menu, you can save it for use on other projects. 

• To do this, right click on the template and select "save" under "Recent 
templates" in the menu. 
The template will now appear under "Recent templates" beneath the editing 
area and can be used on other projects. 
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Burning wizard 

 

Click "Burn" to open the dialog for creating DVDs, Blu-ray discs, 
AVCHD and other video media including a menu. 

 

Select what kind of disc you would like to create. 
 

Proceed as follows to burn a disc: 

• Set up burner and burn speed: If multiple burners are installed, you may select 
which device you wish to use in this menu. 

• Encoder settings: Use the "Encoder" button to access the selection dialog to 
specify settings for the MPEG encoder (memory requirements, quality, and 
duration of the MPEG conversion). "Advanced settings" accesses a dialog 
featuring additional options. You can adjust all the fine settings for the MPEG 
encoder here. 

• Burning disc/starting video encoding: The button "Burn disc" starts the disc 
burning process. Every time you burn and every time a simulation is carried out, 
the disc project is encoded. Please note that the MPEG file is not deleted from 
the hard disk after the burn process has finished. Depending on the length of the 
project, encoding and burning may take some time. The time required can be 
seen in the dialog. 
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The burn dialog 
Here you can select your burner, the type of disc, the encoder settings. MPEG-2 is 
used for DVDs. Blu-ray discs also use MPEG-2, and higher bitrates are employed in 
order to reach the higher HD resolutions. AVCHD discs use a much more complex 
MPEG-4/H.264 codec, which is documented in detail in the "MPEG-4 encoder 
settings (view page 348, view page 343) section of the PDF manual and in Help (F1 
key). 

 
 

Options 
Simulate first: If you are not sure about the write speed or memory requirements of 
the selected disc, you can simulate the write process before burning.  

Activate buffer underrun protection: Many burners support techniques that prevent 
the much-feared "buffer underrun". Use this option to activate this protective feature 
and burn your files at higher speeds without risking making a coaster out of your blank 
disc. 

Completely format DVD/CD-RW media: This option reformats the RW media and 
deletes all existing file material. 

Shut down computer after burning: Activate this option to automatically turn off the 
computer after encoding and burning has been completed. You could, for instance, 
start the encoding and burning process in the evening, and you don't have to wait for 
the process to finish to switch off your computer. 

Burn standard video DVD onto same disc: You can use this option with a WMV HD 
disc to burn an additional normal DVD video. This ensures that your discs can also be 
played back on standalone DVD players. See Multi disc. 
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Activate the burner's defect management option: If a certain section of the disc is 
defective, then this will be recognized by the burner and labeled as such. No content 
will be saved there as a result. 

Check data after burning disc: The finished disc will be checked for any mistakes after 
burning. 

CD/DVD title: This is the title of the DVD as it will appear on the PC. The disc project 
name is displayed here by default. 
 

Encoder settings 
Use the “Encoder settings...” button to access the selection dialog to specify the 
properties of the MPEG encoder (memory requirements, quality, and duration of the 
MPEG conversion) 

Preset: Here you will find useful presets for the selected disc type. Here are some of 
the presets for a DVD: 

Longplay DVD Video DVD with extra-long playing time. The bit rate is reduced, 
which compromises image quality. 

Longplay music DVD DVD with extra-long playing time for music. The bit rate for 
the soundtrack remains at the highest quality level. 

Standard DVD Normal DVD 

Widescreen DVD Normal DVD in 16:9 format 

Note: For all settings, you can choose between NTSC (USA and Japan) (Europe). 

Bitrate: Bitrate determines the size on the disk that the finished video will take up. The 
greater the bit rate, the larger the file, and the shorter the maximum playing time of 
the movie that fits on a disc. 

Adjust bit rate: The expected file size of the finished video is estimated, depending on 
the set bit rate. If the movie does not fit onto the disc, the bit rate is corrected 
accordingly. 

Quality: Specifies the quality of the encoding process. The higher the quality, the 
better the finished video will look; however, encoding will take considerably longer. 

Smart Rendering: With Smart Rendering you can significantly reduce the encoding 
effort for MPEG files. During the production of MPEG files, only those parts of the 
movie that were changed in the program are re-encoded. Please note: The MPEG files 
contained in the movie must have the same format, i.e. the bit rates (variable or 
constant), audio formats, image resolutions and video formats must match. 
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Anti-interlace filter: Activate this option only for playback on a TV screen, where it 
reduces horizontal flickering around fine details. 

Calculate video effects on GPU: To accelerate exporting, you can let video effects be 
calculated on the graphics card. At this time this applies to brightness, gamma, 
contrast, color, saturation, image size, cropping and position effects as well as various 
fades and mixes. Please note that external effect plugins and elaborate artistic effects 
must be processed on the CPU and for this reason using this function will not yield 
any speed advantage. 

Note: This function is specifically optimized for NVIDIA graphics cards. You can, 
however, experience acceleration with other types of graphics cards, too. 

3D mode: If you have 3D material in your project which has been edited with 
Stereo3D, you can select here in which mode it should be burned to disc here. 3D is 
switched off by default. 

To return to the standard settings, press the Reset button. 

Via "Advanced" you can reach the "Advanced settings" dialog. Here you can make 
changes to all MPEG encoder settings. Read the \ "MPEG-1/2 encoder-settings" 
appendix and "MPEG-4 encoder settings" (view page 348, view page 343) in the PDF 
manual or program help. 
 

Apply hardware acceleration for rendering 
MAGIX Movie Edit Pro supports hardware acceleration for AVCHD exports as well as 
AVCHD and Blu-ray discs. This can noticeably speed up the encoding process. 

• Quick Sync Video: Intel processors starting with „Sandy Bridge“ when using a 
standard MPEG-4 encoder (view page 348, view page 343). 

Note: Make sure that all the necessary drivers are installed. 

If your system does support hardware acceleration, you can activate it in the "Encoder 
Settings" dialog under "Advanced..." > "Hardware acceleration". 
 

Memory 
Disc type Data storage 

medium 
Menu Quality Length (optimal quality) 

DVD DVD Yes  *** 98 min. 

Blu-ray Disc 
(view page 335) 

Blu-ray Disc Yes ***** 110 min. 
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AVCHD (view 
page 335) 

DVD/Blu-ray 
Disc 

Yes ***** 30 min./DVD 

160 min./Blu-ray Disc 

*  The display time for some DVD players can be determined in this menu. The 
amount of image material that can be put onto a CD or DVD depends on the sizes of 
the picture files. 

It is difficult to acquire reliable information regarding required memory, especially 
with the MPEG-2 encoder. If the “Variable bit rate” of the MPEG-2 encoder is 
activated, encoding will occur according to the movements in the picture. The 
required memory depends on the film material; an action film would need more 
memory than a drama, for instance. 

In the MAGIX Movie Edit Pro burn dialog there is a display of remaining capacity, 
which estimates directly how much space remains on the selected disc type with 
current settings. As soon as you change Encoder settings (view page 259), the 
capacity display will be updated. 

Tip: The capacity display is only an estimate. For this reason, always make sure that 
you never completely fill the disc space. Instead, leave a buffer in case the files end 
up being larger than the provided estimate. 

If you cannot save your disc project on a single blank CD, you will have to divide it up 
into various parts. 

Note: Further information on MPEG compression and formats can be found in the 
chapter PDF manual in the chapter "Video and data formats" (view page 332). 

 

Separate project onto multiple discs 
Automatically: If the disc project requires more memory than is available on the disc, 
a dialog will appear before burning asking whether the disc project should be 
automatically segmented for multiple discs. Confirm this by clicking “Yes”. The disc 
project will then be automatically divided into individual disc projects and burned 
sequentially onto multiple discs. This is the easiest method as everything is automatic 
and all you have to do is insert a new blank CD when required. 

Manual 

Case 1: If several movies do not fit on a single disc: 

In this case, switch back to the “Edit” interface and delete as many movies as 
necessary until the remaining movies fit onto the disc. You can create a new disc 
project and load and burn the other movies afterwards. 
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Case 2: If a long movie doesn’t fit on a disc... 

In this case, the movie has to be split into two or more parts that will be burned 
separately onto disc. 

• Switch back to the "Edit" view and place the playback marker to the position 
where you want to divide the movie. In the "Edit" menu, select "Cut -> Separate 
movie". 

• All passages behind the playback marker will be removed from the overly long 
movie and made into a separate movie. Both movies can be controlled in the 
movie tab in the Project window. Save both of them separately to your hard disk 
(“File > Manage movies > Export movie file” menu option, for example, as “Part 
1” and “Part 2”). 

• Remove one of the two movies (for example, "Part 2") from the disc project 
("File" > "Manage movies" -> "Remove from project (view page 269)" menu 
option). 

• Switch to the "Burn" interface and burn the first film ("Part 1") to CD or DVD. 
• Create a new disc project (“New” button), switch to the “Edit” view and load it 

into the second film (“Part 2”). 
• Switch to the "Burn" interface and burn the second movie to ("Part 2") CD or 

DVD. 
 

Create label and CD cover 

 
MAGIX Movie Edit Pro contains an easy-to-use print center. Here, you  can 
design and print track listings, CD covers, CD booklets, and circular CD labels. 
You can find additional information in internal program help opened using F1. 
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Export 
The "Export" button opens the export wizard, which features the most important 
export options for your videos. Please note that you will only export the current 
movie. Other movies in the project and the disc menu will not be included. 
 

Output as video file 
With this option you can recalculate a movie including all objects, effects settings, 
transitions, text, etc. into a video file and save it to a computer. 

 

Select a certain quality (e.g. DVD quality) and a file format (e.g. MPEG -4). The dialog 
provides further information about the properties of your selection. Please note that 
MAGIX Movie Edit Pro also adjusts the quality when you change file format, if this 
wasn't optimally selected for your chosen format. 
 

Export to device 
You can also transfer your project to mobile devices. 

• Click on "Export to mobile device" in the export dialog. Then select the mobile 
device from the list. 

• Click on "Save video". 
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MAGIX Movie Edit Pro now creates a video file. You can keep track of the progress in 
a dialog. A dialog will open as soon as the export is completed. 

 
• Provided that your mobile device is connected to your computer, click on 

"Folder". 
• Select your mobile device and a sub-folder if applicable in the dialog and click on 

"OK". 

Your video will now be transferred to the mobile device. 

Note: Normally your device will be correctly recognized as "Mass storage device" by 
your computer. If necessary, change the connection detection settings of the device 
before connecting to your computer, so that you can select the correct connection 
type (e.g. "Mass storage drive"). For more details on these consult your device 
manual. 
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Upload to Internet 
This option allows you to upload your movie directly to YouTube and Facebook. 
YouTube is the most well-known portal for amateur clips. Facebook is a world-wide 
online community. 

 

Community: Select a platform here. 

• Facebook 
• YouTube 

Note: The following options will be displayed or faded out, depending on which 
community you select. 

Title: Enter the name of your movie here. 

Description: Create a short description of your movie to describe it to other members 
of the community. 

Keywords:Enter terms to help users find your video (in addition to the description). 

Category (YouTube only): Select the category for your movie here. 
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Send: Select whether the film should be private, accessible only to you and authorized 
persons, or public -in other words freely accessible. 

Export settings: Set various quality settings. 
 

Upload to Vimeo 
This option allows you to upload your movie directly to Vimeo. Vimeo is growing in 
popularity for higher quality videos. 

 

Title: Enter the name of your movie here. 

Description: Create a short description of your movie to describe it to other members 
of the community. 
Keywords:Enter terms to help users find your video (in addition to the description). 
Send: Select whether the film should be private, accessible only to you and authorized 
persons, or public -in other words freely accessible. 
Export settings: Set various quality settings. 
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Menus 
Certain menu items are not available on the "Record" and "Burn" screens. The menu 
reference describes the full menu as found on the "Edit" screen. 
 

File Menu 
New project 

 

A new MAGIX Movie Edit Pro project is created. The Start dialog opens in this 
case 

A start dialog will open when the program is launched or a new project is loaded.  
Here you can make important presets for the project. You can change these settings 
at any time by going to "File" > "Settings". 

 

Create new project: Here you can assign a name to your new project. 

Options: This button lets you open and close the options area of the start dialog. 

Watch the intro video: Here you can launch the introductory video with information 
about workflows in MAGIX Movie Edit Pro. 

Project file: Here you can set the path for the project directory where all project files 
should be saved. 
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Movie settings: Here you can set the movie's target format (display norm, resolution, 
frame rate). This setting has no effect on the internal processing quality and can be 
changed at any time by going to "File > Settings > Movie" (view page 74). 

Audio sample rate: Here you can set the audio track's audio sample rate. 

Load existing project: Here you can select and load a previously saved project. 

Use movie template: Here you can choose an included movie template for a new 
project. Read the "Using movie templates" (view page 219) section for more details. 

Shortcut:  Ctrl + N 
 

Open 

 

With this option you can load a project or a media file. Please note that all 
media files associated with it must be loaded along with a project. 

MAGIX Movie Edit Pro will search for all used sounds and video files in the folders in 
which they were located when the move was saved. 

Keyboard shortcut:   Ctrl + O 
 

Save project 

 

The current disc project is saved with the name displayed in the project 
window. If you have not specified a name for your project yet, a dialog will 
open for you to do so. 

Shortcut:  Ctrl + S 
 

Save project as... 
A dialog opens where you can specify the path and name of the video for saving. 

Keyboard shortcut:  Shift + S 
 

Manage movies 
New movie 
Use this option to create a new movie for your recordings and imported files. Since a 
film is normally already opened, you will have to decide whether the movie should be 
inserted into the existing project or if a new project should be created. 

Keyboard shortcut:  Ctrl + Alt + N 
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Delete movie 
This option lets you remove the current movie from the project. However, it is still 
available on the hard drive and can be loaded again at any time. 

Keyboard shortcut:  Ctrl + F4 
 

Attach movie 
Using this function you can attach a movie to an opened one. This is then attached to 
the end of the movie and automatically takes on the original movie's settings. 
 

Rename movie 
You can enter a new name for your movie here. 
 

Import 
Use this option to load a movie into your disc project. Please note that all media files 
associated with it must be accessible. MAGIX Movie Edit Pro will search for all used 
sounds and video files in the folders in which they were located when the movie was 
saved. 

 

You can use the tabs to switch from one movie to another. 
 

Export movie file 
A dialog will open to enter a file name for the movie to be exported. The movie may 
then be imported into other projects again. 

Note: The movie file (*.mvd) includes all information about the media files used, 
cuts, effects, and titles, but not about the image and sound material itself. This is 
always contained in the recorded or imported media files, which remains unchanged 
during editing with MAGIX Movie Edit Pro. In order to save a movie in its own 
folder, e.g. for use on another PC, use the function "Copy film and media to folder". 

Keyboard shortcut:  Ctrl + Alt + L 
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Export movie 
A movie may be exported in different video formats via "File -> Export movie". The 
options available vary according to the selected format. 

Presets: These are typical settings for the selected format for the most important 
applications.  

  Click "Save" to save your own settings and "Delete" to remove them 
from the list. 

Export settings: Specify general export parameters like resolution, aspect ratio, and 
frame rate here. Select the most frequently used values from the list fields; to set your 
own values click on the "..." button. The "Advanced" button opens the specific 
settings for the selected video format. "File" enables you to export your file to another 
folder than the preset (More information can be found in the section "Folder" on page 
78) one. The option "Overwrite file without confirmation" option allows you to 
execute multiple exports in the same file.  

Other: "Other" also provides the option to switch off your computer automatically 
after long encoding processes and to limit export to the selected area (between the in 
and out point).  

Other 

• Export selected range only 
• Apply anti-interlace filter (suppresses flickering) 
• Shut down PC after successful export 
• Calculate video effects on GPU 

Output after export: Some formats allow special playback options (e.g. DV-AVI on 
the camera or WMV export with output via Bluetooth to your mobile phone). 

Note: Burning a disc takes place on the "Burn (view page 72)" screen. Read more on 
this in the chapter "Burning a disc". 

 

Video as AVI 
When exporting to AVI video, you may set and configure the size and frame rate of 
the AVI video and the compression codec for audio (audio compression) and video. 
Please see the general information about AVI video formats (view page 332) as well. 

Keyboard shortcut:  Ctrl + Alt + A 
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Video as DV-AVI 
This option exports the video as a DV encoded AVI. You will be asked for which video 
standard you want to export DV data. PAL (Europe) or NTSC (USA/Japan). The 
arrangement can be easily transferred to the Digicam via the FireWire interface.  

The window will provide further information on all available options. You can access it 
via the button "Advanced..." in the "Export" dialog. 

Keyboard shortcut:  Ctrl + Alt + D 
 

Video as MPEG video 
MPEG stands for "Motion Picture Experts Group" and is a high-performance 
compression format for audio and video files.   

Details on the settings of the MPEG encoder can be found in the "MPEG encoder 
settings" appendix. 

Keyboard shortcut: Ctrl + Alt + P 
 

MAGIX video export 
Exports the movie in MAGIX video format. This format is used for video recording by 
MAGIX video software and is optimized for digitally edited high-quality video 
material. 

Keyboard shortcut:  Ctrl + Alt + M 
 

Video as Quicktime Movie 
Exports the movie in QuickTime movie format. This enables streaming playback of 
audio and video files over the Internet. 

As with RealMedia export, appropriate adjustments can also be made for video site, 
frame rate, and codec settings. However, the export dialog does not permit you to add 
commentary to the video. 

For QuickTime files (*.mov) you have to install the QuickTime library. 

Keyboard shortcut: Ctrl + Alt + Q 
 

Uncompressed movie 
When exporting an uncompressed AVI video file you can adjust the size and frame 
rate of the AVI video you wish to create. The video material will not be compressed 
by a codec. 
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Note: This will create very large files! 

Keyboard shortcut:  Ctrl + Alt + U 
 

Video as MotionJPEG AVI 
Opens the export dialog for AVI video in MotionJPEG format. This format is 
supported by digital picture frames, for example. 

Keyboard shortcut:  Ctrl + Alt + O 
 

Movie as a series of individual frames 
This option exports the video as a sequence of single frames in bitmap format. This 
means a graphic file will be created for every frame of the video. The image count may 
be determined in the export dialog under "Frame rate". 

Keyboard shortcut:  Ctrl + Alt + E 
 

Windows Media Export 
Exports the arrangement in Windows Media format. This is a universal audio/video 
format from Microsoft. The setting options in the Advanced dialog are 
correspondingly complex. 

Manual configuration 

 
Audio/Video codec: Various codecs corresponding to the many versions of Windows 
Media (7, 8, 9) are possible. If playback compatibility problems arise, try an older 
codec with a lower version number. 

Bit rate mode: Constant and variable bit rate modes are possible; however, most 
devices and streaming applications require a constant bit rate. For VBR two-pass 
modes, the movie is compressed in two passes for optimal use of the bandwidth 
required for highly-compressed movies on the Internet. 

Bit rate/quality/audio format: The bit rate substantially determines the display and 
audio quality. The higher this is, the better your videos will look and the larger the files 
and the required encoding time will be. For variable bit rates, the bit rate is adapted 
dynamically to the requirements of the corresponding picture or sound material. Here, 
either the quality value of between 1-100 can be set or, for two-pass encoding, an 
average or maximum bit rate. For audio, the bit rate is set additionally by the audio 
format. 
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Import from system profile (export type): For the most used methods (other than for 
playback on mobile devices; for this you should use the supplied presets), e.g. Internet 
streaming, Microsoft provides a diverse selection of system profiles. If you have the 
Windows Media Encoder 9 installed (available from Microsoft as a free download), 
then you can edit the profiles or create your own. These can be loaded by pressing the 
"Import from profile file" button. 

Go to Clip info to insert title, author name, copyright details, and a description.  

Keyboard shortcut: Ctrl + Alt + V 
 

Video as MPEG-4 video 

Hint: In order to use the MPEG-4 video export feature, you will have to activate this 
function first (view page 337). 

MPEG-4 is the most advanced video format available at the moment. Unlike others, it 
can provide high-quality pictures at the same file size. 

Behind MPEG-4, you'll find a highly complex "academic" standard that operates and 
is supported variably according to make. To go into detail on these differences and 
parameters would be beyond the scope of this documentation. For this reason, 
indications, along with the operational manual of your device, are given that should 
help create executable MPEG-4 files. For more experimental users, the complete 
setup options of the MPEG-4 codec can be found behind the "Advanced settings..." 
buttons. 

Video/Audio: The MPEG-4 format and the advanced AVC format are also available 
but have, as of yet, only been used in a few devices. MPEG4 video can be combined 
with AAC or AMR sound, the latter mostly in conjunction with mobile phones. The 
combination ACC/AAC doesn't appear very often (Apple iPod Video), ACC with 
AMR in contrast, not at all.  

Multiplexer: Here you can find the so-called container formats and special options for 
Apple iPod and Sony PSP. MPEG-4 is usually used as an output format, mobile 
phones mostly use 3GPP. 

Keyboard shortcut:  Ctrl + Alt + G 
 

Hardware acceleration - Quick Sync Video 
MAGIX Movie Edit Pro supports hardware acceleration for AVCHD exports as well as 
AVCHD and Blu-ray discs. This can noticeably speed up the encoding process. 

• Quick Sync Video: Intel processors starting with „Sandy Bridge“ when using a 
standard MPEG-4 encoder (view page 348, view page 343). 
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Note: Make sure that all the necessary drivers are installed. 

If your system does support hardware acceleration, you can activate it in the "Encoder 
Settings" dialog under "Advanced..." > "Hardware acceleration". 
 

Export video as HEVC 
HEVC is the sucessor format to MPEG-4. HEVC (view page 346)allows for the same 
image quality across file sizes, even when smaller file sizes are used. The improved 
image quality can be clearly seen, especially at lower bitrates. 

Shortcut: Ctrl + Alt + I 
 

Audio as MP3 
MAGIX Movie Edit Pro supplies an optional MP3 Encoder for especially fast and 
good-sounding conversions into the popular MP3 audio format. 

Warning: In order to use the MP3 export function, Windows Media Player 10 or 
higher has to be installed to your system. 

Hint: The MP3 Encoder cannot be used as a codec for the audio track of AVI audio 
files.  

Transmission format 
Here you can specify how you wish to send the audio file to the mobile device. Read 
more on this under Transferring files. 

Options 
In the "Options" section you can set the format and the compression of the audio file. 

Bit rate: The "Bit rate" selection specifies the level of compression: The higher the bit 
rate, the higher the quality of the exported audio file. On the other hand, the bit rate 
determines the final file size: The smaller the bit rate, the smaller the files. 

Mono/Stereo/5.1 Surround: Most mobile devices have only one loudspeaker. To save 
on memory, you can export in mono as well. In 5.1 Surround Mode (see Mixer in 
Surround Mode (view page 201)) you can also export in MP3surround. 

Normalize: This function should always be activated. It guarantees that the music is 
not too loud/overmodulated or too quiet. 
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Audio as wave 
The movie's audio track is exported in the wave (*.wav) audio format. 

Keyboard shortcut:  Ctrl + Alt + W 
 

Export as transition... 
Please see "Creating custom alpha transitions (view page 119)" 

Keyboard shortcut:  Ctrl + Alt + T 
 

Single frame as BMP 
Exports the image at the position of the start marker and displayed on the video 
screen as a BMP file. 

Keyboard shortcut: Ctrl + Alt + B 
 

Single frame as JPG 
Exports the picture located at the current start marker and displayed in the video 
monitor as a JPG file. 

Keyboard shortcut: Ctrl + Alt + J 
 

Record audio / images / video 
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A selection window will open to choose the desired recording type. This may also be 
accessed via the "Audio or video recording" button in the transport controls. 

Keyboard shortcut:  R 
 

Import Audio CD track(s) 
A CD track may be imported via drag & drop from the Media Pool just like a normal 
file. If this convenient method fails for some reason, then this menu command may be 
accessed via the CD manager to insert tracks from audio CDs directly into the 
arrangement. More about this is available in the section "Import audio CD". 
 

Export to device 
Open this dialog via "File" > "Export to device". 

 

Here you can transfer your finished video onto external devices. Select the target 
device from the list. 
 

Export to mobile devices 
Most devices require certain format settings (file format, resolution, bit rate, picture 
repeat rate, etc.) to be able to play a video.  

The menu is divided into various device classes to make choosing your device easier. 
The last three selections are saved as favorites in the top part of the device list if you 
have more than one device or want to present your movies to your friends. 

If your device is listed here, you don't have to worry about the format settings, as the 
necessary settings of the export dialog (view page 270) are automatically customized 
to the target device. Simply select your device and click "OK". 
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Output DV/HDV 
For digital output please select "File" > "Output audio/video" and then select 
Camcorder in the device menu. For DV cameras you can select the device DV 
camera for HDV camcorder HDV1 or HDV 2 Camcorder. 

With Settings you can open the respective export settings dialog (DV-AVI export for 
DV camcorder, MPEG export for HDV camcorder). For most applications you should 
use the settings defined here. Advanced takes you to the DV export settings (More 
information can be found in the section "DV export settings" on page 278). 

Now connect your camera and follow the displayed instructions. 

If you want to export a rendered (already edited) movie to DV, there’s no need to 
render it again. Simply activate the “Play own DV file” option and select your DV 
video from the “My audio video” directory.  

Tip: Digital cameras that can digitally record via a PC connection are usually more 
expensive. You may be able to reduce your purchase costs considerably by buying a 
digital camera that cannot transfer digitally and have the function activated by a 
camera specialist. You should enquire about this option before making your 
purchase. 
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DV export settings 
PAL/NTSC: The PAL format is used in Europe, and the US and Japan use NTSC. This 
option usually does not require changing. 

Render changed parts...: Non-edited original files are simply copied into a completed 
DV AVI. Normally, you have to decompress the DV data, add the set effects 
calculations, and recompress it. If no effects processing is pending, then these steps 
may not be necessary. This option can be permanently activated. 

Use references to original material...: Unedited original files are exported directly to 
the device. Effects are rendered in real time. Use this option for finished movies 
without edits and effects, since real-time effects processing of DV data causes high 
processor loads that often result in output errors. 

Transfer DV back to device after export...: Deactivate this option if you are only 
rendering your movie but do not want to export it. You can export your movie later by 
clicking "Export own DV file" from the "Export" dialog. 
 

My device is not in the list, what should I do? 

User-defined: 
If your device does not appear in the list after the online update, you can set up the 
export settings manually. No need to worry though; you only have to do it once, since 
these settings can be saved as a preset.  

Read the instruction manual of your mobile device to find out which file format is 
required for this. If your device supports multiple formats, then you can experiment 
with the formats to get the best results. 

Specify the file format by opening the target device's menu and selecting "User-
defined -> Video -> ...Format". If you then click on "Export", you arrive at the Export 
dialog (view page 270) of the selected file format where you can set all the advanced 
settings. 

For details on these settings, please consult your device manual. Explanations for the 
file format's settings can be found in the Overview of the device classes chapter, for 
the special settings of the export dialogs see "Export movie" in the "File menu" 
chapter. 

Tip: If the format settings for your device are not accessible, then you can try out a 
different device from the same manufacturer and, using it as a template, make 
adjustments accordingly. 

If you find settings you like, we recommend saving these as a preset 
for further use. 
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Batch conversion 
This menu item accesses the batch processing (view page 242) function. This quickly 
and efficiently converts multiple files, movies, or projects into various video formats. 

Keyboard shortcut:  S 
 

Burn CD/DVD 
Manually compile files 
Opens MAGIX Speed burnR to burn videos or other files onto CD/DVD. File selection 
is done via drag & drop from MAGIX Speed burnR's Explorer. 

Keyboard shortcut:  Ctrl + B 
 

Copy CD/DVD direct 
The dialog provides several options for creating a copy: 

• Copy: Here you can directly copy a non copy-protected CD or DVD.  
• Shrink: Compresses a DVD to the size of a regular single layer DVD+/-R/RW. 

All files of the original DVD have to be on the hard drive. 
• Analog copy: Copies your video onto a disc via analog recording. 

Read more about this in the chapter "Record (view page 86)". 
 

Burn copy of an already created video disc 
All necessary files, menus, and encoded video files needed to burn a disc will be 
temporarily stored on your hard drive as an image. After your disc is burned, these are 
not automatically deleted. You can use these images to burn as many discs as you 
would like without having to encode the files again. 

In the dialog, choose the image you want. All necessary files are then transferred to 
the MAGIX MAGIX Speed burnR burning software. 

Tip: For more information on using MAGIX Speed burnR, read the program's help 
file. 

 

Vimeo 
Upload current movie as video: Once you login to Vimeo, the upload dialog will open. 
Enter the title, description, and keywords and select whether you want your film to be 
public or private. "OK" uploads the current film. 
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Upload selected media in Media Pool: Once you login to Vimeo, the upload dialog 
will open. Enter the title, description, and keywords and select whether you want your 
media to be public or private. "OK" uploads the selected media. 
 

Online 
Quick access to MAGIX Online World. 
 

Catooh 
Catooh offers you with the option of finding and purchasing more media and 
templates. Via the "media backup" option, you can import already purchased media 
that are saved on your computer to MAGIX Movie Edit Pro. 

Note: For more information about MAGIX Online World select the menu item "File" 
> "Online" > "Find out more about MAGIX Online World...". 

 

Manage your login details 
In this dialog you can enter and manage your login details (email address and 
password) for all services accessible from MAGIX Movie Edit Pro. You therefore do 
not have to login every time, for example, when exporting to Facebook (view page 
300) or in the MAGIX Online Album (view page 280). 
 

Receive data with Send Anywhere 
With Send Anywhere, you can now receive and send media, movies or whole projects 
from anywhere.  

If you have received a 6-digit key, select one of the following two options in 
"File">"Receive via Send Anywhere": 

Receive media: The downloaded media will be saved and marked under "Downloads" 
in "Media Pool > Import". 

Receive project:  The downloaded project will be saved and marked under 
"Downloads" in "Media Pool > Import". 

If you wish to send data via Send Anywhere, select "Share" > "Send with Send 
Anywhere". 
 

Backup copy 
Files must be saved to be able to be easily retrieved in case of a hard drive crash or 
some other error. 
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For detailed information, read the "Backup" (view page 244) section in the "Wizards 
and special functions" (view page 216) chapter. 
 

Load backup project 
This option loads an automatically created slideshow backup. This type of automatic 
backup gets the file extension MV_ (underscore). This command is only intended for 
use in emergencies, for example, if you unintentionally saved your change and wish to 
return to the previous version of the movie. 

Keyboard shortcut:  Ctrl + Shift  + O 
 

Cleaning Wizard 
The clean-up wizard helps delete projects from the hard drive, including all of the 
media files used. Use this function to free up disk space for future projects. 

Caution: If the files you used in the movie have also been used in other movies (like 
trailers, opening music, etc.), then you should make backup copies of these files 
beforehand. 

Keyboard shortcut:  Ctrl + Shift + Y 

For detailed information, read the "Cleaning Wizard" (view page 246) section in the 
Wizards and special functions" (view page 216) chapter. 
 

Settings 
Movie settings 
Opens the movie settings (view page 74) of the currently selected movie. 
 

Program... 
Opens program settings (view page 76). 

Shortcut:  Y 
 

Keyboard shortcuts... 
This menu entry opens a dialog for editing keyboard shortcuts (view page 328); this 
enables you to adjust MAGIX Movie Edit Pro however you like. 

Keyboard shortcut:  Ctrl + Shift + U 
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Proxy and preview rendering... (Plus/Premium version) 
This menu item opens the dialog for the proxy and preview rendering settings. 

Keyboard shortcut:   Alt + R 
 

Language 
Change the language used in MAGIX Movie Edit Pro here. Normally, the language 
that is used for installation is set as the program language. 
 

Reset program settings to defaults. 
Use this function to reset all program settings you made in MAGIX Movie Edit Pro to 
their original settings. 
 

Exit 
Closes MAGIX Movie Edit Pro. 

Keyboard shortcut: Alt + F4 
 

Edit Menu 
Undo 

 

This command allows you to undo the last changes made. This way, it's no 
problem if you want to try out critical operations. If you don't like the result, 
you can always revert to the previous state using "Undo". 

Clicking on the arrow next to the button opens a list of changes made until now, 
allowing you to undo several changes made in sequence. 

Note: You can adjust the length of the list to your needs in program settings (view 
page 76). A general rule: The longer the list, the more RAM is used. 

 

Restore 

 

This function undoes the previous "Undo" function. 

Clicking on the arrow next to the button opens a list of revoked changes made until 
now, allowing you to restore several "undo steps". 
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Empty undo and cache memory 
This option deletes the memory for undo commands and clipboard (cache). 
 

Cut objects 
This function extracts the marked scene and copies it to the clipboard. You can then 
use the "Paste" command to copy it into any movie. 
 

Copy objects 
This function copies the selected scene (or the selected object in the Timeline-mode) 
to the clipboard. You can then use the "Paste" command to place it into any movie. 
 

Paste objects 
This command inserts the clipboard material (photo or object) at the current position 
of the start marker. 

Keyboard shortcut: Ctrl + V 
 

Duplicate objects 
This command duplicates all selected objects. The copies appear beside the original 
and can be placed in the correct position using drag & drop. 

Keyboard shortcut:  D 
 

Delete objects 
This command deletes the selected scene (or the selected object in 
Timeline-mode). 

Shortcut:  Del 
 

Select all objects 
All objects in the arrangement will be selected. 

Keyboard shortcut: Ctrl + A 
 

Save objects as takes 
The selected objects are saved in the takes directory. To use takes, please read the 
chapter "Saving objects separately (view page 116)" in the PDF manual. 

Keyboard shortcut:   Strg + F 
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Cut 
Editing functions are also accessible using the toolbar. The last selected function will 
appear in the toolbar as a button. 
 

Split scene 

 

This command cuts a scene at the point where the playback marker is 
positioned. This way, two free-standing objects are created. 

Keyboard shortcut:   T 
 

Remove scene start 

 
This command cuts a scene at the point where the start marker is positioned, 
and deletes all material that precedes the start position simultaneously. 

Shortcut:  Z 
 

Remove scene end 

  
This command cuts a scene at the point where the start marker is positioned, 
and deletes all material behind the start position simultaneously. 

Keyboard shortcut:  U 
 

Remove scene 

 
If you want to cut a scene on track 1 out of a movie in the timeline mode at a 
later stage, this option automatically moves objects, titles, and transitions on 
all tracks forward so that no gaps are created in the film. 

Objects on other tracks which extend into the area of the scene in question will not be 
moved automatically; they will remain in their current positions. 

Shortcut:   Ctrl + Del 
 

Split movie 

 
This command divides the movie into two individual movies at the position of 
the playback marker. 

The current project window retains the portion that is located in front of the playback 
marker. The latter part will be removed from the current project window and placed 
as a new film. You can find this movie by going to the "Window" menu. 

Shortcut: Alt + Y 
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Musical editing 
If your background music is edited using the beat recognition assistant (view page 
238), you can automatically adapt your cuts to the tempo with this option. All hard 
cuts (no crossfaded objects) are shifted across the musical quarter note positions. 

Keyboard shortcut: Ctrl + Shift + M 
 

Range 
MAGIX Movie Edit Pro provides object-based functions as well as "band-oriented" 
editing functions. These always refer to the whole arrangement from the first to the 
last track as well as to the area between the start and end marker. 
 

Cut range 
The section between the in and out points is cut from the current project and placed 
on the clipboard. This section can be reinserted elsewhere. 

Shortcut:  Ctrl + Alt + X 
 

Copy range 
The section between the in and out points is copied from the current project to the 
clipboard. This section can be reinserted elsewhere.  

Shortcut:   Ctrl + Alt + X 
 

Delete 
The section between the in and out points is deleted from the current arrangement 
and not copied to the clipboard. 

Keyboard shortcut:   Alt + Del 
 

Insert range 
The contents of the clipboard are inserted at the current project's position of the in 
point.  

Shortcut:  Ctrl + Alt + V 
 

Extract 
The section between the in and out points is preserved, and all of the material in front 
and behind it are deleted. Use this option to isolate a specific part of an arrangement 
for further individual editing. 
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Shortcut:   Ctrl + Alt + P 
 

Insert blank space 
An empty section the length of the period between the start and end marker will be 
added to the first visible track. The objects following this will be moved. 

Note: This function only applies to the first visible track. Therefore, it is necessary to 
scroll through the arranger to bring the track you want up to the line at the top. 

Keyboard shortcut:  C 
 

Insert still image 
The start of the range is inserted as a still shot over the length of the range. 

Note: This function only applies to the first visible track. Therefore, it is necessary to 
scroll through the arranger to bring the track you want up to the line at the top. 

 

Form group 
Orders all selected objects into groups. As soon as an object from the group is 
selected, all other objects in the group will be highlighted as well so that you 
can work on them collectively. 

Keyboard shortcut:  G 
 

Ungroup objects 

 
This turns all selected objects into free-standing objects again. 

Keyboard shortcut:  Shift + G 
 

Wizards 
Slideshow Maker 
Opens the Slideshow Maker (view page 231) 

Keyboard shortcut:  Ctrl + M 
 

Soundtrack Maker 
This command opens MAGIX Soundtrack Maker. 
Keyboard shortcut:   Ctrl + Shift + S 
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Travel route animation 
This menu entry opens the separate Travel route animation program. This enables 
simple creation of animated travel routes with the help of online maps. 

Note: In order to be able to use current map data, maps are fetched by Travel route 
animation directly from the Internet. This requires an active Internet connection. 

 

Mixdown Audio 
This option joins all audio objects in one audio file. The sound material will only 
occupy one track of the project window and will hardly affect the RAM, but it will 
occupy approximately 10 MB (in stereo) on the hard drive. This will give you more 
control over the project window and more space for additional objects. 

MAGIX Movie Edit Pro automatically normalizes the audio file, i.e. the loudest part of 
the wave audio object is identical with the highest figure of the 16-bit resolution 
ceiling. This guarantees the same sound quality, even if you repeat the mix down 
procedure or you combine the mix down file with other wave audio objects again and 
again. 

The mix function is very helpful if you want to go on using the mixdown object. For 
the final AVI or WAV (or any other multi-media) file, which is designed for burning a 
CD or for use on other PCs, use the "Export arrangement" submenu options from the 
file menu instead of the mixdown function. 

Tip: Instead of using the mixdown function, you can use the various options of the 
submenu "Export movie" in the File menu to create a final  final *.avi or *.wav (or any 
other multimedia) file. 

Keyboard shortcut: Shift + D 
 

Audio and video mixdown 
In addition to the "Combine audio" function (see above), all video objects including 
effects, transitions, and edits are combined in a single MAGIX video file (view page 
271). If your computer starts to approach its limits, this enables you to free resources 
for further editing. 

Keyboard shortcut:  Shift + M 
 

Start preview rendering... 
Starts Preview rendering (view page 217). 
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Shortcut:  Ctrl + R 
 

Remove range(s) for preview rendering... 
Removes preview rendering ranges. If multiple sections were defined and the 
playback marker is placed over one of these sections, you will be asked whether you 
would like to remove only this "Secton" or "All. 
 

Marker 
Set project marker 
This option places a project marker at the current playback position. More 
information about project markers is available in the chapter "Markers" under "Set 
project marker (view page 121)". 

Keyboard shortcut:  Ctrl + Enter 
 

Delete project marker 
Deletes the selected project marker (view page 121). Project markers can be deleted 
and renamed via the context menu. 
 

Snap markers 
Set snap marker: To set a snap marker, select an object and place the playback 
marker at the position where you would like the snap marker to be. You can set as 
many snap markers as you like per object. 

You can move a snap marker with the mouse using drag & drop. Or use the "Align 
objects to grid markers" function. 

Keyboard 
shortcut:
 
 #  

Ctrl + P 

A snap marker will be set where the playback marker is located in 
the selected object. 

Set snap markers (advanced): Open the snap markers section in the Media Pool 
under "Effects". 

Align objects on snap grid: Aligns the objects so that they snap to the snap markers. 

Delete all snap markers: This deletes all snap markers for all objects in a film. 

Show or hide snap markers:You can hide snap markers if required and show them 
again later. 
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Set chapter markers 
Places a chapter marker at the position of the playback marker. This creates a 
chapter entry in the disc menu in case the movie is being burned to disc. 

You can rename the chapter markers by right clicking and selecting "Rename" in the 
context menu. The new name will also appear in the chapter menu (view page 248). 
 

Set chapter markers automatically 
This option automatically sets chapter markers in the project according to specific 
rules that will then appear as chapters in the film menu of a disc. This is useful if you 
need to burn a disc immediately after recording. 

Keyboard shortcut:  Shift + Alt + Return 

 

Automatically create chapter marker 
• At the beginning of a movie: The movie contains only one chapter 
• At object starts in a track: Every object in a track creates a chapter, Track 1 is 

preset. 
• At the position of existing title objects: Subtitles, for instance, as faded-in 

subheadings, give the position of the chapter markers. 
• Provide interval (in minutes)/provide quantity: If the chapters are separated 

without any particular method and are just needed for quicker navigation, 
chapter markers may also be inserted in pre-defined intervals or as a pre-
defined number of chapter markers. 
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Naming chapter markers 
• No marker name: Marker name and marker number are not specified. 
• Custom: You can use a custom name. A sequential marker number will be 

attached to it.  
• Apply object name: The marker name is taken from the object name and the text 

in the text object. No sequential marker number  is specified. 

Options 
• Delete existing chapter markers: Deletes chapter markers that have already 

been set. 
• Only take the selected area into account: The chapter marker is automatically 

set to the area between the start and end markers only. 
 

Delete chapter markers/delete all chapter markers 
Delete one or all chapter markers. This removes chapter entries in the disc menu if 
the film is burned to disc. 

Keyboard shortcut:  Ctrl + Alt + Enter 
 

Marker -> Set range start/end 
Sets a range start/end marker at the position of the playback marker. 

Keyboard shortcut:  I/O 
 

Marker -> Jump to range start/end 
Sets the playback marker at the position of the range start/end. 

Keyboard shortcut:   Shift + I/O 
 

Range above blank space 
If you set the playback marker in a empty range in the first visible track, this function 
will create an area over the length of the range.  

Alternatively, you can find this function in the context menu of the empty range. 

Note: This function only applies to the first visible track. Therefore, it is necessary to 
scroll through the arranger to bring the track you want up to the line at the top. 

Shortcut:  X 
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Fill blank space with still image 
The blank space in which the playback marker is located is filled with a still shot with 
the last image before the blank space. 

Alternatively, you can find this function in the context menu of the empty range. 

Note: This function only applies to the first visible track. Therefore, it is necessary to 
scroll through the arranger to bring the track you want up to the line at the top. 

 

Marker -> Reset selected range 
Deletes the range start and the range end. 
 

Move screen view 
Using these commands, a viewable portion together with the start marker will be 
moved in the timeline. You can quickly skip between different markers (skip, chapter, 
scene, ad-marker) and object edges. 

Keyboard shortcut: See "Keyboard shortcuts", "Project window". (view page 
321)  
 

Multicam 
This command switches to Multicam mode. 
 

Mute audio tracks (Multicam) 
To avoid the interference of several multicam audio tracks being played at the same 
time, you can mute all of the audio tracks. 

Keyboard shortcut:  Alt + Shift + M 
 

Effects Menu 
Master effects 
This menu item accesses the movie's effect settings (view page 171). The settings 
affected here apply to the entire movie. 

Keyboard shortcut:  Ctrl + Shift + H 
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Video object effects 
Scene recognition 
Calls up the automatic scene recognition, which "cuts up" longer videos into scenes 
for storage in the "Takes" directory.  

Keyboard shortcut:  Shift + Z 
 

Image stabilization 
Select which image stabilization you want to use. In the Media Pool, you can choose 
between the normal image stabilization dialog  (view page 169)and proDAD Mercalli 
2.0 (view page 145). Both will allow you to correct blurry footage. Try both to see 
which one gets you better results. 

Image stabilitaion keyboard shortcut: CTRL + L 
 

In MAGIX Photo Designer bearbeiten 
Graphic files (BMPs or JPEGs) from the project window can be post-edited in an 
external graphics program. The selected image file is loaded automatically and, once 
editing has been completed, is used in the MAGIX Movie Edit Pro instead of the 
original material. For this, MAGIX Movie Edit Pro offers the high-performance photo 
editing program MAGIX Photo Designer. 
 

Save photos with effects 
This allows you to save photos used in the movie and add the object effects used in 
MAGIX Movie Edit Pro (e.g. StoryMaker) to the photo. 
 

Create panorama... 
Opens the dialog for setting a panorama. Place as many photos in the correct order as 
you like, and align brightness and color settings to get the best results. You should 
make sure that the photos harmonize at the transitions. 
 

Video effects 
Here you can find adjustable effects for video and photo objects. The effects can be 
set only after selecting an object in the respective effects dialog. For more 
information, go to the "Video effects in the Media Pool" (view page 138) section in the 
"Effects" chapter. 
 



 

 

Menus 293 

 

Video effect templates 
This features general templates that can be added to the video objects via drag & 
drop and several video mix effects that can be quickly and easily applied, e.g. 
bluescreen. 
 

Movement effects 
These are movement effects you can use to animate the frame by using zoom or 
camera movements. For more information go to the "Effects" chapter, section 
"Movement effects in Media Pool" (view page 147). 
 

Movement effect templates 
These are templates for movement effects. These can be added from the Media Pool 
into the arrangement by double-clicking or via drag & drop. 
 

Section 
Places video objects in a particular part of the screen. Please read the "Video effects" 
chapter for more details. 
 

Stereo3D 
This accesses the program's Stereo 3D functionality. Please read the corresponding 
chapter "Stereo 3D". (view page 208) 
 

Background design 
Select a color, a picture, or any video on your hard disk which you would like to serve 
as the background for the photo displayed. This function is especially useful when 
photos have black bars around them, or if they are reduced in size. 
 

Reset background 
Resets the background design (view page 293) settings to default settings. 
 

Set as background 
Uses the selected photo or video as the background. 
 

Load video effects 
This command enables a saved effects combination to be loaded for the currently 
loaded object. If multiple objects are selected, then the effects combination will be 
applied to each selected object. 

Shortcut:   Ctrl + - 
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Save video effects 
This command saves the current effects combination for each object separately. 

Shortcut:   Alt + - 
 

Reset video effects 
This option allows you to deactivate all currently used effects. The material will be 
reset to the state it was in before you applied the effect.  

Shortcut:  Ctrl+ Alt + - 
 

Copy video effects 
Effects settings for an object may be copied to the clipboard to add (view page 294) 
them to other objects. 

Keyboard shortcut:  - 
 

Insert video effects 
Video effects may be inserted into the selected object from other objects. The 
settings must be copied (view page 294) beforehand into the clipboard. 

Keyboard shortcut:  Shift + - 
 

Apply video effects to all 
The current effects settings will be applied to all scenes and photos in your movie. 
 

Apply video effects to all of the following 
The current effects settings will be applied to all scenes and photos in your movie 
which lie behind the selected object. 
 

Audio object effects 
Normalize (maximum level) 
The function "Normalize" raises the level of an audio object to the maximum possible 
level without clipping the material. This searches for the largest signal peak in the 
audio material and raises the level of the object so that this position matches exactly 
0 dB (maximum overdrive). 

Keyboard shortcut:  Shift + N 
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Automatic track damping 
Please see Reduce volume (view page 195) in the audio effects chapter. 

Keyboard shortcut:  Alt + L 
 

Adjust loudness of selected objects 
This function adjusts the loudness of all selected objects to fit the last activated 
object. 

You can find more information about this under "Adjust loudness of selected objects" 
(view page 174). 
 

Set volume 
This function, located in both the effects menu and the context menu, controls the 
sound volume for individual objects, just like the object handles in the project window. 
 

Audio cleaning 
Opens the "Audio Cleaning (More information can be found in the section "Sound 
optimization" on page 180)" dialog. 

Keyboard shortcut:  Alt + A 
 

Echo/Hall 
Please see "Reverb/Echo" in the chapter "Audio effects". 

Keyboard shortcut: Shift + H 
 

Timestretch/resample 
Read more about this in Timestretch/resample (view page 185). 

Keyboard shortcut:  Ctrl + Q 
 

Audio effects 
These options open the individual effects from the audio effects folder in the Media 
Pool. 
 

Audio effect presets 
This option opens the audio effect presets in the Media Pool. 
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Load audio effects 
This command enables a saved effects combination to be loaded for the currently 
loaded object. If multiple objects are selected, then the effects combination will be 
applied to each selected object. 

Keyboard shortcut:  Ctrl + + 
 

Save audio effects 
This command saves the current effects combination for each object separately. 

Keyboard shortcut:  Shift + + 
 

Reset audio effects 
This option allows you to deactivate all currently used effects entirely if you want to 
undo the changes. 

Keyboard shortcut:  Ctrl + Alt + + 
 

BPM Wizard 
Read the section concerning the Tempo and beat recognition (view page 238) in the 
chapter "Audio" for more about this. 

Keyboard shortcut:  Alt + Shift + K 
 

Volume curve 
The most important effect, the volume, is available here directly. The volume is also 
available via the Media Pool under "Effects -> Audio effects -> General (view page 
154)", where it may also be animated. 

Keyboard shortcut:  Ctrl + Shift + V 
 

Title Effects 
Title Editor 

 
Opens the Title editor for the selected photo, video, or title 
object. 

Keyboard shortcut:  Ctrl + T 
 

Load title template 
Use this command to load previously saved title effects for the current object.  
Shortcut:   Alt + Shift + T 
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Save title template 
You can save the current effect combination for each title object separately and apply 
it to other title objects later. 

Shortcut: Alt + T 
 

Design elements 
Picture-in-picture: These are various effect templates for image stacking. 

Collages: These work similarly to normal picture-in-picture effects but more objects 
are used. Depending on the collage, arrange the selected objects one after the other 
and drag the collage onto the first object. 

Test images: These are professional test images for calibrating your system. You can 
also use the colored backgrounds for your own color transitions, for instance. The 
special "User" template opens a color selection dialog where you can choose the 
desired color. 

Backgrounds: Here you can find static and animated photo and video backgrounds. 
Video backgrounds are capable of being looped, meaning that their length can be 
extended by duplication. 

Image objects: Here you will find various image objects like black bars, thought 
bubbles for cartoons, etc. 

Intros/Outros: These are beginning and end scenes for films with various themes. 

You can find additional information in the "Effects (view page 155)" chapter, in the 
section "Design element in Media Pool". 
 

Effects library 
Using these menu choices, you can control the corresponding directories in the Media 
Pool (view page 27, view page 46). 
 

Windows Menu 
Window arrangement 
Standard 
This option switches from the multiple monitor setting (see below) back to the 
standard single monitor setting. 
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Multi-monitor with maximized preview monitor 
This option can be used when several computer monitors are connected. It enlarges 
the preview monitor for a fullscreen display on one of the connected monitors. The 
other elements are displayed on a second monitor. 
 

Reset window arrangement 
If you have moved the windows around in MAGIX Movie Edit Pro, you can put them 
back to the original position using this command. 

Keyboard shortcut:  F9 
 

Cut Trimmer 
Shows or hides the "Cut trimmer" window. This allows you to make fine adjustments 
to the position of the selected video or image objects and their handles – as well as 
the transition characteristics (transition type, length). Please read the "Fine 
adjustment of video ("Trimming") (view page 114)" chapter for more details.  

Keyboard shortcut: N 
 

Object trimmer 
Shows or hides the trim window. This enables the position of the selected video or 
image object and its handles to be adjusted more finely. Read the chapter "Adjusting 
videos precisely" ("Trimming") (view page 114). 

Keyboard shortcut:  Shift + N 
 

Mixer 
With this option you can open and close the real-time mixer. Further information can 
be found in the Mixer (view page 196) chapter. 

Shortcut:  M 
 

Master audio effect rack 
Opens or closes the master effects rack; you can also use the "Master FX" button in 
the mixer window for this. 

Shortcut:  B 
 

Mastering Suite 
This opens the Mastering Suite. 
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Program monitor 
Opens and closes the video window. If the standard layout is chosen the Mediapool 
can be shown in a freely scalable and moveable window. 

Keyboard shortcut:  Shift + V 
 

Show Media Pool... 
This option hides or displays the Media Pool. 

Shortcut: Shift + P 
 

Project 
Shows/Hides the project window 
 

Activate next window 
This option activates the next window respectively and allows better control with 
keyboard shortcuts in MAGIX Movie Edit Pro. 
 

Show movie overview 
With this option, you can display an overview of the entire arrangement on the video 
screen. It is particularly suitable for long and complex arrangements to prevent you 
from losing track. You can view the whole movie and you are, despite this, able to 
access the object you're looking for in a split second – you can zoom in directly on the 
video monitor or move around the clip displayed in the project window. 

Keyboard shortcut:   Shift + A 
 

Optimize movie view 

  
The zoom level is set to 100% so that you can see every object and the entire 
film.   

The start and end markers are set to the beginning or end, so that the entire movie 
can be played. 

Keyboard shortcut:  Ctrl + F 
 

Zoom horizontal 
Here you will find a range of functions for altering the visible time axis section. 
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Zoom vertical 
The number of simultaneously visible tracks can be changed here. The more tracks 
are visible, the smaller they will appear. 
 

Remove all movies from project 
Closes all opened movies. 
 

Share Menu 
Here you will find many options for for quickly and easily publishing your data from 
the program on the web. Additionally, data transfer into other programs for 
specialized editing, if you have such programs installed, is enabled. 
 

Vimeo 
Upload current movie as video: Once you login to Vimeo, the upload dialog will open. 
Enter the title, description, and keywords and select whether you want your film to be 
public or private. "OK" uploads the current film. 

Upload selected media in Media Pool: Once you login to Vimeo, the upload dialog 
will open. Enter the title, description, and keywords and select whether you want your 
media to be public or private. "OK" uploads the selected media. 
 

Youtube / Facebook 
This is the direct link to YouTube and Facebook. 
 

Youtube / Facebook 
Uploads the current film to the selected portal or to the selected community. Enter 
the data for video into the fields provided, so that the search function for this portal 
can also find this video. 

MAGIX Movie Edit Pro partially uses the H.264 format for this, which is a component 
of the MPEG-4 codec. Since Flash supports this format directly and most 
communities and portals use the format, the film does not need to be re-rendered on 
the corresponding server. This avoids loss of quality. 

When HD material is uploaded, a resolution of 720p is used for the HD format. 
 

Upload all selected media in Media Pool 
Uploads the media selected in the Media Pool to the corresponding portal or the 
selective community. 
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Note: To import and export AVC(HD) and MPEG-4 files, the MEPG-4 codec must 
first be activated (view page 337). A dialog will open if the codec is required. 

 

Send with Send Anywhere 
If you want to share media or a project with another person, select "Share > Send with 
Send Anywhere". 

You will receive a 6-digit key that you need to send to the other person so that they 
will be able to receive your data. As soon as they enter the key and click on "Receive", 
the data will be transferred live. This means that you cannot close MAGIX Movie Edit 
Pro during the transfer! 

Send current film as video: Creates a MPEG-4 format video that corresponds to the 
movie template for your film. 

Send media selected in Media Pool/Send media selected in film/Send current project 
and media: The selected data will be transferred. 
 

Back up to CD or DVD 
This option opens MAGIX Speed burnR for burning files directly to CD or DVD. 
 

Additional options 
The additional options in the "Share" menu vary depending on the installed software. 
For example, you can edit photos or graphics in Xara Web Designer or Xara Photo & 
Grahpic Designer, the audio can be improved in MAGIX Audio Cleaning Lab, or you 
can add audio dubbing to your movie with MAGIX Music Maker. 
 

Help Menu 
Help 
This command is available for almost every feature of the program, and it opens the 
"Help" file for the corresponding topic. Use this command to get help on any of 
MAGIX Movie Edit Pro's functions. 

Keyboard shortcut: F1 
 

Context help 
The mouse cursor will turn into an arrow with a question mark.  

Click on any button of the main screen, to open program help which will describe the 
control element in question. 
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Shortcut:  Alt + F1 
 

PDF manual 
Opens the manual in PDF format. Similar to the Help feature that can be accessed by 
pressing F1, this manual contains all of the important information about the program. 
 

Quickstart/Recording/Editing/Burning and exporting 
tutorial video 
Displays tutorial videos on different video editing topics in MAGIX Movie Edit Pro. 

Tip: If you are using MAGIX Movie Edit Pro for the first time, we recommend you 
view the tutorial videos first. They will give you a quick introduction to the most 
important topics. 

 

Display tooltips 
Tooltips are small information windows that open up automatically if the mouse 
pointer stops briefly on a button or some other area. They provide information about 
the function of the button. These information boxes can be switched on or off with 
this option. 
 

magix.info 
Ask magix.info a question. 

You can also present your own videos on magix.info.  
 

Online video tutorials 
There is a series of video tutorials about MAGIX Movie Edit Pro on the MAGIX 
Website that provide clear, descriptive explanations for many of the features. 

Note: An Internet connection is required. 
 

Online tutorials 
Interesting tutorials and useful tips for working with MAGIX Movie Edit Pro can be 
found on the MAGIX website.  
An online connection is required. 
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Register online 
This option opens the MAGIX homepage for online registration where you can 
register as a MAGIX user. 

Registration grants you access to the MAGIX support website where various program 
updates and help programs can be downloaded. 
 

Online Update 
Connects directly to the online update page where you can get the latest version of 
your program. 
 

Install extra content 
This opens a dialogue where you can install additional Codecs and extra content. 
 

Activate content packs 
Use this menu option to activate the additional programs included in the Premium 
version. Enter the coupon code in the dialog for the content pack. The add-on 
software will be downloaded and installed automatically. In addition, five free 
downloads will be added to the Store, which can be used for any Store content. 

Deactivate Program 
This menu item deactivates MAGIX Movie Edit Pro with immediate effect. After 
deactivation, it is possible to immediately install and activate MAGIX Movie Edit Pro 
on another computer  
 

About MAGIX Movie Edit Pro 
Displays copyright info and version number of MAGIX Movie Edit Pro. 
 

Context menu (right click) 
Context menu can be reached by right clicking on a selected object. It offers functions 
which are available and can be expected in the given context. 
 

Video objects 
Create frame table (new) 
Sometimes, rebuilding a frame table can get rid of problems in certain MPEG files. For 
example, such problems can be present if the navigation (positioning of the playback 
marker, transport) is bumpy or doesn't function at all. 
Normally, when loading MPEG video, a frame table is not created in order to speed up 
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the loading process. If you do create one anyway, MPEG files are normally noticeably 
faster and easier to edit. 
 

Audio functions 
Here you'll find various options for editing the audio track. These correspond to the 
menu options "Effects" > "Audio object effects" with the following exceptions: 
 

Create wave form 
In most cases, the waveform display of an audio file will not be required. However, if 
you require this, e.g. to navigate while cutting video, a waveform display can be 
produced manually via this function. 
 

Adjust loudness of selected objects 
This function adjusts the loudness of all selected objects to fit the last activated 
object. 

You can find more information about this under "Adjust loudness of selected objects" 
(view page 174). 
 

Mute/activate audio object 
Mutes the audio track of the video object without deleting it or reactivates the 
previously muted audio track in a video object. 
 

Remove/restore audio object 
This option allows you to remove or restore and audio object to simplify the display. 
The audio itself is not affected or deleted. 
 

Video/audio on one track 
Video material and the corresponding audio material (original sound) will be 
displayed as one object on one track. Using the top object handle you can adjust the 
video's opacity. The lower object handle adjusts the object's volume. 
 

Video/audio in separate tracks 
Audio material will be displayed on a separate track below the corresponding video 
material. This makes it easier to make advanced adjustments to audio material that 
go beyond changing the soundtrack's volume. 
 

Align other audio objects with this track (Plus/Premium version) 
Use this feature to automatically align audio objects or combined objects that contain 
an audio or video track with the same or similar audio material. Each object must be in 
a separate track to do so. 
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• First click on the reference object that the other objects should be aligned to. 
• Then select all the objects that you want to align to the reference object by 

holding down the Ctrl key. 
• Then select the option "Align other objects with this track" from the context 

menu. 

The objects are moved over each other so that your tracks run parallel. 

Tip: This feature is especially useful for editing video material in multicam mode 
(view page 131). 

 

Scene recognition 
Calls up the automatic scene recognition, which "cuts up" longer videos into scenes 
for storage in the "Takes" directory.  

Keyboard shortcut:  Shift + Z 
 

Image stabilization 
Select which image stabilization you want to use. In the Media Pool, you can choose 
between the normal image stabilization dialog  (view page 169)and proDAD Mercalli 
2.0 (view page 145). Both will allow you to correct blurry footage. Try both to see 
which one gets you better results. 

Image stabilitaion keyboard shortcut: CTRL + L 
 

Cut Trimmer 
Shows or hides the "Cut trimmer" window. This allows you to make fine adjustments 
to the position of the selected video or image objects and their handles – as well as 
the transition characteristics (transition type, length). Please read the "Fine 
adjustment of video ("Trimming") (view page 114)" chapter for more details.  

Keyboard shortcut: N 
 

Object trimmer 
Shows or hides the trim window. This enables the position of the selected video or 
image object and its handles to be adjusted more finely. Read the chapter "Adjusting 
videos precisely" ("Trimming") (view page 114). 

Keyboard shortcut:  Shift + N 
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Snap markers 
Set snap marker: To set a snap marker, select an object and place the playback 
marker at the position where you would like the snap marker to be. You can set as 
many snap markers as you like per object. 

You can move a snap marker with the mouse using drag & drop. Or use the "Align 
objects to grid markers" function. 

Keyboard 
shortcut:
 
 #  

Ctrl + P 

A snap marker will be set where the playback marker is located in 
the selected object. 

Set snap markers (advanced): Open the snap markers section in the Media Pool 
under "Effects". 

Align objects on snap grid: Aligns the objects so that they snap to the snap markers. 

Delete all snap markers: This deletes all snap markers for all objects in a film. 

Show or hide snap markers:You can hide snap markers if required and show them 
again later. 
 

Insert still image at the playback marker 
MAGIX Movie Edit Pro can create a still frame of an object at the playback marker 
position. This is inserted for the length of the standard display time (Program settings 
> Video/Audio > Standard display time) in the original object. 
 

Insert still image in range 
The start of the range is inserted as a still shot over the length of the range. 
 

Motion 
Lets you move video objects on the screen. See "Movement" in the "Video effects" 
chapter. 
 

Section 
Places video objects in a particular part of the screen. Please read the "Video effects" 
chapter for more details. 
 

Attach to picture position in the video 
This can be used to attach the current video, image, or (3D) text object to a 
movement path in another video object. Read more about this in the chapter 
"Magnetic objects (view page 168)". 
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Interpolation for interlace material 
Choose this option to remove interlace artifacts from your video image. If, for 
instance, you extract freeze frames from a video, ridge structures appear in sequences 
which feature movement. 
 

Anti-flicker filter 
Choose this option for still pictures with detailed structures and high contrast. This 
filter reduces line flickering during TV playback. 
 

Border cropping adjustment: 
Select this option if the edges are cropped during playback on your television. Values 
stored in "Movie effects settings (view page 172)" ("Effects" menu) will be applied. 
 

Background design 
These options allow you to design the background of an image using a simple editor. 
You can use a color or an image or video file. 
 

Video effects 
The entries for this submenu are directly available in the Media Pool. 
 

Copy/insert/cut/delete object 
These options correspond to the menu options under "Edit". 
 

Save objects as takes 
The selected objects are saved in the takes directory. To use takes, please read the 
chapter "Saving objects separately (view page 116)" in the PDF manual. 

Keyboard shortcut:   Strg + F 
 

Fade in date as title 
MAGIX Movie Edit Pro can add a time or date (“time code”) to the picture material. 
To add a time code, right-click the video object and choose the “Fade in date as title” 
option from the context menu. 

If you’re using a DV-AVI file (a digital recording from a camcorder, for instance), the 
recording date will be used from the chosen place. If you’re using a different file, the 
creation date will be used as the time code. The title editor is then opened in order to 
customize the entry. 
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In the preview monitor context menu you will also find the "Display play time" option. 
This will create a time code. 
 

Object properties 
This function displays all the information about the currently selected objects such as 
file name, position on the hard-drive, tempo, etc. The Object Editor also defines the 
foreground and background color of every object in the projects. Depending on the 
type of object, the elements displayed will vary. 

General information 
The name of the selected object, the fore/background color and aspect ratio for the 
object in unselected status can be changed here. Additional information is also 
displayed about which file the selected object points to. 

Calculation of intermediate images (only for video objects) 
Interlace properties:  Normally, MAGIX Movie Edit Pro automatically makes suitable 
settings for this. Adjustments still need to be made to faulty video footage. If playback 
of the exported movie is very jittery, if flickering occurs, or if some effects do not look 
how they should, you can reverse the source material frames. 

Deinterlace options: Normally, the setting Automatic interlace processing does not 
have to be changed. The frames are processed separately and passed to the encoder 
when exported. If necessary, MAGIX Movie Edit Pro will perform high-quality 
interlacing. If "No interlace processing" is set, then it is assumed that the source 
material contains full frames. 

For more information on interlacing, please see "Interlace" (view page 361). 

Interpolate intermediate frames: Activate this function in order to smoothen motion 
during playback in order to get a more fluid image. 

Tempo/Pitch (audio objects only) 
If there is information about the tempo, then the tempo can be doubled or halved 
here. You set the tempo with the BPM Wizard. 

Metadata (only when metadata is found in the object) 
Metadata from images or AVCHD videos will appear hear - if available. In this way 
you can find additional information about the object. 
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Image objects 
Change photo length 
This dialog gives exact values regarding the display duration for the selected photo. 
You may select multiple photos beforehand to change their display duration at once. 
 

Edit in Xtreme Photo Designer 
This loads the image in MAGIX Xtreme Photo Designer for detailed editing. 
 

Save photos with effects 
This option enables you to save photos with effects from MAGIX Movie Edit Pro as a 
new image file. 
 

Create panorama... 
Opens the dialog for setting a panorama. Place as many photos in the correct order as 
you like, and align brightness and color settings to get the best results. You should 
make sure that the photos harmonize at the transitions. 
 

Cut automatically to fit screen 
This function ensures that images don't have black edges (in case they don't fit into 
the given format). 
 

Transitions 
 The context menu for transitions can be accessed via the A/B button on each 
background object. Along with the various transitions you will find the following 
options: 

 

Save as transition template 
Saves your transition as a template, which you can then select via the transitions 
context menu. 
 

Apply to all objects in the track 
Applies the current transition to all transitions between two objects in the selected 
track. 
 

Apply to all of the following objects in the track 
Applies the current transition to all transitions between two objects in the selected 
track that are behind the object that you are currently editing. 
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Random transitions in the track 
Provides all transitions between objects in the currently selected track with random 
transitions. 
 

Transition length 
You can set the length of a transition in "Transition length" in the transition menu. If 
you select "Apply to all", the selected length will be used for all transitions in your 
movie. 
 

Settings... 
The transitions page in the Media Pool with the settings for the corresponding 
transition will be displayed. Depending on the transition, different settings are 
available. 
 

Audio objects 
The options in the context menu for audio objects correspond to the menu options 
"Effects" > "Audio effects" and the "Edit" menu with the following exceptions: 
 

Audio effects curves 
This feature provides direct access to diverse object effects, and these can be 
automated using a curve. All of the audio effects listed here are found in the Media 
Pool under "Effects -> Audio effects -> General". 
 

Adjust loudness of selected objects 
This function adjusts the loudness of all selected objects to fit the last activated 
object. 

You can find more information about this under "Adjust loudness of selected objects" 
(view page 174). 
 

Display track curves 
The most recently selected track curve is displayed on the object for editing. Use of a 
curve causes the parameters set in the mixer to be disregarded. 

Note: The track curves of audio objects can be animated in the same way as video 
effects. Read more about this in the chapter "Animating objects (view page 162)". 
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Reset track curves 
All track curves can be reset with this function. The settings made in the mixer will be 
applied to the track again. 

Caution! Before applying this function, make sure none of the track curves will be 
need in the future.  

 

Align other audio objects with this track (Plus/Premium version) 
Use this feature to automatically align audio objects or combined objects that contain 
an audio or video track with the same or similar audio material. Each object must be in 
a separate track to do so. 

• First click on the reference object that the other objects should be aligned to. 
• Then select all the objects that you want to align to the reference object by 

holding down the Ctrl key. 
• Then select the option "Align other objects with this track" from the context 

menu. 

The objects are moved over each other so that your tracks run parallel. 

Tip: This feature is especially useful for editing video material in multicam mode 
(view page 131). 

 

Object properties 
This function displays all the information about the currently selected objects such as 
file name, position on the hard-drive, tempo, etc. The Object Editor also defines the 
foreground and background color of every object in the projects. Depending on the 
type of object, the elements displayed will vary. 

General information 
The name of the selected object, the fore/background color and aspect ratio for the 
object in unselected status can be changed here. Additional information is also 
displayed about which file the selected object points to. 

Calculation of intermediate images (only for video objects) 
Interlace properties:  Normally, MAGIX Movie Edit Pro automatically makes suitable 
settings for this. Adjustments still need to be made to faulty video footage. If playback 
of the exported movie is very jittery, if flickering occurs, or if some effects do not look 
how they should, you can reverse the source material frames. 

Deinterlace options: Normally, the setting Automatic interlace processing does not 
have to be changed. The frames are processed separately and passed to the encoder 
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when exported. If necessary, MAGIX Movie Edit Pro will perform high-quality 
interlacing. If "No interlace processing" is set, then it is assumed that the source 
material contains full frames. 

For more information on interlacing, please see "Interlace" (view page 361). 

Interpolate intermediate frames: Activate this function in order to smoothen motion 
during playback in order to get a more fluid image. 

Tempo/Pitch (audio objects only) 
If there is information about the tempo, then the tempo can be doubled or halved 
here. You set the tempo with the BPM Wizard. 

Metadata (only when metadata is found in the object) 
Metadata from images or AVCHD videos will appear hear - if available. In this way 
you can find additional information about the object. 
 

Text objects 
Title Editor 

 
Opens the Title editor for the selected photo, video, or title 
object. 

Keyboard shortcut:  Ctrl + T 
 

Disable effects 
All effects applied to the text will be deactivated. 
 

Load title template 
A dialog for loading a title template will open. 
 

Save as title template 
This allows you to create your own templates using your title creations. The function 
"Load title template" enables these templates to be used again quickly. 
 

Save as special effect 
This function saves the title with all objects that have been grouped (view page 286) 
with the title object. This enables you to create title templates that contain all 
required overlay objects. 
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Convert to 3D title 
The title object will now be turned into a MAGIX 3D Maker object, and a limited 
version of MAGIX 3D Maker will open. 
 

Attach to picture position in the video 
This can be used to attach the current video, image, or (3D) text object to a 
movement path in another video object. Read more about this in the chapter 
"Magnetic objects (view page 168)". 
 

Border cropping adjustment: 
Select this option if the edges are cropped during playback on your television. Values 
stored in "Movie effects settings (view page 172)" ("Effects" menu) will be applied. 
 

Object properties 
This function displays all the information about the currently selected objects such as 
file name, position on the hard-drive, tempo, etc. The Object Editor also defines the 
foreground and background color of every object in the projects. Depending on the 
type of object, the elements displayed will vary. 

General information 
The name of the selected object, the fore/background color and aspect ratio for the 
object in unselected status can be changed here. Additional information is also 
displayed about which file the selected object points to. 

Calculation of intermediate images (only for video objects) 
Interlace properties:  Normally, MAGIX Movie Edit Pro automatically makes suitable 
settings for this. Adjustments still need to be made to faulty video footage. If playback 
of the exported movie is very jittery, if flickering occurs, or if some effects do not look 
how they should, you can reverse the source material frames. 

Deinterlace options: Normally, the setting Automatic interlace processing does not 
have to be changed. The frames are processed separately and passed to the encoder 
when exported. If necessary, MAGIX Movie Edit Pro will perform high-quality 
interlacing. If "No interlace processing" is set, then it is assumed that the source 
material contains full frames. 

For more information on interlacing, please see "Interlace" (view page 361). 

Interpolate intermediate frames: Activate this function in order to smoothen motion 
during playback in order to get a more fluid image. 
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Tempo/Pitch (audio objects only) 
If there is information about the tempo, then the tempo can be doubled or halved 
here. You set the tempo with the BPM Wizard. 

Metadata (only when metadata is found in the object) 
Metadata from images or AVCHD videos will appear hear - if available. In this way 
you can find additional information about the object. 
 

MAGIX 3D Maker objects 
Edit settings... 
A limited MAGIX 3D Maker version is opened to edit the selected object. 
 

Insert still image at the playback marker 
MAGIX Movie Edit Pro can create a still frame of an object at the playback marker 
position. This is inserted for the length of the standard display time (Program settings 
> Video/Audio > Standard display time) in the original object. 
 

Motion 
Lets you move video objects on the screen. See "Movement" in the "Video effects" 
chapter. 
 

Section 
Places video objects in a particular part of the screen. Please read the "Video effects" 
chapter for more details. 
 

Attach to picture position in the video 
This can be used to attach the current video, image, or (3D) text object to a 
movement path in another video object. Read more about this in the chapter 
"Magnetic objects (view page 168)". 
 

Interpolation for interlace material 
Choose this option to remove interlace artifacts from your video image. If, for 
instance, you extract freeze frames from a video, ridge structures appear in sequences 
which feature movement. 
 

Anti-flicker filter 
Choose this option for still pictures with detailed structures and high contrast. This 
filter reduces line flickering during TV playback. 
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Border cropping adjustment: 
Select this option if the edges are cropped during playback on your television. Values 
stored in "Movie effects settings (view page 172)" ("Effects" menu) will be applied. 
 

Background design 
These options allow you to design the background of an image using a simple editor. 
You can use a color or an image or video file. 
 

Video effects 
The entries for this submenu are directly available in the Media Pool. 
 

Save objects as takes 
The selected objects are saved in the takes directory. To use takes, please read the 
chapter "Saving objects separately (view page 116)" in the PDF manual. 

Keyboard shortcut:   Strg + F 
 

Fade in date as title 
MAGIX Movie Edit Pro can add a time or date (“time code”) to the picture material. 
To add a time code, right-click the video object and choose the “Fade in date as title” 
option from the context menu. 

If you’re using a DV-AVI file (a digital recording from a camcorder, for instance), the 
recording date will be used from the chosen place. If you’re using a different file, the 
creation date will be used as the time code. The title editor is then opened in order to 
customize the entry. 

In the preview monitor context menu you will also find the "Display play time" option. 
This will create a time code. 
 

Object properties 
This function displays all the information about the currently selected objects such as 
file name, position on the hard-drive, tempo, etc. The Object Editor also defines the 
foreground and background color of every object in the projects. Depending on the 
type of object, the elements displayed will vary. 

General information 
The name of the selected object, the fore/background color and aspect ratio for the 
object in unselected status can be changed here. Additional information is also 
displayed about which file the selected object points to. 
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Calculation of intermediate images (only for video objects) 
Interlace properties:  Normally, MAGIX Movie Edit Pro automatically makes suitable 
settings for this. Adjustments still need to be made to faulty video footage. If playback 
of the exported movie is very jittery, if flickering occurs, or if some effects do not look 
how they should, you can reverse the source material frames. 

Deinterlace options: Normally, the setting Automatic interlace processing does not 
have to be changed. The frames are processed separately and passed to the encoder 
when exported. If necessary, MAGIX Movie Edit Pro will perform high-quality 
interlacing. If "No interlace processing" is set, then it is assumed that the source 
material contains full frames. 

For more information on interlacing, please see "Interlace" (view page 361). 

Interpolate intermediate frames: Activate this function in order to smoothen motion 
during playback in order to get a more fluid image. 

Tempo/Pitch (audio objects only) 
If there is information about the tempo, then the tempo can be doubled or halved 
here. You set the tempo with the BPM Wizard. 

Metadata (only when metadata is found in the object) 
Metadata from images or AVCHD videos will appear hear - if available. In this way 
you can find additional information about the object. 
 

Timeline 
Marker -> Reset selected range 
Deletes the range start and the range end. 
 

Edit range 
Choose whether the selected area, bordered by the start and end marker in the 
timeline, should be cut, copied, deleted, inserted or extracted, or do you wish that an 
empty space is inserted. 
 

Start preview rendering... 
Starts Preview rendering (view page 217). 

Shortcut:  Ctrl + R 
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Remove range(s) for preview rendering... 
Removes preview rendering ranges. If multiple sections were defined and the 
playback marker is placed over one of these sections, you will be asked whether you 
would like to remove only this "Secton" or "All. 
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Problems and solutions 

File will not load 
If files do not load, the following problems could be the cause: 

• Problem: The format is not supported by MAGIX Movie Edit Pro. 
Solution: None. 

• Problem: You do not have the necessary user privileges. 
Solution: Check to make sure you have the necessary user privileges. You need 
reading and writing privileges in the source folder as well as in the project folder. 

• Problem: There is not enough space on the hard drive. 
Solution: Check to see how much free space is available on the hard drive. If 
needed, delete unnecessary files to free up space or extend storage space with 
another storage device. 

• Problem: The corresponding codec needs to be activated.  
Solution: Read the Import formats (view page 21) section. 

• Problem: The codec used in the AVI file is not installed. 
Solution: Read the "General tips for AVI videos" (view page 332) section in 
"Appendix: Digital video and storage media". 

 

Choppy or uneven playback 
Don't panic if the picture on your screen is choppy or uneven. The finished product 
will look perfect and play smoothly. Don't forget that MAGIX Movie Edit Pro 
calculates all effects in real time. This lets you see for yourself what sort of influence 
each of the effects will have on your video footage. Some effects make even today's 
high-performance PCs work quite hard, and often, a steady, continuous video stream 
is simply not possible on your PC. The final product, free from previous choppiness, is 
only available after rendering it to DVD or exporting it. For that reason, you should 
first edit the movie in its raw version without effects. The preview generally delivers a 
steady picture, allowing you to work quickly and quietly. Towards the end, you can 
add effects to your movies to give them a special touch of Hollywood! 
 

Problems and Remedies regarding the Auto 
Remix Assistant 
Problem: The playback stutters, the metronome is suspended, the computer is 
overloaded... (on older computers.)  

Remedy: We recommend changing to wave drivers ("P" key, "Playback parameter" 
dialog) instead of DirectSound.  

Problem: The metronome does not work and there are no lines on the the wave-
shaped display.  
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Probable cause: The material does not contain beats or the song contains a passage 
without beats.  

Remedy: The song should be limited in such a way that only rhythmic passages are 
contained.  

Possible 2nd reason: Inaccurate tapping or a false BPM value has been entered.  

Remedy: Try the tempo correction buttons or tap until the "locked" condition is 
attained.  

Problem: The metronome sounds inaccurately or is jerky, the lines in the wave-
shaped display are irregular and thinly drawn.  
 

Activation problems 
The MAGIX website won't open 

Check your Internet connection; you may have to use manual dial-up. 

The form for ordering via post/fax won't open 

• Check that an adequate text editing program is installed and activated (for 
example, MS Word). 

I still haven't received an email with the activation code 

• Check that your inbox isn't full. 
• Have a look in your spam folder. 

You can always send questions via email to our support whenever you like. Please 
have the following information at hand so that we can assist you as quickly and as 
specifically as possible. 

• Complete product name 
• Exact version number (to be found in the about box in the "About" menu item of 

the "Help" menu) 
• Encoder/Decoder name 
• Your user code (accessible via the "Activate via post/fax" dialog) 

Problem: I have installed MAGIX Movie Edit Pro on a new computer, installed a new 
hard drive in my old computer (sound card, memory...), or installed it multiple times 
on the same computer. My activation code is no longer accepted! 

If the program cannot be activated again after it has been activated multiple times, 
please contact the MAGIX customer service. 
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Keyboard shortcuts 

Tip: In Windows, keyboard settings are changed using the Alt + Shift key 
combination. Those who often use keyboard shortcuts can accidentally change their 
keyboard settings, so that they keys don't correspond to the pictured symbols. To 
prevent this, you can remove the check mark found by going to "Control panel" > 
"Regional and language options" > "Languages" tab > "Details" > "Keyboard" > 
"Change keyboard combination" under "Change input layout". 

 

Playback functions 
Start / Stop Spacebar 

Increase playback speed in stages L 
Shift + L 

Stop playback (playback marker is stopped at 
the current position) 

K 

Reverse playback or rewind in stages  J 
Shift + J 

Speed up fast forward Shift + Right arrow  
(Hold keys down) 

Speed up rewind Shift + Left arrow  
(Hold keys down) 

Restart beginning at playback marker Backspace 

Playback marker back to the beginning Home 

Playback marker to end End 

1 frame back Left arrow 

1 frame forwards Right arrow 

5 frames back Ctrl + Left arrow key 

5 frames forward Ctrl + Right arrow key 

Set project marker  Ctrl + Enter key 

Play from range start to range end # 

Playback at current frame + 

Activate smooth playback for preview P 
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Monitors 
Fullscreen video monitor Alt + Enter key 

Other resolution Alt + G 

Adjust video monitor to movie settings Ctrl + G 

Adjust video monitor to selected video Ctrl + Shift + G 

Anaglyph display Ctrl + . 

Display partially interlaced (left image first) Alt + . 

Standard (2D) . 

Side-by-side display (left picture on the left) Shift + . 
 

Project window view 
Enlarge section Ctrl + Up 

Shrink section Ctrl + Down 

Play movie fullscreen Alt + Enter key 

Movie overview Shift + A 

Optimize view Shift + B 

Zoom 1 frame / 5 frames Ctrl + 1/2 

Zoom 1s / 5s / 1min/ 10min  Ctrl + 3/4/5/6 

Entire movie Ctrl + 8 
 

Move view and start marker 
To next object edge Alt + W 

To previous object edge Alt + Q 

To movie start Home 

To movie end End 

To beginning of range Ctrl + Home 

To end of range Ctrl + End 

Scroll left by page Page up 

Scroll right by page Page down 
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To scroll grid unit to left Ctrl + Page up 

To scroll grid unit to right Ctrl + Page down 

To next project marker Ctrl + Shift + Page down 

To previous project marker Ctrl + Shift + Page up 

To next snap marker Ctrl + Alt + Page down 

To previous snap marker Ctrl + Alt + Page up 

To next scene marker Shift + Page down 

To previous scene marker  Shift + Page up 

To next chapter marker Alt + Page down 

To previous chapter marker Alt + Page up 

Go to right marker W 

Go to left marker Q 

To next empty range < 

To previous empty range Shift + < 

To next selected object Shift + W 

To previously selected object Shift + Q 

Select next object Ctrl + W 

Select previous object Ctrl + Q 
 

Transport control in the Media Pool 
Set start of range I 

Set end of range O 

Go to the start marker Shift + I 

Go to the end marker Shift + O 

Select range above blank space  X 

Play from start to end marker # 
 

Mouse Modes 
Mouse mode for individual objects 6 
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All tracks mouse mode 7 

Single track mouse mode 8 

Curve Mode 9 

Object stretch mode 0 

Preview audio objects Alt + 6 

Context Help Alt + F1 
 

Insert modes 
Automatic application 1 

Single-track ripple 2 

Multitrack ripple 3 

Exchange 4 

 Overwrite 5 
 

File menu 
New project Ctrl + N 

Open project Ctrl + O 

Save project Ctrl + S 

Save project as... Shift + S 

Record audio/images/video... R 

Export to device... H 

Batch conversion S 

Burn CD/DVD -> Manually compile files... Ctrl + B 

Cleaning Wizard Ctrl + Shift + Y 

Load backup project Ctrl + Shift + O 

Exit  Alt + F4 
 

Manage movies 
New Ctrl + Alt + N 

Remove from project Ctrl + F4 

Export Ctrl + Alt + L 
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Export movie 
Export as AVI Ctrl + Alt + A 

Export as DV AVI Ctrl + Alt + D 

Export as MPEG video Ctrl + Alt + P 

Video as MAGIX video Ctrl + Alt + M 

Video as Quicktime Movie... Ctrl + Alt + Q 

Uncompressed movie Ctrl + Alt + U 

Video as MotionJPEG-AVI Ctrl + Alt + O 

Video as sequence of frames Ctrl + Alt + E 

Windows Media Export Ctrl + Alt + V 

Video as MPEG-4 video Ctrl + Alt + G 

Video as HEVC video Ctrl + Alt + I 

Audio as WAV Ctrl + Alt + W 

Export as transition Ctrl + Alt + T 

Single frame as BMP file Ctrl + Alt + B 

Single frame as JPEG Ctrl + Alt + J 

Animated GIF Ctrl + Alt + F 
 

Backup copy 
Copy project and media into folder Alt + S 

Copy movie and media into folder Shift + R 
 

Settings 
Movie E 

Program Y 

Proxy and preview rendering Alt + R 

Keyboard shortcut Ctrl + Shift + U 
 

Edit menu 
undo Ctrl + Z 

Restore Ctrl + Y 

Cut objects Ctrl + X 
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Copy Objects Ctrl + C 

Paste objects Ctrl + V 

Duplicate objects D 

Deleting objects  Del 

Select all objects Ctrl + A 

"Cutting"  

Split scene T 

Remove scene start Z 

Remove scene end U 

Remove scene Ctrl + Del 

Split movie Alt + Y 

Musical editing adjustment Ctrl + Shift + M 

Edit range  

Cut range Shift + Del; Alt + X 

Copy range Alt + C 

Delete range  Alt + Del 

Insert range Alt + V 

Extract range Shift + X 

Insert empty space into selected range C 

Group objects G 

Ungroup objects  Shift + G 

Wizards  

Slideshow Maker Ctrl + M 

Soundtrack Maker Ctrl+ Shift +S 

Combine audio... Shift + D 

Combine audio and video... Shift + M 

Start preview rendering... 
 

Ctrl + R 

Markers  

Set project marker Ctrl + Enter key 



 

326   

www.magix.com 

Set snap markers Ctrl + P 

Set chapter markers Shift + Enter key 

Set chapter markers automatically... Alt + Shift + Enter key 

Delete chapter markers Ctrl + Shift + Enter key 

Delete all chapter markers Ctrl + Alt + Enter key 

Set range start I 

Set range end O 

Jump to range start Shift + I 

Jump to range end Shift + O 

Select range above blank space X 

Move view see "Move view" (view page 321) 

Mute audio tracks (Multicam) Alt + Shift + M 
 
 

Effects menu 
Movie effects settings Ctrl + Shift + H 
 

Video object effects 
Scene recognition Shift + Z 

Image stabilization Ctrl + L 

Edit with MAGIX Photo Designer Alt + Shift + D 
 

Video effects 
Brightness Alt + Shift + H 

Contrast Alt + Shift + O 

Gamma Alt + Shift + G 

Saturation Alt + Shift + F 

Color correction "Alt + Shift + C" 

Chroma key video level Alt + Shift + B 

Sharpness Ctrl + Alt + S 

Video effects plug-ins Ctrl + Shift + P 

Load video effects Ctrl + - 

Save video effects Alt + - 
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&Reset video effects Ctrl + Alt + - 

Copy video effects - 

Paste video effects Shift + - 
 

Movement effects 
Position/size Alt + Shift + I 

Section Alt + Shift + P 

Camera/zoom Ctrl + Alt + Z 

Rotation/mirror Alt + Shift + R 
 

Audio object effects 
Normalize Alt + N 

Volume reduction Alt + L 

Audio cleaning Alt + A 

Echo/reverb Shift + H 

Timestretch/resample Ctrl + Shift + Q 

Load audio effects Ctrl + + 

Save audio effects Shift + +  

Reset audio effects Ctrl + Alt + + 

BPM wizard Alt + Shift + K 

Edit wave files externally Alt + Z 

Volume curve Ctrl + Shift + V 
 

Title effects 
Title editor Ctrl + T 

Load title effects Alt + T 

Save title effects Ctrl + Shift + T 
 

Effects libraries 
Audio and video effects Ctrl + Shift + E 

Transition effects Ctrl + Shift + B 

Title effects Alt + Shift + L 
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Window menu 
Edit trimmer N 

Object trimmer Shift + N 

Mixer M 

Master audio effect rack B 

Program monitor Shift + V 

Media Pool Shift + P 

Reset window arrangement F9 

Switch to next window Ctrl + TAB 

Movie overview Shift + A 

Optimize movie view Ctrl + F 

Zoom horizontally/vertically See project window view (view page 
321) 

  

Help menu 
Help F1 

Context help Alt + F1 

Display tooltips Ctrl + Shift + F1 

About MAGIX Movie Edit Pro Alt + Shift + F1 
 

Edit keyboard shortcut 
In this dialog you can specify keyboard shortcuts for all menu function of MAGIX 
Movie Edit Pro. This allows you to adapt existing shortcuts to your requirements or to 
add new ones. 

The settings are automatically saved in a file upon closing the program, i.e. they will 
be available the next time the program is used. 

The display of the entire menu tree is the key function of MAGIX Movie Edit Pro. 
 

Add keyboard shortcut 
To add a keyboard shortcut, proceed as follows: 

• Look for the required menu point and select it with a simple mouse click. Under 
"Current menu point" the currently selected menu point will be displayed. 
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• Then, click on the "New keyboard shortcut" field. 
• Type in the keyboard shortcut. You can also use combinations of any key with 

"Shift", "Alt", and "Ctrl". 
• Then click on "Assign shortcut". If the shortcut should already have been 

assigned a corresponding warning will be displayed. 

Note!  Please do not use the space bar, "Esc", or "Insert" key ("0" in the number 
block), since the functions of these keys are permanently assigned in MAGIX Movie 
Edit Pro and can not be changed. 

 

Keyboard shortcut list 
Reset: Activates all preset shortcuts again. 

Load: Previously saved shortcuts are loaded and activated again. 

Tip: MAGIX Movie Edit Pro offers additional presets for those switching from other 
programs. These settings make it considerably easier to switch to MAGIX Movie 
Edit Pro. 

If you have used MAGIX Video Pro X3 and want to use its keyboard shortcuts, load 
Video_Pro_X3.ssc. 

Warning:  The current settings will be overwritten during loading! Save your current 
keyboard shortcuts in advance if you would like to keep them. 

Save: The current keyboard shortcuts can be saved after naming the file appropriately. 

List: This button opens a window where a complete list of current keyboard shortcuts 
appears. The included Copy button can be used to copy this list to the Windows 
clipboard and then edit and print it using a text editor. 
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Integrated browser 
The integrated browser offers many useful functions that help you collect material for 
using in your project. All kinds of media can be collected – images, videos, sound or 
simply text can be all integrated using the built-in browser with great results. 

Tip: You must have an Internet connection to use the full range of options offered by 
the integrated browser. 

 

Open browser 

 

The integrated browser is opened by clicking on the 
"Internet media" button in the Media Pool ("Import" tab). 

 

Navigation in the browser 

 
One page back: Switches to the previous page. 

 
One page forward: Switches back to the page before the "One page back" 
button was pressed. 

 
Stop: Stops loading the selected page. 

 
Reload: The current page will be reloaded. 

 
Home: Returns to the home page. 

In the address header, next to the navigation buttons, you can simply enter an 
Internet address like http://www.magix.com. Press the enter button and the 
corresponding page will be loaded. 
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Loading Internet media 
The buttons described here are used to collect and load media directly from the 
Internet into the current film. The corresponding functions can be found in the context 
menu of the browser. 

 
Save selected text: The selected text will be saved. It can then be edited using 
the title editor (view page 132). 

 
Start screen capture: Opens the capture dialog for starting screen capture. 

 
Download selected images: The selected images will be saved to your 
computer. 

 
Import screen capture of the opened Internet page: The loaded Internet page 
will be saved as an image file. 

 
Start audio recording: A dialog for audio recording opens. 

Hint: For recording from the Internet, it is important that the sound card is 
selected as the sound source. 

 

Accept media after download 
This option makes sure that the downloaded media are loaded into the current movie 
right away. 
 

Define the path for saving Internet media. 
To define the path for saving Internet media, simply click on the folder symbol and 
navigate to the desired folder. Confirm your selection with OK. 
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Annex: Digital Video and Data Storage 

MPEG Compression 
MPEG means "Moving Picture Experts Group" and defines a workgroup which 
cooperates with the International Standards Organization (ISO) as well as the 
international Electro Technical Commission (ETC) to develop standards for video and 
audio coding.  

Generally, the graphic data rate of the digital video standard is 167 megabits per 
second, which, when not compressed, requires a far higher storage capacity than a 
DVD can offer. A one-sided DVD 5 with 4.7 GB storage capacity is enough for 4 
Minutes. For this reason, the available pictorial material must be effectively 
compressed – a function which is achieved with the MPEG procedure. 

This procedure is based on the simple fact that up to 96% of digital video data 
consists of repetition and can be compressed without visible degradation of the 
pictorial quality.  

Each MPEG compression is, however, a data reduction and as such connected with 
information loss. If the video consists of very extensive details, or if the content 
changes very fast, then the picture may blur (dependent on the strength of the 
compression and the quality of the encoder). 

Errors can also result from so-called compression artifacts such as small color defects 
or images that are too dark.  

At average compression rates under 3 megabits per second it is probable that you will 
notice reduced quality. At rates around 6 megabit per second the degradation in 
quality becomes almost invisible.  
 

General notes on AVI videos 
The AVI format (Audio Video Interleaved) isn't actually a proper video format! 
Rather, it is a so-called "container", where the conventions for transferring audio and 
video files to the program are only loosely defined. The codec (coder/decoder) 
actually defines what storage format is used. A codec compresses audio/video data 
into its own unique format which can only be read by the codec itself and is decoded 
when the film is played.  

In concrete terms, a computer-generated AVI file can only be loaded by and played 
on a different computer if the same codec is installed on it. 

Many codecs (e.g. Intel Indeo® video) have now become standard components of the 
Windows installation. Others are not standard. If you are generating an AVI file for 
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future play on another computer using one of these codecs, you should first install 
this codec on the other PC. The best method available is to copy the codec installer to 
your export directory and burn it every time you create a video disc (slideshow disc) 
for play on computers. 

You may encounter some problems when using older video editing cards with codecs 
which only function with the card’s hardware. Such AVIs can only be used on the 
computer which was used to create them. Try to avoid using this kind of codec. 
 

Overview of the different disc types 
MAGIX Movie Edit Pro supports numerous disc types, and these depend on whether 
you want to burn a movie or slideshow and which disc type you are using (CD, DVD, 
or Blu-ray DiscTM), or the type of playback device or quality required.  

The table below will explain which disc types are best for different cases, the 
differences in quality, and how much storage space each format requires. 

More detailed information, consult the chapters concerning the individual disc types. 
 

Disc type Data storage 
medium 

Menu Quality Length (optimal quality) 

DVD DVD Yes  *** 98 min. 

Blu-ray Disc 
(view page 335) 

Blu-ray Disc Yes ***** 110 min. 

AVCHD (view 
page 335) 

DVD/Blu-ray 
Disc 

Yes ***** 30 min./DVD 

160 min./Blu-ray Disc 

*  The display time for some DVD players can be determined in this menu. The 
amount of image material that can be put onto a CD or DVD depends on the sizes of 
the picture files. 
 

Digital Versatile Disc (DVD) 

Quality 
Featuring a resolution of 720 x 576 (PAL) and encoded with MPEG-2, 25 frames per 
second provides very good results. 

Writable data storage formats 
The recordable DVD market is currently split into three types: "DVD-RAM", 
"DVD+RW", and "DVD-RW". 
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DVD-R/+R: This medium may only be written to once. The DVD-R may be specified 
with file structures for DVD video, DVD audio, or DVD-ROM. 

DVD +RW: +RW drives allow re-writable DVDs to be created which may be read by 
almost any commercial DVD-ROM or DVD player. The companies involved are 
mainly Philips, Sony, HEWLETT PACKARD (as well as Ricoh, Yamaha and 
Mitsubishi). 

DVD-RW: This is a write/erase DVD technology promoted by Pioneer and Sharp. 
This format was developed by the Pioneer company and should be compatible with 
existing DVD players. 

DVD-RAM: DVD-RAM technology is based on either Phase Change, MOs, or hard 
disks, etc. and is now almost 100% incompatible with all available players. 

Due to the small storage capacity and incompatibility with DVD players, setting on 
this standard is not recommended. 

Note: MAGIX Movie Edit Pro supports DVD±R and DVD±RW, but not DVD-
RAM. 

Blank discs: Single-sided recordable blank discs featuring a capacity of 4.7 GB and a 
duration of approx. 2 hours. 
 

Copy Protection 
Macrovision (APS): The movie industry claims that even DVD-ROM drives and 
decoders or diagram cards with composite outputs or s-video outputs must support 
the Macrovision analog copy protection (APS). Only some older DVD players do not 
possess APS.  

APS adds additional signals to a DVD’s stored graphical data. The data is almost 
unchanged. These supplementary signals disturb the synchronization and the 
automatic recording regulation of most video recorders to prevent recording of the 
video. They are not noticeable on the television or the monitor, however. 

Content Scrambling System (CSS): CSS prevents saving and duplication of DVD 
video tracks to hard disk. The VOB streams of DVDs without CSS can otherwise (like 
other video files) be loaded via the Import Video button 

There are further types of copy protection besides APS and CSS which ensure that 
retail DVDs cannot be copied without distortion 
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Blu-ray Disc 
Since early 2008, Blu-ray Discs are viewed as successors to DVDs and offer 
especially high storage capacity of up to 27 GB in a single layer (double-layer up to 54 
GB) with very few write errors. 

The term Blu-ray Disc comes from the blue color of the laser. Because a color cannot 
be registered as a trademark, the letter "e" was removed from the word "blue". 

The high storage capacity of the Blu-ray Disc suits high definition videos and 
slideshows in high quality perfectly, since these are characterized by large file sizes 
(depending on material approximately 40 MB/sec) and very high memory use. The 
MPEG-2 codec is used to create video. 

Companies that were involved in developing Blu-ray technology have united 
themselves into the Blu-ray Disc Association (BDA). 

Blu-ray Discs come in three varieties: 
• Only readable BD ROM (comparable to DVD video), 
• rewritable BD-RE (comparable to DVD±RW or DVD-RAM),  
• and as a disc that can be written to only once BD-R (comparable to DVD±R). 
 

AVCHD disc 
Use this format to create a high-resolution video. You can burn Blu-ray (BD-R/RE) 
blanks as well as conventional DVD±R/RWs. In contrast to Blu-ray Discs (view page 
335), MPEG-4/AVC codec (view page 348, view page 343) is applied as the video 
format, which requires less memory at a comparable image quality. 

Compatibility 

AVCHD disc on Blu-ray blank: Since this is a BD-conformant format, the disc created 
can be played back in any conventional Blu-ray player. Playback problems can almost 
always be traced to incompatibilities between Blu-ray blanks and Blu-ray players. In 
this case, consult the instructions for your Blu-ray player or ask the manufacturer 
which blanks are compatible with the device. 

AVCHD disc on DVD blank: The DVDs created with AVCHD video are not supported 
by all Blu-ray players. The behavior of the devices is quite different. Normal DVD 
players cannot replay AVCHD discs, since the AVC format is not supported. 

For this, the playback device needs to be able to support the following formats: 
• AVCHD disc: AVCHD 1.0 
• AVCHD disc with 50p frames: AVCHD 2.0 
 



 

336   

www.magix.com 

Note: To import and export AVC(HD) and MPEG-4 files, the MEPG-4 codec must 
first be activated (view page 337). A dialog will open if the codec is required. 
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Activate codecs 
Special encoders/decoders are needed to use and generate various file formats. 

Why is activation required? 
To import (decode) or export (encode) certain video and audio formats you will 
require a specific codec to be able to read in and export these formats. As soon as a 
corresponding decoder or encoder is needed, MAGIX Movie Edit Pro will notify you 
and ask you if you would like to activate it.  

The integration of decoders and encoders from third parties into programs usually 
costs the software publisher money. These codecs are therefore added to MAGIX 
 programs via a voluntary activation, which may be free or require a charge for 
expensive specialist codecs. It is therefore possible for MAGIX to provide an optimum 
price/performance ratio for your software in the future. 

Which codecs does this pertain to? 
The following codes are automatically activated when needed: 
• MPEG-2/MPEG-4 basic (standard) 

These codes are needed for importing and exporting MPEG-2 and MPEG-4 
videos. The codecs are activated simultaneously and are free. 
Use cases: 
- MPEG-2: MPEG-2 import and export as well as burning DVDs and Blu-ray 

discs. 
- MPEG-4: MPEG-4 import and export as well as burning AVCHD discs. 

• Audio expansion package 
This package is necessary for certain audio file formats, including  but not limited 
to: AC3 with stereo and 5.1 Surround Sound. Activation is free. 

You can also activate the following codecs: 
• MPEG--2 (MainConcept) 

This codec can also be used for MPEG-2 (Standard). Activation is free. 
• MPEG-4 (MainConcept) 

This codec can also be used for MPEG-4 (standard). Activation is fee-based (view 
page 338). 
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Activate MPEG-4 (MainConcept) (fee-based) 
Requirement 
• MAGIX Movie Edit Pro is already registered in your name. 

Note: If you have not registered MAGIX Movie Edit Pro, you can do this at any time. 

Instructions 
1. Open the menu "Help" > "Install additional programs". 
2. Select "MainConcept MPEG-4 codec". 

MAGIX Movie Edit Pro will check to see if the codec has already been licensed to 
another MAGIX software and will use that license if this is the case. 
If the codec has not already been licensed, then the fee-based activation will 
continue. 
The activation dialog will appear. 

3. Click on "Activate online". 
Your Internet browser will open. 
If you have not already activated MAGIX Movie Edit Pro, a website for registering 
MAGIX Movie Edit Pro will open. 
You will then be forwarded to a website where you can request the corresponding 
activation to be carried out. 

4. Enter the requested information and complete the order. 
Normally you will receive the activation code within a few minutes. In some cases, 
this can take longer. 

Note: In the event the activation code does not arrive after a longer period of time, 
check to make sure the e-mail was not accidentally sent to your spam folder. 

5. Copy the activation code from the e-mail. 
6. Paste the activation code into the input field in the activation dialog. 
7. Click on "Activate...". 

The codec will be activated. MAGIX Movie Edit Pro checks the registration data, 
downloads the codec and installs it. 
In some cases, MAGIX Movie Edit Pro needs to be closed and restarted in order to 
start using the codec. 

Note: After successfully activating the MainConcept codec, you need to specify 
under Program settings that this is the preferred codec to be used. 
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Activate HEVC (fee-based) 
The HEVC codec requires a one-time, fee-based activation to be used. 

You will be asked to activate HEVC the first time you import a video created with the 
codec or export a project with the codec.   

1. Click "To the shop" if you want to activate the codec online. (Alternatively: Click 
"By Post/Fax..." to receive an activation code by post or email and follow the 
instructions that appear.) 
When activating online, the web browser where you can register your MAGIX 
Movie Edit Pro first (if you have not already done so) will open. You will then be 
forwarded to a website where you can request the corresponding activation to be 
carried out. 

2. Enter the requested information and complete the order. 
Normally you will receive the activation code within a few minutes. In some cases, 
this can take longer. 

Note: In the event the activation code does not arrive after a longer period of time, 
check to make sure the e-mail was not accidentally sent to your spam folder. 

3. Copy the activation code from the e-mail. 
4. Enter the activation code into the input field in the activation dialog. 
5. Click on "Activate...". 

The codec will be activated and the feature is now available in MAGIX Movie Edit 
Pro. 
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MPEG-2 encoder settings (Standard) 
In the "Advanced Settings" you can make detailed adjustments to the MPEG-2 data 
flow. 

The advanced settings are divided into "Video", "Audio", and "Multiplexer".  
 

Video 
Tip: For more information read the MPEG glossary (view page 359). Many of the 
terms used here are explained in detail in the glossary. 

Bit Rate Mode: The bit rate indicates how much data is saved in the video per second 
(at playback speed). This makes the bit rate the deciding parameter with regard to the 
file size and quality of the video to be encoded. A higher bit rate means better quality, 
but also a larger file size. 
• Constant: The exact value entered in "Average bit rate" is applied which enables 

precise calculation of the video size.Constant: The exact value entered in 
"Average bit rate" is applied which enables precise calculation of the video size.  

• Variable: The value entered in "Average bit rate" is used as an approximate 
guideline for the value applied to the video. This means that the size of the video 
can only be estimated. 

• Constant quantization parameter: This parameter ensures that the video quality 
remains the same throughout. 

 

Average bit rate (kbps): The bit rate entered here is used as the average rate applied 
to the video. The size of the video to be exported can only be approximated. 

Maximum bit rate (kbps): This is the maximum bit rate for the video stream, i.e. the 
maximum number of bits the decoder is allowed to transfer per second. This 
parameter only takes effect in the "Variable" bit rate mode. 

CPB (Coded Picture Buffer): The entered value specifies the maximum amount of 
storage space for an encoded frame. Higher values can improve quality, but might 
also cause problems during export. If export is aborted, lower this value. The setting 
"0" means that the encoder has determined the disk space. 

Maximum GOP length: The maximum GOP (view page 361) length is determined 
here. High values mean improved compression. Lower values create stronger security 
protection and enable improved access to individual frames for processing the video. 

Tip: A good rule of thumb is to enter the frame rate as the GOP length. 
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GOP structure: The GOP structure is the sequence of the various frames. At the 
beginning of a GOP there is an I-Frame, at the end there are several B-Frames, 
followed by a P-Frame (view page 363). The sequence of B-Frames und P-Frames 
repeats until the end of the GOP. 

Example: A GOP with a length of 20 and the "IBBP" structure will look like this: 

No. 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 

Frame I B B P B B P B B P B B P B B P B B P B 
 

Profile: Profiles define the encoder properties that are supported. 
• SIMPLE: Intended to be used as the basic profile for applications with limited 

computational power, e.g. video conferences or mobile phone videos. This 
profile does not allow B-Frames, which first and foremost means more data 
traffic, but contributes to better reliability.  

• Main: This profile was originally intended for the broadcast industry and for 
backup purposes. It has become less popular since the development of the "High 
Profile" for this purpose. 

• HIGH: This profile is used for broadcast and backup applications and is also 
sometimes used in the HDTV industry (High Definition Television). This profile 
is used for Blu-ray discs. 

Note: You should only change this setting when there are problems playing back the 
generated video. 

Level: MPEG 2 defines various levels. The level determines which bit rate and 
resolution are possible for the video. With the "Auto level" option, the encoder 
determines the level automatically on the basis of the set video format, the specified 
bit rate and the profile. 

Coding quality: This is the easiest way to set the ratio between coding duration and 
quality. Select the setting which best suits your needs. 

Hardware acceleration: MAGIX Movie Edit Pro supports the use of "Quick Sync 
Video" hardware acceleration. This can noticeably speed up the encoding process. 

Smart Copy: If this option is activated, unedited MPEG 2 material with hard cuts is 
transferred without changes. This drastically accelerates the encoding process. The 
transfer always takes place on the GOP borders is not frame-precise. 

HRD (Hypothetical Reference Decoder): When this option is activated, a virtual 
decoder checks the data stream for compatibility with the video standard during the 
encoding process. This ensures that the generated video is compatible with various 
playback devices, but it also slows down the encoding process. 
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Audio 
Sample rate  (Hz): Here you can set the sample rate for audio encoding. For DVDs 
the standard is set to 48 kHz. If you change the settings here, it may result in not 
being able to play back the sound or the entire video. 

Channels: Determines the number of audio channels. 
• Mono: 1 channel, mono sound 
• Stereo: 2 channels, one for left and one for right. 
• Surround: 6 channels (5.1) 

Bitrate (kBit/s): The desired bit rate is entered here. 

Audio encoder: This is where you define how audio material will be coded, or whether 
it should be written to the exported file as an uncompressed PCM data. If PCM is 
used, you can no longer adjust sample rate and bit rate. 
 

Image settings 
Interlace: Specifies whether the video is coded in frames or fields (in interlaced 
scanning, also "Interlaced"). 
• Progressive 

The video is coded in frames. 
• Bottom field first 

The video will be interlaced. The lower lines (Bottom field) are used for the first 
field and upper lines for the second. 

• Top field first 
The video will be interlaced. The upper lines (Top field) are used for the first field 
and the lower lines for the second. 
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MPEG-4 encoder settings (standard) 
In the „Advanced Settings“ you can make detailed adjustments to the MPEG-4 data 
flow. 

The advanced settings are divided into "Video", "Audio", and "Multiplexer".  
 

Video 
Note: The preset values and status of the control element (locked/unlocked) 
depend on the selected export preset. 

Bit Rate Mode: The bit rate indicates how much data is saved in the video per second 
(at playback speed). This makes the bit rate the deciding parameter with regard to the 
file size and quality of the video to be encoded. A higher bit rate means better quality, 
but also a larger file size. 
• Constant: The exact value entered in "Average bit rate" is applied which enables 

precise calculation of the video size.  
• Variable: The value entered in "Average bit rate" is used as an approximate 

guideline for the value applied to the video. This means that the size of the video 
can only be estimated. 

• Constant quantization parameter: This parameter ensures that the video quality 
remains the same throughout. 

 

Average bit rate (kbps): The bit rate entered here is used as the average rate applied 
to the video. The size of the video to be exported can only be approximated. 

Maximum bit rate (kbps): This is the maximum bit rate for the video stream, i.e. the 
maximum number of bits the decoder is allowed to transfer per second. This 
parameter only takes effect in the "Variable" bit rate mode. 

CPB (Coded Picture Buffer): The entered value specifies the maximum amount of 
storage space for an encoded frame. Higher values can improve quality, but might 
also cause problems during export. If export is aborted, lower this value. 
 

Maximum GOP length: The maximum GOP (view page 361) length is determined 
here. High values mean improved compression. Lower values create stronger security 
protection and enable improved access to individual frames for processing the video.  
A general rule: The shorter the GOP, the more compatible the generated video file. 

Tip: A good rule of thumb is to enter the frame rate as the GOP length. 

GOP structure: The GOP structure is the sequence of the various frames. At the 
beginning of a GOP there is an I-Frame, at the end there are several B-Frames, 
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followed by a P-Frame (view page 363). The sequence of B-Frames und P-Frames 
repeats until the end of the GOP. 

Example: A GOP with a length of 20 and the "IBBP" structure will look like this: 

No. 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 

Frame I B B P B B P B B P B B P B B P B B P B 
 

Profile: Profiles define the encoder properties that are supported. 
• Main: This profile was originally intended for the broadcast industry and for 

backup purposes. It became less popular when "High Profile" was developed for 
exactly these applications. 

• HIGH: This profile is used for broadcast and backup applications and is also 
sometimes used in the HDTV industry (High Definition Television). This profile 
is used for Blu-ray discs. 

Note: You should only change this setting when there are problems playing back the 
generated video. 

Level:  H.264 defines different levels. The level determines which bit rate and 
resolution are possible for the video.  

With the "Auto level" option, the encoder determines the level automatically on the 
basis of the resolution of "AVC preset" video formats, the set bit rate and the profile. 

Coding quality: This is the easiest way to set the ratio between coding duration and 
quality. Select the setting which best suits your needs. 

Hardware acceleration: MAGIX Movie Edit Pro supports the hardware acceleration 
"Quick Sync Video" for AVCHD exports, AVCHD and Blu-ray discs. This can 
noticeably speed up the encoding process. 

Smart Copy: If this option is activated, unedited AVCHD material with hard cuts is 
transferred without changes. This drastically accelerates the encoding process. The 
transfer always takes place on the GOP borders is not frame-precise. 

HRD (Hypothetical Reference Decoder): When this option is activated, a virtual 
decoder checks the data stream for compatibility with the video standard during the 
encoding process. This ensures that the generated video is compatible with various 
playback devices, but it also slows down the encoding process. 

Interlace: Specifies whether the video is coded in frames or fields (in interlaced 
scanning, also "Interlaced"). 
• Progressive 

The video is coded in frames. 
• Bottom field first 
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The video will be interlaced. The lower lines (Bottom field) are used for the first 
field and upper lines for the second. 

• Top field first 
The video will be interlaced. The upper lines (Top field) are used for the first field 
and the lower lines for the second. 

 

AAC audio 
Note: The preset values and status of the control element (locked/unlocked) 
depend on the selected export preset. 

Sample rate: Here you can see the sample rate for audio encoding. 

Channels: Determines the number of audio channels. 
• Stereo: 2 channels, one for the left side and one for the right. 
• Surround: 6 channels (5.1) 

Bitrate (kBit/s): The desired bit rate is entered here. 

Audio encoder: Shows which audio encoder is being used. 
 

Image settings 
Interlace: 

 
• Bottom field first 

The video will be interlaced. The lower lines (Bottom field) are used for the first 
field and upper lines for the second. 

• Top field first 
The video will be interlaced. The upper lines (Top field) are used for the first field 
and the lower lines for the second. 

 

Multiplexer 
Streamable: The generated video is suitable for live playback on websites. 

HTML Start file: MAGIX Movie Edit Pro generates an HTML file with a video player 
that opens the HTML file and plays it back. 
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HEVC encoder settings 
In the "Advanced Settings" you can make detailed adjustments to the HEVC data 
flow. 

The advanced settings are divided into "Video", "Audio", and "Multiplexer".  

Below is an explanation of all the settings that can be changed. 
 

Video 
Average bit rate (kbps): The bit rate entered here is used as the average rate applied 
to the video. The size of the video to be exported can only be approximated. 

Maximum bit rate (kbps): This is the maximum bit rate for the video stream, i.e. the 
maximum number of bits the decoder is allowed to transfer per second. This 
parameter only takes effect in the "Variable" bit rate mode. 

CPB (Coded Picture Buffer): The entered value specifies the maximum amount of 
storage space for an encoded frame. Higher values can improve quality, but might 
also cause problems during export. If export is aborted, lower this value. 

Maximum GOP length: The maximum GOP length is determined here. High values 
mean improved compression. Lower values create stronger security protection and 
enable improved access to individual frames for processing the video.  
A general rule: The shorter the GOP, the more compatible the generated video file. 

Tip: A good rule of thumb is to enter the frame rate as the GOP length. 

GOP structure: The GOP structure is the sequence of the various frames. At the 
beginning of a GOP there is an I-Frame, at the end there are several B-Frames, 
followed by a P-Frame. The sequence of B-Frames und P-Frames repeats until the end 
of the GOP. 

Level: HEVC defines various levels. The level determines which bit rate and resolution 
are possible for the video. With the "Auto level" option, the encoder determines the 
level automatically on the basis of the set video format, the specified bit rate and the 
profile. 

Coding quality: This is the easiest way to set the ratio between coding duration and 
quality. Select the setting which best suits your needs. 
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Audio 
Sample rate: Here you can see the sample rate for audio encoding. 

Bitrate (kBit/s): The desired bit rate is entered here. 
 

Multiplexer 
Streamable: The generated video is suitable for live playback on websites. 

HTML Start file: MAGIX Movie Edit Pro generates an HTML file with a video player 
that opens the HTML file and plays it back. 
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MPEG-4 encoder settings 
MPEG-4 is actually a collection of highly efficient codecs for video and audio based on 
the MPEG standard. Compared to MPEG-2, the same quality can be achieved with 
smaller file size. 

Recommendation: Check the presets that the program offers to find the right preset 
for each application and the right playback device. These presets are optimized for 
typical applications. 

The advanced settings in "Advanced" are divided into "Video", "Audio", and 
"Multiplexer".   

Under "Video“ there is a choice between "MPEG-4 Simple" (MPEG-4 Visual/MPEG-
4 Part 2)  (view page 353)and "MPEG-4 H.264" (AVC/MPEG-4 Part 10) (view page 
348).  

Depending on the purpose of application of the material to be exported, either one of 
these encoder settings can be selected for compressing the video material. Refer to 
the manual for the playback device to find out which encoder is supported. 

Under "Audio", "AAC" (view page 356) is preset. If you have chosen an AVCHD 
transport stream from the presets, "AVCHD audio track" will be available.  

Under "Multiplexer" you can adjust certain presets, e.g. container format and 
streaming properties. This is only recommended for experts. 

The option "Export as website" also creates an HTML page in an integrated Flash 
player that can play back the video created. Read the topic "Embed Flash videos into 
your own web site". 

Tip: First, check if there is a suitable preset in the export dialog for your purposes. 
Advanced users can make specific adjustments to these three areas using the 
advanced settings. 

 

Video codec 
MPEG-4 H.264 
The MPEG-4 H.264/AVC codec is suitable for all types of material; however, it 
requires relatively higher CPU power for later decoding. 

In the advanced encoder settings of the AVC encoder the "Generic" options in "Main 
Settings" are mainly interesting. 
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The AVC preset and video format can be adjusted here. For instance, if DVD quality is 
desired you should select "DVD". The video format should be selected specific to the 
country so that the material can be played on the devices most commonly available in 
these countries. For instance, you should select PAL for Germany, SECAM for France 
and NTSC for the US. 
 

MVC 
MVC: Multiview Video Coding (MVC) is an expansion for stereoscopic applications. 
Activate this to export MVC files.  

Note: MVC is only available in the Video deluxe Pro versions. 
 

2-pass 
The video to be exported will be encoded twice. The first run-through serves to 
calculate the streaming rate for each section (for video this is per frame). The second 
run-through is when the actual video is created with the streaming rates that were 
calculated in the first run-through. The result is an improved image quality, but 
encoding takes place approximately twice as long. 
 

Smart Render and Smart Copy 
Smart Render lowers the demand on the encoder for AVCHD material. In the 
production of AVCHD files, only those parts of the movie that were changed in the 
program (e.g. by video cleaning or effects) are re-encoded. Please note: The AVCHD 
files contained in the movie must have the same format, i.e. the bit rates (variable or 
constant), audio formats, image resolutions and video formats must match. 

The Smart Rendering special mode „Smart Copy“ enables AVCHD material to be 
transferred without having to encode it for the target medium which greatly increases 
the encoding speed. The video material cannot appear to have been altered in any 
way, only hard cuts (without fades) are permitted. These won't be executed precisely 
to the frame, but rather take place at the next GOP borders. For this reason, cuts 
should be set somewhat more generously. 
 

Hardware acceleration - Quick Sync Video 
MAGIX Movie Edit Pro supports hardware acceleration for AVCHD exports as well as 
AVCHD and Blu-ray discs. This can noticeably speed up the encoding process. 

• Quick Sync Video: Intel processors starting with „Sandy Bridge“ when using a 
standard MPEG-4 encoder (view page 348, view page 343). 

Note: Make sure that all the necessary drivers are installed. 
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If your system does support hardware acceleration, you can activate it in the "Encoder 
Settings" dialog under "Advanced..." > "Hardware acceleration". 
 

Advanced video settings 

Generic 

AVC preset 
This is where the actual video stream that will be exported is selected. 

• Baseline: According to ISO/ICE 11172-1/2 standard 
• Main: Corresponds with ISO/ICE 13818-1/2 standard 
• High: High Profile 
• SVCD: Corresponds with MPEG-2 Super VideoCD 
• D1: Corresponds with MPEG-2 DVD 
• DVD: DVD video 
• Blu-ray: Blu-ray-Disc 
• Blu-ray HD: Blu-ray-Disc in High Definition 
• Sony PSP: Sony PSP-compatible format 
• HD 1280x720p: High Profile with a resolution of 1280x720p (progressive) 
• HD 1440 x 1080i: High profile with a resolution of 1440 x 1080i (interlaced) 
• Apple iPod: Apple iPod-compatible stream. 
 

Profiles 
Profiles 

Profiles define the encoder properties that are supported. 

• Baseline profile: The basis of applications with limited computing performance, 
especially for video conferences or videos on mobile telephones. 

• Main profile: This profile was originally intended for the broadcast industry and 
for backup purposes. It has become less popular since the development of the 
"High Profile" for this purpose. 

• High profile: This profile is used for broadcast and backup applications, and it is 
also used sometimes in the HDTV industry (High Definition Television). This 
profile is used for HD-DVD and Blu-ray Discs, for example. 

Level 

H.264 defines different levels. The level determines which bit rate and resolution are 
possible for the video.  

With the "Auto level" option, the encoder determines the level automatically on the 
basis of the resolution of "AVC preset" video formats, the set bit rate and the profile. 
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Frame type 
"Picture type" specifies which parts of a frame should be used as the basis for the 
encoding: 

• Progressive Frame: A single image from a video sequence, also called a 
fullscreen. 

• Interlaced Field:  This is half an image. Two of these are combined to produce a 
frame. Read more about this explanation regarding "Interlace (view page 361)". 

• Interlace Frame: The encoder creates a „Frame field“ which is the basis for the 
encoding. 

 

Field order 

Note: This parameter is only available if the setting "Field" is selected for "Frame 
type". 

In case of interlaced streams, the half-image sequence is set. Read more about this 
explanation regarding "Interlace (view page 361)". 
 

Slice count 
A frame can be divided into multiple slices for encoding. Specify the maximum 
number of slices are permitted. If set to "0", then the number will be determined 
automatically. 
 

Rate control 
The bit rate indicates how much data per second is saved in the video (playback 
speed). This makes the bit rate the deciding parameter with regard to the file size and 
quality of the video to be encoded. A higher bit rate means more quality but also a 
larger file size. 
 

Mode 
• Constant bit rate: The constant bit rate should only be used if the device used to 

play the video supports constant bit rates. 
• Constant quantizer: In this mode, a fixed colour quantization is used for the 

macro blocks. Under Advanced settings, a value between 1 and 32 can be set 
independent of the respective frame (I-Frame (view page 361), P-Frame, or B-
Frame (view page 363)). The higher the value, the stronger the quantization: 
small values produce qualitatively high-quality images and the data rate 
increases, and larger values produce a reduction in data, but the quality suffers. 

• Variable bit rate: The bit rate varies. For faster movements in the video, the bit 
rate increases, and for still images or slow pans, a lower bit rate is sufficient for 
creating the video in constant quality. 
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Pass 
Here you can choose whether you want to manually perform one-pass or multi-pass 
encodings (2-pass, multi-pass) 

Note: The 2-pass option in the main dialog of the MPEG-4 export is recommended. 
This automatically performs two encoder passes. 

If you want to perform 2-pass encoding manually, you must select "Multi-pass 
analysis" in the first pass and "Multi-pass encode" in the second pass. 

• Single pass: The encoder process takes place without prior analysis. This 
requires the least amount of time.  

• Multi-pass analysis: Analysis data is calculated during encoding and used for 
multi-pass encoding. 

• Multi-pass encode: Assumes that an analysis has already been performed The 
analysis data is used during encoding to optimize the results. 

 

Bit rate (Bits/s) 
• In "Constant bit rate" mode: Exactly those values entered are applied to be able 

to calculate the size of the video precisely.  
• In "Variable bit rate" mode: The values entered here are applied to the video as 

an average as a guideline. The size of the video to be exported can only be 
approximated. 

 

HSS rate 
This is the maximum bit rate that should be present in the video stream, i.e. maximum 
number of bits that may be transferred to the decoder. 

Note: This option is only available in "Variable bit rate" mode. "Use HRD" must also 
be activated. 

 

Aspect ratio 
In the film industry, this is an indication of the ratio between width and height of a 
rectangle, monitor, or screen.  

There are 3 different sizes available: 

• Picture Aspect Ratio (also Display Aspect Ratio, DAR): This indicates the 
desired aspect ratio of the video to be exported. Here are some examples of 
typical aspect ratios: at home 4:3, 16:9 (typical for TV sets) or 16:10 
(widescreen-flatscreens, widescreen notebooks), 3:2 for 35mm films and 
photos. In cinemas you mostly find 1.85:1. 
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• Pixel Aspect Ratio (PAR, pixel aspect ratio: Indicates the aspect ratio of 
individual pixels. The majority of computer monitors have quadratic pixels 
(PAR=1:1), for analog television monitors (PAL at 4:3) 128:117. 

• Sample Aspect Ratio (SAR, also Storage Aspect Ratio): Aspect ratio of the saved 
resolution (number of pixels), e.g. 720:576 at PAL. It also calculates picture 
aspect ratio and pixel aspect ratio: SAR = DAR / PAR. 

Note: In the standard case, the "Aspect ratio" remains set the way it is. You should 
only change the settings if the resulting video is exported distorted or stretched or if 
you need to correct the video because it is in the wrong aspect ratio. 

 

GOP structure 

Max GOP length 
Determines the maximum GOP (view page 361) length. High values mean improved 
compression. Lower values create stronger security protection and enable improved 
access to individual frames for processing the video. 
 

Max b-frames count 
The maximum number of b-frames (view page 363). Several cases of application, e.g. 
video conferences require "no b-frames" in order to achieve the shortest possible 
reaction times during transfer. 
 

Scene change detection 
If this option is activated the scenes will be detected during encoding, thus allowing 
you to insert an I frame (view page 361) after a scene change.  
 

MPEG-4 simple 
If MPEG-4 H.264 cannot be played back on your device, use MPEG-4 Simple. 

Note: We recommend that only advanced users make adjustments to the advanced 
settings. You can use the technical specifications of your playback device to help 
with this. 

 

Advanced video settings 

Generic 

MPEG-4 preset 
Different presets located within the encoder. 

(A)SP@L0-L5: (Advanced) Simple Profile in Level 0-5 
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(Q)CIF (Common Intermediate Format): CIF is a video format produced as soon as 
1990 with the video compression format H.261. At that time, the format was used for 
video telephone conferences. 
The "Q" in QCIF stands for "Quarter", and since resolution is halved in terms of height 
and width compared to CIF, the entire size is only a quarter of CIF. 
QCIF was popular with mobile telephone manufacturers, since the resolution of 176 x 
144 pixels was sensible for the first affordable SmartPhones (144 x 176). 

(Half)D1: D1 corresponds with MPEG-2 DVD. HalfD1 has exactly half of the entire 
number of pixels, meaning that the pixel number of the height and weight is 2/3 of D1. 

720p: Video stream with a resolution of 1280 x 720p (progressive). 

Apple iPod: Apple iPod-compatible stream. 

Sony PSP: Sony PSP-compatibler stream. 
 

Profile/Level 
Profiles: Profiles define the encoder properties that are supported. 

Level: The level determines which bit rate and resolution are possible for the video.  
 

Picture type 
"Picture type" specifies which parts of a frame should be used as the basis for the 
encoding: 

• Frame: A frame is a single image from a video sequence, also called a full image. 
• Field: A half-image, two of which combine to produce a frame. Read more about 

this explanation regarding "Interlace (view page 361)". 
 

Field order 

Note: This parameter is only available if the setting "Field" is selected for "Frame 
type". 

In case of interlaced streams, the half-image sequence is set. Read more about this 
explanation regarding "Interlace (view page 361)". 
 

Slice count 
A frame can be divided into multiple slices for encoding. Specify the maximum 
number of slices are permitted. If set to "0", then the number will be determined 
automatically. 
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Rate control 
The bit rate indicates how much data per second is saved in the video (playback 
speed). This makes the bit rate the deciding parameter with regard to the file size and 
quality of the video to be encoded. A higher bit rate means more quality but also a 
larger file size. 
 

Mode 
• Constant bit rate: The constant bit rate should only be used if the device used to 

play the video supports constant bit rates. 
• Variable bit rate: The bit rate varies. For faster movements in the video, the bit 

rate increases, and for still images or slow pans, a lower bit rate is sufficient for 
creating the video in constant quality. 

• Constant quality: Similar to the "Variable bit rate" mode, the bit rate varies 
according to the video material. The quality depends on the selected profile and 
can be changed. 

• Constant quantizer: In this mode, a fixed colour quantization is used for the 
macro blocks. Under Advanced settings, a value between 1 and 32 can be set 
independent of the respective frame (I-Frame (view page 361), P-Frame, or B-
Frame (view page 363)). The higher the value, the stronger the quantization: 
small values produce qualitatively high-quality images and the data rate 
increases, and larger values produce a reduction in data, but the quality suffers. 

 

Bit rate (Bits/s) 
• In "Constant bit rate" mode: Exactly those values entered are applied to be able 

to calculate the size of the video precisely.  
• In "Variable bit rate" mode: The values entered here are applied to the video as 

an average as a guideline. The size of the video to be exported can only be 
approximated. 

 

Max. rate 
This is the maximum bit rate that should be present in the video stream, i.e. maximum 
number of bits that may be transferred to the decoder. 

Note: This option is only available in "Variable bit rate" mode. 
 

Pixel aspect ratio 
Specifies the page ratio of the individual image points (pixels). 

Meaning: Different television norms and the standard pixel ratio. Select a setting and 
the results are displayed as "X" and "Y". 

X/Y: The actual pixel ratio. If under "Meaning" the setting "Custom" is selected, then 
a custom ratio can be set. 
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GOP structure 

Max key interval 
Determines the maximum GOP (view page 361) length. High values mean improved 
compression. Lower values create stronger security protection and enable improved 
access to individual frames for processing the video. 
 

B-frames count 
The number of B-Frames (view page 363). Several applications, e.g. video 
conferences, require a setting of "0" for this, i.e. no B-Frames, in order to enable the 
shortest possible reaction times for transfer. 
 

Scene change detection 
If this option is activated the scenes will be detected during encoding, thus allowing 
you to insert an I frame (view page 361) after a scene change.  
 

Audio codec: 
Under "Audio", "AAC" (view page 356) is preset. If you have chosen an AVCHD 
transport stream from the presets, "AVCHD audio track" will be available. 
 

AAC 
AAC was developed by MPEG, the Moving Picture Experts Group, as an audio data 
compression process that was specified as a further development of MPEG-2 
Multichannel in the MPEG-2 standard.  

AAC is equally suitable for encoding general audio information and not especially 
optimized for certain types of audio material.  

AAC audio can be encoded with a sample rate of 8000, 16000, 24000, 32000 or 
48000 Hz in either mono or stereo. By default, the sound is set to 48000 Hz stereo. 
The higher the sample rate is, the larger the resulting file and higher the audio quality. 
You can use the technical specifications of your playback device to help with this. 

Advanced audio settings: 

• The bit rate can be set between 6 and 512 kbit/s. 160 kbits/s is active by 
default. The higher the value is, the larger the resulting file and higher the audio 
quality. After a certain limit, additional improvements to audio quality will not be 
perceived. Bit rates under 64 kb/s are not recommended. 

• As an MPEG version, set MPEG-4 or the older, proven MPEG-2 format. 
• For the File Header Type, choose either RAW or ADTS. The "Header" indicates 

an explanatory head for the beginning of the file segment, which in fact takes up 
extra space, but is required for decoding under circumstances. 
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- RAW indicates material which does not include a file header in audio format. 
The audio material is therefore transferred directly without any special 
additional information (raw). 
This requires that decoding routines are able to process the material without 
the explanatory file header. Especially in case "exotic" sample rates are set, 
this can lead to problems during RAW encoding. 

- ADTS indicates a file header type which contains information for encoded 
audio material. In case of doubt, select this file header type, since fewer 
problems can be expected in this case. 

 
Profiles:  

• Low complexity: Data is present in a form that hinders different decoding 
algorithms (noise replacement), but enables others (temporal adjustment noise 
formation). 

Note: For example, Apple iPod requires "low complexity encoding". However, you 
don't need to worry if you select the right preset for Apple iPod in the export dialog. 

 

AVCHD audio track 
If you have chosen an AVCHD, AVCHD transport stream, or Blu-ray (H.264) from 
the presets, "AVCHD audio track" will be available. 
 

Multiplexer 
The Multiplexer combines audio and video streams so they can be played back 
together on playback devices. 
 

Output format 
MPEG-4 file: This is an MPEG standard (ISO/IEC-14496) with the original goal of 
supporting devices with less computing performance. Currently, MPEG-4 has reached 
a wide bandwidth of application, from HD video to support for mobile telephones. 

JPEG2000 file: DCI (Digital Cinema Initiative) has been replaced by the JPEG2000 
format for encoding movies. The current distribution and presentation of films has 
been taken over by digital projectors that play back high-resolution Mj2 streams in 
outstanding image and sound quality. 

3GPP file: A standard supported by plenty GSM and UMTS mobile telephones. 3GPP 
is very similar to the MPEG-4 standard, but also supports formats that are not 
permitted by MPEG-4. 
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Streamable format 
Activate this option if you would like to create files that can be integrated into and 
played back on websites. This way the file can be played back without having to be 
completely preloaded. 

Note: This setting is recommended if you choose the option "Export as website". 
 

For Sony PSP 
Switch on this option if the video should be played back with the Sony PSP. 
 

For iPod 
Switch on this option, if the video should be played back with the Apple iPod. 
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MPEG glossary 

Motion estimation 
Motion estimation is a further element for reducing data used in MPEG encoding.  

Motion estimation also occurs in the B and P frames. The image difference that still 
exist after prediction (view page 363) are examined. Complex algorithms are used to 
search for an original occurrence of the macro block in the reference frame of each 
macro block of the P or B frame (these are units of 2x2 blocks specially combined for 
this purpose), which have been moved either by movement or by camera pan. They 
can then be left out in the P and B frame. Only the information by how far and to 
where the macro block has been moved is saved instead. This vector is called the 
motion detector. 

In the General encoder settings, you can specify the quality of the final MPEG video. 
This factor also influences the time required for encoding. The longer it takes, the 
better the quality. 
 

Bit rate 
MPEG is a format used for storage and transferring. With older formats (e.g. AVI) you 
could predict that 20 seconds of movie would result in 20 MB of data. The file size is 
this a direct measurement of quality.  

This is different for MPEG: The amount of data available can be used differently for 
different display modes. 20 MB can be 4 seconds of DVD Video or 5 minutes Internet 
streaming in thumbnail format. The quality of an MPEG video is measured by the 
width of the created data stream, the bit rate. This is the amount of the transmitted 
data per time unit; it is stated in kBit/s or bit per second. 

Bits, not bytes are used, since the data word width has to address the transmission 
restrictions. 

The file size can be calculated from the average bit rate, if its length is known: 

F = (BRV + BRA) * t 

F=File size BRV= 
Video bit rate 

BRA= 
Audio bit rate 

t=Length in s 
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Block 
For almost all image file editing techniques the image is subdivided into 8 x 8 pixel 
blocks (image points). This should be noted if you would like to used user-defined 
image resolutions (width/height), and they should always be a multiple of 8. 
 

Chroma format 
The color value of each image point consists of the color values for the primary colors 
red, green, and blue (RGB), and for traditional and technical reasons it is transformed 
into one brightness value (Y = 0.299*R = 0.587*G + 0.114*B) and two color 
difference values (U = R - Y, V = G -Y). 

The Y value alone produces the black and white picture. These signal components 
allow brightness and color information to be handled separately. The first data 
reduction occurs  when single rows comprising a picture are read. Because the human 
eye has a lower color resolution than a brightness resolution, the color components 
are recorded only for every other point of a row (4:2:2) for each four pixels grouped 
(4:1:0), i.e. color signal under-reading. 

4:2:2 This corresponds to the established TV standard. One piece of color information 
is transmitted per row for two pixels which corresponds to a 2/3 compression of the 
output data. 

4:1:0  This is the color coding used for DVDs and most other consumer video 
applications. For each 4 pixels grouped together on two rows, one unit of color 
information is saved. This corresponds to a output data compression of 1/2. 
 

Field 
A half-image, i.e. two halves which combine to produce a frame (see de-interlacing 
(view page 361)).  
 

Frame 
A frame is a single image from a video sequence which also called a full image. PAL 
video, for example, contains 25 frames per second, NTSC 29.97 frames.  

Video recordings, with the exception of computer animations and still frames, don't 
contain full images. Instead, they have double numbers of half-images (fields) which 
are transmitted in an interlaced state. However, we still refer to frames, since many 
predecessors of MPEG compression are based on such frames. Video editing 
literature usually refers to frames. 
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GOP 
Group of Pictures: The sequence of I frames and the P and B frames that belong to 
them. 

e.g. I B B P B B P B B I ... 

(This GOP has a length of 9, with 2 P frames and 2 B frames) 

I frames contain the entire image information of a frame, while P and B have part of 
the information. So-called prediction (view page 363) and movement approximation 
are methods used for reduction. 

The combination P B B is called a subgroup. 

I frames must appear in regular intervals in the data stream for image and sound to be 
synchronized. Between the I frames only a limited count of P and B frames is allowed. 
This explains a few things: Since P and B frames contain only differential information, 
these differences will be larger with time, since more and more changes takes place 
from frame to frame. A large count does not make much sense, since GOP has a 
maximum length of 15 (4P, 2B) in PAL and 18 (5P, 2B) in NTSC. (More than 2 B 
frames between P frames is not allowed). 

In a closed GOP, B frames of the last subgroup may contain only backward 
predictions or references to the preceding P frame, but no references to the following I 
frame, since it belongs to the next GOP. 
 

I frames 
Intra-frames: In these pictures, the entire image information of a frame is saved and 
only information from this frame is used ("intra-frame encoded"). In contrast to the I 
frame, P and B frames save only the differences between the current frame, and 
preceding and/or following frame are also found in MPEG video (P frame = "predicted 
frame", B frame = "bidirectional frame", see Prediction (view page 363)). 
 

Interlace 
For historical reasons, pictures in a movie are always recorded and transmitted in the 
form of two fields, first the lines with even numbers and then those with odd 
numbers. These fields are alternatively displayed with a double-frame rate. The (lazy) 
eye of the viewer or the processing of the TV tube puts the two frames together to 
form one. 
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The output image First field Second field 

You normally don’t have to worry about field processing. The video material goes 
through the entire processing chain as fields and is exported again as fields or burned 
onto DVD or shown on TV when played back on a DVD as a full picture. Only in 
certain rare conditions is it necessary to delve deeper into this process. Two problems 
can occur: 

Interlace artifacts 
To be displayed on a computer monitor the two fields must be combined to form a 
full screen.  

These two fields are not the same, since two fields are created during the recording 
(between which a 1/50 of a second gap is evident). Moving objects can therefore 
produce artifacts at the vertical edges. 

  

Typical interlacing errors 

You can use so-called "de-interlacing" to avoid these artifacts. A picture in between 
the two fields is created (interpolated). So if you want to create stationary pictures 
from movies, then you should definitely use a de-interlace filter. 

Incorrect field rate 
If you move around the series of fields in a movie data stream you can see strong jitter 
and flicker effects. Picture objects move in a backward movement - two steps 
forwards, one back - since a delayed field is shown before the previous one. This can 
happen in the processing chain if you export video material improperly with the wrong 
field order and then import it into different material.  

We use MXV or MPEG "Top field first" format for all analog recordings ("odd" in 
other programs). DV-AVI on the other hand is saved with “Bottom Field First”.  
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P frames and B frames 
P frames save only the difference between the current picture and the preceding I 
frame. The "P" comes from the term "prediction" which describes this process. 

B frames save the differences between the current picture and the I or P frame 
preceding and following. This includes the information that was the same before and 
remained the same after the current frame. Both directions are analyzed (indicates 
the "B" in the name, i.e. "bidirectional-predicted"). You can read more under 
prediction (view page 363). 
 

Prediction 
Prediction is a method of data reduction used by the MPEG format. The image 
elements already known from the previous or following frames are removed from the 
data stream. 

How does it work? 
The encoder has a precisely defined GOP, for example IBBPBBPBB. This sequence is 
transmitted together with the encoder, which always knows exactly which kind of 
frame comes next. I, P, and B frames are differentiated. 

Hint: When we talk about pictures, we mean frames of the video output, and I, P an 
dB frames are the frames of the encoded video. Just as in movement approximation, 
blocks (8x8 pixels) are united into macroblocks (16x16 pixels) during prediction. 

The first frame is always the I frame. It is completely encoded from the first picture. 
Afterwards, the 4th picture is analyzed for the creation of the first P frame. (As 
already said, the encoder, and later the decoder, will know that two B frames belong 
between them.) This image will also be completely encoded, and afterwards all 
macroblocks that haven't changed in comparison to the I frame will be deleted. They 
will be replaced by corresponding references for the decoder that tell it "you already 
know what should be shown here, and you can get it from the last I frame". 

Now, the 2nd will be completely encoded, and all macroblocks identical to the first I 
frame and the following P frame will be removed. References to previous frames  are 
called backward predictions, and references to following frames are called forward 
predictions. The third picture will be edited in exactly the same fashion. 

The fourth picture we have already explained, and now we need the next P frame, or 
picture number 7. Pictures 5 and 6 are B frames again, which are compared to P 
frames to both sides of them (picture 4 and 7); these are followed by the last two B 
frames. These have a special place, since in closed GOPs, they may contain only 
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backward predictions, and no references to the next I frame, because it belongs to 
the next GOP. 

Something else: Since the decoder is no prophet, the P frames are always transmitted 
before the B frames! The GOP explained above will be encoded and transmitted in the 
order it is written. 

Original 
GOP 

I0 B01 B02 P01 B11 B12 P02 B21 B22 I1  

Data stream I0 P01 B01 B02 P02 B11 B12 B21 B22 I1 ...  for closed GOPs 

 I0 P01 B01 B02 P02 B11 B12 I1 B21 B22 P11...  For open GOPs 

Due to this nested structure, it is easy to see that during direct editing of MPEG 
material, complicated computations have to take place! These are made easier using 
a frame table. A frame table contains a list, where the information of every frame in 
the data stream is found, identifying the type of frame it is.  

Using Movement prediction (view page 359) P and B frames are likewise reduced. 
 

Quantization scaling 
The single pictures in MPEG are saved using a compression method comparable to 
JPEG with bitmaps and associated with quality loss. For this single images are divided 
into 8 x 8 blocks (view page 360). 

Each one of these blocks is then transformed into an 8 x 8 matrix (a table with rows 
and columns) using a DCT (discreet cosinus transformation) mathematical method. 
Each of these values is produced using all 64 individual pixels of the block, but the 
values in the matrix are ordered in such a way that the image information is ordered 
according to its importance. 

This matrix will then be multiplied by another matrix, i.e. the quantization matrix. 
Exactly how and why this matrix must be created is the biggest secret of encoder 
programmers, since this determines the quality of the whole encoding process. What 
is known is that the result should contain as many zeros as possible! These zeros 
correspond to the "unimportant" image elements mentioned and will not be 
transmitted in the data stream. 

Depending on the encoder parameters regarding the target bit rate, fewer or more 
values of the matrix will be declared unimportant by dividing the quantization matrix 
by the quantization scaling factor. Since only whole numbers are used, a division can 
produce a zero is the remainder is discarded. 

This factor is also a direct measure of the sought image quality of the MPEG data 
stream, since the "Q" in "Q" factor stands for quantization and quality. 
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If you still have questions 

Note regarding special program versions: This documentation describes the full 
range of features in MAGIX Movie Edit Pro. The range of features may differ in the 
program version/edition you have acquired. 

 

Tips for Program Help 
When the program is open, you can access the Help feature by pressing F1 on your 
keyboard. The program Help contains tips on how to use the program and lots of 
additional information. Many important terms are indicated in the text in italics. 
Simply click on these terms for a more detailed explanation of what they mean. 

Context Help: Press the "F1" key on your keyboard at any point in the open program 
and Help will open with the matching help topic. 

Search function: This feature can be used to look for specific words in the Help 
section. Enter either the individual word or use logical operators (e. g. OR, AND, 
NEAR) to refine your search if you have several search words. 
• OR (between two words): all topics which contain both words or one of the 

words will be listed. 
• AND (between two words): only those topics will be listed which contain both 

words. 
• NEAR (between two words): only those topics will be listed which contain both 

words. A maximum of 6 additional words are allowed between two search 
words. 

• NOT (before a word): topics which contain this word will not be listed. 

Print: The print function can be used to print out specific Help topics or entire topic 
sections. The print button is located at the very top of the toolbar in the Help window. 
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Glossary 
Symbols & Numeric 
1080i/1080p 
1080i or 1080p are the so-called Full HD resolutions. These have a resolution of 1920 
x 1080 pixels. The "i" stands for "interlaced" (view page 372) and means that each 
field is stored, as with interlaced scanning. The "p" stands for "progressive" and 
means that entire images are stored. 
 

720p 
This is the "small" HD resolution, which is sized at 1280 pixels x 720 pixels. The "p" 
stands for "progressive", i.e. full images are always displayed. 
 

A 
Aliasing 
Aliasing, or alias effects, are mistakes that appear during digital scanning of sounds, 
videos or images when the sample frequency (in audio editing) or resolution (in video 
editing) used are too low. 
 

ATN: 
This abbreviation stands for "Absolute Track Number". Which is the actual time code 
of DV and HDV recordings recorded using the helical scan method.   
 

Audio 
This is then referred to as "audio" when the sound signal is saved directly as such on 
the PC. The actual sound is recorded or played back here. 
 

audioid 
audioid is a process used to determine the title and artist name base on musical 
properties. An Internet connection is required to access the audioid database. 
 

AVCHD 
Stands for "Advanced Video Codec Definition". It is an HD format for video cameras, 
which has been developed by Panasonic and Sony. In comparison to the "HDV" 
format, a clear improvement in quality can be seen here. 

MPEG-4 AVC/H.264 is used for video encoding and AAC or AC3 for audio encoding. 
The maximum bitrate is 25 Megabits/sec. 
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AVI 
The AVI format (Audio Video Interleaved) isn't actually a proper video format! 
Rather, it is a so-called "container" for which the conventions for transferring audio 
and video files to the program are only loosely defined. More in this topic can be 
found in General notes on AVI videos. (view page 332) 
 

B 
Backup disc 
Copying of files to a different file storage medium to secure these files is called 
backing up, or creating a backup. 
 

Browser 
A browser (also known as web browser, or Internet browser) is a computer program 
that displays websites. The best-known browsers are Internet Explorer, Firefox, Safari, 
and Opera. 
 

Button 
Refers to an element of the graphic user interface of a program. The button initiates 
an action in the program via left mouse click. 
 

Button 
Refers to an element of the graphic user interface of a program. The button initiates 
an action in the program via left mouse click. 
 

C 
Cache 
Simply stated, this is a temporary folder where frequently accessed files are saved so 
that they can be quickly launched while you are working. 
 

CC 
CC stands for "Connectivity Co-ordination" and describes how the change of a 
domain name from one provider to another occurs (domain transfer). 
 

Clip level 
Signifies the volume level at which the recorded signal is overmodulated, or "clipped". 
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Clipboard 
The clipboard is used to temporarily store objects during execution of commands like 
"copy" and "cut". 
 

Clipboard 
The clipboard is used to temporarily store objects during execution of commands like 
"copy" and "cut". 
 

Compatible 
Different devices are compatible with each other if they operate together without any 
errors occurring. 
 

Context menu 
Context menu can be reached by right clicking on a selected object. It offers functions 
which are available and can be expected in the given context. 
 

Copyright 
Protection of intellectual and creative property against unauthorized copying. 
 

Copyright 
Protection of intellectual and creative property against unauthorized copying. 
 

CPU 
Central processing unit: The name for the main processor of the computer (CPU). 
Modern computers have even two or more processors, or one processor with several 
cores.  
 

D 
Dialog 
A dialog opens in a new window and lets the user interact with the program. This 
means that the dialog can present information to the user and/or expects to receive 
input from the user. 

A dialog can contain various user elements which can be manipulated by a simple 
mouse click. Keyboard entries are also possible. 
 

Disc project 
A "Disc project" includes everything that you want to put on your CD and DVD.  
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This normally contains one or more movies and includes a menu structure/menu 
design which allows you to choose a movie later on the CD or DVD. 
 

Disc types 
The disc types determines the format and medium (CD, DVD, Blu-ray disc, etc.) to 
which the current project will be burned. 
 

Dissolve 
Transitions, Dissolve. Can be used to fade between objects. 
 

DNS 
The abbreviation DNS stands for Domain Name Service and refers to a provider of 
Internet services that registers domain names for customers. 
 

Domain 
A domain is the website's Internet address. It consists of the name of the Internet 
protocol (usually http://), the computer or network name (such as www), the 
second-level domain (such as magix), and the top level domain (like .com, .net). 

Altogether we have: protocol://networkname.second-level-domain.top-level-domain 
(such as "http://www.magix.com"). 

Domains are allocated by a country's so-called NIC (Network Information Center). In 
Germany the DENIC is responsible for the release of domains. 
 

Domain transfer 
See CC. If you already have a domain, you can move it from your previous provider to 
another provider. 
 

Downmix 
A method developed for audio technology to turn a Surround Sound recording into a 
version with fewer channels. Most often (as is the case with MAGIX Movie Edit Pro) 
this will be a stereo version. 
 

Drag & drop 
Enables files and objects to be moved freely between various applications (or within 
an application) by dragging the object and letting it drop using the mouse cursor. 
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F 
Fader 
Used for visual input of values. Similar to volume control on a mixing board, you can 
control various parameters by sliding the fader. A very common example for this is 
the zoom slider that lets you see a picture in more detail. 
 

Field 
A half-image, two of which combine to produce a frame (see interlace). 
 

Flip menu 
Drop down menus create menus consisting of lists of selectable choices. They look 
very similar to text input fields, but have a button with a downward-pointing symbol 
on the right-hand side. 
 

Frame 
A frame is a single image from a video sequence which also called a full image. 

A PAL video contains 25 frames per second; NTSC contains 29.97 frames. 
 

H 
Handles 
Handles are the five little rectangles at the edges of selected objects. All curve points 
can be moved by holding down the left mouse button. 

Length handles: Bottom right and bottom left. You can use them to change the length 
of an object. 

Transition/Fade handles: Top right and top left. These can be used to softly fade an 
object in or out. 

Volume/Brightness handle: Above-center. You can use it to adjust the volume or the 
brightness. 
 

Hard disk 
Storage medium with the largest storage capacity where the operating system(s), 
programs, and files are saved. A hard disk can be built into the computer, but there 
are also external hard disks which can be used with different computers via a USB 
connection (portable drives or external hard disk). 
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Hard disk drive 
Storage medium with the largest storage capacity where the operating system(s), 
programs, and files are saved. A hard disk can be built into the computer, but there 
are also external hard disks which can be used with different computers via a USB 
connection (portable drives or external hard disk). 
 

Hardware 
The all-encompassing name for all internal components of a computer. For example 
hard disk, graphics card, mainboard, etc. External peripheral devices are also 
considered hardware, i.e. printer, scanner, monitor, etc. The synchronization of single 
hardware components is coordinated by the software. 
 

HDD 
Storage medium with the largest storage capacity where the operating system(s), 
programs, and files are saved. A hard disk can be built into the computer, but there 
are also external hard disks which can be used with different computers via a USB 
connection (portable drives or external hard disk). 
 

HDTV 
This acronym stands for "High Definition Television. 
 

HTTP 
Stands for Hyper Text Transfer Protocol and is used for transferring websites onto the 
Internet (from web server to the browser). For this reason, the abbreviation http:// 
always comes before the Internet address. This is automatically inserted and does not 
have to be entered when entering the Internet address. 
 

Hyperlink 
Hyperlinks (or in short "links") are references to other websites/online documents (or 
other computer networks). They build the base of the World Wide Web (WWW) as 
it is only via these hyperlinks that networking or interlinking between the billions of 
website out there is actually possible. 
 

I 
ID3 tags 
ID3 tags contain title information that can be added to a music title. This includes the 
title, artist, album, as well as the genre, year of release, and other criteria that can help 
searching through a database. The database is created using this information. 
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Info: Title information will only be saved for MP3s in the so-called ID3 tags (Identify 
an MP3), but other formats offer similar possibilities, like "Vorbis comment" for the 
OGG Vorbis format, for example. 

 

Image 
An image is a representation of a CD, DVD, hard drive, or another storage medium 
that is saved as a file. 

The difference from a copy or backup is that an image contains information about the 
structure of the original storage medium, and not just individual files. This enables 
01:01 copies of complete storage media to be created. 

Caution! Copyright laws forbid copying of commercial CDs/DVDs, and for this 
reason, this process can be prohibited by copy protection. 

 

IMAP 
Stands for Internet Message Access Protocol and is an advanced process of receiving 
emails. 
 

Interlace 
Describes the creation of a full image from 2 half-images (fields). 

In this process, even and odd lines are alternately assigned to one of the two fields. 

The human eye perceives both of the projected half-images as a single full image, so 
that despite the slow image repetition rate (25 Hz for PAL, 29.97 for NTSC) a 
subjectively fluid image is seen. 
 

Intro 
"Intro" means the introduction or opening credits of a movie. 
 

J 
jpx 
A format developed by MAGIX which is used for photo editing. It enables free 
experimentation with effects without altering the original file. The effects settings are 
also displayed when the photos are opened using a different MAGIX program. 
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M 
Menu 
Menus contain practically all the program functions. They can be opened using a 
simple mouse click on the corresponding menu. Keyboard shortcuts, if available, are 
also found at the end of menu entries. 

The graphical surface of a CD/DVD will also be represented as a menu. 
 

Menu bar 
Almost every program has a menu bar. It can normally be found underneath the title 
line of the program. A simple mouse click opens a corresponding menu. 
 

MIDI 
MIDI files do not contain the actual sounds like audio files, but only the note control 
information which can be interpreted during playback by the synthesizer chip on the 
sound card or an external synthesizer. 
 

MMC 
MMC stands for MIDI Machine Control and is part of the MIDI protocol. Transport 
control and position data is conveyed using MMC. 
 

Motherboard 
This is the centerpiece of hardware components of a computer. All other hardware 
components like CPU, RAM, hard disk, additional drives, graphics cards, as well as 
other cards for specialized uses are connected to the motherboard.  
 

Motherboard 
This is the centerpiece of hardware components of a computer. All other hardware 
components like CPU, RAM, hard disk, additional drives, graphics cards, as well as 
other cards for specialized uses are connected to the motherboard.  
 

Motherboard 
This is the centerpiece of hardware components of a computer. All other hardware 
components like CPU, RAM, hard disk, additional drives, graphics cards, as well as 
other cards for specialized uses are connected to the motherboard.  
 

MOV 
MOV is a video and audio format developed by Apple, which has since become 
widely used with Windows. QuickTime supports lots of compression technology, 
which make it possible to optimize audio and video and even graphics for the Internet 
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and multimedia/video applications. Conventional (hardware) DVD players are not 
able to play this format. 

 
 

Movie 
In MAGIX Movie Edit Pro, an arrangement of various objects (videos, photos, text, 
sound, etc.) is called a movie. A movie file has an "mvm" extension. 
 

MP3 
MP3 (actually MPEG-1 layer 3) is currently the most important standard for 
compressing audio files. 
 

MPEG 
MPEG is short for "Moving Picture Experts Group" and refers to a committee 
concerned with the standardization of video and audio data compression as well as 
container formats. 
 

MS audio 
A process developed by Microsoft for compressing audio files with properties similar 
to those of MP3. 
 

MTC 
MTC stands for MIDI Time Code and it transmits the exact playback position via 
MIDI. In this way, programs and devices can be synchronized with each other. 
 

MXV 
This is the MAGIX video format for quicker processing with MAGIX products. It 
offers very low loss of quality, but it cannot be played via conventional DVD players. 
 

N 
Noise Sample 
Sample of a noise that is to be removed 
 

NTSC (USA, Japan) 
NTSC stands for "National Television Systems Committee". This is a US institution 
that defined the first color carrier system for TV which is now used in most of 
America and some East Asian countries. 

The image repetition rate for NTSC is 29.97 Hz. 
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Numeric keypad 
Also known as the numpad, or the number block. 
 

O 
Offset 
With an offset of 60:00:00 (1 hour) you can, for example synchronize a tape whose 
time code that starts at 1 hour, MAGIX Movie Edit Pro however, still starts the tape 
beginning at 0.  
 

OGG VORBIS 
This is a new, royalty-free format with similar properties to MP3. 
 

P 
PAL (Europe) 
Phase Alternating Line, or PAL, is a process for color transmission for analog TV that 
is primarily used in Europe, but also in Australia, South America, and many African 
and Asian countries.  

The image repetition rate for PAL  is 25 Hz. 
 

Play marker 
The play marker is a red vertical line which moves from left to right during playback. It 
indicates the current play position.  
 

Playlist 
Arrange your songs in playlists from various sources in different formats and in 
whatever way you like, sometimes updated daily. 

Important: Playlists are only links to songs on your hard drive or in your CD drive.  

When you add a song to your playlist whose real source is a CD in your computer's 
drive, the song will no longer be playable when the CD is removed from the drive. 

Similarly, when you move a folder on your hard drive, the playlist will no longer be 
able to play the song, since the link is no longer valid.  

For the latter, however, there is a simple solution: If you know where the song has 
been saved, then you can redefine the path. A corresponding dialog window is 
provided for this purpose. You can reset the path by navigating through the Explorer 
folders. The playlist is now correct once again.  
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Plug-in 
Plug-ins are additional programs that expand the functionality of the main program. 
They are inserted into the main program. 
 

POP3 
Stands for Post Office Protocol (version 3) and is used in standard email programs for 
receiving email (for example, Outlook Express). POP3 enables email to be collected 
by the provider's email server and loaded into your email program. 
 

Project 
A "Disc project" includes everything that you want to put on your CD and DVD.   

This normally contains one or more movies and includes a menu structure/menu 
design which allows you to choose a movie later on the CD or DVD. 
 

Provider 
A provider or ISP (Internet Service Provider) offers Internet services like webhosting 
or domains (DNS). In relation to the MAGIX Website Service, MAGIX is the provider. 
 

R 
RAM (Random Access Memory) 
This is a hardware component of a computer. RAM is needed to temporarily save 
files. This type of storage is erased when the computer is shut down or reset. The 
larger this storage is, the faster you can work with programs to change and save files. 
 

Ratio 
The aspect ratio is the ratio between the height and width of a rectangle. In practice 
these are photos, screens or projection screens. This method can also be used to 
describe the aspect ratio of pixels. 

Here are some examples of typical aspect ratios: at home 4:3, 16:9 (typical for TV 
sets), or 16:10 (widescreen flat screens, widescreen notebooks), 3:2 for 35 mm films 
and photos. In cinemas you mostly find 1.85:1 
 

Red Book 
Specific standards have been established for the different CD types in order to unify 
their data structure and to make them compatible with the different CD drives. Their 
names refer to the color of the books where these standards were written.   

The term "Red Book" is common language for the Compact Disc Audio Standard. The 
requirements listed here have to be observed for industrial CP production. Audio CD 



 

 

Glossary 377 

 

players only read CDs created according to the Red Book format. It is therefore 
necessary to first convert PC files into this format before writing them onto an audio 
disc compatible with any audio CD player. 
 

Restore 
Restoration of files originating from a backup is called "Restoring". 
 

RM 
RealMedia includes all of the media formats from software developer RealNetworks. 
RealMedia especially refers to the "RealVideo" video format and the "RealAudio" 
sound format. The quality of RealVideo files is comparably good at high compression 
rates, but does have some loss of quality. These formats cannot be played back by 
(hardware) DVD players. 
 

S 
Scene 
Freely definable section of a video in MAGIX Movie Edit Pro. 

In general, a scene is a segment of a film that is a product of various settings and 
conveys a certain action. 
 

Screenshot 
A screenshot is an image composed of all visible screen elements (messages, open 
dialogs, etc.) at a certain time. By pressing the "Print screen" key on the keyboard, this 
image is saved into the clipboard. Next, open a program which can edit images and 
select "Insert" (shortcut "Ctrl+V") in a new document to add the screenshot for 
editing and saving. 

Note: Press "Alt + Print screen" on the keyboard to capture the active window only. 
 

Slider 
Used for visual input of values. Similar to volume control on a mixing board, you can 
control various parameters by sliding the fader. A very common example for this is 
the zoom slider that lets you see a picture in more detail. 
 

SMTP 
Stands for Simple Mail Transfer Protocol and enables the exchange of emails across 
computer networks. 
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Software 
The name for all non-physical functional components of a computer. This primarily 
includes computer programs and files that are meant to be used by computer 
programs. 
 

Submenu 
Along with normal entries, a menu can contain submenus that offer additional 
functions. These provide a better overview of the menus. 
 

T 
Timeline 
In the Timeline-Mode (view page 30), the media being used is always displayed on a 
timeline that runs from left to right. 
 

Toolbar 
Here you will find small buttons that provide a function when clicked. For example, 
you can cut out a selected object by clicking on the scissors. 
 

Toolbar 
All basic functions of the corresponding program can be found here. The 
corresponding functions can be called up via mouse click. 
 

Top-level domain 
Top-level domains (TLD) are always those separated by a dot at the end of an 
Internet address (for example, "http://www.magix.com" < here, .com is the top-level 
domain). Among these are also country top-level domains, such as .co.uk, .us, .de as 
well as so-called generic top-level domains like .net, .org, .biz, and so on. 
 

Traffic 
Traffic (data transmission) occurs within your MAGIX Website Service as soon as 
data is transferred across the Internet: for example, when uploading or downloading 
files to your website or when someone else opens your website. 
 

U 
Universal Plug & Play; UPnP 
Universal Plug ‘n’ Play (UPnP) is a network protocol which enables data exchange 
between different devices (PCs, hi-fi systems, video cameras, PDAs, and webservers). 
UPnP allows various devices to participate in network-wide communication, i.e. the 
initialization of functions and other device functions. Long-winded configuring or 
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installing of drivers is not required as the devices can handle their own functions and 
data sources by themselves. Find out more at www.upnp.org. 

Hint: To work with UPnP you have to activate it first. This can be found under 
"Options" ("Y" -> UPnP).  

 

URL 
URL stands for Uniform Resource Locator and describes where a source can be found 
online (for example, a website). The address or the path to the storage location of a 
file on your computer is known as a URL. Often the term URL is used as a term for the 
domain. The URL for the MAGIX website is: http://www.magix.co.uk 
 

V 
VirtualDub plug-in 
Plug-ins are additional programs that expand the functionality of the main program. 
They are inserted into the main program. 

VirtualDub plug-ins are also referred to "VirtualDub filters" and have the "VDF" file 
extension. You can use them to apply additional video effects to video objects. 
 

VST and DirectX plug-ins 
Plug-ins are additional programs that expand the functionality of the main program. 
They are inserted into the main program. 

Two standards exist for audio editing: VST (Steinberg) and DirectX (Microsoft). VST 
has asserted itself stronger in the current market.  
 

W 
WAV 
Wave (*.WAV) is a standard uncompressed audio format. 
 

Wave 
Wave (*.WAV) is a standard uncompressed audio format. 
 

Wave file 
Wave (*.WAV) is a standard uncompressed audio format. 
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Webhosting 
This means that an Internet Service Provider makes domains and webspace available 
to its customers. With the MAGIX Website Service, MAGIX provides webhosting to 
its customers. 
 

Webmail 
Webmail enables the customer to view and receive the contents of their email inbox 
without having to install email software on their computer. Customers of the MAGIX 
Website Service can use MAGIX Webmail for this. 
 

Webmaster 
A webmaster is responsible for the administration and maintenance of a website. 
Often, the webmaster is also the owner of the website as well as the domain that 
belongs to it. Once you have registered a domain in the MAGIX Website Service, an 
email account will automatically be set up, for example: 
"mailto:webmaster@domainname.co.uk". 
 

Webserver 
Webserver refers to the computer on which your host saves your website's pages and 
which makes your pages accessible on the Internet 24-hours a day. 
 

WMA 
A process developed by Microsoft for compressing audio files with properties similar 
to those of MP3. 
 

WMV 
Windows Media Video (WMV) is a trademark video codec from Microsoft. If you 
have Windows installed on your PC, then playing WMV files shouldn't be a problem. 
Only a few (hardware) DVD players are able to play this format. Read more about this 
in your DVD player's manual. 

This video format is very good for web videos as it allows relatively high compression 
rates. 
 

World Wide Web (WWW) 
WWW stands for "World Wide Web" and is the most used service of the Internet. 
On the WWW, web browsers (for example, Internet Explorer) are used to display 
information via websites. The process is colloquially called "Surfing the Internet". 
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